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Importing Clients

» Exporting Your Clients From Act! Into Client Track

Step 1

"% ACTY 2005 for Windows - test2

E[ Edit View Lookup Contacts Groups Schedule Write Reports
|6 NewDatabase. Cri+N | (3 & & @ @ B & §
(5 OpenDatsbase.. Ctrl+0 ’
e o cutew
I B save Ctrl+S
Save Copy As... F12 / | Phone | Address 1
Import... Alt+F12 ggg;gg ;2;:;::10“
| Eeort. Bl (6557739999 565 Redding Road
Back Up >
Restore »
Set Password...
@ Print... Ctrl+P
&2 Quick Print Current Window
1test2.pad
2test.pad
& et Alt:F4
R In menu, go to File > Export
Step 2
"Export Wizard (1 of 2) =)
Specify Destination E:)
Select the cestnaton databasa ocfie.
What type of file o you want to export to?
Test Deimted vl

User Nome { |

Password { ]

1) Select Text Delimited from drop-down list to export file to.
2) Click Browse and save export text file.
3) Click Next.




Step 3

Export Wizard (2 of 5)

Specify record type(s)
ACT! dta2as0s 030 CONtan CONDE 1000Nds, SOUP 80ids 3nd COMPany re0nds.

Wihat kind of recceds would you Ike to expoa?
(® Contact Records

O Group Resends
O Cempany Racords

Which records 6o you want to expott?
(® Current rececd
O Curract lockup
O Al cecords

Select type of records to export and then click Next.

Step 4

Spe—

EXport Wi'/_ardv(3 of "»-)

Specify export options
You may spechy the delmzecto be used for the expin, 3nd whether oe nat 20 ndiude
fold names with the exponed dats,

Salect field separatee

character €0 you want 1o use?

@ Comma
Ot

00 you want 1o expont field names?

WWhen expoating receeds, you have the opticn 10 include field names from the current

(V] Yes. expant faid namas

Export files are created with 3 spacific character separating each field of 3 record. What




"Export Wizard (4 'of b)

Contact Map W
Spacky the coder in wiich the certast falds from the cumently open ACT! database wil
oe wponed.
[Field Mame ~ set Feld
Add o ACT! Note ] =
a . Remove Field
I
Addeess 2 Pese
Addeess 3
Aliernate Extension
Alternate Phoce
Birth Date
City
Comrpany
-~
Couetry
S vl Sovelisp
CcBooc Jihee> ] | Fre | [LCaccel]

Select order of fields from list to export and then click Next.

Note: The order of the export fields do not matter because the field can be mapped
in Client Track.

Step 6

Export Wizard (5°of 5)
7 v =

Completing Export Wizard
Here is what you requested:

Dats Type: Texa Detimited

File Cestinaticn: C"Documents and
Settings'David Desktop ACT-Expoet-File.tet

Click Finish to complete exporting file.

Step 7

To import Act! export file into Client Track, follow the instructions on pg.35.



» Exporting Your Clients From Maximizer Into Client Track

g £6t View Sewch Actors
Ney Address Boox,.. Culant

Connect 10 Address Book...
3 Smcetunt B Qe Address Book C¥is0 Zen Zeceren  Cwece
| arveve Cloge Acdress Book :
Paoe e
ot . L
B etz TR agrinsrator
Lot 4
0t ip e SeAved Pern Page Sevp,
L) e Pt »
| wer
zrn gace (2 Send Emal
P, werd 4
oot .
PrreTer— et Lp Uses Dafinad Felds
v O 13 Preferences
= 8 o e —
e o
e Adben bty Olmine  Security Srouse \
| =]
Agton Plan Lbeaey,..
[rpoet »
B8 Expoct Address Book Ervms.,. |
Trarsfer »
« Bach i
L " i B { Pedey Cove 15, 3950
2t

R In menu, go to File = Export Address Book Entries

Step 2
Export Address Book Entries =

~Specfy expart fie

e |

Eormat: |Comma Separated value (") v| [ DOS text
SE——— COmmMma Seperated Value (7))
~Export opton| ;aafelmnd

[V Include field names as frst record in export fie

IT Include contacts

[T Include UDFs

I Include notes

[T Include documents

™ Support non-Snglizh ¢

1) Name export file and click Browse tc save the file to.
2) Select Comma Seperated Value from drop down list and then click Ok.



Step 3

Sever: | [ Deskton
‘c’)w Oodurents
| 5 My Computer
My Racert %w:namm
D?éf“ Seea Clent Lst.cov
Demton 2
\} Fle J I e ;I
MWOommsns | | Saveastype:  [CSV(".csv) |
abdeimied ("bd)
My Comoxtor All Files (%) i
W%N::‘v& Fla narray: [Eosnn = s |
Swoastpe:  [CSVCasv) ~| Cencel |
a0 Calmied " e}

NFies (2

1) Create export file name and select CSV (.csv) from drop-down list.

Step 4

'S("E'Cl Fields for Export

Qrder of expart fields to
ExportLUst. LSV

Al Name:
Address Lve 1

Frst Name
Full Acgess
2Denzficaton =

R Iy Wr Goa's
Snvestment mfvmam\:muw: Kronledoe

& nir s -
Srvestment Informatonfnvestrent Types [!J
= i - Taoal
< G |12

poot | gexe | comes |

Select which fields to export and then click Export.

Note: The order of the export fields do not matter because you can map the
fields in Client Track.

Step 5

To import Maximizer export file into Client Track, follow the instructions
on pg.35.



» Exporting Your Clients From Simply Into Client Track (A)

Step 1

' Simply Accounting by Sage Pro 2009 -

File | Edit View Setup Business Assistant  Services  Maintenance

New Company... CrleN (B Close other windows
Open Company... Ctrl+O
Save As... CtrleS vables

Save 2 Copy... |

Backup... @

Restore...
Customersv
Properties
I Import/Export » | Import Transactions...
Accountant's Copy N Import Records...
ort Records...

| .

Q In menu, go to File = Import/Export = Export Records

- The Export Records wizard vall help you export data from Simply
Accounting Simply Accounting can expoct & vatiely of infoimalion
Would you like to:

© Export to a Simply Accounting i He b

Export price hists

Click Newt to continue

1) Select Export records to a Simply Accounting import file format.
2) Click Next.



Step 3

Export Ledger Records Wizard - Select Record Type oS

Select the lype of records 1o expert:

) Vendees

© Customers

) lrwentory & Services
) Marketing

Enter & name for the expoat fle:
Chent List

Enter the location where you would ke to store the fle:
C:\Users\Demo\Deskiop\ | Browse... |

Click Next to contnue

| <Bock || MNet> | [ Cocd | [ Hep |

1) Select Customers as type of record to export.
2) Create export export file name and click Browse to save to.
3) Click Next.

Step 4

-&podledgcrkccords\ﬂrmrd-is_el«tke_coqu — 3

0 Select the customers pou want 10 export.
Cickinthe §g cokmntoputa / nextto the Rems youwant lo expart.

Narme -
4% B Tox Service E
4K Gupla
A1 Accounting & Business Solutions Inc
41 Tax & Bookkeeping
Access Bookkeeping Inc.
Accounting for Success
Accul ax Fnanciel Services Inc.
Adams and Associates Lid b

NSNS SSSS

[ Include inaclive customers | SelectAll |

Click Newt to continue

| <Bock | Net> | [ Cocd | [ Heb |

Select which customers you want to export and click Next.



Step 5

Export Ledger Records Wizard - Finish o]

Siply Sccounting has successfuly expotted receeds lo:

C:\Users\ashlesh\Desktop\Chent List Ixt

—_—

Click Finish to complete exporting file.
Step 6

To import Simply export file into Client Track, follow the instructions on

» Exporting Your Clients From Simply Into Client Track (B)

- |
Type a question for hep | Help Search_|+] "=

Reports | Help
Repert Centre... ‘rch: |Quick Search l =t
5 My Reports... Switch to
ﬁl Lists » | Chart of Accounts... 2
Financials » Accounts...
Banking » Vendors...
Vendors & Purchases... » | Customers... |P
Customers & Sales... » Employees...
Tax... Inventory & Senvices...
Payroll » Project...
Inventory & Services » |(604) 555-938¢ | $2
Project i (604) 555-4310 $14
(604) 555-8945
Recurring Transactions... (604) 555-8297
Transaction Details » |(604) 5558754
(604) 555-5037
Mailing Labels > | (604) 555-1927




Step 2

Customer List - ModifyReport 7 (o)
| Template: [ <Defauit report options> v| [ SaveTemplate.. |
By ] Include inactive customers
Sod Repod
Fiter Report
Print Settings
Font Settings

[ e l[w.lludol‘

Go through the Customer List options on sidebar and click Ok.

Step 3

"Customer List

|| File | Options Help

Reports & Forms... Ctrl+Shift«F ] Export Ope
Printer Setup...
Print Preview D
Print... Ctrl+P
Export... Ctrl+E 11
! .
2 : Street
Open in Microsoft® Excel... h Street
ide Drive
Close 2 B Alt+F4 luth Boulevard
|Brown, Jerome B. Tyler Lincoln 207 Heather Street
|Cavendish, Peter S. Helen Grano 123 Plimmerton Avenue
|Construction Concrete..  Chris Eberhardt 8940 Burrard
|DAB Collision Lid Sukhi Dylan 2550 Mo 3 Road
'E District Of Slocan Michael Young 4Gonville Street
Fogarty Motors SylviaHogan 8053 Great South Drive

R | In meny, go to File > Export



Step 4

[] Export Selection :q- '—ﬁ‘ e

3 ~/M Desktep » [ fseorr 3

iews ~ B New Folder

Favorite Links Name Size Type Date modifi
% Recently Changed Eﬂshley
1. Public
| B8 Desitop 1% Computer
‘I U Recent Places =¥ Network
& Computer | Backgreunds File Folder 26/02/2009 1
l I} Documents 1. Backup File Folder 02.'0312009”
B Pictures . Data File Folder 26/02/2008 1
B Music 1. David Backup Feb 27, 2., File Folder 27/02/20091
I Searches 4 Simply Screenshots File Folder 2300372009 }
s (& Documents 1KB Shorteut 14/01/2009 ¢
Folders » Il i | »
File pemez  Customer.csy -
Save 3¢ ype [Comm sepacated (".csv) v]
A Hide Felders [ Sawve | [ Canosl ]

1) Name export file and select Comma Seperated as save export type from
drop-down list.
2) Click Save.

Step 5

To import Simply export file into Client Track, follow the instructions on pg.35.

» Exporting Your Clients From QuickBooks Into Client Track

Step 1

{3123 - QuickBooks Pro 200809 (1rial)
300 Eat View Usis Compony Customers Supplers Smployees Boning Reports VWindowr Mep
en G @ | T % R_B

X -
Oden 0¢ Restire Corpany,.. Employee Centre  Report Centre
Qo Previcns Comdayy 4
Save Cooy o B3
Cloze Company
Snitch to MUt user Mode i =
iroor o ,
Tre > T -t - iF7 Fies
Audt Compay Fie Symdrense Conacts
Accountant’s Copy §]_Sonvet
Coavert Accountant’s Copy o Company fle (Q5W)...
Sewve a3 20 POzt MUSUser Azcess..,
PrsFerms )
Prone Set... :'”'.ND:a
Select Forrrs to Enad 4 : 3
Send Eor1rs... Clean Up Company Doa...
Updste Quasasis... S Qz,
- eate Syles
Artvate QuUddosks... i Receps
vt AeFs |

R In menu, go to File = Utilities = Export = Addresses to Text



Step 2

Select the lists that you would like to export.
[[] Chart of Accounts [[J payment Terms List
[¥) Customer List! [] payment Method List Cacel
[ suoplier List [ shipping Method List —
[l employee List [[] customer Message List
[[] other Names List [J sudgets
[C] Customer Tupe List [ 7o Do Notes
[ supplier Tyge List [J sales Rep List
[ Class List [JPrice Level List
[[J 20b Type List [[] Tax Code List
[] item List
] Payroli Items

Check off Customer List and then click Ok.

Step 3
- an Dosuments
@ | W My Comauter
Yy Resent My Netneck Places
Documents
‘ |
i\
Iy Documents
Wy Compct
¥ Fie name: E] E
Save astype: [ixxnm (=) E] [Cancel_|
My Netwok

1) Create export file name and select txt files (.txt) from drop-down list.
2) Click Save.

Step 4

QuickBooks Information

i) Your data has been exported successfully.

Click Ok after successful export.

11



Step 5

To import QuickBooks export file into Client Track, follow the instructions

on pg.35.

'@ Exporting Your Clients From Profile T1 Into Client Track

Client Track seamlessly imports the information from Profile T1 & T2 with
a click of a button. All you need to do is tell Client Track where your Profile files

are located and Client Track will give you a list of your clients entered in Profile and
allow you to indicate which files to import. Client Track automatically manages your
clients by updating the clients you already have entered and adding any new clients

entered into Profile.

Step 1

!ﬁk]“ﬂ Tocls Cuntom Tatks Reports  Users  Suppert

B (W S)(®)[8] (> 231 ) (2 0te ) | Ont. () 2011 [F]] (@ 5e
Open..

e T oo Twas Tom T o coe Toore T

’  — |
Impon Data » Impon Business Chents From T2 TaxPrograms » P"M""S”“" Coent  |'S] Scratch Pad ]
Synchronze with M$ Outiook Impont Personal Tax Cherts From T1 Yax Programs » Trarafer Busness Chents to Personal Tax Section ‘
Synchronze with Simply Accounting Impoet From Time & Eiling Programs. » Import from TXT or CSV fies
Synchionze with Quicktcots by Salon T st Import from CANTAX T3
Cerp
Sactr e roest Import from De. Tax T2 |
p/Resh [ Pasrel [ Impon from Profile T2 Files |

ot ™ Papcd R - -

1) Open up Client Track 6.0 on your computer.
2) In menu, go to File = Import Data > Import Personal Tax Clients from T1
Tax Programs > Import from Profile T1 Files

Step 2

3 Import Personal Tax Clients (Profile T1)

@ Import Personal Tax Clients (Profile T1)

This wizard allows you to import your Personal Tax Clients
from Profile T1 files into Client Track

Client Track allows you to import from Profile 2004 to 2009.

Select Profile T1 File

Click the Browse’ bulton to select the profie files folder location for the T1
personal tax clients you wan! to impest into Client Track.

C:\Wseis\David\Documents\My Profile Browse &

Note: You need lo have Prolile T1 2003 installed and fully licensed on this
computer in ocder to impoit your Profile information into Chent Track.

Cancel Back to Stant

< Back Next >

1) Click Browse and select Profile T1 file from your computer.

2) Click Next.

12



Step 3

B3 Import Personal Tax Clients (Profile T1) (=)

@ Import Personal Tax Clients (Profile T1)

Select The Files You Want To Import

V] N arne. 08T
Select A1 Select Only Chents Not Akeady Entered In Chert Track
Step 4
'E) Import Personal Tax Clients (Profile T1) ==
@ Import Personal Tax Clients (Profile T1)
Profile T1 Import Options
Couples Returns Options
@ Impoa the husband and wife into Clent Track as lwo sepatale enlries.
 Impoet only the prmaty indrvidual into Clent Track,
 lmpea both the husband and wife in as one enliy ie. John & Mary Smth
Note: Yeu cen easily spit and coenbing spouses in Clent Track on an individual basis &t any
b 50 pou have the option of changng the oplions &ftés impoiting the infernation.
Ii the selected T1 1eluins have a sole peoplietorship business, do
[V youwant to aleo create the business in the Busness Clents section Mote Business Impont Options I
of Clent Track?
Click 'Advanced Oplions' 1o ndcate what information wil .
be irportedinto Chert Track fiom the Profile T1 fles. Advanced Opons |
Cancel | BacktoStat <Back | Next> |

1) Select type of import for couple returns.

2) Optional: If T1 return has scle proprietorship business, click More Business
Import Options and proceed to Step 6 below.

3) Click Advanced Options to select what information to import.

4) Click Next.

13



» Exporting Your Clients From Profile T2 Into Client Track

Step 1
[File] Edt Tools CustomTesks Repotts Users Suppod
New.. (#0)[@)/®) (18] (> %4 ] (@ 0ok ) [ 0mt. () 20
Cpen..
S NlRoM[YoarEnd[ComTa[WSlalsml Lza)wlomorlmﬂom_
A ~— =
Import Data » Import Business Clients From T2 Tax Programs » Impert frem TXT or CSV files
Synchecace with MS Outiock Impeet Personal Taw Clients From T1 Tax Programs » Impeet feoen CANTAX T2P1us
Syncheenize with Simply Accounting Import From Time & Biling Programs » Impert frem Dr. Tax T2
T T T Comguter Conzubrg s |
Backup/Restore = P o &

™ Paol Resstts Suppot
¥ Bockkeepng

Syrcheenize with Quickbocks Salcn ‘ l I HST | Impeet from Profile T2 Files

Bt ™ Payrol

1) Open up Client Track 6 on your computer.
2) In menu, go to File = Import Data = Import Business Clients from T2
Tax Programs > Import from Profile T2 Files

Step 2

&3 Import Business Clients (Profile T2) (=3

@ Import Business Clients (Profile T2)

This wizard allows you to import your business clients from
Profile T2 into Client Track.
Select Profile T2 File -

Click the 'Browse' button to select the Profile folder location for the T2
cosporate tax you want to import into Client Track.

C:\seis\David\Documents\My ProFile Browse (&

Note: You need to have Prcfile T2 2008 installed and fully icensed on this
compLRes in order to impon your Profile information into Client Track.

Cancel Back to Start < Back Next >

1) Click Browse and select Profile T2 file from your computer.
2) Click Next.
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Step 3

£ Import Business Clients (Profile T2) (==

@ Import Business Clients (Profile T2)

Select Which Profile Files You Want To Import:

[C2] Coark Track [200S0815) 612

Select All I

-~ File Selection Options

[T Select Only Clients Not Already Entered In Client Track, Select File.
r Select Only The Most Recent Profile File For Each vzl I

Company.

Cancel Back to Start < Back | Next > I

1) Select the Profile T2 file(s) you want to import into Client Track.
2) Click Next.

Step 4

& Import Business Clients (Profile T2)

@ Import Business Clients (Profile T2)

Profile Address to Import: |cboProfiledddress =~

- Duplicate Entries
[V Check For Duplicate Business Client Entries

Match Clients By
& Match by Business numbets (Recommended)
" Match by Business (Operating) Name
" Match by Corporate (Legal) Name

Choose which option to perfoim if Cliert Track finds an exisling duplicate
" Dontimport any information if the client akeady exists.
" Automatically create new client vith same name (Creates duplicates).
@ Update client information. (Recommended)
" Prompt each time 2 duplicate is found to ask to overwite.

Cancel Back to Start < Back Next >

1) Check off Duplicate for duplicate personal tax client entries and then
select Match by Business numbers and Update client information.
2) Click Finish.

15



gj Import from profile completed successfully.

Click Ok to complete importing data from Profile T2.

@ Exporting Your Clients From CANTAX T1 Into Client Track

Step 1

Download file from www.clienttrack.ca/tpls/Client_Track Cantax_T1_Export_Template.tpl.

Step 2

| Semith, Ok - 2008 CANTAX 117 - Ewshasion Verson

Ele E& Yew poes Bt Guo loov Ducre e

Blgl=a) /14| siels] S8 9 €3 iRiFc o) 9

tudee  Prbdede | wro |
= L ~N0
2 53‘“" T4 - INFORMATION
Do
;’8 St Parsonal Information:
5 1%s0ns Q
1) 1RAsss Social Insurance Number (SIN, ITN, TTN) ... §52-356-874
7 fo TH0 (MEMOBOIC) 1 ot oo o e o et Mr.
L -]
% o Fiestname and InIals .....oovuvuinnnnns perek
0] et ) o s e e e o) Snith
o : Birth date o e e I e 1968/02715
Disabllity amount No First year of claim (Comple
Your language of corresponcence ......... E] English D French
Display colour for this taxpayer ............ E Primary D Secondary
Has the taxpayer's namo changed in 2008,
orls this the firsttax return? .............. No

Open a file in CANTAX T1 to export.

Step 3

EI Smith,Derek J. - 2008 CANTAX T1Plus - Evaluation Version

I File Edit View Index Print Goto | Tools Options Help

@'&I@Iﬂl[ﬁl /IQI :@ Calendar

B8 Calculator Alt+F2

Index  Pathfinder | INFO | |8 Pause Timer

B4 INFO Set Timer
% :345'3 -956-362 Edit File
3 De:rekJ. m System Snapshot  Ctrl+F10
@ Smith Per _» Weord Processor
B 1988/02/15 ST
-[2] 162 Aura St. & Import
-{Z] Kanata Dictionary

R In meny, go to Tools = Export


http://www.clienttrack.ca/tpls/Client_Track_Cantax_T1_Export_Template.tpl

Step 4

Export el X
Expont template: IL]
IQ\Users\David\Deskwp\Clienl_lrack_Canwc_T‘l Browse... Cancel I
Expont flename: Edit... I
|C:\Users\D avid\Deskiop\tl_export TXT Browise...

Help |
Output
" Currentfile

1) Under Export Template, click Browse and select the T1 template file (.tpl)
you downloaded from Step 1 above.

2) Under Export Filename, click Browse and save export file to desktop.

3) Under Output, click Select Files.

Step 5
T3 Epont Deto 12 i3

File Report Select Index

V0 (Fied Local and Netwedk Drives

d

Tarpayes | Long File Nome |Folde: Path [sin - Print Report
M| Amanda Jerking Derek_Sith C:\Users\David\De 560

‘L
i

g
-
3

!l

dil

<« b Heb

g
=
$
=
@
&

Visible Count: 0 [Selected Count: 0 Elapsed time: 0.078 seconds

Click Select All to export all T1 files and then click Export.

Note: To select certain T1 files to export, hold Ctrl key on keyboard while clicking
on the files from list and then click Export.

Step 6
[File] €6t Tocls CumomTasts Repoms Usess Suppont
New.. (W[ S)[®)[®] (@ 21 [ 0se ] 0m. [F] 20m1 [F]] [ Sexch
il IR G | Yoot 03] Geep Tas | WSS [EXT Lampr | Onae | Covio I
e N 2
Impect Dets ’ Ieepect Butimess Chents From T2 Tax Programs » '['f"“-""ﬁ MvY:s Sanple Choskt ,,,
Synchegace wieh M Owiooi Irepon Pessonal Tax Clants From Y1 Yau frograms. ’| Transtes Buniness Cherts 1o Personal Tax Secton
Synchecoize with Sewply Mccurtng Iepot Frem Trme & g Progroms L Tmpeet faoen TXT o0 SV ks
Symehecnizewish Quicibocts Taee TTHST || Impecttiom CANTAXTL |
e o r#s1 Tga fiomn D, Tex 1L
R " PapclPamit  Ympeet fromm Profile Th Files

1) Open up Client Track 6.0 on your computer.
2) In menu, go to File = Import Data = Import Personal Tax Clients from T1
Tax Programs > Import from CANTAX T1



This wizard allows you to import your personal tax clients from CANTAX T1
files into Client Track,

Step 1:

Clck the ‘Save Expoct Template Fie® button below to save the espact template flie that will tel CANTAX how to
expaet the nfoemation Clent Track needs. For thes step, we are smmply saving 3 tempotary lile to the local
corrguter and we will need thes saved He n o Iates step.

Save Export Template File I
Step 2: | Seith Derek: J. - 2008 CANTAX T1Phs - Evolusation Version
Tobeon the expatting . : |
e doote | &t Yew Index pin Golo | Tooks Qptors Heb |
Tocls > Expoet fioen the top Bgls @R 2la) gacumu
theres bar (thown k) e &3 Caleulator AlteF2
toden_ Potbiete | INFO | [ Pause Timer
Set Timer
,% Bport...
& impont...
Owctionary

<Back ‘ N”) I Finith

1) Click Next since Steps 1 & 2 has been done in the Import Wizard.

You have not saved the expat file yel. You need to click the

; ! *Save Expoit Template File' button to let Client Track create the
pioper CANTAX export template file so  can get the coirect
information from CANTAX.

Age you sure you want to conlinue without creating this file?

No |

2) In warning pop-up, click Yes to continue since template has been downloaded
from Step 1.
3) Keep clicking Next in export wizard until Step 5.

Step 8

Step 5:

saved from Step 3 of this import wizard.
Step 6:
Tax Year chents vall e impotted vt 12010 v

~ Duplicate Entries
[ @ Check For Duphcate Personsl Tax Cient Enties | ’
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~ Duplicate Entries
[ @ Check For Duglicate Personsl Tasx Chent Enities |
Match Chents By:
& Machby SIN numbers (Recommended) ¢ Maich by name

Select Which Option To Pesfor i Chent Track Finds An Existing Duplcate Recod

¢~ Don'timpoet any nformation f the client ¢~ Putemabcally create new chent wih
dready exitte came name (Creates duploates)
@ Update clent nfoimation ¢~ Prompt each me a duplcate s
{Recommended) found to atk to overwiite
Advanced Opboas

1) Click Open CANTAX Export File and browse to the CANTAX T1 text file that
was exported from Step 5 above.

2) To avoid duplicate fields, check off Check For Duplicate Personal Tax
Client Entries and select type of duplicate search.

3) Click Finish.

Exporting Your Clients From CANTAX T2 Into Client Track

Step 1

Download file from www.clienttrack.ca/tpls/Client_Track Cantax_T2Plus_Export_Template.tpl.

Step 2
T71 ABC Auxounting - 2008 CANTAX T2 with Conpioration Wt Fng + - [vahartion Vevson (= 8 el
e (38 Vew des it Gote Took Optons OFRE bewntFdey Mep ]
Mzisau s sla A8 o £ @ /L)) [
el el 2o | |
P prery -
21 Cacdwon ™1
L g il | || For Returns Dated January 1, 2006 & Later Only | =
© L) Sy o et ot banabin rome
© ) Ircome rdhym NAME OF CORPORATION: (Legal name)
€ L% Provros e ard ol coldstor -
(2 Foren Moprg sceritfe eieach C ‘Zacount te
0 Fotm i e cokton W2ex_bamianii
o L) beaten o hevddes
@153 Lo Copopions the Corporation Internet ¥ iling:
1 Ovew We  Ye
o 0 Abets - 100 vt e Caatin o D0 yow Wit 16 select this Lax tetum 15 Do Leasevmed 18 the CRAY 4 B
2 Mwacoa 15 this Lax st 23y 10 b s .
. _:Jz.um (¥ the tax retwen Is ready. select yes )
T’b&ml
@ O Tw noeary Coefiemution Nurmber (160 Help <F13)
o-Qn Coefemation of Recent
Ontacio DERLL:
¥
Are you requiced 10 OFILE s setuen? E _&
D0 you Wit 16 DFILE the CT23 oven £ 1 is nit sequwed? ra W=
15 this tax setum seady S buldng of reduldng Phe CFLE? 4 =
(¥ the tax retues i ready. select yes)

Open a file in CANTAX T2Plus to export.
Step 3

71 <Unnamed> - 2008 CANTAX T2Plus with Corporation Internet Filing -
File Edit View Index Print Goto | Tools Options DFILE Internei

8| d|w| 2|2 @|gB calendar
& Calculator Alt+F2

Index ] Pathﬁnde,l "ﬁ&] F:EJ:": T?HT&!

#-(4 |dentification ST

] Taxable Income Calculation Edit File
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http://www.clienttrack.ca/tpls/Client_Track_Cantax_T2Plus_Export_Template.tpl

-] Taxable Income Calculation - e
—~ pom Faloen Edit File

~ il gas and mining calculations @) System Snapshot  Ctrl+F10

-] Summary of net and taxable income

] Income Analysis @ Word Processor...

24 Provincial tax and credit calculatior @

_] Foreign, logging, scientific research ,% Import...
[#--(24 Federal tax payable calculation

o BB 8 T JU CHSR v 1

Dictionary...

X In menuy, go to Tools = Export

Step 4

Export

(L0
Export template: Lok |
Cancel
_Ea |

IC:\U sers\David\Desktop\Client_Track_Cantax_TZ Browse... I

Export flename:
IIC:\U sers\David\Desktop\t2_expost. TXT Browss... I

Output
("’ Cuirent file

1) Under Export Template, click Browse and select the T2Plus template file (.tpl)
you downloaded from Step 1 above.

2) Under Export Filename, click Browse and save export file to desktop.

3) Under Output, click Select Files.

Step 5
57 Export Data (D it
File Report Select Index
View [Fered Local 2 Metwork Diives | I[EI
| [raspaper | Tax Year |LonpFie Name  |Foider Path |8us. number  [Ste - Pirk Repout
M Amanda Jenkine 2008 ABC Accounting C:\Users\David 000001002 L | | inecee
Smﬁepo«l
Detzit Repot
Select Al
Cloor A1
Rebuld Incex
Cleenlndex |
cose |
Hep |
<= i
Visible Count: 0 [Selected Count: 0 Elapsed time: 0015 secends | I KeepMaks

Click Select All to export all T2Plus files and then click Export.

Note: To select certain T2 files to export, hold Ctrl key on keyboard while clicking
on the files from list and then click Export.
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Step 6

TFile] st Teols Custom Tasks Repors Users Support

v (S )] e ) @ 00w om (21 zoms (1]
0
s::; bt Romitt | Year End | Corp Tax | WSS [ EHT | Lawyer | Omar [ Custom
5 . = I—
Import Data ! Imgont Business Clients From T2 Tax Pregrams » Import from TXT or CSV fites
Synchrcnize with MS Outlook Impert Personal Tax Chents From T1 Tax Programs » | impert feom CANTAX T2P1us |
Synchronize with Simply Accounting Imgont From Time & Biling Programs Import from Or. Tax T2
Synchrenize with Quicibooks San T WSt Import feom Profile T2 Files
Qo rest T Compide Conmirg &
Backup/Restore D sen
I PapcARorits SR { %

1) Open up Client Track 6.0 on your computer.

2) In menu, go to File = Import Data = Import Business Clients from T2

Tax Programs > Import from CANTAX T2Plus

Step 7

Business Clients (C T2Plus,

@ Import Business Clients (CANTAX T2Plus)

This wizard allows you to import your business clients from CANTAX T2Plus

files into Client Track.

Step 1:

Cick the "Save Expont Template File' button below to save the export template fle that wil tell CANTAX how to
expoit the nicemation Chent Track needs, Foe this step, we are simply saving a temporaty like to the local

cocrputer and we wil need the: saved lile n a later ep.
Save Export Template File l

Step 2:

71 <Unnamed> - 2008 CANTAX T2Pius with Corporation Internet Filing -

Tobegn the expocting
process, select chent and go to
Tools> ‘Ewt'ﬁomkhelop
enares bat (shoan iight)
Index | Paide |

LY Iderthication

File Edt View Index Print Goto | Tools Options DFILE Internel

bglsaw 22 & _Jchm-'

B Calculatee AReF2

5 Pttt s |55 R

) ) Foesign, Sopging, sciertihc tezearch || 74 lmpon...

) (Y Fodarsd tax pagatle caloulsion

Dicticnary...

< Back

Mest > Finish

1) Click Next since Steps 1 & 2 has been done in the Import Wizard.

A

You have not saved the export file yet. You need to click the
‘Save Export Template File’ button to let Client Track create the
propei CANTAX export template file so it can get the corect
information from CANTAX,

Age you sure you want to continue without crealing this file?

2) In warning pop-up, click Yes to continue since template has been downloaded

from Step 1.

3) Keep clicking Next in export wizard until Step 5.
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Step 8

&3 Import Business Clients (CANTAX T2Plus) )

& Import Business Clients (CANTAX T2Plus)

Step 5:

Click the Vpen CANTAX Expart Fie' button and locate the expect He you o |
saved from Step 3 of this inmpedt vizard Open CANTAX Expont File |

Step 6:
Duplicate Enties
| % Chack Fee Dupicate Business Chant Eniries
Match Chents By:
& Maich by Business Nurber (Recommended) (" Match by Business Name
Select Wrich Oplion To Patforen I Clent Track Finds An Exsting Dupiicate Recced

¢~ Dontimpat any nformation  the clent ¢~ Autoenaticaly create new chent wih
akeady entls same name [Creates duplicates)
® Update clent information ¢~ Promes each time a duphcate is
(Recommended) found to 8tk 10 overwilte
~Address Oplions

Vhich CANTAX Address do you wank 10 use for the man Chert Trock address?
@ Use CANTAX Man Address ™ Use CANTAX Madng Address

Cancel <Back

1) Click Open CANTAX Export File and browse to the CANTAX T2 text file that
was exported from Step 5 above.

2) To aveid duplicate fields, check off Check For Duplicate Tax Client Entries
and select type of duplicate search.

3) Click Finish.

'@ Exporting Your Clients From Excel Into Client Track

Step 1

EE9-c DEE):

N ——
\/ | Home ] Insert Page Layout Formulas Data Review
’ ‘JA - (

, & Cut Calibri lu AN [E ==
| ;aste g Copy B 7 U -2y A== - £
| JFormatPainterJB £ B i ||
‘ Clipboard ) Font r;

Al v (o £ 1
Plal s |c| D 7 E
Ll | 1! 1  Sample Overhead Door Manufa Overhead Door Corp.
2 2 1 SampleTatoo Parlour Tatoo Parlour Corp.
3 3 1 SampleTrucking Company Trucking Company Corp.
4 4 1 Sample Aesthetics Parlour Aesthetics Parlour Corp.

Open a file to export in Microsoft Excel.
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Step 2

@“:ﬂ 9-¢-DB&F)*

: j Save a copy of the document
New
. q Excel Workbook

Save the workbook in the default file

i Excel Macro-Enabled Workbook

gl
l I Save | Save the workbook in the XML.based and
macro-enabled file format.

— @ Excel Binary Workbook
& SaveAs | » | S0 | Save the workbook in a binary file format

optimized for fast loadina and savina,

3 In menuy, go to File > Save As > Excel Workbook

Step 3

File name: [IES M= CReY -

Save as type: | CSV (Co delimi

Excel Workbook (*.xlsx)

Excel Macro-Enabled Workbook (*.xlsm)
Excel Binary Workbook (*.xIsb)
Excel 97-2003 Workbock (*.xls)
XML Data (*xml)

CSV (Comma delimited) (*.csv)
Text (Tab delimited) (*.txt)

Authors:

4 Hide Folders

Create export file name and select CSV (.csv) from drop-down list.

Step 4

i~ Save As (e
@O ri- » David » Decuments » vl‘,”s‘earch »
\ Organize™~ 883 Views v WB NewFolder O
Faverite Links Name Date modified  Type Size » 2

r Documents Js Adobe

T 1. AdcbeStockPhotos

1. Camtasis Studic o
Folders v | EccH =

4. AppData “ L Jeons and Cursors
& Application D4 | )y Music

File name: ,, q _am ec9 »
Save a5 type: |CSV (Comma delimited) (*.csv) -
Authors: David Tags: Add atag
~ Hide Felders Tools w l Save ] [ Cancel ]

Click Save to complete exporting file.

Step 5

To import Excel export file into Client Track, follow the instructions on pg.35.



» Exporting Your Clients From DrTax T1 Into Client Track

Step 1
P Cremtit Sl
Pm— v =
aa e am e DJB32R[OT D W fowwm 3 2008
d €3 Carter, Julia S27.000-45%  2031:035:2) Erg Reoady to proe A7Ted0 o
€4 Cacer, Nohoiae $27-000-087 39290626 B Ready to prme 750 o
€22 Maninl, Rodert $27-000-583  1945-12-12 Enp Ready to orve 282,008 OF
€05 Trembiay, Paul $27-000-391  1952:06-15 Fe Ready to oot Q ready 30 pone 03Fedld o

1) Open up Dr Tax T1 file to begin exporting clients.

2) To select certain clients to export, click on a client and press Spacebar on your
keyboard. A light yellow bar will appear to let you know that the clients has/have
been 'marked'.

Note: To export all of your clients, proceed to Step 2.

Step 2
+ DT Max T1 2008 v12.30 - Demo C\Users\David\AppData\Local\DT Maxlients\
File| Edit View Tools Efile Management Preferences Window
B New client F3
% Openfile of client F2
Delete marked client Fa .
2008 ~] [[J €
Save 2s ... » :
Type of list =
| Print g Keywords
Change tax year Pt : :_:hent 1'St Cutsp
Changer de langue 3 frangais  Ctrl+L & ik i
Ba Restart DT Max =
B Exit Ctd+Q [ R Client labels
> Customizable labels
@ 1 Certer Julia -
R In menu, go to File = Print = Client List
Step 3
Print or save client list information ﬂ
Seleclefentls ——————————————— ~Deslination
€ Cunent chent  Prirt
(‘: Cunient lﬂw " EW 1o lile
® Marked cients g Era b i
 Your own clients e 3
Expatt to Ie - XM
(" Allclents on database
| Select datato expail. ., "

Hame of the fle teceiving the exported data
|C:\Progiom Files\O T Max\DTEXPORT CSY Biowse |

[ ok | coawel | Hep |

1) If certain clients were selected from Step 1, Marked Clients will be
automatically selected as shown above. If not, select Current Client.

2) Under Destination, select Export to file - comma delimited.

3) Click Select data to export.

4) Click Browse and find location on your computer to save export file.
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Step 4

Select data to export “
V' Client rumier ™ Processing status
I Plans ™ Processing status - Quebec
™ Name I~ E..ifefle
¥ Social insurance rumber ™ Dale of last activiy
[V Bith date I~ Accountant
I Age (3t Deceber 313t) ™ R... if reshicted chent
W Langusge I~ CLIENT-CODE keywiced
I Province of iesidence I LIST-MEMO keyword
¥ Stieet ¥ Home phone number
v Ciy [V ‘Wordk phone rumber
¥ Postal code ¥ Cell phone rumber
[V Province v Eenal address
¥ County
™ DT NelLirk status
I~ DT NetLink user ID
I DT Netlink password
Resstodelors | | OK | Concd | Hep |

1) Check off only and all of data fields shown above to export.
2) Click Ok.

Step 5

Print client list

Resuks g

Chert 635

Exportng chent kst data for chert 635

Export of data to lile C:\Program Files\D T Max\D TEXPORT.CSV hireshed.

< | [ | »

Expoit of data to fle C:\Program Fies\DT Mad\DTEXPORT.CSV

Job completed

Select “Cloze” to continue...

G oen G ] @ves

Click Close after successful export.
Step 6

[Fie) €de Tools CusmeenTasks Repodts Users Sugpont

o) (W)@l 2] 1] (w s | (3 0eee | [ (7] 2011 [7]][F Search
:::_ bt Remitt | Year End | Corp Tax | WeiB [ €HT | Lawyer [ oher [ custom
i o

Impon Dats | Impor Business Chents From 12 Tax Programs :J"‘W'""s-v"ﬁ-l

Synchronae with MS Ousiook | importPersonal Tax Chents From T1 TaxPrograms > | Tramsfer Busimess Chents to Pessonal Tax Secticn

Synchronge with Simply Accourting Inpoet Feoon Time & Biling Programs » Import from TXT ce CSV files

Synchionze wih Quickbocks Freeen T“HST | Importfrom CANTAX T

S o ; #st [ impotfromOr. TerTa ]
Payeodf Import from Prefle 11 Files

bk [ Parct -

1) Open up Client Track 6.0 on your computer.
2) In menu, go to File > Import Data = Import Personal Tax Clients from T1
Tax Programs > Import from Dr.Tax T1



Step 7

3 Import Personal Tax Clients (Dr.Tax T1) (3]
@ ImportPersonal Tax Clients (Dr.Tax T1)

Step 5:

Cick the 'Open Ds. Tax Export File’ button and locate the export file you
saved fiom Step 3 of this impott wizerd, Open O Tox Expou Fie l

Step 6:
TeaxYes charts vall be mpoited nto: | vl
~ Duplicate Entries
| @ Check Foe Duplicate Pessonal Ta Chent Entiies |

Match Chents By:
& Matchby SIM numbers (Recommended) " Match by name
Select Which Option To Peifoim 1 Chart Track Finds Sn Existing Dupbeate Receed
¢~ Deontivpo any information if the chant ¢ Hwtomaticaly creale new cherk wih
hieady exists same name [Creates duplcates)
& Update clent information ¢ Prompt eachtme o dupbcate is
(Recommended) found 1o stk 1o overarde

Cick the ‘Advanced Options' to speciy what Chent Track wil pul from
the Di, Taxdats fles,

Cancel I <Back Nest > Finish

1) Keep clicking Next in export wizard until Step 5.

2) Click Open Dr.Tax Export File and browse to the Dr.Tax T1 text file that
was exported from Step 5 above.

3) To avoid duplicate fields, check off Check For Duplicate Personal Tax
Client Entries and select type of duplicate search.

4) Click Finish.

Exporting Your Clients From DrTax T2 Into Client Track

Step 1
2 et o= rox )
Type ofbar \ =@ Flrer
2% Qb w2 [Nevedcomsn ] BE,Q})OJ@,‘Q|W”W3. 2008 E
36 Alvena Inc. Jondt Realy 10 semt 10nte  OEMO -
f 41 Ontarno Inc. Ape2o Reody to peat 1ints  OLMO J
' 140 Quebdec Inc. Apedd Reaty to gt 160mts  OEMO

1) Open up Dr Tax T2 file to begin exporting clients.

2) To select certain clients to export, click on a client and press Spacebar on your
keyboard. A light yellow bar will appear to let you know that the clients
has/have been 'marked'.

Note: To export all of your clients, proceed to Step 2.

26



Step 2

D v DOS 1

File| Edt View Tools Efile Mansgement Preferences Window Help
(2 New dlient £3
.Y Open file of chient £2 : 1
e [ RBERROL
[Producten = [#
Save as ... ’ e oeee s ] ]
Print g Keywords
Client list |
{ GIFl 4
- G2 Tox return Crel+pP
Change tax year >
Changer de langue & frangais  Crrl+L Ig
n Restart DT Max @ Client labels
B e crisq | Custemizsble sbels
' 1 Alberta Inc. I
R ’ In menu, go to File = Print = Client List
Step 3
Print or save client list information m
Destination
 Print
g Current famdy € Expottiofie
¥ Marked cients 6 Py i
© Your ovm clents

¢ 2l cherts on dotsbase

 Expott to fe - 5041

| Select data to evport... ||

MName of tha il recening the expoited data

lC:\Prog'am Fles\DT Ma\DTEXPORT.CSY

|l

Browse

1) If certain clients were selected from Step 1, Marked Clients will be
automatically selected shown above. If not, select Current Client.

2) Under Destination, select Export to file - comma delimited.
3) Click Select data to export.

4) Click Browse and find location on your computer to save export file.

Step 4
Select data to export (5]
[V Chent number [T Processing status
[~ Plans [ Processing 2lalus - Quebec

[V MName of corporation
[V Busness number

[V NEQ [Quebec)

[V Yea-end

[V Name of contect

™ Language

[T Province of residence

[T Processing stalus - Ontatio
I Processing stalus - Alberla
[T E.. #ele

[T Date of last activily

[T Accountant

[T 8. restricted client

[~ CLIENT-CODE keyword
[~ LIST-MEMO kepwoed
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¥ Stect ¥ Phane number

W Ciy [ Phone number (night
[V Postal code [V Faxnumber
¥ Province [ Email sddress

Resetto defous || oK |

Cancel I Help |

1. Check off only and all of data fields shown above to export.

2. Click Ok.
Step 5
Print client list
Resubs g
Client 41
Exporting chert kst data for chent 41

Expect of data to fle C:\Program Files\DT Max\DTEXPORT.CSV fnished.

<« m

| »

Export of data to lile C:\Progrom Files\DT MaxADTEXFORT.CSY

Job completed

Select “Close” 1o continue...

Go Pimky [ Sovely P Coe | @ Heb

Click Close after successful export.
Step 6

[File] €t Took CustomTasks Repedts Usess Suppest

o (W)[)(®) ) (o 235 ) (2 0o ] | Ot (] 20
Swve s

Impeet Data ’ Import Buziness Chents From T2 Tax Programs Impoet feom TXT oe CSV files
Synchreize with MS Outlock Import Perscnsl Tax Chents From T1 Tax Pregrams » Impeet from CANTAX T2lus
Synchecaize with Simply A 03 Impert Frem Time & Biling Programs »|  Impeetfrom Or. TexT2 |
Synchecaize with Quicibocks Sabn [T 1wt Impeet from Profie 12 Files

Pone

1) Open up Client Track 6.0 on your computer.

2) In menu, go to File = Import Data > Import Business Clients from T2

Tax Programs > Import from Dr.Tax T2

@ Import Business Clients (Dr.Tax T2)

Step 5:

Chick the Vpen Dr Tax Export File' butten and locate the expoit fle you
saved from Step 3 of this impor wizaed.

Step 6:

Open Dr Tax Export File
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- Duplicate Entries
[ @ Crock Fee Duphoate Busingss Clerk Entries |

Match Clients By,
@ Match by Business Nurber (Recommended) ¢ Match by Business Nome

Select Which Oplion To Peifoe i Clerk Track Finds An Existng Duplcate Record:
" Doatimport any information ¥ the client akeady exists
 Automaticall create new chent with same name (Crestes dupbeates)
& Update client informatics (Recommended)
€ Prompt each lime » dupbcate is found to ask to overvaie

Cancel | ShowGid | Beck | MNews> | Finish

1) Keep clicking Next in export wizard until Step 5.

2) Click Open Dr.Tax Export File and browse to the Dr.Tax T2 text file that
was exported from Step 5 above.

3) To avoid duplicate fields, check off Check For Duplicate Business
Client Entries and select type of duplicate search.

4) Click Finish.

Client Track seamlessly imports and exports the information contained in
Microsoft Outlook 2000 and higher. You can synchronize your information back
and forth and have control to indicate which information gets synchrenized at which
time. Client Track allows you te synchronize your client information, tasks, and
appointments. This means you have an easy way to synchronize with many PDA's
like the iPhone, Blackberries, and Palm series.

Step 1

File | Edit Tools Custom Tasks Report

New...
Open...

Save As...

Import Data »
Synchronize with MS Outlook |
Synchronize with Simply Accounting
Synchronize with Quickbooks

Backup/Restore

Exit

R In menu, go to File = Synchronize with MS Outlook
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Step 2
'MS Outlook Synchornization Wizard

,_@’ MS Outlook Synchronization Wizard

This wizard allows you to quickly synchronize your client's
information with Microsoft Outlook.

~Select What You Want To Synchronize -

@& Synchronize your Companies and Contacts

" Syrcheonize your Appointments

" Synchronize your Tasks

Login Options (Dptional) |

Cancel I < Back | Next > Finish

1) Select Synchronize your Companies and Contacts.
2) Click Next.

Step 3

' MS Outlook Synchornization Wizard

@ MS Outlook Synchronization Wizard

Synchronize Companies & Contacts

This wizard allows you to quickly syncheorize your companies &
contacts with Microsoft Oullook.

Method of Synchronization

2 ° Synchronize your information from
W ® 157 Client Track to Outlook

y Synchronize your information from
101 % i:!\j " Dutlook to Clent Track

Advanced Options I

- Dpen A Saved Synchronization Scheme - 1

| cboSavedScherne ~|  Delte

Cancel < Back I Next > I Finish

1) Select Synchronize your information from Outlook to Client Track.

2) Click Save.
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Step 4

- MS Outlook Synchornization Wizard

._@’ MS Outlook Synchronization Wizard

Select clients you would like to include in the
synchronization process:

= []49 Outlook Contacts
=-[14) outlook Contacts
182 e e
l

Cancel | < Back Next > Einish

Select which contacts you would like to synchronize.

Step 5

'MS Outlook Synchomization Wizard

L@’ MS Outlook Synchronization Wizard

Synchronize Setup Finished!

Client Track has all the information it needs to complete the syncronization,

~Save Synchronization Scheme

Client Track alows you to save the synchionization setlings for
this session as well as the clients vou have selected.

This allows you quickly recall this schems later with the
same chents selected.

I CT_BusinessClients Save |

Cancel | < Back | Next> | Finish

1) Optional: Name your synchronization scheme and click Save.
2) Click Finish.
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» Exporting Your Clients From Taxprep T1 Into Client Track

Step 1
Go | Toos Transmisson Help
= Professonal Centre  Shit+Cri+p
€8 Chent Manager Shift4+CurleC
| TaxRetum Shift+Ctrl+T
¥ Print Formats Shift+Ctri+M
&) Preparer Profles  Shit+CtrisR
[ cent Fiers Shit+Ctrer |
|# Lettersand Labels  ShiftaCrrisL
& Rate Tables Shit+Curl+8
@ EFILE Log Shift+Ctr+0
J EFLLE Archive Shift+Curi+A
R In menu, go to Go > Client Filters
Step 2
Step 1 of 2 (optional) - Set the condition 2> f

Display a form, then drag and drop the appropriate cels into the area below.

:lrmftchbon >
Ne
e xample
‘ FPreparer]~ “John Seuth™ AND GetRetumStatus(~"Ready to pnnt
Test Condtion ‘

1) After you click Client Filters, select New. The lower part of the screen will
change showing few options.
2) Click Step 2 of 2 - Select Columns con right top corner shown above.

Step 3

Step 2 of 2 - Select columns
Select the columns to be displayed in the Chent Manager as well as the display order.

:
:
i

4 | Reorder 4

R

Select the checked column names to export as shown.

Note: Do not select any TP1s since they are irrelevant.
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Step 4

| Type

Clent profie
Chent profie

Click Save on top right corner and name the file.

Step 5

1) Click the Tax Shortcuts button on sidebar
2) Click Client Manager icon shown above.

Step 6

pde: [rfCurrent Year —~ |9 =

Ic)

| |»/[FieName / | » [LastName

In Client Manager, click Current View icon on top.

Step 7

Fie Data
Cient Data

Predefined Clent Fiters »
My Clent Fiters
My Groups

Select the saved client filter from Step 4.
Step 8
Fie |

] New Curi+l

a QOpen CuleO
Rol Forward 4
Plnner »
Import Data »

Export Clent Manager...
@) Export Tax Retyms...

1) Go to File menu and select Export Client Manager.
2) Save the export as a csv file.

Step 9

To import Tax Prep export file into Client Track, follow the instructions
on pg.35.



» Exporting Your Clients From Taxprep T2 Into Client Track

Step 1
Follow Steps 1-2 in Tax Prep T1 instructions above.

Step 2

Step 2 of 2 - Select columns
Select the columns to be diplayed in the Clhent Manager as well as the dsplay order.

Column Name
Location
File Name

€ | Reorder | @ Order ‘:
v
V! Corporation Name
v
v
v

N

Year End

Return Status
CO-17 EFILE Status
T2EFILE Status
DFILE CT23 Status

W NDAWN KW - O

Select the checked column names to export as shown.

Note: Do not select any TP2s since they are irrelevant.

Step 3

Follow Steps 4-9 in Tax Prep T1 instructions above.

Address | ) C:Ar2-2010108ta v e

S = [ Chents " Clents.MDX
2 Success A ‘@\ )
) t1-2003 (
= ) t2-2010
Chent Docurnen

® ) Temp

® ) TF-2006

® ) TF-2007 v
< >

1) On your computer, go to the Start menu and click Computer.

2) Click on the (C:)Drive, double-click Program Files and then Visual Tax folder.

3) Click Data folder and select which DBF file you want to export from T1 or T2
folder shown above.

Note: Your computer may not show file extensions, thus, you need to right-click
the file to make sure it is indeed a DBF file (see above).
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Step 2

(& savers =
OO [i] <« Adsmo» Desktop » 'I"”Sfa' o
Favorite Links Name Dste modified  Type Tags
| Documents 1. testing data files
More » #)2010 Workshopdsx
Folders v
m Desktop ~
). adam
L dvd2
& coom-
Filename: Clientsadsx 5

Swve s type: [Excel Morkbook (sl <l
_ Excel Workbook (*adsx)
AUthors: ML Spreadsheet 2003 (*ami)
Microsoft Excel 5.0/95 Workbook (*xls)
B CSV (Comma delimited) (*.csv)
ormatted Text (Space delimited) (*.prn)

1) Open up Microsoft Excel on your computer and open the DBF file you want

to export.
2) In Excel, go to Save As and select CSV from list as export type (see above).
3) Locate the new exported file and follow Step 3 below.

Step 3

To import Visual Tax export file into Client Track, follow the instructions on pg.35.

'@ Importing Your Text/CSV File Into Client Track

Step 1
EQ g6t Creste Tooks Custom

New Data File

Open Data File

Save Data File As

Impont Clients’ Informati > Business Clients from T2 Tax Programs » Text/CSV File

Synchronize with MS Outlook Personal Tax Clients from T1 Tax Programs » CANTAX T2

Data File Location ‘ Time & Billing Programs » DrTax T2

Compress Data File Transfer Business Clients to Personal Tax Secti Profile T2
Taxprep T2

Backup/Restore Data File

R In menu, go to File = Import Clients'... = Business Clients From T2...

R In menu, go to File = Import Clients'... = Personal Clients From T1...



Step 2

Import Business Clients 5]

& Import Business Clients

This wizard allows you to import your business clients from a comma
separated value (CSY) ortab delimited text file (TXT) into Client Track.

Select CSV or Text File
Click the ‘Browse' button to select the CSV o Text file you want to import
into Client Track
CWseis\David\Deskitop \ExpectCSV cav Browse ﬁl
~ Current Data File

To impout the nfaimation from the CSY fle into your curent file, use the
fie location specilied below.

Otherwise, clck the ‘Browss" button to specify a new data file to create of
to select an existing fle to import the CSY infoimation into.

I Erowse o3

Cancel | < Back | Nest> | inish |

1) Click Browse and locate the export file (.txt/csv) and click Ok.
2) Click Next.

Step 3

RS e~ R m'-—
@ Import Business Clients

- Select Type Of Delimiter That Seperates Your Fields:
‘('18) " Semicolon @ Comma|  Space (‘Qﬂm’_

| Evst Row Contains Field Names ||  +] Test Qualiier: | -

Sola Propestosh 1
| Web Se v

>

I
AN o Palo oep e Propeetoe '-l
Sample Tiucking Coerpar| Trucking Compary Cop. | Corporation 1
Sampls Roof Builde: Reof Bulder Ceen Cesgotation '
Samob&bariabae()xom Chantzbiz Cop. Cocporztion R
< ( »

UmeledAlI [~ Chek to format your data if the data is al uppes of lowes case.

Cancel I < Back HNext > Einish

1) Select title for each column field from drop-down list.
2) Click Next.

Note: If Yes, export field names was checked off in Act! Export Wizard,

then check off First Row Contains Field Names in Import CSV Wizard.
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Step 4

Import Business Clients |3

@ Import Business Clients

~ Duplicate Entries
|# Check Foi Duplicate Business Cliert Entiies |
Match clients by
® Malch by Busness Numbe: (Recommended)

" Malch by Busness Name

Select which oplion to peifeem if Client Track finds an existing
duphcate record:

" DonYimport any information if the chent dieady exists,

" Automatically create new client with same name (Crestes duplicstes).
& Updale chent nfoemation. (Recommended)

" Peompl each time a duplicate is found to ask 10 overweie.

Cancel < Back Next > FEinish

1) Check off Check for duplicate Company Name Entries.
2) Select which opticn to check for existing duplicate(s) specifically.
3) Click Finish toc complete the import.

'@ Transfer Business Clients To Personal Tax Section (Copy)

Step 1

m Edit Create Tools Custom
New Data File
Open Data File
Save Data File As

Import Clients' Information  » Business Clients From T2 Tax Programs »
Synchronize with MS Outlook Personal Tax Clients From T1 Tax Programs >

Data File Location Time & Billing Programs >

- [ Transfer Business Clients to Personal Tax Section ]
Compress Data File
Backup/Restore Data File [

Q In menu, go to File = Import Clients' Information = Transfer...

Step 2
Transfer Business Clients to Personal Tax Clients Wizard

| Transfer Business
Clients to Personal Tax



This wizard alows you to quickly tansfer Business Clents and conlacls to the Personal
Clients section in Client Track.

Select What You Would Like To Do

@ Copy contacts entered in the Business Clients section to the
Personal Clients section.
Alows you to specily which contacts who are entered as personinel for your
business chenls ace also personal Lax chents.

¢ Move Personal Tax Clients from the Business Clients section to
the Personal Clients section.

Alows you to move any peisonal tax clients who you may have ertered or
mpoited as companies in the Business Clients section and should be moved
to the Personal Clents seclion

Note: You can also use the Address Book to easly drag n' deop your busingss clients into
your persenal clients section.

Back ‘ Nest > Finish

1) Select Copy contacts entered in the Business Clients section....
2) Click Next.

Step 3

Transfer Business Clients to Personal Tax Clients Wizard ]

Transfer Business
Clients to Personal Tax

From the list below, select any contacts you have listed for your companies
who are also personal tax clients,

Note: Any contacts you select wil be copied to the Personal Clients section and can be
teferenced from both the business and personal chents sections.

SR M!JAddress Book
=-[C1&¥ Client Track Business clients
g
- [[]&) Corporation
= [v]183 Sample Beauty Salon
[ Stylist, Saesh
=-[]82 Sample Chantable Organzation
[O8 Samaritan, Joan

L) >

[

Pessonal Tax chents willbe snpocted into: 2010 v

Copy Selected Contacts to Personal Clients Section

Cancel <Back | News | Finish

1) Check off which clients to copy to personal tax.
2) Select year to import personal tax clients from drop-down list.
3) Click Copy Selected Contacts to Personal Tax Section.

~

:Q)! The selected contacts were copied successfully

4) Click Ok after confirmation.
5) Click Finish.
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Step 4

File Edt Tools Custom Tasks Reports Users Support

[0rganizalion_ Sample] @@@

Business Clients

Perional E‘.llienbt’]

Employee Assigned: |Nons Assigned

Client Info Client Information &) Income Tax Inf

1) Click Personal Clients on left sidebar.
2) Verify that the client has been moved in the client bar shown above.

Transfer Business Clients To Personal Tax Section (Move)

Step 1

m Edit Create Tools Custom
New Data File
Open Data File
Save Data File As

Import Clients' Information » Business Clients From T2 Tax Programs
Synchrenize with MS Outlook Personal Tax Clients From T1 Tax Programs »

v

Dats Filé Location Time & Billing Programs >

Compress Data File ‘ [ Transfer Business Clients to Personal Tax Section ||

Backup/Restore Data File ‘

R In menu, go to File = Import Clients' Information = Transfer...

Step 2

Transfer Business Clients to Personal Tax Clients Wizard m|

| Transfer Business
Clients to Personal Tax

This wizard allows pou to quickly tansfer Business Clents and conltacts to the Personal
Clients section in Client Track.

Select What You Would Like To Do

¢ Copy contacts entered in the Business Clients section to the
Personal Clients section.

Alows you to specily which contacts who are entered as personnel for your
business chenls ace also personal Lax chents.

& Move Personal Tax Clients from the Business Clients section to
the Personal Clients section.

Alows you to move any peisonal tax clients who you may have entered or
mpoited as companies in the Business Clients section and should be moved
lo the Personal Clents seclion
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Note: You can also use the Addeess Book o easly drag n' deop your busingss clients into
your personal clients section.

Back ‘ Next> Finish

1) Select Move Personal Tax Clients from Business Clients Section....
2) Click Next.

Step 3
Transfer Business Clients to Personal Tax Clients Wizard )

| Transfer Business
Clients to Personal Tax

From the list below. select anv clients who are personal tax clients.

=-[1&9) Address Book 7
= [149) Client Track Business clients

0
-[[1&) Corporation
- [183 Sample Beauly Salon
182 Sample Chaiitsbie Digarization |
- [182 Sample Electiic Company Limiled
-T2 Sarnnle Hoee Rudder | id =

Personal Tax Clients wil be imported into: [2010 v l

Move Selected Clients to Personal Clients Section ’

" When lransfening selected cherts, tiznsfer the address information to the personal
addresses foe the selected comtacts,

Cancel

1) Check off which clients to move to perscnal tax.
2) Select year to import personal tax clients from drop-down list.
3) Click Move Selected Contacts to Personal Tax Section.

<P This will conveit the selected items to the peisonal tax section
\QJ and remove them from the business section entirely.

This tool is provided to easily move personal tax clients entered
in the business section when they should really only be in the
personal tax section.

If you only want to copy items to the personal tax section then
click 'No' and proceed to the next step.

If you are sure you want to move the selected companies to the
personal tax section, click "Yes'

4) Click Yes in pop-up warning window.
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' The following names are oonlao.ls entered under the company
H ‘Sample Charitable Drganization”.

Joan Samarkan

Michel Sooner

M. Derek P. Smith

Are you sure you want to move this compary and all the
contacts listed to the personal tax section?

1f you chck “Yes', Chent Track wil move this company and 2l of
il's contacts to the personal tax section,

Note: If you click No', you can individually move any of the
contacts to lhe personal Lax section in the addiess book by
draging 'n diopping.

S) Click Yes te confirm moving business client to personal tax.

:Q}g The selected contacts were moved successfully

6) Click Ok after confirmation.

Step 4

File Edt Tools Custom Tasks Reports Users Support
ISumarimn. Joan] @@E}

Members

Business Clients

Personal Clients |
Employme

i‘“' Client Status: Active Employee Assigned: [Nons Assigned

Client Information @ Income Tax Inf

1) Click Personal Clients on left sidebar.
2) Verify that the client has been moved in the client bar shown above.

Client Info
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After you have finished installing the free trial version of Client Track on
your computer, follow the instructions below to set up Client Track.

Step 1

Double-click the Client Track 6 icon on your desktop.

Step 2

3 30-Day Free Trial / Register

30-Day Free Trial / Register

Select Type of Edition To Try For 30 Days

" Smal Business Edition

@& Time & Billing E dition

" Accounting Integralion Edition
" Workflow Edition

Registration Code

If you are interested in purchasing Client Track beyond the 30 day free-trial
petiod, please contact us lollfree at 1.868-423-8525 or click the 'Emai Us'
button with your Product Number below. When you are given your ovin
registiation code in an email from us, copy & paste the code below and then
click on Register Now' button,

Product Number: 183183

Email Us | Register Now |

Visit O Website I Try Client Track For Free

1) The 30-Day Free Trial/Register window will first appear. Select type of
edition you want to try for 30 days.
2) Click Try Client Track For Free.
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Step 3

@ Client Track Startup Wizard

Client Track is an practice management software designed to
help Bookkeepers manage their client's information, tasks
and appointments.

Click 'Next' to continue wizard to create your new data file and
start using Client Track.

~Data File Location

Click the 'Specify File Location' bulton below if you already have a
Client Track data file on this computes or on the network and you
wish to connect to that file.

Specify Data File Location |

Cancel | <Back |  New> | Finish

Client Track automatically creates a data file for you, therefore, click Next.

Note: If there is en existing data file, click Specify File Location and link
Client Track to that data file. For more information on data file, go to pg.47.

Step 4

@}‘ Client Track Startup Wizard

Select Your Province

‘L

| cboProvince

a}‘

Concel | <Back |  New> | Finish

1) Select your province from drop-down list.
2) Click Next.
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Step 5

% Client Track Startup Wizard

Enter Your Company Information

~ Company Information

—

Business Name: l

Coiporate Name: l

Address:

Ciy: l
Province: |

Postal Code: |

County: I

Note: You can edt and change this information at any time in the
‘Edit' menu, under 'Change yowr Company Information’.

Cancel I < Back Next > Einish

1) Insert all of your company's infermation in required fields.
2) Click Next.

Step 6

l._ -
:L\__‘fé Client Track Startup Wizard

Enter Your First User

User's Information

You need to enter an user to login to Client Track.

This user wil be given adminstrative rights so you can add
and edit more users for Client Track in the User
Management section.

User Full Name: |
i.e. Yohn Smith'

User Name: [
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Note: You can edit and change this information at any time in the
‘User* merw, under 'Manage Users'

Cancel | < Back Next > Einish

1) Type in full and user names.
2) Click Next.

Note: The user name appears in the legin screen when you start up Client Track.

Step 7

-

k. _’1 -
ey Client Track Startup Wizard

Your Clients

Select how you would like to start Client Track with
your clients’ information:

~Type Of Clients

& Automatically Install Sample Clients

You can remove sample clients at any time and it won't
affect any clients you import or enter manually.

" Manually Add Your First Client

Note: Youmay install or uninstall the sample clients at any time
without affecting any of your existing information or any new
infoemation you enter.

Cancel I < Back Next > Einish

1) Select Automatically Install Sample Clients.
2) Click Finish to begin using Client Track.

Notes

After you purchase Client Track, you can import your clients by the following:

1) Importing Clients’ List (pg.1)
2) Importing text/csv file into Client Track (pg.35)
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'@ Register Client Track

To continue using Client Track after 30-day free trial period, you must
purchase a licence and register Client Track.

Step 1

Help Center
Download User Guide (PDF)

Check for Upgrades
Upgrades Settings

Register Client Track
About Client Track

Visit our Official Website

R In menu, go to Support = Register Client Track

Step 2

&5 Register Client Track
~
Illm Register Client Track

You have 15 days for using this free-trial version.

You are using the Accounting Integration Edition.

Registration Code

If you are interested in purchasing Client Track beyond the 30 day free-trial
period, please contact us toll-free at 1-866-423-8525 or click the 'Email Us'
button with your Product Number below. When you are given yow own
registeation code in an email from us, copy & paste the code below and then
click on ‘Register Now' button.

| Product Number: 183183 |

Email Us I Register Now |

Visit Our Website I Close

1) Write down your 6-digit Product Number on a piece of paper.
2) Head over to our order page to purchase licences at www.clienttrack.ca/
pricing_store_new_licences.html
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®» Client Track Order (New Licences)

Insert Your Client Track’s Product Number O Info

| Product Number: |

3) Type in your Product Number in order form shown above.

4) Complete rest of order form and click Proceed to Checkout.
When your purchase has been successfully received, you will receive an email
from us that includes your Registration Code to unlock 30-day free trial.

3 Register Client Track

|
““ﬂjl Register Client Track

You have 15 days for using this free-trial version.

You are using the Accounting Integration Edition.

Registration Code

If you are interested in puichasing Client Track beyond the 30 day freetrial
period, please contact us toll-free at 1-866-423-8525 or click the 'Email Us'
button with your Product Number below. When you are given yowr own
registeation code in an email from us, copy & paste the code below and then
click on ‘Register Now' button.

Product Number: 183183

Email Us | Register Now I

Visit Our Website | Close

5) Copy & paste your Registration Code inside the white box shown above
and click Register Now.

Note: You can also purchase Client Track by contacting us at 1-866-423-8525 or
by email at sales@clienttrack.ca. You will need to give us your preduct number(s)
toc receive your registration codes by email.

" ® Finding Data File

When you complete filling your information in the Startup Wizard after opening
up Client Track for first time, Client Track automatically creates and saves
your data file on C:\ drive on your computer.

Step 1

m Edit Tools Custom Tasks Users
New Data File
Open Data File
Save Data File As
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Import Clients' Information »
Synchronize with MS Outlook

Data File Location

Compress Data File
Backup/Restore Data File

Templates Folder Location
3 | From menu, go to File > Data File Location

Step 2

“Z| Data File Location Wizard

Cliont Track stores your clieats” and scheduling information in a sepasate deta file. Use this wizaed to manage
location of your data fite(s).

- Data File Information
Dars Fle Veeson 6.0.550
OataFie Suet 22.25Moytes
Data Fille Location: C:isers'GrophicGuy \AopOots Rosmng \ClentTrack

Dawbidh.cd
Open Data Flo Foldee l

~Dala File Location———————————— E————

Clici this button to manusly specly enothee 4t (e 10 uze ¢,  you have Label Maker setup
003 retvaek, pou can click below to corenct 1o the Label Maker remoate fle

Specify Dala File Location |

The data file path is shown under Data File Information shown above. This can
be very useful to ensure that everyone in office is connecting te the same data file
in Client Track.

'8 Placing Data File

Step 1

Create a new folder on your desktop and name it Client_Track_Data as example.
Copy your data file (i.e. data_company.ctd) into this folder and place the folder
on your shared server. Note the path of your data file on server. For example;

'Your server Name/Directory/Client_Track_Data/data_company.ctd’

Step 2

17150 Edit Tools Custom Tasks Users

New Data File
Open Data File
Save Data File As
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Import Clients' Information 4
Synchronize with MS Outlook

Data File Location

Compress Data File
Backup/Restore Data File

Templates Folder Location

R From menu, go to File = Data File Location

Step 3

g Data File Location Wizard

Client Track stores your clients' and scheduling information in a separate deta file. Use this wizard to manage
locaton of your data file(s).

Data File Information

Data Fie Versiorr 6.0.580
DatsFie Svec 22.25Moytes

Data Fide Location: C:'\sers\GrophicGuy \AppData \Roaming ClentTrack
WDan'blah.ctd

Opan Dats Fle Folde: l
Data File Location

Clck this button to manusly specly anntive 6223 lle 1o uze ¢,  you have Ladbel Maker setp
00 redwick, pou can cick below to connect 1o the Label Maker resote filo .

Specify Dota File Location ||

1) Click Specify Data File Location

2) Browse to data file in folder you placed on shared server from Step 1.
(i.e.data_company.ctd)
3) Click Close to save it.

" ® Missing Data File

If data file has been moved, renamed, accidently deleted, or if server is down, the
Missing File Data Wizard window will appear when Client Track starts up.

c% Missing Data File Wizard

Client Track had dilficulty accessing your main data file. Use this wizard to troubleshoot and access your data file,

Last Data File Accessed | - Data File Access Error Description
The ast data fe that was successfuly socested vt 'l]:wwafhoa?-hhwveka Tl&t&!a
Keger els whee
C:\Program Files\Chen Track5\Data\Datactd - ..,.'f Tha mout glow: c:: nha
~ the dats Mo we: moved tece Label

Makes wasz last un Usze the Spacly
- Fie Location' button 1o spexily the
Tey Recorenching l cutrent data e lcaion
~ Repait Options
Cherk Track has found a data fle in: ’ ‘

Chick the Create New Fie' Euton lo

C:\Program Files\ChientTrack\Data\Data.ctd create 3 new daa fle:

(157
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 Repait Oplions

Cheer Track has found a data fle i | Chck the Craste New Fie' button to
Ci\Program Files\Chent Track\Data\Data.ctd - } croate o now & He:
Creste NewFie |

|
Use thiz File l | -

3 - | Ohek the Restocs 2 Backup Fie' bution

Cick the Specty Fils Locabon’ buiton lo manually spectly the data fle location ¢ | torestecs liom o peevious backup:

10 ConNAct 1o & temate dala e f you hive Label Maker satup on & network: ‘

Speciy Fie Locsicn Reslece 2 Backup File

Solutions

1) Turn on and boot up the server and then click Try Reconnecting.

2) If you still receive an error, check the path and file name on both Missing
Date File & Data File Location under File menu. In addition, check the
location of your data file on your shared server.

» Backup Data File

Step 1

710 Edit Create Tools Custom Tasks

New Data File
Open Data File
Save Data File As

Import Clients' Information »
Synchronize with MS Outlook

Data File Location
Compress Data File
Backup/Restore Data File

Address Bock
Exit
R In menu, go to File = Backup/Restore Data File

Step 2

ﬂ Backup & Restore Data File

Itis & good ideato perorm backups of your dota file periodically to prévent data loss in case of o
computes failure, thelt or fire.

Backup Data File Restore Data File
Backup your currert data fle to 3 backup fie. Restore data data froen 3 backup fle.

Backup Data I Restece Data |

e |

Click Backup Data.

50



Step 3

#3 Save the Client Track Backup File As .. oSy

@Q‘{I- » Computer » Removable Dick (K) »1] « [ %] [Search )

Q Organize ~ 252 Views ~ B New Folder

Favodite Links Name Date modified Type Size Tags .‘

IF Documents 1. Client_Track_Backup
More »

Folders v
o Removable Disk (F ~
e Removable Disk (&

o Removable Disk (K
L. Spotlight-Vi00
1. JTrashes =
IS Clnem_l'vack_&acf|
& Help Centre  ~ |

File name: v |
Save as type: | Client Track Backup File (".ctc) vl
~ Hide Folders (_sove | [ Cocet |

1) Create a backup folder and click Save. Notice the saved path.

D The file was backed up successiuly

2) After the backup save is complete, click Ok.

» Restore Data File

Restoring Backup Data File allows you to recover the previous data file if your
current data file is damaged.

Step 1

m Edit Create Tools Custom Tasks
New Data File
Open Data File
Save Data File As

Import Clients' Information »
Synchronize with MS Outlook

Data File Location
Compress Data File
Backup/Restore Data File

Address Book
Exit

R In menu, go to File = Backup/Restore Data File



Step 2

% Backup & Restore Data File

Itis & good idea to perdorm backups of your dota file periodically to prevent dota loss in case ol o
computer {oilure, thelt or fire.
- Backup Data File ~Restore Data File
| Backup your curert d3ta file to 3 backup e Restore data data from 3 backup fle.

1 Backup Data l Restoce Dats I

oo |

Click Restore Data.

Step 3

l‘ﬂj Are pou sure you want to restore information from another dala
/ source and replace yow existing information?

{ Yes m‘—‘i No
1) Click Yes to confirm restore.
(2% Select a Client Track Backup file to Restore ey
B (o[ « Clem Teck saciup | * %] [seorcn 2

Q) Organze v & Views ~ B New Folder

Name Datctoken  Tags Size Rating
No preview available.
examplectc
L example.ctc Date modified: 14,084/2009 3:49 PM
CTC Fite Suze: 144 MB

Date crested: 14/04/2009 3:49 PM
Flensme: warple e v [Qlent Track Restocs Fie (et v
([Open Iv] [ Concet |

2) Select the backup file to recover and click Open. Notice the opened path.
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» Terminal Services

Client Track generally runs without any issues in Terminal Services but
it does need to be installed properly with the correct install permissions.
Below is the best way to install Client Track in terminal services.

Client Track uses a component call MDAC (Microsoft Data Access Components) and
to install software properly on a Terminal Server computer, Terminal Server must
be set in Install Mode. One way to do this is to use the Add/Remove Programs
application from Control Panel to install the software.

The issue is when you install MDAC in this manner, the setup program reports that
Add/Remove Programs must be terminated before installation can continue
because files needed by MDAC could be locked by "Add/Remove Programs” and
setup would require a restart to copy these files. However, if you terminate
"Add/Remcve Programs”, there is a risk of losing data because Terminal Server
will no longer be in Install Mode.

To install Client Track on Terminal Services properly, follow these steps:
Step 1

Set Terminal Server in Install Mode by entering the following command at a
command prompt: change user Jinstall.

Step 2
Launch the Client Track setup procgram.

Step 3

After the installation succeeds, you can execute the following command to return
Terminal Server to the default setting: change user /execute.

Note: For more information, go to|http://support.microsoft.com/ |

" ® 64-bit Windows

Microsoft has developed a type of software (WOWG64) built intc Windows that is
designed to allow 32-bit programs to run on a 64-bit operating system. What is the
real difference between 32 and 64-bit Windows? The 64-bit Windows can run many
more programs at once in a faster and efficient pace.

Generally, Client Track will run without any problems in 64-bit editions of Windows.
However, if, in the rare case, you do encounter a problem relating specifically to
the 64-bit emulator,you must contact Microsoft to help answer any of your questions
because we do not directly support 64-bit Windows. We will, of course, support and
answer any questions relating to Client Track itself when running in 64-bit windows.

What is WOW64?

WOWS64 is an x86 emulator of Windows that is capable of running 32-bit applications
and is included on all 64-bit versions of Windows (Windows 2000 Limited Edition,
Windows XP Professional x64 Edition, Windows Server 2003, 63-bit versions of Windows
Vista and Windows Server 2008). WOW64 is designed to take care of all the
differences between 32-bit Windows and 64-bit Windows, particularly involving
structural changes to Windows itself.

The 64-bit Windows isclates 32-bit applications from 64-bit applications which
includes preventing file and registry collisions. Censcle, GUI, and service
applications are supported the 64-bit operating system provides intercperability
across the 32/64 boundary for scenarios such as cut and paste and COM.


http://support.microsoft.com/default.aspx?scid=kb;en-us;Q304332

However, the 32-bit processes cannot locad 64-bit DLLs for execution, and 64-bit
processes cannot load 32-bit DLLs for execution. This restriction does not apply to
DLLs loaded as data files or image rescurce files.

» Windows Server 2008

Step 1

Right-click on Computer icon on your desktop and then click on Properties.

Step 2

Click on Advanced System Settings under Tasks on left sidebar.

Step 3

Click the Advanced tab and then click the Settings button under Performance.

Step 4

Click the Data Execution Prevention tab.

Step 5

Performance Options

| visual Effects || Advanced | Data Execution Prevention |

Data Execution Prevention (DEP) helps protect
against damage from viruses and other security
threats, How does it work?

(O Tum on DEP for essential Windows programs and services
only

(®iTurn on DEP for all programs and services except those 1
select:

dient

Your computer's processor does not support hardware-based
DEP, However, Windows can use DEP software to help prevent
some types of attacks,

| ok [ cencel |[ aopy |

1) Select Turn on DEP for all programs and services except those...
2) Click the Add button and browse for the Client Track application file (.exe).
3) Click the Apply button and then click Ok.
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‘ » Add New Users

Step 1
[ Manage Users
Replace Users
Login As Different User
Change Password
X In menu, go to Users > Manage Users
Step 2
3 Manage Users i

@v Manage Users

[
it Of Usors
‘ Employes Name:  EmployeeName

| User Nome: [ Ed Employee Information

-Select User Privileges - 1
(@) & stmrimaton (@) € Favser (@] © Poner User

‘ (@) € earuser € LimtedtoProtle User

€ Appairiment User  ReadOnly User

View Information on User Priviledges |

1 User Password

I Enable Pasiword Protection

I [ 783 Now User ﬂ Erter Curiont Password l Cleat Passwoed I

[ Delete User ] Ented New Password | Change Password I
[ > ™ l Veiily New Password I
Currertly. 100 Users

Corcel | Ok |

Click Add New User under List of Users shown above.

Step 3
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Step 3

& Add New User

Enter Name Of User You Want To Add

You need to enter an user to login to
Client Track.

This user will be given adminstrative rights so you

can add and edit more users for Client Track in ‘

'Manage Usets' window. ‘
|

User Full Name: IOM\d Staples
ex. John Smith'

Display Name: IO.'md

ex. John'

Note: You can edit and add more information for this user by
going to Users > 'Manage Usess’ from menu bae.

< Back Next> Einish I

1) Enter in full and display names of user shown above.
2) Click Finish toc save added user.

Step 4
3 Manage Users I — ==
@ Manage Users
List Of Users [ User Namo
IDeMd I Employes Name:  Employecame

User Name: IOavid Edit Erployes Information

- Select User Privileges -

(@) @ adairisnato ®| C ravser  [®] © Powes User

€ EdtUser  UmitedtoProtie User

€ Apponiment User " ReadOn User

View Information on User Privileges I

1) Select added user from List of Users category.
2) Click View Information on User Privileges.
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User Privileges

@ User Privileges

-Privileges Type - - - -

Administrator
- Adrminsteator is the only user level that can change user profile privileges and passwords.
- Has ful access to 2ll features of Clent Track.
Full User
« Has lull access to 3l features of Chent Track with the only restriction being that this user
cannot change any uses privileges
Power User
- Simdiae to the 'Full User’, but cannot change any progiam preferences of setlings which
alfect the scheduing
Edit User
- Designed to alow an individual to edit 2ny information in existing clients or any tasks akeady
scheduled, but cannot add new chents or schedule ary new tasks,

3) Read over the user privileges to determine which privilege is right for user.
4) Click Close to exit User Privileges and select a privilege from list.

User Password

| Enabe Password Protection |

Enter Mew Passweed: I*“"u" Clou Foshined l
Verly MNew Password: Ixxzx:xx: Set Passwotd I

I

[~

3
=) B

1) For adminstrator of Client Track within office, enter new and verify new password
and then click Set Password (Enable Password Protection will autecmatically
be checked off).

2) Click Ok to complete added user.

Note: Only administrator has rights tc change user privileges. Te change the
password, click Change Password to enter in new password.

|

Manage Users

Replace Users

Login As Different User

Change Password

R In menu, go to Users = Manage Users
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Step 2

B3 Manage Users =
—
&v Manage Users
List Of Users User Namo
lD = I Employes Namne:  Employeciame

User Name; [l)avid Ed# Employes Information

Select User Privileges

(@) & sdonimatn (@) © Favser (D) © Pomervse

€ EdtUzer € LimitedtoProfle User

" Apportment Usst " ReadOnl Usee

View Information on User Priviledges |

User Password

[T Enable Password Protection

( 7d3 Now User ) Erter Curtort Password | Clear Pazswoed I
|[ ke thie ]l Entes New Password. | Chums Posscd |

Veily New Passwoed |

( Replace Uses |

1) Select user to delete from List of Users category.
2) Click Delete User.
3) Click Ok tc save change.

» Replace Users

Step 1
Manage Users
I Replace Users
Login As Different User
Change Password
Q In menu, go to Users = Replace Users
Step 2
3 Manage Users 5|

@ Manage Users
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User Name
Employes Nacne:  EmployeeName

List Of Users

Jason User Name: |David Edi Emrployes Information
~ Select Uszer Privileges
(:A&m'w (‘FdUm (‘Pow«Uw
(@) ¢ eduser (@) ¢ Lemtestopitie user

© Appoviment User © ReadOny Usee

View Information on User Privileges |

User Password

™ Enable Pasword Protection

( 763 Now User ] Erter Curtent Password | Cleat Pazswoed I
[ DcleteUser ] Entet New Password. | Change Password l

| l Veiity New Password |

|[ Resisce User

1) Select user to replace from the List Of Users category.
2) Click Replace User.

Step 3

‘Replace User Wizard
@ Replace User Wizard

This wizard allows you to replace all nstances of an user

being assigned to tasks with another user,
Replace This User: | Sarah Metied |
With This User: [Pimanda vievo IIIRD
Replace User

View Replace User Options | Close I

1) Select which employee to replace and by who from drop-down lists.
2) Click View Replace User Options.

Options.
& Replace User Options
Options for replacing John with Jane
~ Renl, Izrr Assi din Tazks
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- Replace User Assigned In Tasks

| V' Replece al tasks onginaly assigned 1o John and make them assigned lo Jane.

~ Replace User Assigned in Appointments -

@ Dont replace ary appointments
" Replace ol appointments assigned to John and make them assigned to Jane

¢~ Replece orly the sppainiments specihied below that sie assigned to John and make

them assigned to Jane
" Search for appointments on: " Search foe appointments on of aRes:
l = ] )
P gee'am? for appairtments on of € Search for appointments betweert
r . ~
and | =l

3) Check off Replace all tasks originally assigned... and select whether to
replace user's appointments as well or not.

4) Click Close.

5) Click Replace User tc save change.

'@ Change Password

Step 1

I servon

Manage Users

Replace Users

Login As Different User

| Change Password

R In menu, go to Users = Change Password

Step 2

Change Your Password

E Change Your Password

[~ Enable Password Protection

Enter New Password: |=**=*



[T Enable Password Protection

Enter New Password: la:xz:s

Veiify New Password: I’""‘"“

Set Password I
Cancel l (1] 3 |

1) Enter in new password twice and click Set Password.
2) Optional: Check off Enable Password Protection.
3) Click Ok tc save new password.

. » Login As Different User

Step 1

s

Manage Users

Replace Users

I Login As Different User ]

Change Password

R In menu, go to Users = Login as Different User

Step 2

Login Screen

User Name: |Jason |

Password: |

Forgot your password? Click here.

Exit Client Track I Manage Users Sign In

1) Select user name from drop-down list.
2) If Enable Password Protection (Step 2) was activated, enter in Password.
3) Click Sign In.
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‘ #, Business Clients

» Client Information

The Client Info tab is designed to be the main source that contains all of your
business clients'information and quick access to all of the main client options
and tools of Client Track in one area. Familiarize yourself with the sections below.

R In Business Clients, go to Client Info = Client Info (tab)

Monelrfoleiem[ Bookkesping | HST [ ST [ PapolRemtt | YexEnd | CopTax | WSIB | EHT | Lowper [ Other |

(@] chent Status: Active - Somple Client 3 b Butiness Number: [ € [ scitchPad
Company Name: Samle Besaty Ssizn I HST ¥ Lowses Relsted @ Cuent Ogtions
Corporate Name: Beavty Saioe Corp. 5
Camy TG g ([ S
Industry Type: Retsl b ™ Pagrol Reswtts ) e

in Phone: ™ Papol [ it = h
Main Phone: (705) 55.1234 [ Pesseod Tach —
Fax: (705) $65.2568 ¥ YexEnd 19 Sond Letter
Emait nfo@sarpiabeavissin ca  Copl I~ Finencial § | onoLetle! |
Web Site:  www. sampktesutyssn cs L r 14 o o
Address: ™ wsie Repe ‘ Caent Reports .I.
Sample Beasty Sakn I EHT |3 Customize List I ’ﬁ e I}
111 Haley Helow l
Calgary. 4B A1A 121 -

Contact Information @ @
Kame: M3, Vary Ance Sorandon -
Default Contact: Yes f

Main Phone: (705 §55-1234 L .
Fax: (705) §55-2598

Emait: raryante@sabn cs Sy
Wed Site:  sampiedesutysabncs

Address; i

a. Client Status b. Business Number ¢. Scratch Pad d. Client Information
e. Client Services Provided f. Contact Information g. Client Software/Options
h. Send Notifications i. Client Reports j. Address Book

(a) Client Status

If a particular business client is no longer your client for whatever reasen but would
still like to keep their information in Client Track, you can set the business client to
Inactive by following the steps on pg.292.

(b) Business Number

Insert business client's 9-digit business number here.

(c) Scratch Pad

Click on pencil icon to insert additional notes on selected business client.

(d) Client Information

To edit a business client's information, click the pencil icon and fill in the updated
information under each tab, if applicable.
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(e) Client Services Provided

Checklist of all services that client provides for tax returns. Removing or adding
additional services can be done by clicking on Customize List shown above.

(f) Contact Information

The default contact’'s information appears first in display. If you have
multiple contacts for a company, you can see their information by clicking the
people icon and selecting a contact from drop-down list. You can also edit a
contact's information by clicking the pencil icon.

(g) Client Software/Options

! Client Software

Client Name: Sample Beauty Salon
~ Software Information

Software List

Quiddocks Name: [Quickbooks ~|

Serial #: |

Version: |

Account #: |
™ Receive Uparades

Client Software includes information of all your softwares added inte one place
for easy convenience. To begin, simply click Client Software button. Insert

all the information tied to software and then click Add New Software to save it.

For instructions on how to customize options for business clients, go to pg.295.

(h) Send Notifications
For instructions on how to send a notification to personal tax client, go to pg.325.
(i) Client Reports

For instructions on how tc merge documents with business client, go to pg.259.

(i) Address Book

Address Book contains all of your business and personal clients. You can add other

contacts to Address Book such as friends, partners, family members, etc.
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» More Info

The More Info tab is designed to add additional information about the business
client such as questions, missing documents, appointments and custom tasks.

Gientinto |More Info | Propcts
(RTHLLDREIE D 0 Define Cuttom Frids

Chent Chook List

[~ kem1
[~ hem2

Q ‘ In Business Clients, go to Client Info = More Info (tab)

wcts | Sockdeepr | HST | PST | PapclRemstt | Papecd | YewEnd | ComTax | WSIB | EHT | Lowper |

[= g

Missing Information (0 entries)

« | o
(3] (openivsned iz i |

5 Add New Commanication Entry | Open Advanced Communication Form l

Client Aged Summary - Account Owings e

Tots Outtandng 0-300Dw 80D

a. Custom Fields b. Checklist c. Missing Information
d. Client Communication Information e. Client Aged Summary

(a) Custom Fields

Allows you add multiple custom fields of other specific tasks for business client.

(b) Checklist

Allows you to make a list and check off other items done for client when completed.

(<) Missing Information

Allows you to add documents that are missing relating to tasks for business client.

(d) Client Communication Information

Allows you add logs of communicaticn information for client.

(e) Client Aged Summary

Allows you to view total ownings that the business client needs to pay.
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The Projects tab is designed to apply saved project template including projects
steps and other information such as billing tc a business client.

X In Business Clients, go to Client Info > Projects (tab)

amm[u«ameum«m | HST | PST | PopctRemtt | Payeoh | YewErd | ComTax | WS | €HT | Lawes |

Projects b

Dercription Due Date Assigned Close | Notily
mmg;’:" Compary Bachure - Sendto Prtes Feb2. 11 Nara srtiyred 0O O 6GGed
Compary Biochure - Thunbesls  Fed2.11 Nore sttryed O O 6GD
Compary Bachure - Coke/Ferts Sele Feb2.11 Neeo atiyed O 0O GGD
Corpary Brschure - Corps Feb2.11 ] 0O 0O GGD
a Compary Brcchure - Clerk's Paview  Feb2.11 Nore sriyred 0O O GGD
- Compary Bxachure - Salocted Conps Fed2, 11 Nore atsynd O 0O 6GD
Ceesgrary Bracher - Cheed's Paviews § Feb2.11 Neen aiyed O O Gad
Compary Brachuse - FralVesson  Feb2.11 Nora svsiyred 0O 0O GGD
Compary Bacchue - Retesch Feb2 11 Nore ariyed 0O O GeGGd
. e fa
[ Asonseectedpaetiovs e | = =
C

[ Mansge Terglate Projcts ]"'

e i i k
T ] ® ! 1 =
ez (©)0)

d Numbes of Projects: 0 Project Display: |Show Prcjects and ther Steps v |

a. Tasks List b. Scratch Pad ¢. Task Tools d. Quick Links e. Task Description f. Task Timers
g. Task Information h. Client Options i. Assign User j. Auto Notify k. Edit Notification Template

(a) Task List

Allows you to assign a saved project task to a business client.

(b) Scratch Pad

Include additional notes on a business client with regards to Custom. If there are
notes inside, the notepad icon will include a pencil.

(c) Task Tools

Allows you to assign a selected project to a business client as well as editing
a saved project template.

(d) Quick Links

Built-in links to websites with more infermation on Custom. You can add your own
links or attach documents by clicking the glocbe icons.

(e) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.
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(f) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(g) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.

Tk for in =

Sample Beauty Salon

ttense
¥ B Problem Flap

P P :
N | [Bookeesing 07 MusngirtoFlag LJ T NetesFip
Type | [Bockieegmng 3 Ovecdun iy
Enciopee Assiynd [None Azngned =) | Stotus Information - Completed Information———
Dus Ote: Moy 25,201 v I~ 1Poszestin Clozed ™
Intouze Dus Dater Uanuay 22201 « ™ Debvered
= I Need Date Completed "
Colerdy Date: FMZI.ZDI vl I~ Prepxed
— Completed By (Neem Assvre v )
EmmgedTee [V he[  mn ™ Receved
W Doy wark to recur thes ok each yau? I Payoeed e
Custom Information _ Defen Status Irfo | Py [ :]'
Q‘Ml:l i
~ Notes
Cunoen 2 |
Cuzom3 |
Cumteen & |
Cumonns |
Define Custom Fields
< ‘ %) Carcel ok
PrrtRegot | MentoDec
(h) Client Options

For instructions on how to customize options for business client, go to pg.295.

(i) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(3) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a nctification methed and click Finish.

(k) Edit Notification Template

To customize the notification template for Custom to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.
2) Select template type from drop-down list and insert merge fields shown below.
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3) Optional: Change the number of days
4) Click Close.

Edit Notification Templates =)

@4 Edit Notification Templates

Customize your nosication templates that will be used when you notly your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

|Custom |
Custom
Customize Your Notification Template Save
Dear <<Contact Full Name>>,
stk Infol Test
'Your <<Task Name>> is due on <<(Due Date, dddd. | |7k N
mmmm d yyyy)>>. Due o:," Resel to Defact
lnmuuguooh
Please arrange to drop off all paper work to allow us Calendx Date
to complete the retumn. Emn"mp'“"g - Reset Al Unsers Chert
; . Completed By NotiScations Of Ths
You can call our ofice if you need any assistance or | |Date Completed Typo ToUse Ths
lh“ any questions. Custom }ﬁ Fﬁ ; = Terplste Comment
Enter the number of days prior to task due date you want your .
clients to be notified of theis upcoming tasks of this type. Notification Period: 15 |
Note: Clert Track vl ooy subliact busness days and gnoce weekends and hobday:. Open Hobdyy Waxd
Cote

. » Bookkeeping

The Bookkeeping tab is designed to schedule bockkeeping tasks for your business
clients. This includes data entry, data verification and much more.

R In Business Clients, go to Client Info = Bookkeeping (tab)

Cioetleto | Morelrto | Projects HS!|PSI| Papcd Rerst | Paecd | YewErd | CopTax | WSIB | €HY | Lowe |

Bookkeeping Services Q

Description Due Date Assigned Clase | Notily
[~ Schada Data Erty Account Reccrciiaion 1511 Naooe Artryed 0O 0O Ge®
& Schedde Account Reccoc Accourt Recercis Fb 1511 Noow Astiyed O O GGD
T Schadids Data Verdation Acoourt RecereBiyion Ma 1501 Noow Assignd 0O 0O Ga®
[ s Yt Seskiasto | Acosurt Recencision secis Neisiyed O O GGO
Acoourt Recorclision Mag15.11 Neow Aztizred 0O 0O GGD
ez Accourt Becoresion An15.01 Neos Astiyed O 0O GGd
Accourt Recceciicn M5 T Neos Astiynd 0O 0O Go
Acoourt Recereiicn 20515.11 Neow Astiped O 0O GGD
a | Acosurt Reconciiston Sep15.11 Noen Assirad 0O 0O GRD
Account Reconclision 015,11 Noes Astiyred 0O 0O eeo®
e fa

[ AsonSectedSenvicerotis Gt | €

: i
Chek hate to zelact docur v|@@ = l ==
ezl @) [O o stove . (TN

d

a. Task Options & List b, Scratch Pad ¢. Task Tools d. Quick Links e. Task Description £, Task Timers
g. Task Information h. Client Options i. Assign User j. Auto Notify k. Edit Notification Template
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(a) Task Options & List

Allows you to select type of bookkeeping task such as data entry, account
reconciliation, data verfication and other services for a business client.

(b) Scratch Pad

Include additional notes on a business client with regards to Custom. If there are
notes inside, the notepad icon will include a pencil.

(c) Task Tools

Allows you to assign a saved bookkeeping service to a business client.

(d) Quick Links

Built-in links to websites with more information on Custom. You can add your own
links or attach documents by clicking the globe icons.

(e) Task Description

Includes infermation type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(f) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(g) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.

Sample Beauty Salon
i
P Py B PtiemFisy
Naew | [Bookkesping 07 MizsngleloFlag LJ T NeresFig
Type: | [Bookieepmng 37 Ovectin Fizy
Eergigen Astrnd [None Azsigned ~ | Statiss Uit . ~Completed lnformation ——
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(h) Client Options

For instructions on how to customize options for business client, go to pg.295.

(i) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(3) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(k) Edit Notification Template

To customize the notification template for Custom to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

TR NotRcton Tenplte T . — =

g Edit Notification Templates

Customize your notstcation templates that will be used when you notify your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

l&mom ;]
Custom
Customeze Your Notification Template Save
Dear <<Contact Full Name>>,
f .~.r' et Test
'Your <<Task Name>> is due on <<(Due Date, dddd, |ﬁ NG (E
mmmm 4 yyyy)>>. Oue Dote Resel 1o Defatt
hn«nogwt)&
Please arrange to drop off all paper work to allow us c*'.“" ;‘". y
o complete the retum. ;mnPaid Resat A Unsert Cherk
; : Compieted By Notiscotions Of Ths
You can call our ofice if you need any assistance or | |Date Completed Type ToUse This
have any questions. Cuttomn ;g F::; 5 Tecrpisto Cotnnent
Enter the number of days prior to task due date you want your e g <
clients to be notified of theit upcoming tasks of this type. Notification Period: [i5 ]
Note: Clert Track wall caly ubliact Buzness day: and ignoce weekend: and hobdsys. Open Hobdyy Wead
Coze \
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» HST (Harmonized Sales Tax)

The HST tab is designed to schedule HST returns for your business clients. The
federal and provincial dates for HST returns are built inte Client Track, therefore,
all you need to do is include the HST information and select a type of payment
schedule for a business client.

R In Business Clients, go to Client Info = HST (tab)
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HST Quick Links !'
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a. Task Sertings b. Scratch Pad ¢. Quick Links d. Task Description e, Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

(b) Scratch Pad

Include additional notes on a business client with regards to HST. If there are notes
inside, the notepad icon will include a pencil.

(c) Quick Links

Built-in links to websites with more infermation on HST. You can add your own links
or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categeries can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional infermation on tasks such as dates, type of flag,
status, custom information and notes shown below.
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ToskInformation for 1t Quarterly HST Retum =
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification methed and click Finish.

(i) Edit Notification Template

To customize the notification template for HST to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

Edit Notification Templates =
s} Edit Notification Templates

Customize your novticstion templates thal will be used when you notly your clients of upcoming tasks.
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Select Notification Template Type You Want To Edit

HST )
HST
Customize Your Notification Template Select List ltem To Save
I
Dear <<Contact Full Name>>, ioeest Alklews r
»-! 9 4 A Test
5 - Tatk Type f
'Your HST remittance is due on <<{Due Date, dddd, Tatk Nome E
mmmm d yyyy)>>. Oue Date Resel to Delot
u.aouxogwom
Please amange 1o drop off all paper work to allow us c“"‘“l 0
to complete the retum. P 3o Resat M Unseek Clerk
) : Completed By Notiscations Of Thes
You can call our o%ice if you need any assistance or | |Date Completed Typo ToUse Ths
have any quéstions. Cuttorn }x Fz; | Teerplate Coennant
Enter the number of days prior to task due date you want your e a0 :
clients to be notified of their upcoming tasks of this type. Notification Period [F |
Note: Clert Track will caly ubliact Buzness days and gnoce weekends and hobdsy:. Open Hobday Waad
Cose

'@ PST (Provincial Sales Tax)

The PST tab is designed to schedule Provinical Sales Tax/Retail Sales Tax returns
for your business clients and stores information such as PST Number.

Note : You can schedule PST due dates for other provinces by temporarily changing
your working province. For more information on how to do this, go to pg.298.

I3  In Business Clients, go to Client Info > PST (tab)
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Aszign above to: Auto Nonty 23 Abowve

a. Task Sertings b. Scrartch Pad ¢. Quick Links d. Task Description e. Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

(a) Task Settings
Insert PST-related information and select type of PST payment for business client.

(b) Scratch Pad
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(b) Scratch Pad

Include additional notes on a business client with regards to PST. If there are notes
inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more information on PST. You can add your own links
or attach decuments by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additicnal information on tasks such as dates, type of flag,
status, custom information and notes shown below.

= o =
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.
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(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(i) Edit Notification Template

To customize the notification template for PST to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

Edit Notification Templates ==

—4 Edit Notification Templates

Customize your nottication templates that will be used when you notity your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

[PST =l

PST
Customize Your Notification Template Select List ltem To Save
Dear <<Contact Full Name>>, !MM Abecoe F
‘ 3 - '6“
- 5 Tatk Type
'Your PST remittance is due on <<(Oue Date, éddd, Tatk Name E
mmmm d yyyy)>>. Due Dale Resel 1o Defacht
tnnomogut Date
Please arrange to drop off all paper work to allow us | |C8endx o2 .
to complete the retumn. 5,«,,“’ 'p' o Resat Al Unsers Chart
; _ Coenplsted By NotiScatons Of This
You can call our ofice if you need any assistance or | |Date Completed Type ToUse Ths
have any quéstions. Cuttom }g F:g ; o Terrplate Cornment
Enter the number of days prior to tatk due date you want your . .
clients to be notified of their upcoming tasks of this type. Notification Period: (15 I
Note: Clent Track will caly sublisct Buzness day: and ignoce weekends and hobdsy:. Open Hobdsy Woxd

Caose

, » Payroll (Souce)

The Payroll (Source) tab is designed to schedule payroll remittances for your
business clients throughout the year.

R In Business Clients, go to Client Info = Payroll (Source) (tab)
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f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

(a) Task Settings

Insert payroll-related info and select type of payment plan for business client.

(b) Scratch Pad

Include additional notes on a business client with regards te Payroll Remitt. If there
are notes inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more infermaticn on Payroll Remitt. You can add your
own links or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional infoermation on tasks such as dates, type of flag,
status, custom information and notes shown below.
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—4 Edit Notification Templates

Customize your notfication templates that will be used when you notfy your chients of upcoming tasks.
Select Notification Template Type You Want To Edit

|Payroll Remin :]
Payroll Source Deduction
Customeze Your Notification Template Select List ltem !o Save
Dear <<Contact Full Name>>, insertA Hesse Eleid
g o Jia Test
Your payroll source deduction remettance is due on gﬁ "’z:, E
<<(Due Date, dddd. mmmm d yyyy)>>. Due Date Rezel to Defauit
Irrtouse Dus Date
Please arrange to drop off all paper work to allow us g“"“'o“‘.
{to complete the retumn. m'”y °p° ”‘~ 255d Resat Al Unsect Chert
. ; Complated By NotiScations Of Ths
You can call our ofice if you need any assistance or | |Date Completed Type ToUse Ths
have any quostions. C‘M: }x ;:3 ; . Teetplare Cocreract
Enter the number of days prior to task due date you want your - .
clients 1o be notified of their upcomang tasks of this type. Notification Period: [15 |
Note: Clent Track wll ooy sublisct buzness days and ignace weekends and hobdsy:. Open Hobday Waad
Cose

The Year End tab is designed to remind your business clients' year end date.

R In Business Clients, go to Client Info > Year End (tab)
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(a) Task Settings

Select year end date and type of financial statement(s) for business client.

(b) Scratch Pad

Include additicnal notes on a business client with regards tc Year End. If there are
notes inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more information on Year End. You can add your own
links or attach documents by clicking the globe icons.

(d) Task Description
Includes information type of task, due date, and assigned user based on type of

payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categeries can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom infermation and notes shown below.
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification methed and click Finish.

(i) Edit Notification Template

To customize the notification template for Year End to send to a business client or
the number of days prior to task due dates to notify business client of upcoming
tasks deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

'Edit Notification Templates [

/= Edit Notification Templates

Customize your notication templates that will be used when you notly your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

|Yeor End =
Year End
Customeze Your Notification Template Select List ltem To Save
: !
Dear <<Contact Full Name>>, 7num A Metge Fiold
(T g Ik - Test
< Tatk Type ( S ——————————
Your year end is due on <<(Due Date. dddd. mmmm | |7k Name |E
d yyyy)>>. Due Dote Resol 1o Defackt
lnmu:ogzoa
Please arange 10 drop off all paper work to allow us | |CsendxDate
to complete the return. E,a,,”’ 'p'“' Sod Resat Al Unsec Chert
s . Completed By NotiScations Of Ths
You can call our ofice if you need any assistance or | |Date Completed Typo ToUse Th
have any questions. WE }ﬁ ’Ez; || Tempiste Comement
Enter the number of days prior to task due date you want your I .
clients to be notified of their upcoming tasks of this type. k‘“"“""" Period: [15 |
Note: Clent Track vl caly sublisct buzness day: and ignoce weekends and hobdsys. Open Hobday Waad

Ootej
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The Corp Tax tab is designed to keep track of corporate tax returns of your
business clients throughout the year and store important information such as
federal corporate tax number, incorporation date and type of corperation.

3 In Business Clients, go to Client Info > Corp Tax (tab)
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a. Task Sertings b. Scratch Pad ¢. Quick Links d. Task Description e. Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

(a) Task Settings

Insert corp tax-related information under Corp Tax Deadlines and Corp Tax
Info tabs for business client.

(b) Scratch Pad

Include additional notes on a business client with regards tc Corp Tax. If there are
notes inside, the notepad icon will include a pencil.

(c) Quick Links

Built-in links to websites with more infermation on Corporate Tax. You can add your
own links or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.
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(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom informaticn and notes shown below.

Tasknformation for Corporate Tax Payment =
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(i) Edit Notification Template

Te customize the notification template for Corp Tax to send to a business client or
the number of days prior to task due dates to notify business client of upcoming
tasks deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.
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@:4 Edit Notification Templates

Customize your nottication templates that will be used when you notity your chients of upcoming tasks.
Select Notification Template Type You Want To Edit

[Corp Tex =
Corporate Tax
Customize Your Notification Template Seloct List Item To Save
: L
Dear <<Contact Ful Name>>, o0 Hess Fhd =
Your corporate tax remittance is due on <<{Due }ﬁ:;ﬁ
Date, ¢ddd, mmmm d yyyy)>>. Oue Date Resel 1o Defaudt
hﬂ«nogwoa
If you make all of your corporate tax payments on Calendx Date
v 2 . Emplopee Asspned
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: 3 Completed By Noticatons Of This
Youcancalloqvclcolyoonndanyammoa Date Completed Type ToUse Ths
have any questions. Custom }::: ;z; dl Teerplste Coenment
Enter the number of days priot to task due date you want your Re
chients to be notiied of their upcomeng tasks of this type. Notification Period: |15
Note: Clert Track vl ool subliact buzness days and ignoce weekends and hobdsy: Open Hobday Waad
Cote

'® WsIB

The WSIB tab is designed to schedule WSIB (Workplace Safety & Insurance
Board), WCB (Workers' Compensation Board), WorkSafe remittances for your
business clients and stores information such as firm number and insurance details.

R In Business Clients, go to Client Info = WSIB (tab)
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(a) Task Settings

Insert WSIB-related information and select type of WSIB payment option for
business client.

(b) Scratch Pad

Include additional notes on a business client with regards to WSIB. If there are
notes inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more infermation on WSIB. You can add your cwn
links or attach decuments by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.
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(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification methed and click Finish.

(i) Edit Notification Template

Te customize the notification template for WSIB to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

Edit Notification Templates =4
4 Edit Notification Templates
= e

Customize your notfication templates that will be used when you notdy your clients of upcoming tasks
Select Notification Template Type You Want To Edit

‘wss ~
WSIB
Customize Your Notification Template Select List Item To Save
Dear <<Contact Full Name>>, !""“ AHeoe r
0 .. : ] Test
Your worker's compensation remittance is due on y: N’::, £
<<({Due Date, dddd. mmmm d yyyy)>>. Due Date Resel 1o Defacit
lnﬂwsoguobh
Please arrange 10 drop off all paper work to allow us | |CSendx Date
Employee Assigned
to complete the retum. Amount Pad Resat Al Unser2 Chart
: ) Coenpleted By Notibcations Of Ths
You can call our office if you need any assistance or | |Date Completed Typo ToUse Ths
have any quéstions. c.m;::;ﬁ; = Terrplste Cotrment
Enter the number of days prior to task due date you want your - . .
clients to be notitied of their upcoming tasks of this type. L"“"“"“‘ Poiiod: [i5 ]
Note: Clent Track vl coly subliact buzness days and ignoce weekends and hobdsys. Open Hobdyy Woad

Cote

» EHT (Employer's Health Tax)

The EHT tab is designed to keep track of employer health tax's remittance
due dates for your business clients and store information such EHT number,
registration, and premium rate.

R In Business Clients, go to Client Info = EHT (tab)

Clertinto [ Masirto | Poects | Bockkeeping [ BST [ PST | Pagect Rewit [Pw]YwEM[M!u[WsW[W[le
Employer's Health Tax h

EHT Nusbee | Cloze | Notily

EHT Regutered [~ | &th Quasedty Ore. ENT Jan3111 Noow Assgrnd 0 O GGD
Harve ENT authoreaion? 1 | Areassl Ork EHT Retan Mar 35,11 Neew Assgrmd 0O 0O GGdH
PravirsRse | 11 Qutedy Ot EHT AN Noow Assred 0O O GGD
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Sy 9800 L eestatpad, 0000
Nors Assgred 0O 0
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© Quatedy EHT Payearis a d
© Moty ENT Payments
€ Zevosd EMT Paymert
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Gamem iz (@)Q) h i i

R T e

a. Task Settings b. Scratch Pad ¢. Quick Links d. Task Description e. Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

|[a]

(a) Task Settings
Insert EHT-related information and select type of EHT payment for business client.
(b) Scratch Pad

Include additional notes on a business client with regards to EHT. If there are notes
inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more information on EHT. You can add your own links
or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.

Sample Beauty Salon

R

|
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\
P Py B mctlem Fisp
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| = ™ Notbed Date Completed 'I
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(i) Edit Notification Template

To customize the notification template for EHT to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks
deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

Edit Notification Templates =4

g Edit Notification Templates

Customize your notfication templates that will be used when you notly your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

[EHT e

EHT

Customeze Your Notification Template Save
Dear <<Contact Full Name>>, T
Your EHT remittance is due on <<(Due Date, dddd,
mmmm d yyyy)>>. Due Date Resel o Defacit
Please arrange to drop off all paper work to allow us | |CSiendx Date
to complete the retum. iuo\n.w‘l;d" eond Reset Al Unsect Cler |

Coenpleted By NotiScatons Of Ths

You can call our ofice if you need any assistance or | |Date Completed Typo ToUse This
th any questions. Cuttom ;& F$ ; i Terrplate Corment
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Enter the number of days prior to task due date you want your . . l
clients to be notificd of theit upcoming tasks of this type. Notification Period: [15

Note: Clert Track vall only sublisct Buzness day: and ignoce weekends and hobdsys. Open Hobdey Wead

Cose

The Lawyer tab is designed to schedule law related reminders for your business
clients who are lawyers such as levy deadlines, trust returns, and recoencilations.

R In Business Clients, go to Client Info = Lawyer (tab)

Cloctlnto | Motelito | Propcts | Sockieegrg | HST | FST | Poysct Remt |Pw|veam|coom|ws|s|smm

Lawyer Information Q

L::m Dercription Due Date Assignod Clote | Notify -

Arerax LawPRO lrsnesnce Pogeoae Jan 1. 11 Nowasped O O GGD
i i Lo U Doanga Law Socsety Duss sl Nomassosd O O GGD
¥ Meotly Tosit Accourt 12h Toant Recorciation Jan 251 Norw Assigned O O 6eGad
- mnm 3 | |househLonte Jsn 311 Nosssoned O O GGD
T AroodLowbROAspicsicn | |1 Tmat Recenchston Feb 25,11 Nowhsined O O GGD
T Arensl LWPRO Papment 2nd Trutt Reconciiation M 25,11 Nomhssined O 0O GGD
¥ Arewssl Law Socisty Dons Arerssl Truzt Redan M 31,11 Noow Assigned O O GGD
d ef

ETTT—
[Chck hete o setect docur v G] h i i

Cick here to zelect wed 2 v ) = =
o] @) i abore te: IV

a. Task Sertings b. Scratch Pad ¢. Quick Links d. Task Description e. Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template

(a) Task Settings

Type in society member number and select type of law related reminder(s) to
schedule for business client.

(b) Scratch Pad

Include additicnal notes on a business client with regards to Lawyer. If there are
notes inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more information on Lawyer. You can add your own
links or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.
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(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing secticon.

(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.

Task Infoemation for Annus! Trust Return [rsem]
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(i) Edit Notification Template

To customize the notification template for Lawyer Information to send to a business
client or the number of days prior to task due dates to notify business client of
upcoming tasks deadlines, follow these steps :

1) Click Edit Notification Template icon.
2) Select template type from drop-down list and insert merge fields shown below.



3) Optional: Change the number of days
4) Click Close.

'Ea"i":’_v :-“-i--**:-. = ——@

'@*4 Edit Notification Templates

Customize your nosication templates that will be used when you notity your clients of upcoming tasks.
Select Notification Template Type You Want To Edit

Low =

Lawyer Related

Customize Your Notification Template Select List Item To Save
Dear <<Contact Full Name>>, 'm“' Alllespe.Eleid Test
Your <<Task Name>> task is due on <<(Duve Date, }:: Lﬁ. E
dddd, mmmm d yyyy)>>. Due Date Resel to Defait

hﬂmog;:l)do
Please arrange to drop off all paper work to allow us Calendx Date
to complete the retum. f,w,”’ °p' “" 2l Reset Al Unsert Cher
A : Coampleted By Netiscations Of This

You can call our ofice if you need any assistance or | |Date Completed Type ToUse This
Ihave any questions. Cutom Tosk Fid1 || Templste Cormnert
Enter the number of days priot to task due date want s gt .
clients to be notiied of their upcomeng tasks of l,h.: typeo. ou Notification Poriod i? I
Note: Clent Track wall coly tubliact buzness days and ignoce weekends and hobdsy:. Open Hobday Woad

Cose

The Other tab is designed to schedule miscellanecus reminders for your business
clients who are in the agriculture, IFTA, and contracting industy.

R In Business Clients, go to Client Info = Other (tab)

i | Wawio | Ponts | Goiar | HST | #5T | Papctont | Fovel | YewEod | CoTac | Wt | €8T | Lo [0t [ Gision |

Other Reminders 9
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oty e 0 66O
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a. Task Settings b. Scratch Pad ¢. Quick Links d. Task Description e. Task Timers
f. Task Information g. Client Options h. Assign User i. Auto Notify j. Edit Notification Template
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(a) Task Settings

Select which other reminders tc schedule for business client.

(b) Scratch Pad

Include additional notes on a business client with regards to Other. If there are
notes inside, the notepad icon will include a pencil.

(<) Quick Links

Built-in links to websites with more information on Other Reminders. You can add
your own links or attach documents by clicking the globe icons.

(d) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(e) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(f) Task Information

Can edit or include additional information on tasks such as dates, type of flag,
status, custom information and notes shown below.
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(g) Client Options

For instructions on how to customize options for business client, go to pg.295.

(h) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.

(i) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(i) Edit Notification Template

To customize the notification template for Other Reminders to send to a business
client or the number of days prior to task due dates to notify business client of
upcoming tasks deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.
3) Optional: Change the number of days

4) Click Close.

‘it Nothication Templates =
4 Edit Notification Templates
= -

Customize your notfication templates that will be used when you notly your chents of upcoming tasks.
Select Notification Template Type You Want To Edit

[Omer =]

Other
Customize Your Notification Template Select List Item To Save
Dear <<Contact Full Name>>, A!""“ ANegs F Yout
Your <<Task Name>> task is due on <<(Dve Date. | |7ak Name P
dddd. mmmm d yyyy)>>. Due Date Resel o Defait
Irriouse Dus Date
Please arrange 10 drop off all paper work to allow us | |C8endx 0
to complete the return. Reset Al Unsert Chert
, i Noticatons Of Ths
You can call our ofice if you need any assistance or Typo ToUse This
have any quéstions. Teerplsto Coenment
Enter the number of days prior to task due date you want your . .
clients to be notified of their upcomeng tasks of this type. Notification Period F l
Note: Clent Tiack wll caly tublisct Buzness days and gnoce weekends and hobdsys. Open Hobday Waad
Clote

The Custom tab is designed te schedule specific tasks for your business clients.
This may include one-time deadlines that do not appear in other tabs such as
Family Trusts and Wills or add recurring tasks in which you can control the
frequency of deadlines. You can create up to a maximum of five custom fields.
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R In Business Clients, go to Client Info = Custom (tab)

| Gt | Wawid | P | Boicpeg | HST | P51 | Puyeteni | Pl | VewEod | Con T | WEiS | 4T | Lo | O [ Cottom

Custom Tasks Q

€ A aNew S Tak e Jn 10,11 Norn Assigred O O GGD
C MNm Beoabg Teds Bockbeeping I 10,11 e A o O 6ao
‘ Jn 281 David Andesson O 0O 6GD
B2 Noen Assiped 0O 0O GGD
Jan .11 Susan Andrews 0O O GGD
Feb7,11 David Andevscn o O 6ed
e fa
L
|| Asoon Cuatoe Tosks To Thi Cleet |
‘[ OpenCuton TadsManses | €
‘[ Mavin Yoor Taks Foe Ths Gt |
‘ [k revero semaraocer =) (@) (9] 1 1 K
\ (G rmer na vt =) (@) | 1© on above te: (XTI Horo Notty M Above || %

a. Task Options & List b. Scratch Pad ¢. Task Tools d. Quick Links e. Task Description f. Task Timers
g. Task Information h. Client Options i. Assign User j. Auto Notify k. Edit Notification Template

(a) Task Options & List

Allows you to select type of custom task such as single, recurring or a saved
custom task for a business client.

(b) Scratch Pad

Include additicnal notes on a business client with regards to Custom. If there are
notes inside, the notepad icon will include a pencil.

(c) Task Tools

Allows you to assign a saved custom task to a client and manage your custom
tasks all at once from here.

(d) Quick Links

Built-in links to websites with more information on Custom. You can add your own
links or attach documents by clicking the globe icons.

(e) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Information for tasks in 3 categories can be edited by clicking on the text.

(f) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.
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(g) Task Information

Can edit or include additional information on tasks such as dates, type of flag,

status, custom information and notes shown below.

(h) Client Options

For instructions on how to customize options for business client,

(i) Auto Notify

Te notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

(k) Edit Notification Template

To customize the notification template for Custom to send to a business client or the
number of days prior to task due dates to notify business client of upcoming tasks

deadlines, follow these steps :

1) Click Edit Notification Template icon.

2) Select template type from drop-down list and insert merge fields shown below.

3) Optional: Change the number of days
4) Click Close.

go to pg.295.

Edit Notification Templates

\‘5} Edit Notification Templates

Customize your notfication templates that will be used when you notfy your chents of upcoming tasks.
Select Notification Template Type You Want To Edit

|Custom =
Custom
Customize Your Notification Template Save
Dear <<Contact Full Name>>,
Tatk Typ Ton
Your <<Task Name>> is due on <<(Due Date, dddd. | |7ark Nome |E
mmmm d yyyy)>>. Due Date Resel o Defait
hmusoguooa
Please arrange to drop off all paper work to allow us Calend I“'. y
to complete the return. Em"”” °p° wid Resat Al Unsect Charr
: : Completed By Notibeations Of This
Yoocmcalloqto‘co i you need any assistance or | |Date e ‘l';poToUulN!
have any questions. O‘Mc Lhorstiorrd SIS erplate Coenment
Enter the number of days priot to task due date you want your e e .
clients to be notified of their upcomeng tasks of this type. Notification Period [F l
Note: Clert Tiack vl ooy subliact Buzness day: and ignoce weekend: and hobdsy:. Open Hobday Woad

Cote
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' ® Client Info

Step 1
Client Info
R In Business Clients, go to = Client Info (icon)
Step 2
7 Chent Track =3 = |
Fle Edt Tools CumoenTasks Pepots Uses Suppoet

T <onsio Goouty Salon (NSO o At ) (3 S ) Ot (2] 2010 ()] (0 Sk )

Colgary A8 AtA 124

[ cloccroces: | User: Jascn
GHGO B oun Wednestay. Deconter 22000

To learn the how-to's of Client Info, select one of the following:

» Client Info (pg.62) » WSIB (pg.81)

» More Info (pg.64) « EHT (pg.83)

» Projects (pg.65) « Lawver (pg.86)

» Bookkeeping (pg.67) = Other (pg.88)

» HST (pg.70) » Custom (pg.90)

* PST (pg.72) « Client Status (pg.292)

« Payroll (Source) (pg.74)  « Client Options (pg.295)

» Year End (pg.76) » Send Email, Fax and Letter (pg.325)
» Corp Tax (pg.79) » Create Reports (pg.259)

« Address Book (pg.220)
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" ® Find Client

Step 1

Find Client

R In Business Clients, go to = Find Client (icon)

Step 2

Find Client (2

& Find Client

Search Criteria T Search Results ]

Search by Business Client Name

Cliert Name: || ;]

~Search by Criteria
Search Field [Name =l
Search Text [Salon

[ Match Whole Phrase
[ Match Upper and Lower Case

Find \

Cancel

1) Under Search Criteria tab, select type of search from drop-down lists above.
2) Click Find.

Step 3

Find Client ==

& Find Client

Seaich Creria T Search Results ]

Data Found
"'Sample Beauty Salon",
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| n . »

Go To Record l

Concel |

1) Under Search Results tab, select the appropriate business client above.
2) Click Go to Record tc have business client automatically show up.

" ® Edit Client

Step 1
Edit Client
R In Business Clients, go to = Edit Client (icon)
Step 2
Edit éompany =
Business InIoI Personnel T #m Other ]
Business Name: [Sample Beauty Sdon Main Prone: [(705) 5551234
Coiporate Name: |Beauty Salon Corp. Al PM"EI
g Fauc [[705) 565.2598
Business Type: [Comporation 7] Emat: [info@samplebeaulysalon.cs
Industiy: [Retoil ;' \Webste: \wonw.camplebeautyealon ca
Addiess: 711 Haiey Hollow FaceBook:|
24 lehel:] @]
City: [Calgary .
Aoice: 8 =
Postal Codz: 1414121 Supervisng Patlner; v
Courty:. | Mensgngdcooment] =]
&) Print Report | | @& Print Labels ~ Comcel | 0k

1) Edit business client's infermation in any of following tabs shown above:
Business Info, Personnel, Associated Professionals, and Other.
2) Click Ok to save changes.
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» View Tasks

Step 1

View Tasks

R In Business Clients, go to = View Tasks (icon)

Step 2

LPLERN G T

Advanced View/Hide View/Print Tasks For Tasks For

\

)

All Prior

Search Columns Report This Week This Month Unclosed Tasks

". Refresh List

All uncompleted tasks

i D02t Close | Exglojce Astigned

Sample Lawyess Olfice 10th Trust Reconciistion

T Company Name  Name

Sample Tattoo Studio 10th Alts. Monthly PST Retun
Sample Tattoo Studio 11th Alta. Monthly PST Retumn

Sample Lawyess Olfice 11th Trust Reconciiation

Nov 25,11
Nov 15,11
Dec15. 11

Dec 25,11

None Assigned
None Assigned
None Assigned
None Assigned

Follow the instructions on how to view business clients’ tasks on pg.122.

» Merge Document

Step 1

Create Doc

R In Business Clients, go to = Create Doc (icon)

Step 2

Merge Document

»g Merge Document

Switch to MS Word Merge
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Choose Type Of Merge Document You Want To Create Or Open

N

Companies ] Contacts ] Tasks ] Appoirtments

[ New Company Meige Doc (use Default Contact)
™ New Company Meige Doc [use Specified Contacts)

Click The Document You Want To Open

Apology to Client Letter.cib ~ | | Open an existing template
Audit Waiver.cth (1| | document by selecting it
Business Inttoduction Letter.ctb [= || from kst on left side.
Change Accountants for Chent.cib ‘
Cliers Appreciation & Refenal ctb ;
CoBecion Lettec.ctb Browse For File Not In List ’
Hoully Rate Inciease.clb

Letter - Professional ctb x

Change Templates Folder Location

1) Select the document from the list to merge company with as shown above.
2) Follow the instructions on pg.234.

» Address Book

Step 1
Address Book
Q In Business Clients, go to = Address Book (icon)
Step 2
& Adsreis Bock BTy

| Fle (se Tocls Fapons Wep ’

J- P 72 X @ 1

New fnd

« £ Ovent Track Client Track Business Clients |

= Chent Track Busisess cleats |
-8 JLC Dowkgns [
= ] Sorpie Mome Bulder L84 5 |
= 8 Sample Lywyers Offce p L |
= 81 Somgie Overheas Doy Manfactse
« Q] Zargie fvenng larvoes yee:
* B3 Samoie 200! Dukder Wdustry Type: Graghe dengn

« B Savgie Tataoo S0
* 1 Savgle Trudng Congeny Bain Phone: (613) 0004001

tde Odlete | WebSae  Pagent

s Cna | otewat e
I Mastaees Vob Sea:  www jodengeaca Rasers:
AC Desgrs
Address: Joe Kaley
¢ Oengen 1224 Vervam Re
1035 Weraie g Nepaan, Crtar KM 175

Nesesn, o o 83

To learn the how-to's of the Address Book, select one of the following:
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« Add New Contact (pg.220) » Delete Contact (pg.228)
+ Add New Company (pg.222) « Delete Category (pg.229)

« Add New Category (pg.223) = Moving Multiple Contacts (pg.230)
- Edit Contact (pg.225) « Preferences (pg.231)

« Find Contact (pg.226)

'@ Document Vault

Step 1

Doc Vault

R In Business Clients, go to = Doc Vault (icon)

g Sampte Doy Solon M)
[ Add Cotogories J sag oot | Openshornan [ osete Surtan | Fnssnonas |

= Owhm -
&3 Chert Trach Merge Disc) Diag 'n diop powe client documents in the white box below foe casy accoss.

Appoentments Note: The Gocumernt iora ntade the sivie bom are hinzuts 13 the cepnsl documert lies. Movin). seramny
o Selatrg the Shonouts vl it STect the cnpnal documernt et

Step 2

( Add Categories |l Client Documents
- & g Clien! Document .
= I Add New subCategory to this Category \
|
\
|

&7 Client Track M

Edit this Category
Delete this Category

Add shortcuts to this Category

Properties

1) To add new business client, right-click on main category (Client Documents)
and select Add New subCategory to this Category shown above.

Optional: Click Add Categories button to create new category.



Add New Document Category ()

Category Information

Create Category Inc | Cliert Documents |

Category Name: [Clent Track

Description: ’Soﬂwaxe Related Documents -

Folder Synchronization Oplions

You can speciy a folder on your compates of nelwoek which Clent
Track wil automatically show 2ll Ihe fie conlents i this calegoty,

] &owseb"‘

| el | ook |

2) Type category name and description shown above.
3) To synchrenize a folder from network, click Browse.
3) Click Ok.

Note: To delete a category, select category and hit Delete on keyboard.

Step 3

[ Add Categories ] Client Track

E{‘j Client Documents

| {\3 Client Track Drag 'n drop your client documents in

b Q3 Client Track Merge Doc

1) Select new category that you have created in Step 2 shown above.

Drag ‘n drop your client documents|in the white box below for easy access.

&8 "X

e

case_studp.doc  letter.pdf
2) Click Add Shortcut and select file(s) from your computer to store in doc vault

shown above.

Optional: You can drag 'n drop files from your computer in doc vault.

Step 4

case_study.doc  [ELEH
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Solutions Inc.” and all sub categories and file links within this

' Are you sure you wanlt to remove the category 'Trilobyte
h—s' categoy?

1) To delete a document from Doc Vault, select a document shown above.
2) Click Yes to confirm delete in pop-up window.

Note: Documents that are stored in doc vault act as 'shortcuts’, therefore, deleting
them will not delete the original file scurce on your computer.

Step 1

3 In Business Clients, go to = Reports (icon)
Step 2
Client Reports prem

Client Reports for Sample Beauty Salon

Client Information Reports Client Task Repoits

" Client Summary Report " Client Task List
Client repaet which shows client Show all tasks dus foe this client i date
addiess and mportant information. order for the selected year.

(" Client Details [1 page) " Client Task List (by type)
Client repoet which shows most of the Show all tasks due for this client n date
clent’s address and accounting order i the selected year for the task
riomation type specified below.

" Client Details (2 pages) & HST
Client repoet which shows all of the .
clent’s address and accounting " Payroll Source Deductions
rfoimation and notes, " Employee Payroll

" Company Information C wsie C PSY
Compary repart which shows all the
iformation entered in the Edit ¢ wsie " Corporate Tax
Compary/ section. C Laywer © EHT

" Default Contact Information ¢ Custorn ¢ Other
Contact report which shows 3l of the
rioimation entered for the default For mote specific tasks reponts, use
contact, Tasks' view,

Follow the instructions on how to create a report for a business client on pg.259.
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Personal Clients

» General Info

The General Info tab is designed to be the main source that contains all of your
personal clients' information and quick access to all of the main client options and
tools of Client Track in one area. Familiarize yourself with the sections below.

R In Persconal Clients, go to Client Info = General Info (tab)

i “""“"I e 8 I‘WI el ]'MW’]E:WIW“"]%[%] Quices
(®) chiont Status: Active 3 b tmplopec Avigned: Dsniicdn v €

I =)

Name: Mr Retert Prtnci Orate Relum Type e © Awating Clent f -
d @ Regds - C InPoyess - i

Associsted Categony: = € Deceated € 0kl - Quasicns =

€ Snol Buornss e :

Intiouse Due Date: || = Onthlé-Misnglto
Business Information Wiz’m j Oa Kol - Oee
———— g hd (\ C 'l I -
Company Name: Sangie Printng Services ‘: ek Repodts j.

Main Phone: (70%) S55-5774 Chent Sexvices Provaded
Cedl Phone: (£12) S20-0000

Fax: 70%) $48-437¢

Email: retena@sangiesantng ca rm ™ Uelnnaance a
Web Ste: www savpieprning ¢ rw DRty lnssanch
Address: R ) [ Ciical Insctonce

Sampie Precng Secvces s =

Ve Robert Patrick Orsle T Modpan Inouwarce

1111 Seach Averue ™ RASP

Sasiatocn, Sasiachewss A1A1Z1  fgeo T Travelleouwsnce

[ Toxis ™ Hesth 3 Dents Inzuance

" e

a. Client Status b. Employee Assigned ¢. Personal Tax Info d. Client Information
e. Income Tax Info f. Return Status g. Client Services Provided
h. Scratch Pad i. Send Notifications j. Client Reports

(a) Clients Status
If a particular personal tax client is ne longer your client for whatever reason but

would still like to keep their information in Client Track, you can set the personal
tax client to Inactive by following these steps on pg.292.

(b) Employee Assigned
Ability to assign specific employees to business clients.

(c) Personal Tax Info

Can edit or include additiocnal information on task such as informaticn on return,
type of flag, custom informatiocn and notes shown below.
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Personal Tax (Task Information) =

ATD Banking 2010 [ )
5 |
Retun Type [Repd ~l Retum Dus Dater | ~|
Return Statuz: [ Awating Coert E] InHowse Due Dater MMS?(E]
Employee Assigoed | =

Flag Infoimation
P oPiiyflag £ T MasnglaoFleg B T Protienflsy L0 1 NotesFlsg B & OverdusFlag

-Custom Inloimation

e —

caen2 [ (@] | Motes
Camend [

et [ @

Cotens [

Define Custom Fields

(d) Client Information

To edit a personal tax client's information, click the pencil icon and fill in the
updated information under each tab, if applicable.

(e) Income Tax Info

To create an income tax return for a personal tax client, select type of income tax
and set an in-house due date.

(f) Return Status

To set status on an income tax return for a personal tax client, select one from list.

(g) Client Services Provided

Checklist of all services that client provides for tax returns. Removing or adding
additional services can be done by clicking on Customize List shown above.

(h) Scratch Pad

Click on pencil icon te insert additional notes on selected personal tax client.

(i) Send Notifications

For instructions on how to send a notification to personal tax client, go to pg.325.

(j) Client Reports

For instructions on how to create a report for a personal tax client, go to pg.261.
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» More Info

The More Info tab is designed to select which type of tax prep deccuments
relating to employment and income have been brought in by your personal clients
and on what date.

'Gen«dldo Nore Indo, ;:‘,‘xm IEWI w‘ ]lm:l%lthl?ﬁm[m] Custeen .

Missing Information (0 entries)

" —— E v
- Commpmmtieies |
ftem 3
E it Client Communication Information (0 entries) d [ 24z Cones |(@)
™ Itemb Jeck Nove Name Commmuri..  Recewed. d

ﬁ
|
o

r~ ftem 13 . ‘ ™
[ Iem14 i

i Ty

[ ftem18 Client Aged Summary

ey ) 3

a. Custom Fields b. Checklist ¢. Missing Information
d. Client Communication Information e. Client Aged Summary

(a) Custom Fields
Allows you add multiple custom fields of other specific tasks for business client.
(b) Checklist

Allows you te make a list and check off other items done for client when completed.

(c) Missing Information

Allows you to add documents that are missing relating to tasks for business client.

If you are missing documents relationship to income tax return for a specific
personal tax client, follow these steps:

1) Click Add Missing Doc shown below.
2) Type in missing document name and information and click Ok in pop-up window.
3) Send email to perscnal tax client by clicking the basket icon.

(d) Client Communication Information

Allows you add logs of communication information for client.

(e) Client Aged Summary

Allows you te view total ownings that the business client needs to pay.
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" & Family Members

The Family Members tab is designed to store relationships of persenal clients
and create a family tree which appears in the Address Book.

R In Personal Clients, go to Client Info = Family Members (tab)

Gmdlrlo] Mire brbo :‘m, EWI W‘ ]IMM:]?"WINEM@] g::&m] g:ml Custoen

Family Members 3 [B AcdFamiy Member | (& 6t vty Menber | [ Deee iy b |

Famdly Meaber Contact Information m
Deskie, Rodat fwite)

Name: Mr Rdet Patrck Drake

Assccuted Category:

b Susiness Bormation
Company Name: Sarpie Printing Services

Main Phone: (705) $85-5774
Cell Phone: (813) S20-0000

Fa: 705) $88-4778

Emalkt retensQsarpieprnte) <o
Wed Site: warw sanpleicrtng ca

Address:

Sargie Frietey Senvices

Nr Rodert Patnck Orate

1111 Beach Averoe

Sasianeon, Sasiactewan A1A 171

a. Family Member Options b. Family Members List ¢. Relationship Type d. Edit Member

(a) Family Member Options

1) Click Add New Family Member shown above.
2) Click Add a new contact as a family member.
3) Type in contact's information and relationship type and click Ok.

Add Family Member ()
2& Add Family Member

Add Family Member For: ATD Banking

Option 1: Add An Existing Contact As A Family Member

Select Contact: hd I
Selact Relationshpx v |

Option 2: Add A New Contact As A Family Membes

Add Mew Contact As A Famidy Member

(b) Family Members List

The names of family members you add will appear in the left sidebar of list.
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(c) Relationship Type
To edit the type of relationship, select one from drop-down list shown above.

(d) Edit Contact

To edit contact's information, click on the pencil icon.

» Employment

The Employment tab is designed to select which type of tax prep documents
relating to employment and income have been brought in by your perscnal clients
and on what date.

R In Personal Clients, go to Client Info = Employment (tab)

Gm«d!nk[ u«ml Faa Eaieyment e as ]ummmxlz;'dw] mtuelg";m["“‘“ - ] Cuoes
Employment information b
Check all the documents and income Lae items that apply to this client below =
¥ Emglogment Income - T4 ™ Workers Compensation - 15007
¥ [TeRecened I™ 75007 Received
Oute Rocoived Dctober 17,201 v) Dato Received |
™ Commesion Income - T4 [ Taxable Banef - Atomobilo
™ T4Recoved 1™ Sugpatng Documentaton Recsved
Date Pacewved | -] Date Recerved -
™ Disabilty Benefits - TAAIP) [ Tamable Beneft - Low Interest Loans a
7 T4 Recorved I Suppertng Decumentaton Recerved
Dste Racerved vl Date Recerved vl
™ Othet Incomes ™ Employment Deductions - 12200
™ 12200 Recoved ™ Suppatng Decumentaton Recened
Date Recerved | ~l DatoRecerved | ~
™ Emplopment Insuance - TAE [ Apgeenticeship Tools
™ 74 Reosved ™ Sugpoting Deousertaton Recsved
Date Receered 'I Date Recermad v|

a. Documents b. Scracch Pad

(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a perscnal client with regards to Employment.

Note : After you save the notes, the icon will automatically change to a pencil to
let you know that there are notes inside.

" ® Pension & RRSP

The Pension & RRSP tab is designed to select which type of tax prep documents
relating to pension and RRSPs have been brought in by your personal clients and
on what date.
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R In Personal Clients, go to Client Info = Pension & RRSP (tab)

Penswn &

Cm\«dlrﬂo[ ucublo[ m‘ ]Endowm RRSP Immx]?fm,] thlgmml “D:m] Cuzdeer

Pension & RRSP Information b

Check all the documents and income Lae items that apply to this client below

¥ Peaswa Income - TAA

¥ TeRecoved

DatePeceived Detbe 12,2011 o]
[ Canada Pension Plan - T4AP)

™ RRSP Contnbetion Recepts
™ Suppating Decumertston Received
DatoRecerved | -l
™ RASP Retring Aowseo - 12097

™ 1848 Receved I~ 1200 Recorved

L DasReceved [ o]
™ 01 Age Secuiity - TAADAS) [ RRSPs Used To Buy House - T1038

™ T&0AS) Recered I~ 71035 Recerved

DeeReceind [ ] DateRecered [ o]
™ RRSP - T4RSP ™ RASPs Used To Fund Education - RCI6

™ 14359 Recoved ™ RC% Recered

Date Recerved | ~l Date Recered | -]
™ RRIF - T4RIF ™ Pention From Foreign Sources

™ T43F Reoved ™ Supoerting O B 4

OueRecsed [ v DateReceed | v

a. Documents b. Scratch Pad

(a) Documents

Check off type of document(s) you have received from your perscnal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a perscnal client with regards to Pensions & RRSPs.

Note: After you save the notes, the icon will automatically change to a pencil to
let you know that there are notes inside.

» Investments

The Investments tab is designed to select which type of tax prep documents
relating to investments have been brought in by your perscnal clients and on
what date.

R In Personal Clients, go to Client Info = Investments (tab)

Gones| vt | F [ enun | Bt Jivotmn. [ 38, [ movnse | S0, [ n |

@i

Investment Information b
Check all the documents and income tax items that agply to this client below =
ru From Bank Savings A ¥ From Canads Savings Bonds
™ TSReceved TSCSE, TE00 Recer
Oate Received. | ~l DatoRecewed [Octcker 12,201 |
[ Intecest From Tesm Doposits ™ Dividonds
™ 15Recoved ™ 15Racenved
Date Becervnd | -] Dato Recerved v]
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[ Intesent From GIC: [ Inteteat, Dividends From Trusts And Estates
T 15Recsved I T3Recenved a
Qe Recerved | vl Date Recerved vl
[ Intetent, Dividends From Mutual Funds ™ Incomo From Feeeipn Sources
™ 13 1SRecomed ™ Suppoting Decunentaton Racened
Date Recerved | E] Date Recerved | E]
[ Intetent From Noitgages, Netes ™ Treasuty Bill levestments
™ Supooatng R 7] ™ 75008.780
Date Recerved | '| Date Recerved V|

a. Documents b. Scratch Pad

(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additicnal notes on a perscnal client with regards to Investments.

Note : After you save the notes, the icon will automatically change to a pencil to
let you know that there are notes inside.

» Self-Employment

The Self Employment tab is designed to select which type of tax prep documents
relating to self employment have been brought in by your personal clients and on
what date.

Q in Persecnal Clients, go to Client Info = Self Employment (tab)

Gmmlldol Mare b [ ome 2 ]EWI ek Ilmmm. F ,mtml ggm[ “of‘f'm] Cunten

Self Employment Information b
Check all the documents and income tax items that apply to this client below =
7 Sell Englognont Incone ™ Employment Expenises - Vehicle
s ooy Dy R 4 rs 20 pela ey
Date Received | = Date Reconved | ~
[7 Self Englopment Conmission Income - T4A [ Employment £ * Supphes & Equy
™ T4aReconed [ Supgores Documantaton Recerned
Date Recerved | -| Date Recenved -|
[~ Busk Use Of Home Exp ™ Employ Exp ~Heals $ E
~ ¢ ’h o, " r- OW ’ﬁ B, (e | a
Date Recerved | vl Date Recenved v e
™ Business Uso Of Porxonal Automcbde ™ Emph 3 « Legal, A ing Fees
™~ ¢ o " R, 4 r" ew 1 B, 4
DsteRecerved | E] DateRecoved | 3
™ Capital Expenditures I Employment Expentes - Property Taxes & Rent
™ & .h -7 4 r_ 9-" 'A " B, ! "l
Date Recerved | v Dae Recerved | v|

a. Documents b. Scratch Pad
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(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a personal client with regards to Self-Employment.

Note: After you save the notes, the icon will automatically change tec a pencil te
let you know that there are notes inside.

» Real Estate

The Real Estate tab is designed to select which type of tax prep documents
relating to real estate income have been brought in by your persenal clients and
on what date.

R In Personal Clients, go to Client Info - Real Estate (tab)

[ Famdy Percan L Sed } Read | | Other Mo
G""""] powhlo I Mearbers I‘W"‘I ARSP I""““""‘Itw Estate) | Dodxtions | Dedutions [ Gt
Real Estate Income Information b
Check ol the documents and income tax Roms that apply to this chient below —
™ Puchase And Sales Of Real Estote ™ Reontal Propenty Income
™ Suggeninrg Documentation Receved ™ Sugpatnrg Documantanen Recened
Date Recened | ~ Date Pecerved | B -
" Property Tax " Rental Property Expenses
™ Supperinrg Documentation Receved ™ Sugpatng D n d a
DotoRecowed [ B Dote Recerved | |
™ Ront Expentes 7 Aeontal Cagital Expenditures
7 Suppenng Documentshon Beceved [ Suppotng Documentsien Receved
Date Recorved | -] Date Recerved 'I

(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a personal client with regards to Real Estate Income.

Note : After you save the notes, the icon will automatically change to a pencil te
let you know that there are notes inside.
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’ » Other Deductions

The Other Deductions tab is designed to select which type of tax prep documents

relating to expenses, tuition fees, and donations have been brought in by your

personal clients and on what date.

R In Personal Clients, go to Client Info = Other Deductions (tab)

Gmdlnb[ Mere bebo ] :,:"'“, IEWI éﬂs'«?‘ ]Imwxlgfm‘l&d[m Igmm g:;m] COustoen
Other Deductions b
Check all the documents and income Lax items that apply to this client below e
™ Asmony And Noi P, Received ™ Tuition Fees Foe Soll
re 20 R 4 ™ Sugperting Documentation Receved
Date Peceived | ~l Date Pecewed | =
[ Asmony And Noinl Payments Nade ™ Tuition Fees Tramilesied Fiom Spouse/Chid
™ Sugponny Documentston Raceved T Sugpatng Documentaton Recenved
Oate Recerved v|

[~ Chd Cane Exponsos

Oate Recernd -|
™ Charitable Donaticns

I Suzecrtrs O R, 4
v

Date Recerved i

I Political Doastions

™ Supportng O R 4 ™ Sugpertng Documentston Roconed

Date Recerved | 1] Date Recered | E]
¥ Medical Expenser ™ Altendant Cave Expentes

¥ Surpodng Docursentaton Racaved ™ Suggeting Docursertstion Recerved

OseRecerved |Ocicder 17,2011 v

Date Recerred v|

a. Documents b. Scracch Pad

(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a perscnal client with regards to Other Deductions.

Note : After you save the notes, the icon will automatically change to a pencil te
let you know that there are notes inside.

'@ More Deductions

The More Deductions tab is designed to select which type of tax prep documents
relating to union dues, interests, fees, and legal costs have been brought in by
your perscnal clients and on what date.

R In Personal Clients, go to Client Info = More Deductions (tab)

I

More Deductions

Gmslrdol Mare k> I Lm, ]Endmm[ twm‘ ]lmmx]%]%iue]w‘mlﬁ%
Check all the documents and income Lae items that apgly to this client below b

[
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¥ Unioe And Prolessaonal Dues

23 O 1. 4

Date Received [Oonbe 12,2011 &)
™ Intesest On Loanod Money Used To Ean Income

Ouate Recerved v]

[ Intesent Paid To Buy Canada Savings Bondt
Date Received vl

™ Salety Doposk Boxes

™~ ¢ 0, R, 4
weodng

[ Rembansments From Theft Ot Enbezzlement

re 0 -

D&eﬁmn'd—;]

Oste Recerved | -l
[ Feos For Managemont Of Invesiments
™ Sugpotng Documentaton Recerved a
Date Recernd -]
r A ting Fees Foe | Hanagaerd
™ Suggatng Decumentaton Recarved
Date Received vl
™ Legal Coats To Fight For Salaty Or Other Income

© & Oec R 4
FL00Trg

Date Recerved | El
™ Legal Coats Incuned To Fight Revenue

e o =, "

Date Recerred "

a. Documents b. Scratch Pad

(a) Documents

Check off type of document(s) you have received from your personal clients and
select the date(s) on calendar from drop-down list besides Date Received.

(b) Scratch Pad

Include additional notes on a personal client with regards to More Deductions.

Note : After you save the notes, the icon will automatically change to a pencil to
let you know that there are notes inside.

The Custom tab is designed to select which type of tax prep documents relating
to employment and income have been brought in by your personal clients and on
what date.

R From personal clients menu, go to Client Info > Custom

Gmdldo] uceHoI m, IEWI W" ]Imwmxlzd" ,] mtnolmmlwo Ak Cuslom

Custom Personal Tax Tasks <
Description Due Date Assigned Close | Notdly
€ (353 NawSrige Yokl [ 0at21. 11 Osdinaen 0O 0O GGO

 AddNew Recunrg Tanks

ﬁ

[ Asvgn Custces Tacks To Thes Clent ]

=

ef

|
Te}
|5

[ OpenCutcm TaksMonaee |

[ Moriope Yous Tasks For This Gient |

a. Task Settings b. Scratch Pad ¢. Task Description d. Task Timers
e. Task Information f. Assign User g. Auto-Notify
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(a) Task Settings

Create multiple custom fields to meet the specific needs for business client.

(b) Scratch Pad

Include additicnal notes on a business client with regards to Custom. If there are
notes inside, the notepad icon will include a pencil.

(c) Task Description

Includes information type of task, due date, and assigned user based on type of
payment schedule you select. You can notify business client or close a task by
checking off the boxes from here.

Note: Informaticn for tasks in 3 categories can be edited by clicking on the text.

(d) Task Timers

Simply click the start timer to being time entry for billing and when done, click the
stop timer. The billing time of task willin appear in the Time & Billing section.

(e) Task Information

Can edit or include additional information on tasks such as main, custom info,
flag, status information and notes as shown below.

Tok oot o Boakiacpi =

Sample Beauty Salon
e
P Ay B Petiem iy
Naeow: | [Bookeesing B 7 MissmpiefoFlag LT NotesFiag
Type: | [Bookheepng 3 Oveedn iz
Eergiogen Assrmd [Nm- ] ;] !S(mlﬂm . - Completed Inf b
Dus Date: FMZS. 0 v| ™ InPestesinn Closed I
InHouze Dus Date: Nanuap 22,201 » ™ Debvered
™ Nend Date Commpleted ~l
Colorvdy Date: Jarusy 21,201 +] - %
g Completed By Neew Assire -]
EumgedTme: 1 he[  mn ™ Receved
™ Signatue ;
VD0 yons wark 1o tecas e bk each yeue? re Aseinxk Posd
Custom Information _ Defrm Statuz Inéo | Date Post | :]'
Custoea: | . 3.1
- Notes
Cuitoen 2 [ @
Cunoen 3 [
Cutoend: | @
Custoens |
Define Custeen Fields
< ’ » Cancel ok
Prek Repert Mecpato Dec
(f) Assign User

To assign user to all tasks, select an user from drop-down list besides Assign
above to.
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(g) Auto Notify

To notify a business client of a task(s), follow these steps:

1) Click Auto Notify All Above.
2) Check off a notification method and click Finish.

Personal Clients

» Client Information

Step 1
Client Info
R In Personal Clients, go to = Client Info (icon)
Step 2
Fle Eot Teols CumommTashs Repets Users Suppent

Posoers Chants | Semith, Darok #0)[4) )] [ 239 | [3 Dee || 2010 )| (& Sewed )

Worsoral Cheets
N ozt [ oo [ i, [ onsme | 2557 [ imorverts | £ | Pt | 825 | B | o
(0]t s Covtrn . ]
e
Wame: Ur Retert Pk Deate :':":" Tyoe :Anmuw D Sangtmat
g InProges:
Avsociated Categony: & Decosred € On Hoks O, @ Senafa I
€ Sl Buiwrnis ®
O Mok - Mg ko 'q SenaLeter
Busness ACMaton :M'“:;.;;oﬁ © O Mok - Oher -
e Pagmd = " Comgleted
Company Name: Zarple Pretng Services ‘MRM

Mo PRone (706) S95.527¢ Chertt Sorvices Provided
Cell Phone: (1)) 5202000

Fax: 70%) 2255778

Emal: rodeniGsargieprring Co
Wed Siter W m SARQROININg ¢

Addrens:

Sanpie Prntng Services

W Roden Parck Orave

1591 Deacn Avesce

Saskatzon, Saskachewan AlA 121

Yoska
Twre & Sdheq
| Aee
Projects
NS
GGQ@ B 000000 Frday, Docomber 24 2010
To learn the how-to's of Client Info, select one of the following:
« General Info (pg.101) « Real Estate (pg.108)
» More Info (pg.103) « Other Deductions (pg.109)
» Family Members (pg.104)  « More Deductions (pg.109)
« Emplovment (pg.105) » Custom (pg.110)
« Pension & RRSP (pg.105) « Client Status (pg.292)
» Investments (pg.106) » Send Notifications (pg.325)

» Self-Emplovment (pg.107)  « Client Reports (pg.261)
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" ® Find Client

Step 1

Find Client

R In Personal Clients, go to = Find Client (icon)
Step 2

Find Client

& Find Client

Search Ciiteria |  SeachResuls |

~Search by Personal Tax Client Name in the 2010 year
Client Name: |

=]

Find

~Search by Criteria in the 2010 year

Search Field: I <Al ;I

Search Text [Smith

[T Match'Whole Phease Find
[T Match Upper and Lower Case -

Cancel |

1) Under Search Criteria tab, select type of search from drop-down lists above.

2) Click Find.

Step 3

Find Client =)
& Find Client

[ SeachCiteia | Search Results |

Name
Smith, Derek

Data Found

"Smith"", "Mr. Derek P. g
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< | " ’

Go To Record

Cancel

1) Under Search Results tab, select the appopriate personal tax client above.
2) Click Go to Record tc have persconal tax client automatically show up.

"@® Edit Client

Step 1
Edit Client
R In Personal Clients, go to = Edit Client (icon)
Step 2
Edit Contact (23]
Name | Businessirfo | Personallnfo | Spoussinfo | FamlyMembers | Other |
Address: (85 Albeno St| - Main Fhone: ((613) 452.5000
= A Phone: |
Chy: [Konato Cel Phone: [[613] 950-3652
Province: [Brhario =l Fax [[§13) 4525052
Postal Code: |L5G 87 Pager: |
Country: [Cenada Emait Bmekmuh@yd'mca
Websie |
FaceBook:[Derek P. Srith
Twitter:derek14
Gender: [Male - SIN: [360 000 000
Bitday: Dec 30,2010 v|  SpokenLanguage: [Engich
Anniversary. Feb 18, 2011 ~| Childeen: Iz -
’ﬂ?ﬁnt Report I I ﬂ Print Labels l Cancel ‘ Ok ‘

1) Edit personal tax client's information in any of following tabs shown above:
Name, Business/Personnel/Spouse Info, Family Members, and Other.

2) Click Ok to save changes.

114



Step 1

R In Personal Clients, go to = View List (icon)

Step 2

Personal Tax Returns (12 tasks)

gz BT Y (M

FPE ST A : 4
hovarced View/Mide View/Print NiRetuns ASReturns A Returns Al Returns Al Comnpleted || Defino Process
Sosrch Columes  Report | fowplting Clionts in Progross  On Hold Roturns Sweps
—

Chent Nome  ReumStatus | inHouse Du.. | Emplopee Asss
1 Drake. Robert OnHold-Misseglnfo  Aug3.10  DawidAndersca

Fulcero, Mana Awaiting Chant Sep 15,10 Susan Ancrews

Mattizon, James Awating Chent Sep 24,10  Dawid Anderzon

Moos, Nada OnHold - Other £0c30,11 Noew Assigned - -

Samantan, Josn Awating Chert Apc30,11 Noos Assigned & -

Smith, David OnHold-Quesions  Aug 16,10 Adam Abraham - -

1) Te change order of process steps, click Define Process Steps.
Define Process Steps Wizard =

9& Define Process Steps Wizard

This wizard allows you to create and organize the steps you perform to
process and complete personal returns.

@ Move Selected Step Up In List
Meetin
it @ Move Selected Step Down In List

Information Received

Prepared .

ooy Step Information

Reviewed StepName:  [Meeting

gpproxed Step Descriplion: [jnginates whether e =
igne client has been rolified to _

Packaged

Finished Colurn Heading:  [Mesting
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| I 1
| Rieset Lt To Defauit | | Add New Step | | Delete Step |

Ok

2) Select a step and click the up or down arrows shown above.
3) To add a new step, type in the step information and click Add New Step.
4) Click Ok to exit wizard.

Step 3

v v v Notify Now

1) To view information on return, click View Info.

Garrison Industries 2010 [7]
Main Information
RetunType: [Reguler =l Retun Dus Date: | =~
Retun Staus. |Awating Clent ~]  InHouss DueDate [y 272000 )
!—v.. A -' a4 Is A :J

~Flag Inf
P © PaciyFlag L) T MasnglnioFleg M T ProblemFlag [J T MotesFlag [ ¥ OvercueFlap

~ Custom Int
T —
owmemz [ ~Notes
Cuomd [
Owoms: [
Outems [

Define Custom Fislds

e | [Cox]

2) Insert return informaticn, notes and select type of flag shown above.

3) To set a flag on a return, select type of flag under Flag Information.

4) To create custom information about return, type in custom name and
click Define Custom Fields.

5) Click Ok to exit window.

Step 4 (optional)

ﬂ_@ List Options

—

" Refresh List
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1) To customize personal tax list, click View List Options Info icon

Personal Tax List and Report Options (==

Grid Layout | GridOplions | Repotlayow | Colors/Gid | Custom Fields |

Contact List Name Display Options
Select how you wank the contact names to display in your kst
" Display contact name using Display Name' field
" Display contact name using First Last' loimat
& Display contact name using Last, Frst' foemat

~ Contact List Family Relationship Display Options -
Select whether you want to display the relationship for family members:
@ Den't display the famdy relationship of family members
" Display the famiy relationship of family members

Progress Steps Progress Bar

W Display progress bar for completed steps

7 Change the gradient color of the piogiess bar based on the number of
" steps completed.

Progiess Bai Coler: Iﬁ:'

Cancel

1) Edit personal tax list options in any of following tabs:
Grid Layout & Options, Report Layout, Colors/Grid, and Custom Fields .
2) Click Ok to save changes.

» Merge Document

Step 1
Create Doc
R In Personal Clients, go to = Create Doc (icon)
Step 2
Merge Document @

o)
.. Merge Document
E Sl

f Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

| Companies T Contacts ] Tasks ] Appointments ]

[~ New Contact Mesge Document |
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Click The Document You Want To Open

Open an existing template

; document by selecting it
11 Engagement Latter.cte froen list on left side.
Tax Season.cle
Browse For File Not In List
Change Templates Folder Location

1) Select a document from the list to merge contacts with as shown above.
2) Follow the instructions on pg.236.

» Address Book

Step 1

Address Book

R In Personal Clients, go tc = Address Book (icon)

Step 2

i Address Book
foe fde Yook FRepom: Melp

1.2 2 x @

g

Find (= Delete  WebSee Repon

Asdress Book .
& Chent Track Business chents

19 B Semple Oranvtable Orpansater
1 B3 Sample Bectic Comparty Lewie
10 B Samyle rome Bulder L0
4 83 Samgie Lowyers Offce
4 81 Sample Overhead Door Marvft
¥ B Sample Prrarg Servces
¥ G} Sarple Roof Buider
1 Bl Sample Tattoo Stude
® B Sanple Trudang Comparty ¥
séndivad
test
& Chent Track Personal chents
= & 010
Or crens
Featrerioe Inc.
Garmon asves
Favion
Svers Pure

Soorer, el £t Contact

Teo Custons.

Von Ardviect o
- .

erek

Contact Business Inbormation Contact Persenal Idormation
Nome: v Oered P Sty Address:

Compary Mame: Sanple Chartable Organcation  Mr Deved P Sety

Job Title: Drector Oetare
Office: 405 Farruly Momber: Socner (Ushocwe)

Defauk Contact: Yes

Main Phone: (73%) 5550002
Coll Phone:  (613) 294-0000
Fax: (705) 5555045
[mak: -

13
Ur Decet P St

111 Braghord Sureet
Mortresl OC AfA 121

To learn the how-to's of the Address Book, select one of the following:

» Add New Contact (pg.220)

» Add New Company (pg.222)
» Add New Category (pg.223)
- Edit Contact (pg.225)

» Find Contact (pg.226)

» Delete Contact (pg.228)

» Delete Category (pg.229)
» Moving Multiple Contacts (pg.230)

» Preferences (pg.231)
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" ® Document Vault

Step 1

Doc Vault

R In Personal Clients, go to = Doc Vault (icon)

Bunons ety | Sumpli Beouty Salon (aloln [0 0
: COCC e
e [ AdA Coropirian ) asastortoat | Open shonan [ ostete pwnan | Fnasnones |

- mmmxm —_ _ — —
OCI«”M&N«\)@M Diag 'n diop powr client documents in the whito box below for caty accoss.

[o—_ -
Time & Bikng

Appointments Note: The Socument wora ntade the whie Lo e shinzuts 13 the GQns document lier. Moves. seramey)
e o deletrn)

the Shonouts wall it SYedt the Cngnal Sodumert Hiet

Progects

Step 2

[ Add Categories B Client Documents
- S e’ Clienl Document .
= - Add New subCategory to this Categery l
&2 Client Track M

\
Edit this Category
|
|

Delete this Category

Add shortcuts to this Category

Properties

1) To add new personal client, right-click on main categery (Client Documents)
and select Add New subCategory to this Category shown above.

Optional: Click Add Categories button tc create new category.

Add New Document Category |23

Category Information

Create Categosy In: [Uient Documents ;I ‘
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Category Name: [Clent Track
Descrption:

Software Related Documents -

Folder Synchronization Options

You can speciy a folder on your computes of nelwork wiich Clent
Track wil automatically showe 2l Ihe flie conlents i this calegoy,

I Browsep""

2) Type category name and description shown above.
3) To synchronize a folder from network, click Browse.
3) Click Ok.

Step 3

[ Add Categories ] Client Track

B&‘j Client Documents

! &\3 —— Drag 'n drop your client documents in

1) Select new category that you have created in Step 2 shown above.

Drag ‘n drop your client documents|in the white box below for easy access.

@ T

case_sudp.doc  letterpdf

2) Click Add Shortcut and select file(s) from your computer to store in doc vault
shown above.

Optional: You can drag 'n drep files from your computer in doc vault.

Step 4

case_study.doc  |ELEHEL

Are you sure you wanl to remove the category 'Trilobyte
? Solutions Inc.” and all sub categories and file links within this
categoiy?

1) To delete a document from Doc Vault, select a document shown above.
2) Click Yes to confirm delete in pop-up window.

Note: Documents that are stored in doc vault act as 'shortcuts’, therefore, deleting
them will not delete the coriginal file source on your computer.

120



-

» Reports

Step 1
Reports
R In Personal Clients, go to = Reports (icon)
Step 2
Personal Tax Client Reports e

Client Reports for Mr. Derek P. Smith

Chent Specific Repoits General Personal Tax Repoits

(" Client Summary Report " Pessonal Tax Client List
Chent report whech showes chert address ard Lzt of &l poust pecsonal bax chants for thes tax peat.

contact informahon
" Numbered Pessonal Tax Client List

O et BeommesbilionBondod Nurbered it of &l your perscnsl tax chents for
Clent report which shows the documentation this Lax year,
wiotmation tequied and tecesved liom thes clent. : ;
" Personal Tax Client Address List

Lot of &l poust personal bax chants fof thes tax
yeur thovang addrezs réoimation.
" Pessonal Tax Client Contact List
. for
¢ Client Income Tax Infoimalion :md d. ",: m&: mdmmemmm msb,: m'm&ﬁmm
Request Forms
The folowang ate blark genane foims
tequesting perzona ncome tax from the chent.
" Detaded Infeemation Request Form
" Se¥ Emplopment Information Foem
" Moving Expenses Foim
" Rentd Incoms Infoematon Fom

[ Cancel |

Follow the instructions on how to create a report for a personal tax client on pg.261.
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Step 1
Tasks List
3  In Tasks, go to > Tasks List (icon)
et T e=sgey ==}
Fle Ede Yook CumtomsTaks Repets Uien  Sopport
[[Bemass Coerts | Taska List (39 1asks) & Ourgn Enciee Assred | | ©)

PN Y 8 3
w View/¥ide View/ Tyt Tewhs For Seshs For A P
Cobamen  Rugort Thin Weok  Thin Month Unclosed Tasks
m Al uncompletod tasks for tho due dotes butwnen Tuesday,
Fobiuary 1, 2011 and Moaday, Febuary 28, 2011
| ComparyName MName Duelde ” Oue | Evclysedsspned | | .~
Samgie Trucking Cempary Bockheopery Feb25.11 Iesbels Smthy GGL Vewielo | Notty Now
Samgle Taco Shado Bockheepry Fb2S11 Adwmibuban GG Vewkio | NottyHow
Samgle Root Eubder Bockheepiy Feb25.11 NerwAssred (3 G Vewlio | Noylow
——
Samgie Prriing Services Bockheepr F511  Swnindem 3G Vewlio | Notyhow
Samle Ovehesd O & F511 | NemAsged G Vewkio | NottyNow
p—
Samgle Boasy Sakn Bockboeping Fb5.11  OwidAndesn B Gl Viewbio | Notyow
—_—
Samgie Banty Saon &6 Quatedy HST flotum. feb28. 11 Norw Acigred G G Vewiio | Nottylow
—_—
Samgie Banty Sakon Bockheope Fb5.11 | NeneAsigned G G Vewkio | NottyHow
—
Sampie Bansy Sakn 2 Morthy Enplogee Papct  Feb 20,11 Nerhsigrad (B G Viewiio | Notyliow
Samgie Banty $: e ’ Feb15.11 NorwAssoned GG Vawiio | Nottylow
Pregects b — Nodhoocle ERE ekt A AA v | s i’
User: Jason
Ghad 8 oococo Tusstay, Fetauny 82011
Step 2
Name DueDate  Close igned h—_.l
Bookkeeping  Feb25.11 [ | lsabella Smith (B Ga| Viewinfo | Noiify Now

Bockkeeping Feb 25,11 {1 Adam Abraham G G[ ViewInfo | Notify Now

Click View Info on a specific task shown above.

Step 3

Task Information for Bookkeeping . D : "@
Mr. Derek P. Smith
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[ eniomaion |y
P I ProdyFlag B Putien iy
Name: [Bookkeoping B ™ MissinglnfoFisg (T HotesFag
Type: [Custom B Ovedn Flsp
Englopee Azzignad [None Assiprnd E] Status Informat; Complotod Infomats
Oue Date: Peewbel 31.2_-] I5 6Possesson —
InHous . Decenter28,2 v] ™ Detveced
ouse Dus Date bccr = j s SR—— -
Colends Date: Decenber 28.2 « - =]
- Completed By None Assire vl
Edtisted Tierwe [T e[ mn ™ Recewved
™ Signatre
T Do pou wark to recur this task each year? re, Atrurk Pot
Custom Information Define Status rfo Dete Poid =l
Cuagton 1 [0}
' o
Customn 2 | @
Custeen 3 |
Cons|
Cusstom 5 | ‘
Defne Custom Fislds |
< » Cancel ok
Print Report Mergs to Doc

1) Select the dates of task from drop-down list shown above.
2) To set a flag on a task, select type of flag under Flag Information.
3) To create custom information about task, type in custom name and
click Define Custom Fields.
4) To set status information on task, select type under Status Information.
5) Click Ok to exit Task Information.

Step 4

!}‘CorqpanyName ~ Name - DueDate

Mr. Derek P. Smith Bookkeeping Dec 31,10

Verify that flag information appears besides task shown above.

» Tasks Calendar

Step 1

Tasks Calend...

R In Tasks, go to = Tasks Calendar (icon)
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""December 27 - January 1, 2011

-

Thuniday Dec 30, 2010

5

12 1

s 19
n

5 6 7 8 9%
12 13 14 15 16 17 18
19 0 2 N B Mn

% 27 8 PTON
F 4 - | O 7
T Yoday: 30/12/2010

for Sample Home Buider Ltd,
w0 Quick Add - New Task

Neme [

S —

Oate: [Tro 0ec 30,2010 +)

Teve: [5007 <] Te [3005 <]
434 Tock,

ZIERE)] e Sisensr iy )

Select User's Day Timer: Jason I

1) To view tasks of an user, select user from drop-down list shown above.
2) To view tasks in different view. click one of the calendar tabs.

(e sivcber (@

3) To have only tasks list tc appear in Tasks, click Hide Sidebar.

Step 3

Quick Add - New Task

Name: |
Client: | |
Date: | Thu,Dec 30,2010 ~|
Time: [&:004 v To:[s:00 40 +]
AddTask |

1) To add a quick new task, go tc Quick Add - New Task.
2) Name task and select client, date, and time from drop-down lists.
3) Click Add Task.

Step 4

""Decomber 27 - January 1, 2011

4 Mon 27 Tue 28 Wed 29 Thu 30
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1:00p 19 20 21 22 23 M B

% 27 B PTON

200p o0 7, 33 ST .
200p
400p

S:00p Dae: [Sun Dec 26,2010 |

600p Tewe [8004 v To[300 +]

- 454 Tack
[212] [#] (ShomWosionds | [_Hao St | |y]|D)
Click Week tab to view tasks in week view shown above.
" Tasks - Moath View > Day| Weoeh Morih

D bor 2010 eribes v 2010 4

1 =il2 =3 = ) =

5 < e Sz = [8] =|2] = |19 g 0| E

19] = |20) Bl e = |22] = |23) B e = |2s) ]

Click Month tab to view tasks in month view.

'@ New Task Wizard

Step 1
New Task Wi...
R In Tasks, go to = New Task Wizard (icon)
Step 2

E Manage Your Tasks

~ Recuning Task(s) Information
Tasks Name: IBooldma'ng Numbes of Tasks: 1

T | €6t ) ((oele | [ EdtNoshcaion Comment |

If you do not have a recurring task(s) under the Saved Tasks List column, click
on Add New Recurring Tasks on top

Note: If you already have saved recurring task(s) from list, go to Step 4. 125



Step 3

Create Custorn Tasks Waard - Add 2 multiple or recurring 26t of tasks (3]
*m!, Custom Tasks

Add Recurring or Multiple Custom Tasks

~AddR ing/Mukiple Tasks- Deatcaplion Assigned Recur \ Estimated Time Ba
Tosk Home: [Bockikeeping Sockiesging ihe
7 Cicste Numbered Names eg 131, 2nd, olc. Bockkoeging =2 ™
Doty | Weekly | SemiMorth | Mooty | | | Bootsieeging ) The
BrMeethly | Quatery | SemvAneudl | Annual p e
Evey [T <] Month Bosikeeping The
FraDay [10 ) Bookkenging = ke
Secend Doy |25 -l : : " -
Estimated Completion Time:
W ke [ mn | - Save Custom Tasks
Do you wark 2o teces -
I!'les’rlladuead\m" & |LAdd Tasks ihdh""’ L Sﬁ
Cancel cBock | mex Finish |

1. Insert task name and select type of recurrance (i.e. monthly) shown above.
2. Click Add Tasks and verify that new recurring task(s) appear in the task list.
3. Insert custom task name to save as and then click Save.

B The custom recurring Lask(s) has been successfuly saved.

Click Ok to successfully save recurring task(s).
Step 4

@ Manage Your Tasks

Saved Tasks List rR ing Task(s) Inf ti
Bookkeeping TacksMame: (Bookkeeping Number of T acks: 24
Add New Recuriing Tasks [ Edt ] [om] [ Edit Notifcation Comment ]

-~ Schedule Tasks for Clients

Select type of proerpt onwhen ™ Proergt foc day of month, (16 2,17, 25, ate)

scheduling recutring task(s) for Tox=—2
solected chonts lo overnide the 7 Frowet los Employes Assp

preset values: ™ Proergs for Estimated Tine
Business Companies I Personal Tax Contacts ]
B @G Clicnt Track Business clicnts -

m

Coiparation

| [£183 Sample Seauty Salon
M83 Sample Chartable Orgarezation
182 Sample Electsc Company Limded
183 Sampls Hoee Bulder Ltd.
183 Sample Lawyeres Ollice >
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Wain thete iz Seady these
¥ 1ecuniing tazk(z) scheduled loc Apply Tasks Yo Selected Clients I

Cmeell Ok I

1) Select type of recurring task under Saved Tasks List shown above.

2) Check off type of task(s) scheduling for your clients.

3) Check off which clients you want to add recurring tasks to and then click
Apply tasks to selected clients.

4) Click Ok and go to Step 5.

selected clent for given year.

Step 5

Custom Schedule Options

|[g Custom Schedule Options

Client Name: Sample Beauty Salon
Specify Day Of Month, (i.e 2, 17, 25, etc) |10

Specify Employee Assigned [ i) v |
Specify Estimated Time [1_ his I min

Ok

Select which employee te assign recurring task to from drop-down list.

g! The tasks were successfully scheduled for the selected chents.

Step 6

Tuetday Wedserday

Tasks for: Jan 7, 2011

9 AM

1000 =

9n .
— s e

1100

1
I

12 PM
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You can drag 'n drop tasks shown above to other
calendar days to move them

1) Click the Tasks Calendar icon under Tasks.

2) Select the employee you assigned the task to from drop-down list on top right.

3) Verify that the tasks have been scheduled correctly to employee assigned.

» Search Tasks

Step 1

Search Tasks

X | In Tasks, go to = Search Tasks (icon)

Step 2

Tasks List (39 tasks)

/O

Search Columns Report

Advanced | View/Hide View/Print

5 8

Tasks For Tasks For All Prior
This Week This Month Unclosed Tasks

Click Advanced Search as shown above.

Step 3

Advanced Search (Tasks)

[Search Main ]

Search Dates T Seaich Status

[T Search by Task Description Name
Fnd only task names that contain following text:

[T Search by Employee Assigned

Fird only tasks assigned to the
following user:

Search by Client
Find only tacks for the following clisnt:

"

[None Assigned ~]

[T Search by Supervising Partner

[~ Search by Task Type
Find only tasks of the following lype:

;I Fird orly tasks assigned to the
fellowing pariner name:

]N one Assigned ;]

fa

¥ Search by Closed Status
@& Show only unclosed kems
" Show anly closed tems

0 Search by Managing
Accountant

Firvd anly tasks assigned to the
folloving managng accountant:

[Mone Assigned _']

=
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| 1 [ Limit Search To Prior Years Archives ‘ ‘

|

Cancel |

Peiform Search

1) To search task by information, click the Search Main tab shown above.
2) Select search type from one of two categories above.

3) Click Perform Search.

‘Advanced Search (Tasks) X5
Search Main if [Search Dates | Seaich Status
v Search By Date Range
Seaich: |Due Dates |
" Find all tasks onc
[December 1,2010 ;]
" Find 2ll tasks on o before:
[Pecember 1,2010 _:I
" Fird 2l tasks on or after:
€ Find 3l tasks on o after:
Decembe: 1,2010 ;]
& Find 2l tasks between:
Decamber 1,2010 LI and  December 31,2010 LI
Cancel Peiform Search
1) To search task by date(s), click the Search Dates tab.
2) Select type of date range from drop-down list.
3) Click Perform Search.
Advanced Search (Tasks) (mESm)
Search Main i Search Dales 1 Search Status’
™ Search for InPossession [T Search for Received
where equals: IUmhecket vl where equals: [Unchecke: vl
™ Search for Notified [T Search for Signature
where equals: |umheckq vI where equals: [Umckq vl
™ Search for Prepared g::‘c:‘:m
where equals: lUnchecke( vI where equals: |Unchecke vI
™ Search for Delivered
where equals: ]Umhecke( v|
Cancel

Peiform Search
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Advanced Search (Tasks)

Search Main 1 Search Dates | [Search Status

—
|

Search for InPossession

where equals: |Unchecke: v]

™ Search for Notificd

where equals: |Unchecke: ']

™ Search for Prepared
where equals: |Unchecke v]

Search for Delivered

where equals: lm:ke«_;]

W

[T Search for Received

where equals: | Unchecke: vI

[T Search for Signature

where equals: |Uncheckes vl

Searcn 1or

Paumont

where equals: | Unchecket vl

Status Categones

Cancel Peiform Search .
1) To search task by status, click the Search Status tab
2) Check off type of search status from drop-down list.
3) Click Perform Search.
Step 4
Name ODueDate = Chse EmplopeoAssigned | )
Bockkeeping Feb 25,11 [ Isabella Smith [ G[ Viewlinto | Notify Now ]
Bookkeepng  Feb25.11 [ |  AdamAbroham e Q[ Viewinto | Notify Now |

The searched task will appear in the tasks list. To view details of the task, click

View Info as shown above.

‘a

» Merge Document

Step 1

Create Doc

3 | In Tasks, go to = Create Doc (icon)

Step 2

Merge Document

‘g Merge Document
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Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

N\

Companies ] Contacts ] Tasks ] Appointments

[T New Task Merge Document

Click The Document You Want To Open
Task - Need information from client.ctt
Upcoming Task.ct
Open an exsting template
document by selecting #
from list on left side.
Browse For File Not In List
Change Templates Folder Location
[ Cancel Wizard |

Select type of document to merge tasks with from list shown above.

Step 3

m
e x

—é-n-:ahmmmno'ﬁcmmm =
| Document Merge | Emad Merge

PNNEIEI = B (& Qe

Select  Crewte  PriscDecs Save Doce Savets Swvet

| NewDsc  MergeaType  Iraet Merge Inget Firm [agert Date Select Select Select
Fale Fuld Froly < Cantacts Tosks  Mege wed  POF
l Insect Merge Fields Select Information Save Your Merge
Piomal v % | BZU|E)JRIM W -] |ZE|DS
| erx
J 2, p. . . B creent?. 1, | PR RSN T, R N, RS
R T AT AE R Tm IR e e R R N RS
-

Chant Track
] 148 Colonaade Rd. South -
1 Neowan, Ontano K2€ 7R4

Dear Saah Stylse,

Your «Task Name» 5 due on «(Task Due Date, mmmm & yyyy)r. We are mssng otcal
nformation that from you n order 1O COmplete ths task.

Please arrange to drop off al paper work ind nformaton Isted below to alow us to

complete the retum.
Information Required:
{ « - " L
Sechon/l | Pogel/l | (L) | Col) | 300X UM

For instructions on how to merge tasks, go to pg.238.

Step 4
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| Switch to Client Track Merge |

Choose Type Of Merge Document You Want To Create Or Open

Companries ] Contacls ] Tasks I Appaoiniments

N

l [T New MS Word Task Merge Doc |

Click The Document You Want To Open

Open an existing template
document by selecling it
from kst on left side.

Browse For File Not In List }

Note: |f you use the MS Word mesge, the meige docurments will not automaticaly be saved
in the client’s document vault,

Cancel Wizard

1) To merge tasks in Word decument, click Switch to MS Word Merge.
2) Check off New MS Word Task Merge Doc.

Step 5

‘Merge-l;)ocument

Tr?, Merge Document

Switch to Client Track Merge

~ Select How You Would Like Microsoft Word To Open The Documents

¢ Open The Merge Template Document Only

Use this oplion # you wan to be able to edit and insert merge fields into the
document you choose,

Note: You vill be able to perfoim the merge from within MS Word at any time.

" Open The Merge Results Document Only

Use this oplion ¥ you want to just quickly merge the clients you selected
into the document you selected.

Note: You must have some \Word mergs fields in the document to use this
option of the document will be blank.

- Open The Merge Template And Merge Results Documents In
Separate MS Word Windows

Use this option to be open both the merge template and merge results
documents in separate M5 Word windows.
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I 1

Back Peiform Merge |

| Cancel Wizard |

Select type of merge document to open shown above.

EPvpm 1 ot | Weted | Engen Kmee [EEFFNT WoS==smm=—(

To begin merging document, use the merge tools in toolbar.

» Report

Step 1

Report

3 In Tasks, go to > Report (icon)

R <9 bl

1

Print n Colowr v
Task List Client Track Report:
All uncompleted tasks for the due dates between Wednesday, December 1, 2010 and Friday,
December 31,2010

B- Company Name Natoa Due Date Clasa

Smith, Detek Bockkeeping Dec 31,10
| Sampie Roof Buide BiMeekly Emplopes Paprol | Dec 31,10

Sanple Printrg Setvices Chent Yesr End Dec 31,10
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Sample Overhead Door Manufachres | Clent Yex End Dec31.10
Sample Lavyers Ollice Biweekly Employes Paytol Dec 31,10
Sample Home Budder Ltd. ‘Weekl Employee Payrol Dec 31,10
Sample Lawyeis Olfice 11th Teust Reconciation Dec 25.10
Sampbs Home Bulder Ltd. Weekly Emplopes Payol Dec 24,10
Sample Truzking Coerpany BPWeekly Employee Payroll Dec 20,10
Sample Trucking Compary Biweekly Employee Paprol Dec 17,10
< |

Print

To print a tasks list report, click the printer icon on top.

Export

=]
B3 Export =]
Saven: | J. Clert_Track_Bmot | eB B

Name Date modif.. Type Size
This folder is empty.

Flename:  [lask st ba

Save as type: I [Uricode Tent ("be)

~Page Range -
@ Al

 Pages lront|1 bocl

vie

To export a tasks list report, click the document icon on top. Name the export file,
choose format type from drop-down list and click Save.

Step 1

R In Tasks, go to = Options (icon)

Step 2
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" Grid Options | RepoitLayout | Colors/Grid | Custom Fields |
[~ Lock the client name column so it is dhways vishle
™ Wiap textin grid cells
~Alternating Grid Lines
[V Display atemating grid line colors

Alternating Coloe 1:

Ahernating Coler 2: [ +| Reset to Defaut

~Closed Tasks
[V By defauk, dont show closed items in this list

~When The Tasks List Starts, View ...

" Tasks Due Today
" Tasks Due This Week
% Tasks Due This Month

1) To change the display setup of tasks list, click the Grid Options tab.
2) Check off Lock the client name....so it is always visible.

3) Select alternating row celours for grid lines from drop-down colour list.
4) Select type of display view tc automatically appear in Tasks.

Step 3

e
| GridOptions | Report Layout| Colors/Giid |  Custom Fields |

~ Repont Orientation
Select defauk page orientation of the repoct when it is first displayed:

" Potigit ¢ Landscape % SizetoFit

~Report Margins
Top Maigin: |1 inInches Right Margin: |1 inInches
Left Margin: |1 inInches Bottom Margin: |1 inInches

~Report Options -
[V Show Column Headzais On Repont ¥ Wiap Text In Cells
[V Show Colunn Headess OnAlPages ¥ Show Headst Giid Lines

' _ V' Show Main Grid Lines
Header Line Thickness: [2 ¥ Show Hor. Giid Lines

Wi ichones: | W ShowVert Giid Lines

Cancel Ok

1) To customize the display of report layout, click the Report Layout tab.
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| GiidOptions | RepoitLayowt | Colors/Grid | Custom Fields |

~ Title Bar Background Color
Tale Bt Background Celer: [N ~|

~ Grid Colors

Header Background Color; ﬁzl Header Font Color:
Giid Backgiound Color: [ J~|  Grid Font Color: [N -

~ Repont Alternaling Grid Lines
[V Show &ltemating Grid Line Colors In Report

Ahermating Color 1: [ ]+ Ahemating Color 2:

¥ Show 'Date Genesated' On Repott [V Show Page Numbers On The Report

Cancel Ok

1) To customize the colours and grid of report, click the Report Layout tab.
2) Select type of grid colours and lines.

Step 5

" GiidOptions | RepotLayout | Colors/Grid | Custom Fieldsl

You can define custom fields for yous clents by clicking to button
below and entering the field names of your choice

Customize Task Fields

Cancel Ok

1) Optional: To set a custom field on task, click the Custom Fields tab.
2) Click Ok tc save changes.
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'. » Time Calendar

Step 1

Time Calendar

R In Time & Billing, go to = Time Calendar

Step 2

Select User's Schedule: Day| Week Month

Wednesday LN Susan Saturday

1) To view time entries of an user, select user from drop-down list.
2) To view time entries in a different calendar view, click one of the calendar
view tabs as shown below.

22 Client Track
File Edit Tools Custom Services Reports Users Support

Business Clients | %) Time Entries - Week View
Personal Clients
e January 30 - February 4, 2012

Time & Billing = * Mon 30

Time Calendar

3) Double-click on an empty timeslot to create a time entry.
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Step 3

Time Entry

N
i Time Data Entry
|

Business Client: [Sample Printing Services

Pessonal Tax Client: |

Led Lo

Time Dusation: [3 hws [ min

Task: IConltaols

Billing Work Code: |PRl - Printing

Non BillWork Code: |

Lef LefLe

Invoice Desciiption:

(optional)

Cancel I

Ok |

1) Select a business or personal tax client from drop-down list.

2) Insert time duration for entry and select task type, billing work code or
noen-billing work code from drop-down lists as shown above.

3) Click Ok to add time entry to calendar.

Note: The Time Data Entry window is a simple version. The advanced version
can be activated by following Step 3 here (General Options).

Business Clients

Perscnal Clients

Tasks

@ Time Entries - Week View

9:00 am to 12:00 pm
Sample Printing Services
Printing

4) Double-click on the newly added time entry to change additicnal settings.

Step 4

3 Eaieting Time Entey

General ] Biling Info

| BlingDescipion |  BdiTimeTo.. |  Custemlnlo
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Time Entry Name: [Printing

Employes Assigned. [Jason
Date: | Jarwary -3012 ~l

[900am = =] o [1200PM = ~]
Tine Duration [3 s [ min
Busiess Cler: [Sanple Printing Services v
Pessonal Tax Clent: | |
Time Entry Links
Select Tazk: |
Biling Work Code: [FRI - Piinting
Non Bl Work Code: |
Biling Categoiy: | Design

Time Entry Disploy Text
:00 am to 12:00 pm -
Sample Printing Services
inting

Edt Refresh

Cdow Schore: [Design ~ ~] (@)
Tile Bar Backgrourd:
Tile Bat Foreground:
Body Background: [~ 1]
8ody Foreground: [ -

Internal Non Bilable
Merge | Payrol Setvices

Delete
YearEnd Staements

1) Click the General tab.

2) Select type of billing categery and color scheme from drop-down lists.

3) Click the Billing Info tab.

Geneal Billing Info |  BiingDesciplon |  BilTmeYo.. |  Custominto |
[ Is This Time Entry Billable
Time Entry Status: lw«k In Progress 'I
Actual Time
o T G S0 ToblAot: $135.00
@ Bill By Time End Tme: 1200 pm Tax Code: m
Biling Rate: ign - $45. i
ifng Rate: | GDesign - $45.00 | Totl Tine: 3hes T
" Bill Flat Rate Rounded Time
FaRae [ Start Time: 09.00 am
End Time: 1200 pm
Total Tine: 3hie
Told dmeant:  $152.55
[~ Ovewide Time Duration With The Following
[ ks [ min
Delete MergetoDoo | Cancel Ok

4) Select type of billing and rate as well as the tax code from drop-down lists

as shown above.

5) Go through the other 3 tabs to include additicnal information if needed.
6) Click Ok to save new changes for time entry.

Step 5

N
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28+ Client Track

File Edit Tools Custom Services Reports Users Support

Business Clients @ Time Entries - Week View

Personal Clients
Tasks s A i =14 a 4 |
&L B q 0 U

. 8:00a

. S 78

; 5:00 am to 12:00 pm -~

0 Sample Printing Services
10:00a Printing

\Qg 11:00a
dd Depo 12-“’

1) The revised time entry with new changes from Step 4 should appear on calendar.

22+ Client Track
File Edit Tools CustomServices Reports Users Support

\January 30 - February 4, 2012

-

(7200 am to 12:00 pm
Time Calendar Sargie Prntng Services.

10:003 oyt
‘\ S‘;

Tame List

1:00p
1300 pen to 3:00 pm
d Sampie Home Buider Samgle Lawyers Office Sampie Home Bulider Samgie Tattoo Studo
- 2:00p L1d, Fing Ltd, Scanning (Imiernal)
Create Invoice 9 Prepossl -
e 3:00p
m 4:00p
Add Deposit =
5:00p

» Time List

Time List

R From menu, go to Time & Billing = Time List
Step 2
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jost

)

A& &

Columns  Report

", Refresh List

Search Time | View/Hide View/Print | Solect Add Selected Time Add Seloctod Time | Mark Up/Down  Write
Entries Client  To New invoice Vo Existing involce

s/ va

| Change Setected Statuz To... |

Show Alt
Time Entries  Off Ready

All time entries where the status is "Work in Pro

k-——-—.—ﬂ'/ Select Al hd
Client Quick Select Control . I

[<1 Crents>

Refiesh Clents List

" Al Times Ready for Invoice
Al Times Not Invoicad

Al Times Wotk n Progress

" Al Times Sirce last inwoice

& Use ‘Advanced Search’ crteria

1) Click Refresh List to show all clients' time entries in list.
2) To select a specify time entry status, click Search Time Entries in menu.

Note: Time Entries can also be searched by using the quick methed on main

window as shown above.

Search Main Ciitesia | SearchBy TypeDates |

SeaichByTime | Sewch8yEmplopee

\

[~ Seaich by Time Entty Name
Find 8l line entiias that contain folowing
I
[~ Search by Client
Find cnly lime entiies loe the lollowang chent:
[ =
¥ Seasch by 'Billed To® Client
Find only tme entries fot the folowng clert
|Sample Prirting Services ~|
[V Search by Billing Status
Fd ool lime entries loc the lollovang tetus:
|Wotk In Progress |

[~ Seatch by Locked Status &
€ Show only locked tme enives
@ Show only unlocked time entnes
I~ Search by "Allocated to Invoice’
€ Show only peesicusly invoiced tine entries
€ Show only nonvinvoiced time entias
I~ Search by *Show On Invoice®
€ Show time entiios where ‘show on nvoice' true
@ Show lime enliies where not 'show on nvace'
[~ Search by Billable Status
€ Show coly lime entiies that ace bllable
@ Show caly lime enliies that ace non bilable

Select Time Entrics

3) Check off type of search and select from drop-down list as shown above.

4) Click Select Time Entries.

Step 3
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All time entries where the status is "Work in Progress® billed to Sample
\ / Home Builder Ltd.

l Change Selacted Status To

€ 21 Tenes Readybor Irvcice
€ A1 Taves Not ltwoced

@ &1 Tones Work n Progress
© A Tanes Srcs lst evtsce
© UseMdvarcod Seach’ critess

1) The selected time entry(ies) appears on the list as shown above.

All time enlries where the status is 'Work in Progress' billed to Sample Home
Builder Ltd.

Selectdl  ~ | Change Selected Status To.... |

2) Browse through rest of categeries with the horizontal scrollbar to view more
information on time entry.

Step 4 (optional)

& o o

Select Add Selected Time Add Selected Time
Client  To New Invoice  To Existing Invoice

1) To customize which columns appear in list view, click View/Hide Columns.

~| View/Hide Columns
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~Flag Information——————— ~Date & Time Columns

@ W Time Enty Locked [V Time Entry Date
5 W Allocated to Invoice V' Start Time
& |rN W End Time

[V Total Time

- Time Entry Information Columns - )
V' Rounded Start Time

v Billable Time

™ Cient Name V' Rounded End Time
¥ Bill To Client V' Rounded Total Time
[ Bl Erom Fiém V' Use Adjusted Time

V' Time Entry Name V' Adjusted Time

V' Time Entry Status [V Final Total Time

2) Un/check any coclumns to be visible/invisible in list (i.e. Notes Flag)
3) Click Ok to save changes

1
Selectltem (%) |/ BilableTime ~ Selectltem (%) Bilable Time

(] before ] after

4) Ensure the changes appear in list (i.e. Notes flag gone shown above)

" » Add Deposit

Step 1
@
Add Deposit
R From menu, go to Time & Billing = Add Deposit
Step 2
Add Deposit =

ﬂ?@ Add Deposit

Deposit Information ] Items Deposit Paid
Type of Depost | Type vl Date Received: [Dctober 24,2011 ~|
Biling Firme | | Date Deposited: [Dctober 23, 2011 >l

Business Client: |Sample Printing Services _~| Cheque No.: |12$9836
Personal Tax Client: [ :J

Deposit Total Amount: [$2580.00 [ (el oone Conont

Moles: 3 nage brochure, 2000 copies, colow, double<ided
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Coneell Ok I

1) Select type of deposit and date received/deposited from drop-down lists.
2) Under Deposit Information, select client and insert total deposit amount.
3) Add notes about deposit (cpticnal)

4) Click Ok to save deposit.

Step 3
View AR
R From menu, go to Time & Billing > View AR
Step 4
“Time Entry Calendar Display Options for Jason (3]

GeneralOptions | CellBackground | Display Text | Colow Schemes

Preview

Select An Item Below

«Time Enley Star Times to «Tine Entiy End Times | ~ To Inseit A Merge Field

ﬁl\ppohm Names «T ask Names <Company (Time Ertry Info) y
ame» . =
«Time Enty Names Time Enty Name [

Time Entey Date
Time Enley Stat Time
Time Entry End Time
Time Durztion

Time Entry Text

Save Test | ResettoDefaun | [TiMeEntyLocked L

Label2[~  Label2|  Label2[ Label2|

Reset all time enties scheduled to use the above tewt template l

Title Bar Options

¥ Show Title Bar for Time Entries
[V Show time entry status icons in the litke bat
Show this infosmation in title bar: | [Time EntiyInfo] v |

[ Show Custom Checkboxes In The Preview Configure Check Boxes |

~ Other Tools
Apply These Settings to Other Users Duplicate Time Entries Wizard |

Cancel ok |

1) To customize the display of time entries text, click the Display Text tab.

2) Place cursor in Preview window and click a merge field item from list. Click Test.

3) To save the new merge field item(s) in Preview window, click Save.
4) Check off Show Title Bar for Time Entries.
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Step 5

Time Entry Calendar Display Options for Jason k

General Options T Cell Background T Display Text T Colour Schemes |

~Time Entry Colour Scheme Options

I (i ) (]

Scheme Mame: ]

~ Colour Options

Title Bar Background: lil
Tile Bar Foreground: [ﬁl
Body Background: [ -]
Body Foreground: lj_.l

Preview

9:00 8M - 10:30 AM A

This is some sample text -

All colour schemes created here are available to all users.

.~ Other Tools
Apply These Settings to Other Users Duplicate Time Entries Wizard

Cancel Ok ‘

1) To change colours for different dockets, click the Colour Schemes tab.

2) Type in name of scheme besides Scheme Name.

3) Select the background colours from drop-down list.

4) Click Add New Scheme. The new colour scheme appears under Scheme List.

5) Click Ok tc save settings.
Note: To delete colour scheme, select one from Scheme List and click Delete.

Step 1

If an invoice for client hasn't been created, follow Steps 2-6 here.
Note: If an invoice has already been created, go tc Step 2 below.
Step 2

Main | Adjustments WIP Grouping Add Custom Items Templates

\ W ’m’?

Post Print
Iavoice
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g:n;oc:%e., Unit1 I n Vo I Ce

Ottawa, Ontario K2A 2E1 INVOICE # 1

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria, BC A1A1Z1

Date Descnption of Work
Jan 31,12 | Collection

Jon 31,12 | All Proposal tasks $45.00 7 hr 3hrs $135.00
Jan 31.12 | All Review tasks $45.00 7 hr

Sub Total $390.00
Taxes: $50.75
Total $440.75!

Click the Main tab and then click Post Invoice from the invoice menu.

Step 3

View AR

R ‘ From menu, go toc Time & Billing > View AR
Step 4

PISQ&@&

\Mvamod View/Hide View/Print
| Scarch  Columns  Report

All AR for the invoice dates between Sunday. January 1.
2012 and Tuesday, January 31, 2012

!
K
|

Chient Quick Invoice List

Sample Home Buides Ltd.  Irvoice  $330.00

Refresh Clients List

1) Click Refresh Clients List.

2) Select a client from Quick Invoice List and click Search to view invoice
as shown above.

<
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» Quick Entry

Step 1

R ’ From menu, go to Time & Billing = Quick Entry

on:Mnmt ~] [ ¥ change Data Entiy Options |

a,
K@ Quick Time Entry Data Options

Enliy Options | DaaField1 | DataFied2 | DawaFeid3 | DaaFieldd | The quick entry ime
\ options allows youto
3 define the information
[T Wrap Test In Giid Cells which appears in up 1o
[ Alternating Grid Lines four d’?’? d°‘:'“ fields
E i in an efficient way
| ORI s ote based on howyou
\ Alemating Color 1: [ 7] v have yourwork
" Reset to Defauk Colors codes, tasks and
1. Arcmaing Color 2 [ «] _ Resetto Defouk Calors | projects configured.
~ Default Stant Time For example, you
‘ Defeuit Stait Tine fot Tine Entp Dt [9-00AM — v could use Field 1 to
| =k display allthe related
. . tasks assigned to the
O Sty st ach st dmen it selected client Field

2) In the Entry Options tab, customize the grid row colors and entry start time.
(view Step 3 to see new changes)
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/.a_\.
Quick Time Entry Data Options

" ErtyOpions | DataField 1] | DatoFid2 | DaaFied3 | DataFwdd | The quick entytime
= ; options allows you to
W Display this data fied i the time erity d22a form define the information
which appears inupto
Column Name: [Data Eniry Fld 1 four drop down fields
=5 = in an efficient wey
~ Waik Cade Listing Oplions based on how you
V¥ Display Work Codes in list have your vork
" Display work codes using cely Work Code’ lormat kst
€ Oiphy work cadss vebg ol Wok Nene' | projects configured.
(o] Display work codes using Work Code - Work Name' fomat For example, you
s ; could use Field 1to
[~ Display non-Billable Work Codes in list display all the reloted
€ Display work codes uzing cely Woek Code’ format tasks assigned to the
" Display work codes using cnly Work Name' foemat selected client, Field
@ Disploy work codes using Wock Code - Work Name' femat 2to display all the
related projects
W Display Task Types in list (i.e, HST, Pagroll, Year End, etc.) assignedto the
& ihahweitodiones selected client. and
3 . then Field 3 to
& Display only task types that ate assignad to selected chent display all the related
™ Di Projects in list project steps listed
“ﬁ” s i . for the selected
& Display orly projects and/oc staps that are assigned 10 selected chert ke
@ Display orly the priect names The daa enty el
" Disploy only the selected project’s steps sel:rgaeuwspeciic.
: . . 0 each usel can set
" Display the project and each of the project’s steps together kg

| Comeal | ok

3) In the Data Field 1 tab, check off Display this data field in the time...
and create a column name. Select which display options to appear in entry.

4) Repeat Step 3 for other data field tabs. (optional)

5) Click Ok to save settings.

Step 3

1) Click on any of the invisible fields under column names to insert information
of time entry.
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e LA i

Sample Beauty Salon Telobyle Soktions 1. ... Company Brochwie
Sample Printing Sesvices Triobyte Solutions |...

Cancel Add New Ok

2) Click Add New tc add more time entries to list.
3) Click OK to save time entries.

Step 4
Time List
Q | From menu, go tc Time & Billing > Time List
Step 5
All time entries billed to Sample Printing

© [unselectal | [ Change Selected Status To ... ]

|Sample Prinling Services

[ Refresh Clients List_|

1) Select a client from list under Client Quick Select Control
2) Ensure that the added time entry from Step 3 appears in list as shown above.
If the new entry doesn't show up, click Refresh List.

Step 1

R From menu, go to Time & Billing = Reports
149



13 Cheet Track Reports

[ J Client Track Reports

L2 Term and Bl Reports

- LD Accourts Recswvabin Rageds

B &2 WP R

4§D Ergioee e Sheet Repons

O Cherk Repans

- LD Burns Clert Nave LAdSes: List Reparts
xa ‘3 Paesoral Tae Nome & Addess Cheet Lint Regorts
W &3 Other Ciee Lint Repos

D Tack Lt Reparts

+ @ Ta6. 8y Clert

H D TessErginee

&2 Ciert Orech List Lt Repoas

- & Ciert Crck List By Clert

LD Cherr Crack Lint By Sacvce

Step 2

(m |

(m |

(|

1) Select a type of report you want from list. In this example, User Time Sheet.

Generate Repont l

Main Categories Date Categories

" Find all tasks on:
[00!ober 1,201

Choose a report from the list

Client Track Reports

{‘3 Time and Biling Reports
o {‘3 Accounts Receivable Reports

& WIP Repoits
= &‘3 Employee Time Sheet Reports

User Time Sheet

User Time Sheet [with amounts)

{‘3 Client Reports

] {‘3 Business Client Name & Address List Reports
- 83 Personal Tax Name & Address Client List Reports
e {‘3 Other Client List Reports

Employee Assigned: |ETENTALo S |

Time & Biiling Reports

Standard Time Sheet

L

" Find all tasks on o1 before:

chlober 1.20M

L

" Find all tasks on or after:

lUclobct 1,201

L

& Fird all tasks between:

]lJcbber 1.20M

and lﬂcbober31,2011

L L

2) Specify what you want on report (if asked)

3) Click Generate Report
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Time & Biiling Reports

Standard Time Sheet

Enplonen ClientName  Name StartTime  End Time
|

Susan Andrews
| Friday October
. 21, 2011

1:05 pm 1:10 pm
5 min

el [

1) Double-check the generated report to ensure everything is included
2) If so, click Report Settings

'Report Layout|  Colors/Giid |

~Report Orientation
Select defaul page orientation of the repoct when it is first displayed:

C Porat @& Landscape SizetoFit

-~ Report Mal= e
Top:| [ Repatloyout | Colors/Giid |
— 1| [ Title Bar Background Color
¥ Show( -

i Show | [ 6id Colose
Header Background Color: [ -]  Header Fort Color: [N -

—
GadBackground Color: [ +]  Grid Fort Color: N -
Main Gric
~Report Alternating Grid Lines
¥ Show Altemating Grid Line Coloss In Report

Ahernating Color 1: [ +|

Aernating Color 2 [+ Reset to Defaul
Cancel

¥ Show '0ate Generated' OnReport V' Show Page Numbers On The Report

vaeeI Okl

3) Go through both Report Layout/Colors tabs to make any modifications to
report. In this example, grid lines colors were changed as evident in next picture.
4) Click Ok to save changes.
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Time & Biiling Reports

Standard Time Sheet
5'::':’“ Client Name Name End Time
Susan Andrews
Friday October
21,2011
1:10 pm
5 min

| |

5) Ensure the new changes appears on report preview.

Step 4
—— P
50 || =S
Print Page Colour Options  Report First
Settings | | [Pintin Colo_v| Settings | Page  Page

1) Click Page Settings

~ Paper Size [ Inches )

Papes Size:  |[RCUTH SN

Paper Width: l 1 Paper Heighl: |

~ Orientation Margins [ Inches )
" Potal Left: |0.69 Right: Iu
@ Landscape Top: lllBS Bottonn: IQBS

2) Select paper size, type of orientation, and margin sizes.

3) Click Ok to save changes

Ok




Step 5

89 8| 88 «) iy 2

Next Last

Print Page Colour Options Report First  Previous
Settings IP'i"t in Colo ,l Settings Page Page Page Page
Click Print
Step 1
Options
R From menu, go tc Time & Billing = Options
Step 2
Time Entry Calendar Display Options for Jason =

General Options | CelBackgound |  DisplayTest |  Colow Schemes

Start Appointments By Display Time Range

You can indicate what range of times wil show

" The Day View Yo e e
& The\Week View in the day and week view window panes.
€ The Month View [sooam  ~| o [s00PM  ~|

When the Time Entiy view starts, automatically ...

" Show The Weekends In The Week View
" Hide The Wesekends In The Week View
& Remember The Last Weekend View Used

When the Time Entry view starts, automatically ...

" Show The Day &nd Week Sidebars
" Hide The Day And Wesk Sidebars
& Remember The Last Sidebar Setting Used

[V When the time entry timer is stopped, akways show lime entiy information window.

~ Other Tools
Apply These Settings to Other Users Duplicate Time Entries Wizard l

| Cancel Ok |

1) To change the views of the time entries, click the General Options tab.

2) Select type of view for time entries to begin with.

3) Select the time range of the time entries from drop-down list.

4) Select type of display view to automatically appear in Time & Billing section. 153




Step 3

‘Time Entry Calendar Display Options for Jason

General Options T Cell Background T

Display Text

| Colow Schemes

% e’ invredk view
Sunday: 1] Sunday: [ -]
Morday, [T=]  Mondn [T
Tuesday: [~ Tuesday: [+

Wednesday: [EE] Wednesday: [ ]+
Thersday: Thuisday: [ +|
fido 15 Fider [T
Satuday: [ 1+ Satuday: [ -]

Reset To Defaudt \ Use same colour

u scheme as day view,

When viewing other user’s calendars, | want to ...
& View My Background Colours

Calendar Cell Background Colours

" View Thet Background Colous

Show Colours
In Month View

Sundey: [ 1]
Mandy: [T7]
Tuescy:
Wednesday: [ﬁ]
Thasdo: [T5]
Fides: [T
Satuday: [ 1+]

Use same colour
scheme as day view,

v

-

. Other Tools =

Apply These Settings to Other Users

Duplicate Time Entries Wizard

1) To customize the background colours, click the Cell Background tab.

2) Check off all three types of views.

3) For each view, select the background colours for each day of the week

from drop-down lists.

Step 4

‘Time Entry Calendar Display Options for Jason

Preview

General Options T Cell Background T Display Text T Colownr Schemes

Select An Item Below

<Time Enley Statt Times to «Tine Enty End Times | ~ | [CLELLLE S
«dppoiniment Names «T ask Names <Company [Yime Erdry Info) a
Mamex Time Entry Name F
«Time Entiy Names Time Entty Date =
«| |Time Enley Stait Time
B Labeil2~ | Label2[~ | Label2[~ Time Enlry End Time
Time Duztion
[ Time Entry Text
Time Entey Locked
gm JiL Test =N Reset to Default | is Invoiced -

Reset al ime entiies scheduled to use the above tet template
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Title Bar Options

¥ Show Title Bar for Time Entries ‘
[V Show time enlry status icons in the titke bar

Show this information in litle bar: | [Time Entiy Info) ~ +|

[ Show Custom Checkboxes In The Preview Configure Check Bowes |

.rtmm Tools
Apply These Settings to Other Users Duplicate Time Entries Wizard ’

Cancel Ok

1) Tec customize the display of time entries text, click the Display Text tab.

2) Place cursor in Preview window and click a merge field item from list. Click Test.
3) To save the new merge field item(s) in Preview window, click Save.

4) Check off Show Title Bar for Time Entries.

General Options |  CellBackground | DisplayText | Colour Schemes

~ Time Entry Colour Scheme Options

I (s ) (o)

Scheme Name: ]

~ Colour Options
Title Bar Background:

Tille Bar Foreground: [+

Body Background: [ -]

Body Foreground:

~ Preview

3:00 4M - 10:30 AM -

This is some sample text ~

All colour schemes created here are available to all users.

 Other Tools
Apply These Settings to Other Users | Duplicate Time Entries Wizard |

Cancel ok |

1) To change colours for different dockets, click the Colour Schemes tab.

2) Type in name of scheme besides Scheme Name.

3) Select the background colours from drop-down list.

4) Click Add New Scheme. The new colour scheme appears under Scheme List.

5) Click Ok to save settings.
Note: To delete colour scheme, select one from Scheme List and click Delete.
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'@ Billing Categories

Step 1

Setup Options

R From menu, go to Time & Billing = Setup Options

Step 2

Billing Options

-1 Biling

173 Categories
Tasks Billing
Setup

Billing Work
1% Code Setup

I”‘ Non Billing
Work Code
Setup

R From Billing Options menu, go to Billing Categories

Step 2

Billing Categories

This wizerd allows you to create different billing categones so you con allocate your fime entries to
cetegories for racking and analysis purposes.

| o |

Categories List ~ Category Information -
Bookkeeping [caeg«me: [Bookkesping

Consulling S
Design Deccepuort i
Intemal Non-Sillable
Payroll Sevices
Teax Relumns s
Year-End Statements Examples of categories you might use:

o mm « Financial P'm

- Bookkeeping - Traning

Close I

1) Click Add New Category. Insert category name and description (optional).
2) Repeat Step 1 tc add more billing categeries to list.
3) Click Close to save settings.
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Step 4

Time Calendar

R In Time & Billing, go tc = Time Calendar

Step 5

2¢ Client Track
File Edit Tools Custom Services Reports Users Support
Business Clients @ Time Entries - Week View
Personal Clients
Tasks

Time & Billing Mon 30

‘January 30 - February 4, 2012

1) Click on an empty timeslot in calendar to create a new time entry.

v

'Edit Existing Time Entry [
| General ]T Bilnglnfo | BilngDescipion |  BillTmeTo.. |  Customlrio |

Time Entiy Nome: [Printng Time Entty Display Text
Erployes Assigned: |Jason =l F:ooamzo 12:00 pen B
. Sample Printing Services
=
Dae: [ Jonuay 3012 | :
[9:00aM = ~] o [1200PM == ~| EQ | Rehiesh |

sasw B =
Busness Cient [Samplo Pining Services _w]  Colun Scheme: [Design -(@)
Pessonal Tax Clent: Tile Bar Backgiound:

g Fusgord [T

Body Background: [T ]

Lo

Select Task: | Centracts ~|
Biling Work Code; [PRI - Piinting ~||® Body Foregiound:
Non Bl Work Code: | ~|®
Biing Categen | Design ~®
<Sedect > }
| [ -
S | Mooy Intewnel Non Bilable Concel |
Payrol Sesvices

2) Click the General tab. Include name of entry and select time, employee

assigned and type of client.
3) Select type of billing category that was created in Step 2 as shown above.
4) Go through the other four tabs to include additional infermation on time entry.

5) Click Ok to save settings.
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File Edit Tools Custom Services Reports Users Support
° | () Time Entries - Week View

January 30 - February 4. 2012

|

Time Calendar

L

6) Time entry including billing category has been added to your calendar.

Step 6
Time List
R From menu, go to Time & Billing = Time List
Step 7
|Sample Printing Seivices

<81 Clients> = [<Select Category> }

Sample Beauty Salon Bookkeeping

Sample Charitable Organizatio Consultin

Sample Eleclric Compary Limite Desi

Sample Home Buildes Ltd. i Intemal Non-Billa

Sample Lawyers Office P. Seivices

Sample Oveihead Doot Marul Tax Reluns

Sample Printing Sesvices Year-End Statemen

Sample Roof Buider 2

| Reitesh Clients List |

1) Click Refresh Clients List

2) Select same client from Step 5 in which billing categery was added to.

3) Move the horizontal scrollbar until Billing Category column is visible. The
selected category to client should appear on list. The categories can be changed
anytime by clicking on the text field as shown above.
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" ® Tasks Billing Setup

Step 1

7+ Client Track
File Edit Tools | Custom Services | Reports Users Support

Business Clients Create New Custom Service Wizard

Personal Clients Manage Existing Services Wizard

Tasks Manage your Tasks Scheduled For This Client

2 D
EQL D Q

8:00a

R In menu, go to Custom Services > Create New Custom Service...

Step 2
Create Custom Services Wizard 23]
12] !~ Custom Services Wizard
Select Type of Custom Service You Want To Schedule For Client
@ [Create A Custom Seavice [Sinale Task]
Thes 15 ideal for tasks bke chert buthdays and compary audts. You can choose # they wil be
onetme events of if they will recur evedy pear.
" Create A Custom Sesvice (Recurring Or Mulliple Tasks)
Thiz iz ideal for tasks Bke clerk bookkeaping of reviews whete you want o schedule many smiial
custom services over the year
 Schedule A Previously Saved Custom Sewvice
This option allows you to appl a previoush saved custom service for this clent.
Cancel Neat > Finish
1) Select type of task to create. In this example, Single Task was selected.
Create Custom Services Wizard - Add a single task w5

m!n Custom Services Wizard

Add a Custom Service with a Single Task

Task Name: [TZ Corporate Tax Related Retums

Due Date: February 10, 2 vl

Employes Assigned: | |
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Task Type: [T ~ |
Total Estimated Completion Time: [1 his | min
[T Do you want to recur this custom task each year?

Save Custom Service

You can save this custom sesvice if you wish o that you can schedule it for other
chents as well.

[12 Corporate Tax Related Retuns Save

Cancel ] <Back Einish [

2) Insert name of custom task and select employee assigned and type.
3) Insert a custom service name to re-use in future and then click Save.

[2 The custom service has been successfully saved.

Step 3

Setup Options

R From menu, go to Time & Billing = Setup Options

Step 4

Billing Options
Biling
Categories
Tasks Biling
Setup
Biling Work
Code Setup
Non Billing

Work Code
Setup

R From Billing Options menu, go to Tasks Billing Setup
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Step 5

Billing Settings

D ArsaeHr

mlm

Biling Settings for Company 1 Biling Setings foc Users )
T2 Corporate Tax Related Returns
Billing Seltings 1 Othet Sestngs
Monthly EHT - Default Time Entry Name

You can indicate the delaud name that wil be uzed fot the tme enty when

a Quaterly Law Levy
D Monthly Trust Account Recorcll
Aresd Trust Retun
Areradl LanPRO Applcason
Arevssd LawPRO Payment
Arenssl Law Socety Duss

(W iwiv v

:
f

15018 Contractor Repating
Butress Name Renewal
| Fusl Toau Agr

B

(eiwiviiv

o
!

&300:!0-
D) 11 TaxReisted Returs
a 120 Tax Related Botur

< ] | »

ths task Ype is chosen.
(et Tise Ernsy Nosme:[TZ Corporate Yo Feared Fvars ]

-~ Default Billing Fiem

Delauk Fimx | Chert Track |

- Default Biling Information

& By defouk. do you want this task 10 be bllabis?
¥ By delaud, do pou want this tazk 1o show on the chent's invoice?

@ Bill by Time
Biing Rate: [Bockkeeper2 - $75.00 =

" Bill Flat Rate for Task
Fist Rote: [

7 Default Billing Category Allocation

Yeu can sllocate pour time to diferent categories. Indicate below which
category this task thoudd be allocated too

Biling Cateney. |Bockkeeping ;]l

2) Under Default Billing Information, check off both boxes and select type of

gm|

1) Click the Billing Settings tab. Under Billing Settings for Company, select
a task from list to apply billing settings to. The selected task will automatically
appear under Default Time Entry Name as shown above.

billing either by time or flat rate for client.
3) Select billing category from drop-down list (if created).

4) Click the Other Settings tab.

Billing Settings

11 Tax Related Retur
12 Cotporate Tax Reloted Romui;.

¢ " | »

Billing Settings lor Company 1 Biing Settings foc Users
T2 Corporate Tax Related Returns
Billng Sellings i Othes Settings
Monthy EHT || 1 Yime Entry Status
D Areuenr You can speciy the thatus of e enlies azzocisted wih thiz Lazk when
4‘31 oartain task events
<y Tine enhiy status when sla tmec !w«klnﬁoym v|
ﬂ Quatterly Law Levy ] :
D Monthy Trust Account Reconci ‘ Tieoe enliy 2otuz when close task: | Ready fo bavoace -|
1 Ared Tt Retun - Default Colour Scheme
L) deruit il dgsingen [ coo schone: [T =] (@) |
) Anewss LawPRO Paymeit
D) Arens Law Socety Duds Tito Bor Sackgroondt =] Tt Bt Favoground: [ 1.+
€2 Other BodyBackground 1] Body Foreroundt [INL-]
1) 15018 Contisctos Repeing e
1) Busress Name Renend) Inteensl Deserption of Werk Pefosmed
D! Rl Tenipomnens Processed and completed 12C Tax Reled Retun: A
D ass
D Corracs =
&2 Custom =1 || Description for Cheek Irvoice of Wodk Perfoamed
Proceszed and corpleted 120 Tax Relsted Retun: =
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gm|

5) Select type of status for starting and closing a time entry as shown above.
6) Select custom colors for time entry (opticnal).
7) Click Close to save billing settings for company.

Note: To apply settings for users, click the Billing Settings for Users tab
as shown above and follow Steps 1-7 above.

» Billing Work Code Setup

Step 1

Setup Options

R From menu, go tc Time & Billing = Setup Options

Step 2

Billing Options

e

I I Biling
173 Categories
Tasks Billing
Setup
Billing Work
Code Setup
"‘] Non Biling

5, Work Code
Setup

R From Billing Options menu, go to Billing Work Code Setup

Step 3

Work Code Setup
I v [ oo | oo
Woik Codes Informati

Work Codes List Wotk Code: IﬁEV
|FIL-Fiting 5
Work Name: IRemew

|PRI - Punting
|PRO - Proposal Descrighon: | -

|SCA-Scanning
|PAY -Payroll
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- Woik Code Display Options

" Display wock codes uting only Woek Code’ field

€ Display wodk codes using only Wadk Name' fisld

(& Dizplay work codes using Work Code - Work Name' format
Note: These optiors ae speciic 10 each user

- Woik Code Listing Options

The following allows you to set the seltings on how the work codes wil
Sppast when pou diop down the wodk codes selechon box for spachc cherts:

V' Display wadk codes from this Est on the left
™ Diplay tack ypes in kst Le. HST, Pagroll, Yeat End, etc.)
 Display of sk types
@ Daplay ooy latk types that ace astigned 10 chent
™ Display projects in k2
" Display o projacts and thet stepz
@ Display only projects and steps that are a3signed to chent

“ Advared Wotk Code Setup I :

gm|

1) Click the Word Code Information tab.

2) Click Add New Work Code. Insert work code, name and description (cptional).
3) Select type of display and listing option for work code as shown above.

4) Repeat Steps 2-3 to add more billing work codes if needed.

5) Click Advanced Work Code Setup.

‘Advanced Work Code Options. \
N
p Advanced Work Code Options

W [T1 Tax Related Returns |
Quartedy EHT "1 | Tash Display Ogtices -

D Meaty EHT @ Bways Gsplay Bis 19k a1 an option i tack dop domn s

D) sernaenr € Qriy thows thes a2h. 1 Gop down B2ks when thes 1ash. has been scheduied for e selected clert
42 Law - Related Woik Codes

D Quatedy LawLewy [ Rostrict Wik Cods e this sk to the folowsin weeh, codas

1) Moy Trumt accourt Reconcis Work Codes List No Billsblo Work Codes List

D) feral Trat Retun v FL-Filing || |7 COM-Computer Retated

D ruslLanPRO Apgicsion v ENEENCIN| | |- HOL- Holidays

a 2eenssl LawPRD Pagerert IFRI-Prenng [ 1 IME - utiol Meatngs

a Arevsel Low $ oty Dves :m:ﬁopw IVAC -Vacation
2 Othes |SCA-Scanning

D rsmec Reporing

D) Eurmss Nosse Revemd

1) Intemations Fust Tae Areenent
D s

D Cormacts €
2 Curton

D) 11 TaxRelated Retuns

1) 72Coxee TaxRelsted Petur

- = B T _ sean |

l

_ e |

6) Select a task from from list under Task List to apply work code settings to.
The name of task selected appears on top of options area as shown above.

7) Select how to display task and check off Restrict Work Codes for this task...

8) Under Work Codes List category, check off which work codes to add to task.
Repeat Steps 6-7 to apply work codes toc more tasks.

9) Click Close tc save settings and go back to main window.
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Step 4

Work Code Setup

| Add New Work Code | | Deete Wtk Code | | Wk Code lnforma | Woik Code Biing Information |
i et ottt plaee by 1|
AL~ Filing 0 Billing Settings = Other Setings
PAY - ngroll Default Time Entry Name -
PRI - Printing You con indicate the defoul name that will be uzed for the Eme entiy when
[FRO - Proposal thés work code & chosen
[REV - Review Dofouk Time Entiy Name: [Scanving fiatemal]
- Defoult Billing Firm
Dedout Fame | Cherk Track =
Default Billing Information
[V By defoud, do you want this work code to be bilable?
¥ By delodt, do you want thiz wadk coe 1o thow ca the chent's Fvoice?
@ Bill by Time
Bilirg Rate: | GDasin - $45.00 ~|
¥ ¢Selct Rate>
e, |
Flat Rater | Bookkeaper? - $75.00
Cenzubing - $70.00
GDanon - $45.00
Delault Billing Categosy Allocalion
You can alocate wour tiese 1o dlferent categades. Indicate below wiich
categney thiz week code thould be alocated to
Biing Cabegoey: [Design |
| (Seloct Categond

[ Advancedwor Code senn |

U 3
Intetnal NoeyBlladie

Ta« Retuns e I
Yea €nd Statements Clos

1) Click the Work Code Billing Information tab.

2) Select type of billing option from drop-down list as shown above te change
settings for either company or user. In this example, company was chosen.

3) Click the Billing Settings tab. Select a work code from list to apply settings
to as shown above.

4) Click the Other Settings tab.

Work Code Setup

[ Add Mew Work Code | [ Delete Wek Coce | Wk Code lrfona | Woik Code Billing Information |
- Select Work Code Billing Option: [Biing Optioess foe Corrpary v |
FIL - Filing Biing Setting: ﬂ Other Seitings| I
PAY - Payroll -
PR - Printing Time Enlry Status
FRO-Froposal You can specily the status of time eniries associated wih this work code
REV - Review when cestan lazk events happen:
Tie oty 2ahus when st tive: [Work InProgres <
Time oty stahus when close task: [W] nvoe v
Default Colour Scheme
Colow Schems: [Design =~
Tile B Background EEI Title Bax Focoground DB
BodyBackground: [ -] BodyForegound [N -

Default Descriptions
Inteenl Descripton of Work Perfermed:

| -

Description foe Clent Invoice of Work Performad

! :

| Avoncos Wk Code Setvp

5) Select type of time entry status from drop-down lists as shown above.
6) Under Default Color Scheme, select a saved color scheme from list.
7) Click Close to save settings.
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Step 5

PEREG ¢ @ | ¢ 4

Search Time [View/Hide View/Print | Seoloct Add Sclected Time Add Selected Time | Mark Up/Down  Write
Entries | Columns  Report Client  To New Invokce  To Existing Invoice | Time Entries  Off

All time entries where the status is 'Rea

Scarch Main Criteria | SeschBy Type/Dstes | Searchy Time

1

Seaich By Employee

W Seaich by Timo Entiy Nome [ Seaech by Locked Status 5}
Find ol tere ecimes that coctan lolovrsy € Sh cked time erines
M F: Sh h’.‘ od ¢ : e N
earch by ‘Allocated to Invoice'
[7 Search by Chent é PP il
[ &
Fird orly e eriiios ot the folowing cliert Ggm::""'m mx:’*“’
| =)

I~ Search by ‘Show On Invoice'

1 I~ Search by Biled To' Chent © Showtiese enltis wves ‘show 66 Feice” 1vs
Find oy tema eeiries fox the Sedowing chere @ Showtise entiies whvere it 'show oo rvcice’
| | [” Seatch bw Billable Status

I Sawrh by il Staee ® Shom it e i b D
Fird crly time ertiies fot the folowing status
|Wodk InProggess |

Carcel l Select Time Entries

1) Click Search Time Entries on the ribbocn menubar

2) For example, only check off Search by Time Entry Name and type in name
of work code that was created from Step 3 (i.e. Scanning).

3) Click Select Time Entries.

Client Quick Select Control

|<All Chents>

Sample Overhead Door Manuf:
Sample Printing Services 2

4) Move the horizontal scrollbar until Time Entry Name column is visible. The
searched work code should appear on list.

165



'@ Non-Billing Work Code Setup

Step 1

Setup Options

X  From menu, go to Time & Billing > Setup Options

Step 2

Billing Options

I | Billing
3 Categories
Billing Work
V3 Code Setup

3 NonBiling
Work Code
Setup
G Biling
%13 Rates

Q From Billing Options menu, go to Non-Billing Work Code Setup

Step 3

Non Billable Work Codes Setup

lomw“c#' | Work Code Information | | Work Code Bing Infomatien
[ on e o Cose v [ R

Non Billable Work Codes List

Wk CoM

HOL - Holidsys !
IME - Initia) Meetings Wedk Nome: |Computer Related
MAI - Mailing —
VAC - Vacation Descriporc [Restoee, Artivinsies protection, software »
COM - Computer Related 2 updates, ele

—

Advenced Work Cods Setp |

_ Ghose |
1) Click the Word Code Information tab.

2) Click Add New Work Code. Insert work code, name and description (opticnal).
3) Repeat Step 2 to add more nen-billing work codes if needed.
4) Click Advanced Work Code Setup.
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} Advanced Work Code Options

Task Displop Options

&2 Projocts @ Adways digiay Frt tadi. a1 an opbon 0 18tk Gop down ek
£ ust € Oy chow this tack in G100 down §225 whan this tatk has been schaded for e selacted clart
1) Oustey s £ | - Retated Work Codes
O MearyHst [ ]Resticn week Coos te iz skt the seiwiny v ot
D fwnsnatt || o Cosr i
W Akt FIL - Filing COM - Computer Related
U sl BST wen Gustedy Inctsh PAY - Payroll PAHOL - Holkdos
a GSTHST Retuns PR - Printing [ IME < Intal Meeangs
$est PRO-FProposal MA - Mailng
Twi T REV-Roview ¥ VAC-Vecaton
Q wice Arensd PSS SCA- Scannng
) Qustety PST
D Eveey Two Narths PST
D Meethy ST
W Areual P51
&£ Pageoll Source Doductions
a T41 Suenay
a Ta4 3 Sumnyy
O
-~ . - > Select A1 Sedoct Al

. m »

_ Ome |

S) Select a task from from list under Task List to apply work code settings to.
The name of task selected appears on top of options area as shown above.

6) Select how to display task and check off Restrict Work Codes for this task...

7) Under Non Billable Work Codes List category, check off which werk codes
to add to task. Repeat Steps 5-7 to apply work codes to more tasks.
8) Click Close to save settings and go back to main window.

Step 4
Non Billable Work Codes Setup
[Md New Work cw][omm«c«e] " Wok Codelricemstion | | Work Code Billing Information) | |

oloct Work Code Optionl |< Bilng Scepo> -
Non Billable Work Codes List & D I AR

COM - Computer Related
HOL - Holidays

IME - Intal Meetings

MA] - Mailing

VAC -Vacahon

| advancedwed Code Set |

_ Do |

1) Click the Work Code Billing Information tab.

2) Since the setup is for non-billing work code, Select Work Code Billing Option
as shown above doesn't apply.

3) Click Close to save all settings.
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" ® Billing Rates

Step 1

Setup Options

R From menu, go to Time & Billing > Setup Options

Step 2

Billing Options

"\I Non Billing
Work Code
Setup

4R Biling
%1% Rates

X | From Billing Options menu, go to Billing Rates

Step 3

Billing Rates

| Biling Ratos for Compary) | 1 Bl P o User

This wazaed aliows you to sotup the diferont biling rates that are genenc for the whole frm. Enter bding rates here # you biling
ace not uet spechc of you wenk canan rates svalable to ol users .

Billing Rates Information

B )
e
Bookkeeper! - $65.00 Enter 3 shoet cods 50 peu can quickly reference this biling rate:

Consulting - $70.00 :
T - $60.00 Billing Rate: 6500 $/ hou
Bookkeeper2 - $75.00 Biling Options: ™ Exact Biling fio the seccad)

& Rounded Bling
|Rourd uptothe noxest  v|

10 Mrwites vl

Description: -

I~ Dotaut Biling Rate for this User

_ G|

1) Click the Billing Rates for Company tab
2) Click Add New Rate. Include the code name, rate in $5$ and select type

of billing option.
3) If there is no need to create billing rate for user, click Close to save settings

and go to Step 4.
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Billing Rates

] Biling Rates lec Compary ] T Billing Rates for Users )
This watd aliows you to setup the dilerent biling rates foe each of your users.

[s:tec« User [+ I

Billing Rates Information

v | BT

Rates List Billing Rate Code:  [GDesign
GDesign - $45... Enter a shoet code 50 you can quickly reference ths biling rate:
Billing Rate: [4500 $/how

Billing Oplions: " Exact Biling (o the second)
@ Reunded Biling
IR«MQ!QIMmaezl L]

10Mirnses vl

Desciiption: (el mestig, reseatch, ske  »
comps, lles, pirting, tc.

¥ Detaud Biling Rate foe this User

Qotol

4) Click the Billing Rates for Users tab

S) Ensure that your are the user from drop-down list as shown above®
6) Click Add New Rate. Include the code name and rate in $$%

7) Check off Default Billing Rate for this User

8) Click Ok to save settings.

*Note: Only adminstrators of Client Track can view all users from drop-down list
and have the ability to apply billing rates to each user.

Step 4

Time Calendar

R In Time & Billing, go to = Time Calendar

Step 5

2 Client Track
File Edit Tools Custom Services Reports Users Support

Business Clients @ Time Entries - Week View
Personal Clients

— January 30 - February 4, 2012

Time & Billing Mon 30

Time Calendar

1) Click on an empty timeslot in calendar to create a new time entry.
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R B Tre By i~

General || Billing Info |'| BilingDescipion |  BATimeTo.. |  Customlnfo

% Is This Time Entry Billable

Time Entiy Status: |\Work In Progress v
Actual Time
i To Ot STt 313500

@ _Bill By Yime End Tener 12008 1 Cods: [HST -0 ] (@)
BingRae: [GDesin $4500 v (@] |  TowTins: 3hes =T
2 B
¢ Bill Flat Ra émdmsgh Rounded Time
Bookkeepei2 - $75.00 Stat Time: 09.00 am
: End Time: 1200 pen
Tota Tine: 3hes

Totdl Amourt: $152.55

™ Overide Time Duration With The Following

[ s [ mn

Delete Meege to Doc ‘ Concel | 0k

2) Click the General tab to select client and include name of time entry

3) Click the Billing Info tab. Check off Is This Time Entry Billable and select
and select type of entry status. If billing client by time, select Bill By Time and
select the newly created billing rate from Step 3 in the drop-down list under
Billing Options as shown above.

5) Go through the other 3 tabs to include more infermation on entry if needed.

6) Click Ok to save settings.

2+ Client Track

File Edit Tools Custom Services Reports Users Suppert
Business Clients @ Time Entries - Week View

Personal Clients

January 30 - February 4, 2012

" Time &Billing 4 Mon 30

D7
9:00 am to 12:00 pm ~(9:00 am to 11:00 am -
Sample Printing Services Electric
1 Printing y Limited

ing -

11:002

7) Time entry including billing rates has been added to your calendar.

Step 6

Time List

R From menu, go to Time & Billing = Time List
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Step 7

Client Quick Select Control

]<All Clients>

GDesign - $45.00 $135.00

— GDesign - $45.00 [C] $90.00
Sample Beauty Salon

Sample Charitable Olganlzatlon
Sample Electic Company Limit
Sample Home Builder Ltd.
Sample Lawyers Office

Sample Overhead Door Manuf:
Sample Printing Seivices x

GDesign - $45.00 $30.00

| Refresh Clients List |

1) Click Refresh Clients List

2) Select same client from Step S in which billing rate was added to.

3) Move the horizontal scrollbar until Billing Amount column is visible. The
selected rate to client should appear on list. The billing rates can be changed
anytime by clicking on the text field as shown above.

» Interrupt Reasons

Step 1

Setup Options

Q From menu, go to Time & Billing = Setup Options

Step 2

Billing Options

Interrupt
Reasons

&
Q -
&

General
Options

R From Billing Options menu, go to Interrupt Reasons

Step 3
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Interrupt Reasons

This wizard allows you to create different interruptions so you can frack and allocate your interruptions.

| Add New Interrupt | Delete Intenupt

Interruptions List  Interruption Information
E-mail IINMNM |E-med

Emergency
Phona call

Pick Up
Quick Meeting

Description: =

Examples of interuplions you might use:
-Phone Col + Pessonal
~Emal/IM - Meeing
- Colleagus « Traning

Close |

1) Click Add New Interrupt. Insert interruption name and descriptiocn (optional).
2) Repeat Step 1 to include more interruptions to list as shown above.
3) Click Close to save the interruptions.

Step 4
Custom Tasks Users Support
Auto-Notification
Edit Auto-Notification Template Comments
Open Advanced Missing Information Form
Open Advanced Communications Form
New Year Reschedule Wizard
Holiday Schedule Wizard
[ Interrupt Wizard
Maintenance Wizard
Y}g From menu, go to Tools > Interrupt Wizard
Step 5
73 Client Track Interrupt Control (o) ® ==

Keep this window open duting the cowse of this interruplion. Clent Track wil automaticaly 1esume your previous

timer when this window is closed.
-~ Type of Interupplion 1
Interrupiion Type: [ZETE] o
[¢<Select Inenupt> |

- Intenupted By: (Dptional) B
Buginess Chart: |Sample Pinting Senaces v i

Personal Tax Chent: | vl ‘

172



Description of Interruption

Intemal Dascriplion of Inteiuption: Chant Invoice Description of Intetuption:
Irvoice cog, plirk detals, deadine - -~
Cancel Ok

1) Select a type of interruption that was created in Step 3 from drop-down list. If
needed to edit or add more interruption types, click the information icon.

2) Select a business or perscnal tax client

3) Optional: Include more descriptions of interruption

4) Note: Leave window open as long as interruption continues. Note the interruption
time on top as shown above.

S) After the interruption is over, click Ok to save settings.

Edit Bisting Time Entry =

General | Biimglifo | B¥ngDescipton | BilTimeTo.. | Custominfo

|'hme Entiy Name: |Intenupted by: Fhone Cal i Time Entry Display Text

Ermplopee Assigned: | 9:28 am to 9:37 am -
Sample Printing Services
Time Interrupted by: Phone Cal
Dater | Nevembee-0311 | =
[s:28aM = ~] 0w [937aM = | Edt | Reliesh |

TimeDuwatiore [ ks 8 min Time Entry Colours

Business Chont: [Sample Printing Sexvices | Colowr Scheme: [<No Scherne Selectec vl.
PmmalTuC&rLl ~ Tile Bat Background: [N <

et Fospmnt [T

Seloct Task Body Backgound: [ -]
Biling Work Code: Body Foreground: [ -]
Non Bil Wark Code:
Biling Categoty: | <Select Category>
Dedete Mesga toDoc ‘ Cancel 0Ok

6) The interruption information and time appears in General tab as shown above.
7) Optional: Customize the color of time entry from drop-down lists.

8) Go through the other 4 tabs to include more information on interruption.

9) Click Ok tc save settings.

Step 6

Time List

R From menu, go to Time & Billing = Time List
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Select User's Sched

4 Mon 31
9:00a
:00 am to 11:00 am ~|5:00 am to 1:00 pm R
Sample Printing Services Sample Lawyers Office
10:00a 5jjng WC - New Work Code
11:00a
12:00p

The interrupt time entry appears on calendar. Double-click or right-click on time
entry and select Edit Time Entry to view or edit information.

Setup Options

R From menu, go to Time & Billing = Setup Options

Step 2

Billing Options

Interrupt
Reasons

% Taxes

General
Options

R}  From Billing Options menu, go to Taxes

Step 3
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Taxes

Step 1: Create your taxes Step 2: Create your tax groups
Chick ‘Add New' bulton below to creale a kst Click the ‘Add New' button below to add the
of all the individual taxes. taxes in step 1 into groups of one of more taxes .
Taxes List | Tax Groups
HST - Ontario

HST - New Brunswick

HST - Newfoundland
BST - Bt Conmbis. 2100 e
- British Columbia I
GST - Mankoba S (=)
R g |
. ta (})/
| % Create New Tax Rate
|

Tax Name: [HST - Ontario

Tax Rate: |13 %

Cancel I Save

1) In Taxes List category, click Add New.
2) Create a tax name, rate and then click Save.
3) Repeat Step 1 to create more tax rates to list if needed as shown above.

Step 4

Taxes

Step 1: Create your taxes Step 2: Create your tax groups
Click 'Add New' button below to create a list Click the 'Add New' button below to add the
of al the individual taxes. taxes in step 1 into groups of one or more taxes .
~ Taxes List ~ Tax Groups

HST - Ontanio HST -13%

HST - New Brunswick

HST - Newfosndland ek .

HST - Nova Create Tax Groups 5]

GST - Britisk

GST - Manit

PST - Manit

a1 M %% Create Tax Groups

|
Group Name: [HST - Onlario Code: [HSTO Delete |

+ New Biunswick I

[ THST - Newfoundland Clo
" HST - Nova Scotia lose
J _IPST - Manioba l

[ IGST -Albeita

_ Concel | s |

1) In Tax Groups category, click Add New.

2) Create a group name, code and check off which taxes belongs to group and
then click Save.

3) Repeat Step 1 to create more tax groups to list if needed.
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Step 5

Time Calendar

R From menu, go to Time & Billing = Time Calendar

Step 6

42+ Client Track
File Edit Tools Custom Tasks Reports Users Suppert

Business Clients @ Time Entries - Week View
Personal Clients

Tasks Uctobe 1 pvember b |

9:00 am to

11:00 am
Sample Printing
Services

1) Double-click on a time-entry already created for a client as shown above.

Edit Bxisting Time Entry =)

_ Geneal || Biling Info || BiingDescipton | BilTmeTo.. |  Cusiomlnlo

Lock Time Entry

¥ 1z This Time Entry Billable

Adust Time

™ Overide Time Duration With The Following

17 b [ min

Time Entyy Status: Iw«klnthes: vI
Actual Time
T 0033 | S ToARen: $160.00
Biling Rate: |CT001 - $30.00 | Towal Tine: 2hes T
" Bill Flat Rate Rounded Time
FwRate [ Staet Time: 03.00 am
End Time: 11:.00 &
Total Time: 2 hes

Total Amourt:  $180.80

Delete v Mesgz to Doc

2) Click the Billing Options tab

Carcel | 0k

3) Select status of time entry from drop-down list. (i.e. Work in Progress)

4) Select to bill either by time or rate. For example, click Bill By Time and select
billing rate from drop-down list. If a billing rate hasn't been created, click on
information icon beside to create a new one.

5) If entry was under or above the original time set, check off Override Time
Duration With The Following under Adjust Time and insert the new time.
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Edit Existing Time Entry )

Geneeal BilingInfo || BiingDescigton |  BilTimeTo.. |  Customlnlo

[ Iz This Time Entry Billable
Time Entyy Status: |Wook In Progress 'l

Actual Time

e . [S5 o880 15000
@ Bill By Time End Time: 11:00 am Tox Cods: m

Biling Rate: [CT001 - $50.00 -] Tow Tine: 2hes B
3 . - - oSO S S 3

M Hetiue Sub Total Amount: $160.00

Flat Rate: |
- Tax Code: |HST vl [

PST - Albert e G
I~ Overide Time Duration With P 1 - Quebé :
[T b [ min el

| Total Amount:  $180.80 |

Delete Mesg= o Doc Cancal 0k

6) Verify that the Sub Total Amount is correct based on billing rate & actual time.

7) In Tax Code, select the tax group from drop-down list that created from Step 4
above. To create a new tax rate, click on the information icon beside it.

8) The selected total tax cost appears in the white box as shown above. Verify that
the Total Amount is correct by adding the Sub Total Amount and Tax.

9) Click Ok to save the settings.

» General Options

Step 1

Setup Options

R From menu, go to Time & Billing = Setup Options

Step 2

Billing Options
% Taxes
7Y General
4 Options

Q From Billing Options menu, go to General Options
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Step 3

General Options

Required Fields when Entering Time

When entering time, the following fields e required to be filled in ...
[V the Chent Name (exher Business Chent o Pessonal Tax Client)
[~ the Biling Amourt (either a Biling Rate of a Flat Rate ‘
[V the Biling Code (eithet a Biling o1 Non-8iling Code) \
[ the Biling Categoey

[ the Intemal Time Entry Desciiption

[ the Chent Invoice Description

These settings apply to all users. ‘

Quick Time Entry Data Form Type
" Vertical Quick Time Entiy Form Type & Horzontal Quick Time Ertry Form Type

Calendar Time Entiy Data Form Type
" Advanced Time Entry Foim @ Simple Time Entiy Fom

1) Select which required fields is needed when adding new time entry.

2) Select orientation of time entry form.

3) Select type of time entry form (Simple - Step 5, Advanced - Step 6)
4) Click Ok to save settings.

Step 4

Time Calendar

R From menu, go to Time & Billing = Time Calendar

Step 5

#9+ Client Track
File Edit Tools Custom Tasks Reports Users Support

Business Clients | ) Time Entries - Week View h
Personal Clients
Tacks U Dbhe DVE he I

8:00a

e &L B q
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Time Calendar

Sample Printing Services
10:00a Filing

11:00a

1) Click on an empty time slot to create new time entry as shown above.

Time Entry . -

2
p Time Data Entry
]

Business Client: ISample Lawyers Office
Personal Tax Client: |
Time Duration: |3 hrs | Mnin

Led Lo

Task: |Quarterly Corparate Tax Instaliments
Billing Work Code: [W/C - New \Work Code

Non Bill Work Code: |

Cancel Ok I

2) In the Simple Time Entry Form (selected from Step 3), select a business or
personal client, task type, billing or non-billing work from drop-down lists.
3) Insert time duration of entry and then click Ok to save time entry.

Led Lef Lo

Note: The required fields on the time entry form are customizable and can be
changed at any time. To know how to, see Step 3 above.

Step 6

#2* Client Track
File Edit Tools Custom Tasks Reports Users Support

Business Clients | ) Time Entries - Week View h

Perscnal Clients
—— October 31 - November 5. 2011

Time & Billing

9:00 am to 11:00 am

Sample Printing Services
10:00a |rjjing

9:00 am to 12:00 pm
Sample Lawyers Office
WC - New Work Code

1) Double-click on the newly added time entry.
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General | Sdinglafo |  BlingDescipton | BilTmeTo.. |  Customlinfo

Tiene Enty Name: 'WC - New Wark Code Time Entry Display Text
Employes Assigned: IJoson ~| 200 am to 12:00 -
Sample Lawyers Office
NC -New Viork Code
Date: | Novembes-01-11 | :
[9:00am = ~] o [1200FM = +] ER | Retiesh

Time Duratiort ?
S [_ o il Time Entry Colours
Business Clent: [Sample Lavypers Office ~] Colow Scheme: [<No Scheme Selectes v

Personal Tax Clent: | =~ Tile Bax Background [N -

Tie Bas Fossgroundt L7 -]

Seloct Task: IOuaded/ Cotporate Todmtel'_] Body Backgiound: EE]

Biling Work Code: [WC - NewWork Code v || @) Body Foreground: [N~
Non Bl Work Code: | ~|

Biling Calegoy: [<Select Categeeyy v || @

Delete Merge toDoc | Carcel | Ok

2) An Advanced Time Entry Form will open up (option can be seen on 'General
Options' form in Step 3). The same required fields from Step 3 can be edited
here under the General tab as shown above.

3) Select new custom color of time entry title bar from drop-down list (optional).

4) Go through the other 4 tabs to include more information on time entry.

5) Click Ok te save settings.

» Create Invoice

Step 1

If a time entry for client hasn't been created, follow all steps here.
Note: If you have already created an invoice for a time entry, go to Step 2 below.

Step 2
Create Invoice
X  From menu, go to Time & Billing = Create Invoice
Create Invoice for your Clients
< Client not Specified >

Total Outstanding WIP:$0

<Al Clents> ~ ~ .
smem Sakeen A \ \
Smml&lemoamm

Sarmgie Electie Compary Livded

Sarpie Home Buldet U 4

Sarrgie Lavyers Otfce -

Sample Ovehead Doce Mandfach,

Sarple Preting Services

Sample Rood
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Sarmpie 13100 Shudo

: ; Creote Invoice based on Create Invoica bosed on
fBiask Taudking Conpery Cm:!: mo:r::sod curtent WIP whichwil be cutrent VWP which will be
orgenized WIP time hidden and cesplay & flat hidden and add
rate for o senaces customized iImoce items
@ Send s1WIP 1o Invaice
© Send WP 1o Invoice o Select Specde WIP Lo & Send WP to lervimce
¢~ Selsct Spachic WIP 1o ndptavcics ~ Stiect Spectic WiP 1o
send to Invoice £la Rote Amount: [— 2o 10 lervince
Crosta Inveics
Refredh Chorts Lt Nole: You have can combing the difesent rrvomce ttyles 0n 3y wroos 0068 50w &8 1 i rvoes edioe wndow.

Client Aged Summary - Account Owings

0-30Days 31 -60Dags 51 -50Days

Toal Dutzandng

Client Quick Select Control

Create Invoice for your Clients
Sample Home Builder Ltd

Total Outstanding WIP:$315.00 ]

[S serple Home Builder Ltd.
<A1 Chents>

Create Invoice based
on the client's
organized WIP ime

© Send JIWIP tolnvoice

Create Invoice based on
current WIP which will be
hidden and display a fiat

rate for oll senices

@ Send 81 VAP to lrvoice

s Select Specific WIP to
zend to lnvoice

FlelﬂdoMM]

Note: You have can combing the diferent rwoice styles on any nwvoice once §

0-30Days

31 -60Days

Client Aged Summary - Account Owings

Tolal Outstanding

61 - 90 Days

No amount owing

1) Click Refresh Clients List.

2) Select a client from list under te create invoice for. The total invoice costs for
client will appear on top beside Total Oustanding WIP and any outstanding
invoice costs that haven't been paid on time will appear on bottom under

Client Aged Summary as shown above.

3) Select type of invoice and either all or specific WIPs.
4) Click Create Invoice.

Step 4

" Quick WIP Time Selection

Select the WIP you want to send to the invo
Sample Home Builder Ltd.
Total Outstanding W1P:$315.00

CEETRYS ~ || Select All
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Select tem Tine ~ BT me T Status
v 7 Sample Home Bulder Lid ~ Review Work inProgress
@ Sample Home Buldee Lt Proposal Wotk in Progress

“

Number gf WIP Tine Entries: 2 [ Change Gad Cohanns |

Cancel Add Selected Time to Invoice

1) If single or multiple entries appear on list based on same status (WIP),
check off which entries to create invoices for.
2) Click Add Selected Time to Invoice.

Step 5

Main | Adjustments | WIP Grouping Add Custom Items

Y,

N

Amounts | Options
Changes| Formatting

1 Adjust General

:;i;lgog:%le., Unit1 I n VO I Ce
Ottawa, Ontario K2A 2E1 INVOICE #: 1000

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria, BC A1A 121

Date Description of Work

Jon 31,12 | Consulting $45.00 hr 3hrs $135.00
Froposal

Jon 31,12 Rewview $45.00/ hr dhis $180.00|

Sub Total $315.00

Taxes $0.00¢

Total $315.00

1) To begin applying taxes to the invoice, click the Adjustments tab and then
Adjust Amounts from main menu as shown above.

Client Invoice

g Client Invoice

[ Invoice Information T Irvoice Intemal Notes

-~
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lewoice Date: [Jan 31,2012 ~]

DusDae Feb 15,2012 -

g Invoice No.:
Personal Tax Client: | | [1000
Actual WIP Amount Adjusted SubTotal Amount
WIP Sub Totat $315.00 [ Use Adjusted Amount On Inveice
Total Taxes: $0.00 Sub Total |$315.00
Totd WIP Amourt: $315.00 TaxCode: [HST-0 v]
Total Taxes: $40.95
Sub Tetal $315.00 - Total Adusted Amount: $335.95
Discount: Use the adjusted smount to bill the chent an amount that
is cidferent from the Actual WIP amount.
Total Tanes $40.95 Discounted 7 Markup Amount
Final Amount Due: $355.55 [~ Use Discount On Invoice
Discount: |$0.00
Cancel Ok

2) Select a tax code from drop-down list as show above (i.e. HST - Ontario).

The total adjusted amount will automatically change based on the tax selected.

For more information on how to create tax rates, go here.
3) Click Ok to include the tax to invoice.

Main  Adjustments | WIP Grouping Add Custom Items Templates

wN
7

Adjust Genaeral
Amounts Options

Changes| Formatting

Client Track 1
83; rgo;:i\ve., Unit1 I n VO I Ce
Oftawa, Ontario K2A 2E1 INVOICE #: 1000

INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria, BC A1A1Z1

Date Description of Work

Jan 31.12 | Consulting $45.00/ hr

Proposal
Jan 31,12 Review $45.00/ hr

Sub Total $315.00
Taxes $40.9!
Total $355.95

4) Verify that the total amount includes the taxes as shown above.
5) Click General Options from main menu.
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Step 6 (optional)

|, General Numbers T FotmaltingT Colors T Dates T Columns

~Invoice Number Options
[V Show the Invoice Number on Invoice
Invoice Start Number: [001
V' Automalicaly Inciement Invoice Numbers

Note: Theinvoice stat number and auto increment seltings will be applied to
all irvoice templates,

L

~Default Invoice Template

You can specify which of the thiee invoice templates you = B
want to use as the default, R —
Default Invoice Number: l'l -

Note: A1 settings specfied above are for this invoice template only. You can have different
setlings for each invoice templates.

Cancel Ok

1) Click the General tab
2) Insert start number for invoice and default inveoice template.

3) Click the Colors tab

Genesdl | Numbers | Fomattng | Colors | Dates |  Columns

~Invoice Theme Color

Theme Background: lﬁzl

~Invoice Grid Colors

Heade: Background: - Header Font: [~ ] +|
Grid Background: [ +] Grid Font: [N ~|

~Invoice Alternating Grid Lines
¥ Show Alternating Gridine Colors In Report

Ahemating Color 1: [~ +|
Alternating Color 2. Dﬂ
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Reset Colors To Default

Note: All settngs specified abave are for this invoice template only. You can have different
sellings for each inveice templates.

Cancel (113

4) Customize the colors for invoice theme and grid (table chart).
5) Click the Columns tab

Invoice Options for Invoice Template 1 s

e :] = =
E%;,} Invoice Settings

Genesal T Numbers T Fotmatb'ngT Colors T Dates ]f Columns

You can specify which columns you want to view on the
invoice and what the percentage width of each column will be,

Column Order | Column Name -

Managing Accountant []
Time Entry Date 13 1 Date

Actual Start Time O
Actual End Time O —

Actual Total Time O
< :l »

Total Page Width Used: 100 Reset To Default l

Note: All settings specified above are for this invoice template only. You can have different
sellings for each invoice templates.

Cancel | | Ok }

6) Check off which columns to appear on invoice.

7) Customize the % width for each selected column to add up to a total of 100%
besides Total Page Width Used (optional).

8) Click Ok to save new invoice settings.

Main | Adjustments | WIP Grouping Add Custom Items Templates

SV
5

Adjust Genaeral
Amounts  Options

! Changes Formatting

Invoice

INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012
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CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria, BC A1A1Z1

Date Description of Work

Jon 31,12 | Consulting $45.00/ hr 3hrs $135.00
Proposol
Jon 31,12 Review $45.00/ e dhrs $180.00
ub Total
Taxes: $40 95
Total $355.95/

9) Verify that the new settings have been applied to invoice as shown above.

Note: To add and bill custom items to an invoice for client, click here.

Add Invoice Custom Items

Step 1

If an invoice for client hasn't been created, follow Steps 2-6 here.
Note: If an invoice has already been created, go to Step 2 below.

Step 2

Main Adjustments WIP Grouping ||Add Custom ltemsl: Templates

Hide All Show All| | Add Custom |
wip wip Items

Custom Items

Click the Add Custom Items tab and then click Add Custom Items from invoice
menu as shown above.

Step 3

ﬁamge C;stom lnvolce Ttems
%& Manage Custom Invoice Items

Add A New Custom Invoice Item |§ Manage Your Custom Invoice Items f]

Select ltem

There are no custom invoice items for this invoice

Selectdll | Delete Selected ltems

Cancel Save & Close

1) Click Manage Your Custom Invoice Items.
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Add New Invoice Item

This wizard allows you to creste your own invoice items for
services you provide

Invoice Items List -
Collaction Hem Name: |

Date: | January 31-12 =l
Amnount (s} [75.00
TexCods: [HST - Onteo v

Tax: $9.75
Total Amount: $84.75

D

[optional):

| AddNewltem | | Delteltem |

_ Cacel | ok

2) Click Add New Item.

3) Insert name of item, amount, description (optional). Also select date and
tax rate applied for item from drop-down lists.

4) Repeat steps 2-3 for more additional custom items.

5) Click Ok to save custom item.

ooy

% Manage Custom Invoice Items

Add A New Custom Invoice Item If Manage Your Custom Invoice Items |

Select ltem AJG how On Irr‘.h:(-:‘ 1 IE Item Name |rD ale .F.:‘».rnounl A[Bezv:il;-hc-n
(m] 1 EETE v] yen312 $7500 Cebiection
Select&l | Delete Selectedltems |

Cancel Save & Close

6) Click Add a New Custom Invoice Item.

7) Check off item under Select Item column.

8) Select a custom item under Item Name column as shown above.
9) Repeat steps 6-8 to add more custom items to invoice.

10) Click Save & Close to transfer item to inveice.

Step 4

Main  Adjustments | WIP Grouping | Add Custom Items Templates

Q8 U 3L B S &8 3

Hide All Show All Neo Grouping Advasced Group by Group by Geoup by Grewpby  Groupby Group by
wip wip oflvams  Growping  Tasks Bdliag Categories Billing Rates Employees Work Codes Projects

Grouping
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::?:go?:‘:n.. Unit1 I n VO I Ce
Ottawa, Ontario K2A 2E1 INVOICE £ 1

INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Viconia, BC A1A 121

Date Descnption of Work Rate Hrs Total
Jan 31,12 || Coliection $75.00
Jon 31,12 | Al Proposal tasks $45.00 / he 3hrs $135.00
Jan 31,12 | All Review lasks $45.00/ e Ahre $180.00

7 hrs $390.00
Sub Total $350.00
Taxes $50.75
Total $440.75)

Verify that the new custom item(s) added appear under Description of Work
column on the invoice as shown above.

'@ WIP Invoice Grouping

Step 1

If an invoice for client hasn't been created, follow Steps 2-6 here.
Note: If an invoice has already been created, go to Step 2 below.

Step 2

Main Adjustments | WIP Grouping | Add Custom Items Templates

QAU L B S 88 8

Hile ‘Au Show All No Growping Advanced Group by Growp by Growp by Group by Group by  Geoup by
wip wip efltems  Grouping Tasks Bdliag Categories Billing Rates Employees Work Codes Prejects
Grouping
Client Track I
836 Boyd Ave., Unit 1 nVOICe
Ottawa, Ontario K2A 2E1 INVOICE # 1

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A1Z1

Date Description of Work

Jon 31, 12 | Consuling $4500/he
Froposal

Jan 31,12 Riview $45.00/ he

Click the WIP Grouping tab to open up all the types of groupings for inveice as
shown above. 188



Hide All WIPs

0 B S

o)
Hide All |Skew All No Grouping Advanced Group by Group by Group by
wIP wIp of items  Grouging

Grouping

Group by

Main Adjustments wiP Crouph§—| Add Custom Items  Templates

-

Group by  Group by
Tasks Bllling Categories Eilling Rates Employees Work Codes Projects

Ottawa, Ontario K2A 2E1 INVOICE #

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria, BC A1A 121

Date

Descniption of Work

DUE DATE:

SR Invoice

1

Sub Total,|

Total

Click Hide All WIP from inveice menu.

Show All WIPs

Main  Adjustments | WIP Grouping | Add Custom Items Templates

- = P

Qe @ 4 $ &
Hide All |Show All [No Grouping Advasced Group by Group by Group by Greep by
wip wip of ttams Grewping  Tasks  Bdling Categories Biling Rates Employees Work Codes

I Grouping

INVOICE DATE: January 31,2012
February 15, 2012

CLIENT INFORMATION

B =

Group by  Growp by
Projects

[

R i Invoice

DUE DATE:

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A 121

Date Description of Work

Jan 31,12 || Consulting $45.00/hr

Froposal

1

INVOICE DATE: January 31, 2012

February 15, 2012

CLIENT INFORMATION

Jon 31,12 Rewview $45.00 fhr

Click Show All WIP from invoice menu.

Sub Total $315.00
Taxes $40.93
Total $355.95
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No Grouping of Items

Main  Adjustments | WIP Grouping | Add Custom Items Templates

E S & 8 3

Hide All Show All [No Grouping | Advanced Group by Group by Group by Greup by Group by  Growp by
Greeping  Tasks  Bdliag Categonies Billing Rates Employees Work Cedes Projects

Grouping

%'s' 'go‘;r:‘::/e.. Unit1 | n VO I Ce

Ottawa, Ontario K2A 2E1 INVOICE #: 1

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A1Z1

[ Date | [Description of Work Rate | Hrs Total
Jan 30,12 |[ |~ $45.00/ e ahis $180.00
Feb1.12 || || $45.00/he 3his $135.00

Sub Total $315.
Taxes $40 95
Total $355.95

Click No Grouping of Items from invoice menu.
Advanced Grouping

Main Adjustments = WIP Gtouping'[ Add Custom Items Templates

G B & & 8B 3

roup by Group by Geoup by  Greap by  Group by Gre.w by
Tasks Cdliag Categories 8dliag Rates Employees Work Codes Projects

Grouping

Client Track 1
836e lgo;:‘;\vo., Unit1 l n VO ' Ce
Ottawa, Ontario K2A2E1 INVOICE #: 1

INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicoria. BC ATA1Z1

'.’
Hide All Show All No Grouping)
wip wie of ltams

[0ateT [[DSschption of Work

Jan 31,12 || Consulting
Proposs)
Jan 31,12 Review

$45.00/he

345,00 1

Sub Total
Taxes
Total

Click Advanced Grouping from invoice menu.

190



Group by Tasks

Main Adjustments = WIP Grouping |‘ Add Custom Items Templates

Hide AN Show-All No Grouping Advanced |Group by
wip wip of ltams Grewping | Tasks

Group by

-
a
D

-

Groupby  Greepby  Groupdy Group by

Bdling Categories Billiag Rates Employees Work Codes Projects
Grouping

Client Track
836 Boyd Ave., Unit1
Ottawa, Ontario K2A 2E1

Invoice

INVOICE &. 1
INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A1Z1

Date Description of Work Rate Hrs | Tois
Jan 31,12 | |All Proposal tasks $45.00 /e 3hes $135.00
Jon 31,12 | |All Revigwtasks $45.00/hr dhrs $180.00

Sub Total $315.00
Taxes $40.9%
Total $355.95

Click Group by Tasks from invoice menu.

Group by Billing Categories

Main  Adjustments | WIP Grouping | Add Custom Items Templates

M.«-M Show All No Grouping Advasced Group by
wip wip ofleams  Grewping  Tasks

S & 8 5

Group by Grewp by  Groupby Group by

Client Track
836 Boyd Ave,, Unit 1
Ottawa, Ontario K2A 2E1

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A1Z1

Date Descrption of Work

Invoice

INVOICE #: 1
INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Jon31.12 [l Consuingtasks || $4500/h | 7hs | $315.00

Rate Hrs Tota
Sub Total $315.00

Taxes $40.95

Total $356.95

Click Group by Billing Categories from invoice menu.
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Group by Billing Rates

Main  Adjustments | WIP Grouping | Add Custom Items Templates

Qe U L B |8

Hice Al Show All No Grouping Advasced Group by Group by Group by Grewp by  Grovpdy Growp by
wip wip efltams  Grewping  Tasks  Bidling Categories| Billiag Rates | Employees Work Codes Projects
Grouping

g!ls‘ 'g:;:%... Unit1 I n VO i Ce

Ottawa, Ontario K2A 2E1 INVOICE # 1

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A1Z1

Date Description of Work Rate
| Jon 31,12 ||Alltime at rate $45.00 | $45.00 /he m
7 hrs
Sub Total
Taxes
Total

Click Group by Billing Rates from invoice menu.
Group by Employees

Main Adjustments | WIP Grouping | Add Custom Items Templates

' Q3 B 8 &

n-« ANl ShowAll No Grouping Advasced Group by Group by Group by | Grewp by | Groupby Growp by
wip wip ofltams  Orovping  Tasks  Blliag Categories Billing Rated Employees [Work Codes Projects
Grouping

g;': 'go.c:cﬁ::re., Unit1 I n VO l Ce

omw.. Ontario K2A 2E1 INVOICE # 1

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Chekenham Road
Vicona, BC A1A1Z1

Date Description of Work Rate Hrs
Jan 31,12 || Allwork completed by Jeson | $4500/hr | 7his |

Sub Total
Taxes
Toral

Click Group by Employees from inveice menu.
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Group by Work Codes

Main  Adjustments | WIP Grouping | Add Custom Items Templates

QU L B S 6| 8|5

Hicda ANl Show All No Grouping Advanced Group by Group by Group by Greep by | Grovp by  [Growp by
wie wie ofltams  Grewpiag  Tasks  Bidling Categories Billiag Rates Employees| Work Codes | Projects
Grouping

SROEN S Invoice

INVOICE DATE: January 31,2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Viconia, BC A1A 121

Date Description of Work Rate || Hrs [ Total
Jan 31,12 | |All Proposal tasks $45.00 /e Jhrs $135.00
Jan 31,12 | |All Review tasks $45.00 /v

Sub Total
Taxes
Total

Click Group by Work Codes from inveoice menu.
Group by Projects

| Main  Adjustments | WIP Grouping | Add Custom Items Templates

QA U 3Q @B S & 8|3

Hide All Show All No Grouping Advanced Group by Group by Group by Greep by  Group by | Growp by
wip wip ofltams  Growping  Tasks  Billing Categeries Billiag Rates Employees Work Codes| Projects
Grouping

gﬁ: rgo.l;:%e.. Unit1 I n VO I Ce

Ottawa, Ontario K2A 2E1 INVOICE # 1

INVOICE DATE: January 31, 2012
DUE DATE: February 15, 2012

CLIENT INFORMATION

Sample Home Builder Ltd.
111 Cheltenham Road
Vicona, BC A1A 121

Date Description of Work | Rate Hrs

Jan 3112 [[Alloerfems —— | $4500/h | 7his |
7 hrs

Click Group by Projects from invoice menu.
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-
» Invoice Templates

Step 1

If an invoice hasn't been created, follow all steps here.

Note: If you have already created an invoice, go to Step 2 below.

Step 2
Main Adjustments WIP Grouping Add Custom Items | Templates

Template 1 Template 2 Template 2 Template 4

Templates

1) Click the Templates tab from the invcice menu.

Man Adjstments WIP Grouping Add Custom Items  Templates

J

Tomplate & [[Template 2 [Template 3 Tamplate 4

Femplates
Client Track 1
T ia Invoice
Ottawa, Ontario K2A2E1 INVOICE #: 2
INVOICE DATE: February 8, 2012
ODLIC NATE. AMarch 45 M4
— M ER Invoice
1""10[

Invoice #:
Saski  Chent Track
836 Boyd Ave., Unit 1 TRt February 8, 2012
Ottawa, Ontario K2A2E1

IR EIER Mtarch 15, 2012

Feb 8 12 Sample Printing Senvices
i 1111 Beach Avenue
Saskatoon, Saskachewan A1A 121
| Date” | | Descrpticn of Wk Rate Hrs Totd
Febg 12 | Oewsn 345,00/ be s $135.0¢
"¢ | Coatrocss 8

2) Click on a template number to get preview of what the invoice will look like
for print. To edit layout for a specific template, follow the steps below.

Main  Adjustments | WIP Grouping Add Custom Items Templates

& |
Adjuse Genenal
Ameunts Ogtions

Changes Formatting

g;ig 'go.;r:‘ze.. Unit1 I n VO I Ce
Ottawa, Ontario K2A 2E1 INVOICE & 2

INVOICE DATE: February 8, 2012
DUE DATE: March 15, 2012
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CLIENT INFORMATION

Sample Printing Services
1111 Beach Avenue
Saskatoon, Saskachewan A1A 1Z1

Date Descnption of Work

Design
Feb g 12 Contracts $45.00/ hr 3hrs $135.00

3) Click the Adjustments tab and then click General Options from inveice menu.

Step 3

Invoice Options for Invoice Templated (==
@ Invoice Settings
4

|Gene(allr Numbers LFormatﬁng T Colxs T Dates T Columns |

i Invoice Number Oplions
¥ Show the Invoice Numbe: on lrvoice

|
i Invoice Start Number: |1
\
|

Vv Automaticaly Increment Invoice Numbers

Note: The invoice stat number and auto increment setlings will be spplied to
linvoice templates,

- Default Invoice Template

You can specify which of the thiee rwoice templates you =
want to use as the defaull.

Default Invoice Number: [4 S e

Note: Al setlings specified above are foe this invoice template only. You can have different
seltngs for each invoice templates.

Cancel Ok

1) Click the General tab and insert new default template # of your choice.
2) Click the Colors tab.

Invoice Options for Invoice Template 4 (==

g’} Invoice Settings

f General T Numbers T Formatiing Tl Colots[T Dates T Columns ]

i Invoice Theme Color

Theme Background:
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~ Invoice Grid Colors

Header Background: Header Font: lﬁ
Giid Background: [ 7] Grid Fort: [N~

i Invoice Alternating Grid Lines

V' Show &ltemating Gridine Colors In Repoit
Allernaling Color 1; || | +|
Alternating Color 2: H

Reset Colors To Default

Note: All setlings specified above are for this invoice template only. You can have different
seltngs for each invoice templates.

Cancel

Ok

3) Customize the colors for invoice theme and grid (table chart).

4) Click Ok to save settings.

'§ You need to make sure the selected column widths add up to
L

100%.

5) A warning will pop up asking to adjust the column widths. Click Ok.

Invoice Ophons for Invoice Temp’litd

,,

ﬁ’-a_ - =
M Invoice Settings

General T Numbers T FomauingT Colors T Dates T Columns

Adjusted Time O
Final Total Time %)
Yime Entty Billing Type [J
Time Entiy Billing Rate (] 15
Real Total Amount (ba [J
Final Total Amount (af | 10
Time Entty Category [J
Client Time Entry Desc [4 60

<[yl

ITolol Page Width Used: 1123 l_

Note: All sellings specified sbove are foe th
sellings for each rwoice templates.

You can specily which columns you want to view on the
rvoice and what the percentage wicth of each column wil be,

Column Name

>

Adjusted Time O
Final Total Time B 2
Time Entiy Billing Type [J
Time Entiy Billing Rate [ 15 3
Real Total Amount (ba []
Final Total Amount (afi [4 10 4

Time Entiy Category [

Client Time Entry Desc 1
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| Total Page Width Used: 113 |_J Final Total Amount (afi [ 10 4

Time Entip Category [
Note: All sellings specified sbove are foe tf
sellings for each rwoice terplates. | Client Time Entiy Desc 1

Cancel 4[—1

| Total Page Width Used: 100 }—I

6) Check off which cclumns to appear on invoice template.

7) Customize the % width for each selected column tc add up to a total of 100%
besides Total Page Width Used.

8) Click Ok to save new invoice template settings.

Step 4

Main | Adjustments | WIP Grouping Add Custom Items

f-\
Adjust General
Amounts | Options

Changes| |Formatting

Client Track
836 Boyd Ave., Unit1
Ottawa, Ontario K2A 2E1

Click here to insent logo image - Optimum logo
size is any image that is up to 144 pxels high
and appeox. 250 pxels wade

Sample Home Builder Ltd. Invoice
111 Cheltenham Road
Vicoria, BC A1A1Z1

Invoice #:

Jan 31, 2012

Description
Collecton

All Proposal tasks $45.00/ hr
AllReview tosks $45.00/hr

Verify that the new settings appear in the selected invoice as shown above.
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Appointments

» View Appointments

Step 1

View Appts

R In Appointments, go to = View Appts (icon)

Step 2

§1Appolntments - Week View|

1) To view appointments of an user, select user from drop-down list
2) Te view appeintments in a different view, click one of the calendar tabs
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Select Useds Day Tever. Joson l

O Tezing Aup28 10 300 120000Pm Tetten for Saeple Elecin: Comgary Lded
) (o Suyect] DecS.10 (0] 20000 an $oe 200 310 200 o
O oersa Dec 15,10 200 1000004m Dertist foe 200 anto 1000 e
[ Weddeg Snat Dec22.10 1000 120000PM  Gamien Irdarms Waeddrg $34 tox Gasiron Industies 000 5
O Meetny Dec 23,10 1300 40000FN Sanple Lavyers Ofice Moetrs) 1o Savgle Lavgers Cifce) 00 peato
) Meating win Boss Dec 25.10 L) 1200007 Sargls Pretng Seevices Noatrg wih Boss Yo Sample Printing Secnce
[ Caze Shudy Overview Dec 30,10 1w SO000FN Sangle Elecone Comparg Lent . Cate Study Dverview 8 Samgle Electsc Com.
) Ocrtist Sapney Dec 31,10 B0 1000004 Me Docok P Snith Deetist Surgeey boe Mr. Desek P S8 00 &
_—

| {iMence Seoced Asouimms oaoDocumasts |

Click List tab toc view appointments in list view

Step 5
Name Date From To Client
[ Testing Aug24.10  03:00 12:00:00 P¥4
[ (No Subject) Dec 5,10 03:00 S:00:00 AM
] Dentist Dec 15,10 03:.00 10:00.00 &M
[ Wedding Stulf Dec 27.10 10:00 120000PM  Garrison Industries
[CGlMeeting—[Dec28.10  [1300 [ 400:00PM | Sample Lowers Office |
] Meeting vith Boss Dec 23,10 03:30 1200:00PM  Sample Printing Semvices
[] Cace Study Dverview Dec 30,10 14:00 5:00:00 PM Sample Electric Company Limt.
] Dentist Suigery Dec 31,10 03,00 10.00004M  Mr. Derek P. Smith

Select All | Merae Selecled Sopointments into Documents |

1) Tc merge an appcintment in a document, select an appointment
2) Click Merge Selected Appointments into Documents

Step 6

Document
»@ Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

Companies ] Contacts T Tasks T Appointments

[~ New Appoiniment Merge Document

Click The Document You Want To Open

Open an existing template
Client Arevasl Appointment.cta document by selecting &
Cliert Upcorning Appointment cla from list on left side.

Follow-up to Client Appointment.cta

Browse For File Not In List

Change Templates Folder Localion .

Select type document to merge appointments with
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» Add New Appointment

Step 1

Add New

R In Appointments, go to = Add New (icon)

Note: You can alsc add new appecintment under Quick Add - New Appointment
box on the right bottom sidebar.

Step 2
Add New Appointment ==
Genetal | Repeat | AuoNothcaton |  AppToUseis | Customlrfo
Appt Name: Dentst Surgery Appointment Display Text
Denbist Surgery for Me, Derek P, Smith .
Clent:| Swith, Derek ~| 5:00 am to 10:00 am

Date: [Dacember -31-10 ~|

[ Private Appointment

—
[s:00aM = ~] To [i:00aM = +] wsmm

| - oonicios [

W Remind Me: rﬁm hes mn Title Bar Feceground Colour: [ 7]

Bod) Background Cobour: [~ +]

Body Fecagrourd Colour.

Delate MewgetoDoc | Notly Now Concel | Ok

1) To create a new appointment, click the General tab and insert all the
information of the appointment under Appointment category shown above.

2) Select time of appointment under Time category.

3) To create a reminder of appeointment, check off Remind Me and select the
length of time for alert from drop-down list.

4) Select background colours under Appointment Colours category.

Add New Appointment

Generdl [Repeat | AuoMNothcation |  AppbToUseis |  Customlfo |

Repeat this appointment

Choose How Diten This Event Should Repeat
| Nooe | DOy | Week | Moath | Year |

Repeater Interval Information
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Chooze one of the selections above to

choose repeat interval.

Delete [ MewgetoDoc | oty e

Cancel

Ok

To repeat a particular appeintment throughout the calendar, click the Repeat tab

and select type of repeat shown above.

Add New Appointment

( Genetd | Repeat

Date To Be Notified

| AutoNotification | AppyToUsess |

Custom Info

Automatically notify this client of their upcoming appointment

&S r

| Decarmver-2010 ~] Fax Recipient
|M1. Derek P. Smith ~|
3
Recipiant Fax Nusber:
To Iéﬂc‘::@:hslab't: ca ;] @ vV Phone
Ce: | LI Person To Calt
Bee: | ] [M1. Desel: P, Smith ~|
Telephone Number:
_] [ [Lokto [os) 555 9632 |
Deie | MergotoDoc | Moty Now Concel |

1) To create an auto-notification of appointment, check off type of notification

method and select the information from drop-down list
2) Click Ok to complete adding new appointment.

Optional: Tec apply the same appointment to other users, click the Apply to Other

Users tab shown above.

Step 3

Person To Call: |M:. Derek P. Smith

Telephone Number. |(705) 555-3892
Avalable Times: |

IHi,
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This is a remindes that you have an appointment scheduled with Tidobyte Solutions
Inc. on Friday, December 31 2010 2t 8:00 am, ‘We expect this appointment to last
approximately 120 minutes,

This appointment is regarding Dentist Swgey.

Cancel

1) Type in available times and click Finish to send notification.

You will be reminded to call this client about their upcoming
appointment on Thursday, December 30, 2010

2) Click Ok in the reminder window tc confirm notification.

Step 4

5 Appointeents - Week View

Kase Study Overven Sor
s-::sermc Coepny

I (ShowWeskends | _ Showsicebs | a“r:)

1) To view the new appointment in week view, click the Week tab shown above.
2) Select the scheduled day of new appeintment from the sidebar calendar.

Appointesents - Honth View > Day| Week Monih | List

December 2010 Decerter - 00 v

- Appo or: D 8 010
| 1 00 |Meeting for Sample Lawyers | ~ a
Office

5 B 6 T = |8 =
Fhgprs 1 1 = - 1:00 pm to 4:00 pm
'“'“f,. 200
= i3] = = [13] 3 - B
[P L
| @) B ) B
10
= & = E
Ehgpre 1
Tord Teve:
2 s
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1) To view the new appointment in Month view, click the Month tab shown above.
2) Click the scheduled day of the new appointment and move the vertical bar until

new appointment is shown in schedule.

» Overlap Appointments

Step 1
Overlap
R In Appointments, go to = Overlap (icon)
Appointments Overlap Wizard )

"El Appointments Overlap

This wizard allows you to overap two or more user's appoiniments.

~Select Appointment Overlap Users
All Users Users To Overlap

Adam
David Add >>
Isabella
Jason << Remove
Susan

Add Al >>

Overlap Options
Ok
Step 2

Lentamcl

[El[' Appointments Overlap

This wizard allows you to overlap two or more user's appointments.

Select Appointment Overlap Users

All Users Users To Overlap
Adam Isabella
David Jason
Susan
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’ | Add All>> ” |

Overlap Options

Cancel | 0k

1) Select user(s) to overlap from All Users list and click Add
2) Click Overlap Options.

Note: To remove an user from Overlap list, select user and click Remove

@ Appointment Overlap

Set Default Appomtment Overlap Colours For Users

| |[Adam
David

| |Isabella
Jason

Susan

el

Ok

3) Select different background colours for overlap users from drop-down list
4) Click Ok.
S) Click Ok to exit Appointments Overlap window.

ee Joson [ |
“Adom
Dand
Isabella
Jbzon
Susan
8002
9002
10005
11:00a 5
12.00p
1:00p
Meetng for Sample -
200 Lawyers Office
1:00pm to 400 oy
300p
400p
S00p
&00p

we Uter

6) Verify the overlapped appeointments for selected users in Appointments
Note: Te change the order of users and display of overlap appointments,
go to Overlap Control on bottom right and follow the instructions below.

Step 3 (optional)
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Overlap Control Overlap Control [X]
Add New
Appointment

g
b=
lan] »

Isabella

1

=
38 O
Ll =x

BaLLL

Add/Remove
User

Add/Remove
User

Add New
Appointment

1) Te change the order of overlap users, click the up/down arrows
2) Select different background celours for each user from drop-down list.

user to the new color? Click 'No'to pust temporatily change the

' Do you want to permanently change the oveilap colour for this
-5' overlap color for this user for only this overlap session.

Thu 30

Overlap Control

=
| | X [isaveta
AddMemove Uses
|| 2] |35]|@| Overlap Made is Active | Csresiovets | [ ShowWeskeods | [ Show St |§]a‘.~|‘

4) Verify the new overlap colours and order of users in Appointments

» Create Document

Step 1
Create Doc
R In Appointments, go to = Create Doc (icon)
Step 2
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Scarch Main | SeachAppciniment Times |
o
[~ Search by Appointment Name " Find Appointments in 3l dates
Iﬁndoleppwﬂmentslhelcodmlolovwg: € Find 2 -
| =
[~ Search by Client P !
Find oniy agpointments for the following cient s
| Combol | I =
[~ Search by User Name " Find apponiments cn of before:
Find all appointments foe the following user | ~|
ICombo‘l LI " Find apponiments between:
[~ Search by Appoiniment Color I _.I
Find all appointments wath the foloving color: ond
— | =l
Cancel | Select Appointments |

To merge appointment by name, client, user name, color or dates in a document,

click Search Main Criteria tab and check off one of the above.

-r«—,s_—,-»,y.-,vls.l.“h “r. ST %) S—

B

Search Main T Secarch Appointment Times l

[~ Search by Appointment Stait Time
€ Find ony appomiments starting ot

|cboS!mTime vI
¢ Findenly appomiments stating &t
ot alter.
|cb05!a1'l'ime 'I
¢ Findony apponiments starting ot
ot before:
|cbo$tml‘ime vl

¢~ Find cnly appamtments that stet
betwearn

choS!a’lTime 'I
and |cbo$larll’inc vI

Search Appointment Times

[~ Search by Appointment End Time

" Find only appomiments ending al:
|cbo£ndfime vl
¢~ Find only appontments ending at
o alter:
choEndlitm 'I
¢~ Findonly appoiniments ending at
or before:
|cbo£nd‘lm vl

¢~ Find only appainiments that end
betvean

IeboEndTime vI

and |choEndTime v

_ el |

To merge appeintment by time in a document, click Search Appointment Times

Select Appointments

tab. Check off one of the above categories and select type of search.

Step 3
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Document
TI ;'l Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

7 ™

Companies T Contacls T Tasks T Appointments

[T New &ppointmert Merge Document

Click The Document You Want To Open

Open an exsting template
document by selecting it
froen Bst on left side,

Browse For File Mot In List

Change Templates Foldes Location \

Select type of document to merge appointments with from list shown above.

Step 4
& File B0k View hsot Format Tatle Optioes Wiedow Help «lolx

| Document Merge | Emad Margo

e e 4

NewDec  NergeTyze | [nres Verge Insert Fem [nsert Oate
Neld Pate Neld

Iy s e

t Salect Select  Cremte  PristOocs Save Doca Sevets Sevedt
Companian Coetacts Agpoimtmerts Taria  Mesge werd bor

insert Merge Fields Select Information Save Your Mecge
Diomal - beal 2 s 7uiElmzmiws [ SEIQS
| arx
1 2 Loeve i) f- L.a n. .l?....L?? () t I . YO l"e‘ll" i,

-

o3 Cient Track
2 148 Colonnade Rd. South
g5 fiepesn, Ontano K2E 7Ré

Apeil 23, 2009

Sample Owerhead Door Manufacturer
John Doorman

111 Pine Dene

Toronto. ON A1A 121

-

-

Secton 1 Pasln | Lee) | (Col) WX nuM

Verify the results of doc merge by appeintments. For mere information on
document merge options, click here.
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'@ Appointment Options

Step 1
Options
R In Appointments, go to = Options (icon)
Step 2
Appointment Calendar Display Options for Jason =

General Options |  CellBackgound | DisplayTest |  Colow Schemes

Start Appointments By Display Time Range

" The Day View You can indicate what range of limes wil show
@ The Wesk View in the day and week views window panes.

" The Morth View [800aM  v] o [00PM ~]
" The List View

When the Appointment View starts, automatically...

" Show The Weekends In The Wesk View
" Hide The Weekends In The Week View
& Remember The Last Weekend View Used

When the Appointment View starts, automatically...

" Show The Day And Week Sidsbars
" Hide The Day And Week Sidebars
& Remember The Last Sidebat Selting Used

~ Other Tools
Spply These Settings to Other Users Duplicate Sppointments Wizard ‘

1) To change the views of the appointments, click the General Options tab.
2) Select type of view for appointments tc begin with.

3) Select the time range of the appointments from drop-down list.

4) Select type of display view to automatically appear in Appointments.

Step 3

Appointment Calendar Display Options for Jason o]

Genersl Options | Cell Background |  DisplayText | Colow Schemes |

Calendar Cell Background Colours

Show Colours Show Colours Show Colours
¥ In Day View ¥ In Week View ¥ In Month View
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Sundy Sdoy []5]  Sundey
Monday: [+ Mondsy: Menday:
Tuesday: Tuesday: m Tuesday:
Viednesday: Viednesday: Wednesday:
Thursday. Thrsday [ ]~  Thusday: [ ]~]
iy [TF] Fide 1] Fid
Saturday: Saturday Sawday: [ -]

Uze same colour Use same colour
Resel To Defauk G scheme as day view, O scheme as day view,

When viewing other user's calendars, | want to ...
@ View My Backgiound Colows " View Their Background Colous

~ Other Tools
Spply These Settings to Other Users | Duplicate Sppointments Wiard ]

Cancel ok

1) To customize the background colours, click the Cell Background tab.

2) Check off all three types of views.

3) For each view, select the background colours for each day of the week
from drop-down lists.

Step 4

Appointment Calendar Display Options for Jason |

General Opions | CellBackgiound | Display Text | Colous Schemes

Preview

Select An Item Below
To Insert A Merge Field

/. @

«Appontment Names fos «Company Names
.ra.ﬁppoi'menl Starl Times to «bppointment End
imes

Labels) | Label2 | Lsbel2l | Lbel2) -

Save } Test ] nesawoeru]

Reset al appointments scheduled to use the sbove lext template

Title Bar Options

[V Show Title Bar for Appointments
V' Show appontment stalus icons in the tile bar

Show this information i tille bar: | [Appeintment Info] |

[~ Show Custom Checkboxes In The Preview Conligwe Check Boxes I

~Other Tools
Spply These Settings 1o Other Users | Duplicate Appointments Wizard ‘

Cancel | ok

1) To customize the display of appocintments text, click Display Text tab.

2) Place cursor in Preview window and click a merge field item from list. Click Test.

3) To save the new merge field item(s) in Preview window, click Save. 209
4) Check off Show Title Bar for Appointments.



Step 5

Appointment Calendar Display Options for Jason =
General Oplions T Cell Background T Display Text T Colour Schemes |

-~ Appointment Colour Scheme Options

[AddNewSclnme”DeleteSd\eme” Save I

Scheme Name: |

~ Colour Options
Tille Ba¢ Background Colour:

Tille Bat Foreground Colour

Body Background Colour: EE]

Body Foreground Colour:

-~ Preview

Appointment Title

All colour schemes created here are available to all users.

~ Other Tools
Spply These Settings to Other Users ‘ Duplicate Sppointments Wizard l

Cancel ok

1) To change colours for various appointments, click Colour Schemes tab.

2) Type in name of scheme besides Scheme Name.

3) Select the background cclours from drop-down list.

4) Click Add New Scheme. The new colour scheme appears in Scheme List.
5) Click Ok to exit Appointment Display Options.

Note: To delete colour scheme, select one from Scheme List & click Delete.

» View Projects

Step 1

View Projects

R From menu, go toc Projects = View Projects
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Step 2

Fie f6e Tooh Cumemlashs Fageds Usens Soppost

B Gt | Al Projocs Ust (1 projocts) St Pt 31 —_=) Wom Pt ) _ Avts Pttt Gt ()
Personst Clarts e

PS8 &|VNHO D

m mw m!.mluuwlnm Mbgpecs M

i
Ghad 8 wwwe Thusday, Pty 3 2011

All projects for clients are displayed at a glance under the Projects List.
Step 3

58 & iTNA Q6 o

Projects For Pto;mFamUncomma ANl Projects  All Projects Al Projects  All Projects Mlcomue(od
This Week  This Month Fwalting Clients In Progress  On Hold

If you are looking for project from certain pericd or step but are unsure of the
name, click any one of the icons in ribbon bar shown above to narrow down search.

Select Project: [FIAEAS] v|| New Project || Assign Projects to Clients |

Ci Brochuwe

If you are looking for a certain project and know the name of it, simply select
project from drop-down list besides Select Project as shown above.

» Manage Projects

Step 1

Manage Proj...

Q ‘ From menu, go to Projects > Manage Projects

Step 2
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Step 2

'3 Manage Your Projects =

@ Manage Your Projects

Add Now Template Progect Project Information ——— - D) - ——— —y
e e b
Saved Projects List

Number of Steps: 0
~ Schedule Projects for Clients -
Select dm " :Ienwn L3 Popt e Buspctlony
Raclane of pucep * ™ Prompt foe Statt Date

3 P o the
peeset vahies for the selected [~ Picmpt foe Total Time Budget
clieris: [~ Prempt fee Totel Cost Budget
Business Companies 1 Personal Tax Contacts

B DJUient Track Business clients -
C
&) Corpmation
183 Sample Beauty Sslon =
182 Sample Electric Cornpany Limited
182 Sample Home Bulder Ltd
100 € sanle Dant Bidder

Wam i there i akeady the same _ 'y
peoiect scheduled lor selected AwlmeeeIIoSelemdumml

Conoell Ok I

Click Add New Template Project shown above.

Step 3

9& Define Project Steps

Project Name: Company Brochure

[Add New Step || Delete Step ]|[ Generallnfo | Datelrfomstion |  TimeBudgeting | Spen

Steps List ~Step Infosmation =
Research :
Thumbnails e il ] ~Task Informatior
Color/Fonts Selection Step Description: -
Comps g Task Nome: [Re:
Client's Review #1
Selected Comps Revision Colun Headng:  Research
Client's Review #2
F,!m] Version Coluvn Widh: |1
Client's Approval {in inches)
Send o Printer
Default Employee Assigned
[More Assigned ~| .
@Mmoelededslepup ™ Reind me:
Move selected step down
Project Default Billing Cat«
Cancel v Load the Steps From a Previously Saved Project Into This Ono:,

1) Click Add New Step tc begin adding steps to project. Additicnal steps appears
under the Steps List category shown above.
2) Type in step name, description (optional), column header and dimension.
3) Select employee to assign to project from drop-down list. 212



’é Define Project Steps

|Pm'pec( Name: [Comparny Brachure ) I
Genetallnto | Oelrfomation | TewBudgetng | Spendng Budpting | Biling Ik )

Staps List  Stop Infoemation
Reseorch StepNare:  Regasch

- Task Inloimatssen -

Step Descrgnon

Tatk Nare: Retanch

CobenHosdrg Rotosch
CobmaWidh (1
(nweres)

Dot St s

|Noow Arares =
@Nmu&mmw I Remndme [<Seecr  w| beleee
(%] Move selectnd oo down
Peoject Delault Biling Cotegory. | =l
Cocel Load the Steps From a Peovicusly Saved Peaiect Into This One: | ~ Ok

Note: If you want to repeat previous steps from an older project onto a new
preject, you can select project drop-down list besides Load the Steps From A
Previously Saved Project Into This One shown above.

Step 4

Generallnfo | Dalelnformation | [Time Budgeting | SpendingBudgeting |  Bilng Information |

[™ Use Time Budgeting Control For This Step:
% Use Relative Target Times based on a Percentage of the Total Project Time Budget
(" Use Fivad Target Times

- Yime Budgets and Warnings

Total Step Estimated Time: % ol total pecfect budgeted lime
Armount of time this step should ideally take.
Step Warning Time: l % of total project budgeted lime
Secunt of lime that wil pass belore & wainng is sent by emal
ndicating thes step has reached the tme wainng.
Step Critical Time: [ % ol total pecfect budgeted lime

Armount of lime that wil pass before a crbical wainng is sent by emal
ndicating this step has reached the ciitical tme.

Project Default Billing Category: ~|
Browse through other tabs to apply for project if necessary.
Step 5
6 Manage VourPrjects =
@ Manage Your Projects
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- — *
Y ie——

Pro Murber of Steps: 0

- Schedule Projects for Clients

[~ Picept foe Project Naene
Sd“'wfmmmu [ Prompt foe Stan Date

scheduing :
preset vahies for the selected ™ Proenpt foe Total Time Budget
cherts; I~ Preenpt fee Totel Cost Budget

l Business € i 1 Personal Tax Contacts

>

= D! Client Track Business clients
O
&) Corpmation
V182 Sample Beauty Salon
182 Sample Electic Company Limited
182 Sample Home Sulder Ltd
183 Sample Lawyers Olfice
[]83 Sample Overhead Doot Manulachurer
182 Sample Pirting Sesvices =

109 Cwarls Danl Riddar

m

Wamif there i akeady the same
[V peogect scheduled lor selected

Apply Project To Selected Clients I

Cmodl Ok I

1) Verify that the created project is selected under Saved Projects List.

2) Select clients from either Business or Personal Tax tab to assign projects for.
3) Check off Warn if there is already the same project...

4) Click Apply Project To Selected Clients.

Project Schedule Options

Project Schedule Options

Client Name: Sample Printing Services

Project Name: |Companp Brochure

You can a specific project name for
this client, i.e. Project & - Jan 2010'

Project Start Date: | February -02-11 |
Project Total Time Budget: I_ hrs I min

Project Total Cost Budget: I

5) Select the start date of project as shown above and click Ok.
6) Click Ok in Manage Your Projects to save settings for new project.
7) Verify that the added project is shown in View Projects.
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'@ Project Search

Step 1

View Projects

R From menu, go to Projects = View Projects

Step 2

LPE RN 8 8

Advanced | View/Hide View/Print Projects For Projects For All Uncompleted
Search Columns Report This Week This Month Projects

Click Advanced Search icon in ribbon bar shown above.

Step 3
Advanced Search (Projects) 3
Search Main T Seaich Dates & Employee T Search Other )
[ Search by Project Nome v Search by Project Status
Find only project names that contain following: Find only peojects of the following
| [V Awaiting Cliert
[~ InProgress
v Search by Client [~ OnHold - Questions
Find only projects for the following clent; ™ OnHold - Missing Documents
5 ample Beauty S alon - [ OnHold - Othes
[ Completed

[T Search by Project Type
Find only projects of the lollowing type:

| =]

¥ Search by Completed Status
& Show only uncompleted items
" Show only completed items

Cancel Perform Search

1) To search project by informaticn, click the Search Main tab shown above.
2) Select search type from one of two categories above.
3) Click Perform Search.

Advanced Search (Projects) 23]

[ Search Main T Search Dates & Employee T Search Other
I

—_—
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" Search by Project Name

Find only project names that contan following:

I
W Search by Client
Find only projects for the following client;

S ample Beauty S alon -

[T Search by Project Type

Find only projects of the lollowing type:

I =
v Search by Completed Status

& Show only uncompleted items
" Show only completed items

v Search by Project Status
Find only peojects of the following
WV Awaiting Client
[T InProgress
[ OnHold - Questions
[~ OnHold - Missing Documents
[~ OnHold - Othes
[ Completed

_ Canced |

1) To search project by information, click the Search Main tab shown above.
2) Select search type from one of two categories above.
3) Click Perform Search.

Peiform Search

Seaich Man

¥ Search By Date Range

Search: |Project Stant Date |
Proiect Stat Date
Project Target End Date
1 Project Overdue Waming Date
Preject Overdue Clgicd Date
}Janw:ty 1,201 _-j
" Find all projects on or alter:
'Januyy 1,201 ;]
@ Find all projects belween
Nanuary 1, 2011 ;l
and  Apd 30,2011 ~l

T Search Dates & Employee T

Search Other

[T Search by Project Leades

Find only projects assigned to the

folowing user.

[Adam Abiaham Ll
[~ Search by Supervising Partner

Find only projects assigned to

the fllowing painer name:

lé.dam Abiaham ZI

[~ Search by Managing Accountant

Find only projects assigned lo the
folowing managing accountant:

IAdem Abraham ;l

_ Concd |

1) To search project by date/employee, click the Search Dates & Employee tab.

Peiform Search

2) Select type of date range from drop-down list.
3) Click Perform Search.

. Py

Advanced Search (Projects)

(

Seaich Main 1

Seaich Dates & Employee T

Search Other
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Other Searches

@ Show only Rems where 3l the documents have not been received
" Show only Rems where 3l the documents have been received

Cancel Peiform Search

1) To search project by status, click the Search Other tab

2) Check off Search by Received All Documentation Status and select
which items to search.

3) Click Perform Search.

Step 4
¥ Clent Name | Project Name | Project Status | Taiget End... | .‘
Sample Beauly Salon Company Brochure Awailing Chert ViewlInfo | Delete Projct
| ']

The searched project will appear in the projects list. To view details of the project,
click View Info as shown above.

'@ Project Options

Step 1

[ New Project ][ Assign Projects to Clients ] C

A Q@ o

All Projects  All Projects  All Projects All Completed
Awaliting Clients In Progress On Hold Projects

In Projects, click the information icon on top right corner as shown above.
Step 2

Project Task List and Report Options =

Gridl.ayoutT Grid Options T RepotthT Colors/Grid ]

~ Contact List Name Display Options
Select how you want the contact names to display in your lists:
" Display contact name using 'Display Name' field
" Display contact name using 'First Last’ format
% Display contact name using 'Last, First' format

Contact List Family Relationship Display Options
Select whelher you wanl Lo display the relationshvp for family members:
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Select whelhet you want Lo display the relalionship for fanily membess:
@ Dont display the family relationship of family members
" Display the family relalionship of famiy members

~Progress Steps Progress Bar

WV Display progress bae for completed steps

v Change the gradient coloe of the progress bar based on the rumber of
steps completed.

Progiess Bat Color: [ ~|

Cancel

1) To display contacts on preject report, click the Grid Layout tab.

2) Select type of display options for contacts and family members.

3) Optional: If you want the the project steps to appear on report, check off
Display progress bar for completed steps.

Step 3

Project Task List and Report Options

| GiidLayout | Grid Options | ReportLayout |  Colors/Giid |
[T Lock the client name column so it is akways visible
[T Wirap test in grid cells
~Alternating Grid Lines
¥ Display akemaling gnd Irne colors
Atemaling Color 1: || |
Ahemaling Color 2: [ -] Resetto Default |

~Closed Tasks
¥ By defaub, don't show closed items in this kst

~When The Personal Tax List Staits, View ...

@ 2l Retums
" Retums In Progress
" Retums on Hold

~ Concel J ok

1) To change the display setup of project tasks list, click the Grid Options tab.

2) Check off Lock the client name....so it is always visible.
3) Select alternating row colours for grid lines from drop-down colour lists.
4) Select type of display view to automatically appear in Projects.

Step 4
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Step 5

ask List and Report Options

GridLayout | GiidOptions |Report Lapout| Colors/Giid |

~Report Orientation
Select defauk page oiientalion of the report when & i first displayed:

" Porait ¢ Landscape & SizetoFi

~Report Margins
Top Magin: |1 inInches Right Margin. ]1 in Inches
Left Maigin: |1 inInches Boltom Margin: || in Inches

- Report Options

¥ Show Column Headers On Report V' Wirap Text In Cells

¥ Show Column Headers On 4ll Pages V' Show Header Giid Lines
WV Show Main Grid Lines
¥ Show Her, Grid Lines
¥ Show Vet Grid Lines

Header Line Thickness: [
Main Grid Line Thickness: [T

_ Concal |

1) To customize the display of report layout, click the Report Layout tab.
2) Select type of orientation, grid lines and other pages to appear on report.
3) Insert dimensions of report margins.

Ok

7

GiidLayout | GiidOptions | ReportLayout | Colors/Grid |

~ Title Bar Background Color

Title Bar Backgiound Color: [N+

~ Grid Colors

Header Backgiound Color: -ﬂ Headei Font Color: ﬂ
Grid Backgiound Celor: | | +| Giid Font Calor:

~ Report Alternating Grid Lines -
¥ Show Sltemating Grid Line Colors In Repoit

Akernating Color 1: I:j Akernating Color 2; DH

[V Show 'Date Generated' On Report [V Show Page Numbers On The Repoit

Cancel

Ok

1) To customize the colours and grid of report, click the Report Layout tab.
2) Select type of grid colours and lines.
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: » Add New Contact

Step 1

&4 Address Book (2| @ S
file Edit Toolks Repcrts Help

1.2 2 x|@ 3

Find Edt  Delete | WebSte  Report

'.-;!Addmsﬂoel:
# &) Chent Track
B8 Chent Track Business chents
B Savarzan, Jon

o G2 Sermple Bectrc Compuny Umited
83 Samole Mome Bulder Ltd,

& B Saevgle Layers Office

@ $2 Samole Overhead Ooor Manufact
o G2 Seevple Roof Bulder

¥ 83 Semole Tatioo Studwo

& B Sargie Trudking Comanry

Name: Mr. Oerek 8 Michse’s Address:
Company Name: Savpie Printesy M, Derek 8 Michaels
Services AReorts

Job Title; Sericr Avcourtart
Department Accountng

Defauit Contact: Yes

Main Phone: (705) 655774

% & Chent Track Personal chents Fax: 705) S85-5775
Sample Frietng Seevices.
Hr. Derek 8 Mchaels
1111 Beach Averue
Sasiateon, Seskachewsn AlA 121
‘ " .

Select company from Address Book by clicking on it.

Step 2

Y o~
New Find Edit Delete Web Site Report

Category
Company

Contact

R In menu, go to New (icon) = Contact

Other Methods

1) Menu: Edit > Add > Add Contact

2) Sidebar: Add Contact

3) Right-click on a category: Add New Contact to this Category
4) Right-click on Address Book: Add New Contact

Step 3
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Add New Contact =

Name T Business Info T P | Info T Spouse Info TFMMM:T Othes

First Name: |Desek Tale: M,
Micdle Nome: | Disploy Name: M1, Derek Michaels
Last Name: [Michaels NameSufiic [ |

Default Contact
I2 thiz contact the dalault contact for this company? [V

Personal Tax Status

Is this contact a personal tax chent for the 2010ax year? [
In the petscndl tax st ..
& Display only a5 the contact fsted above fie. | S
€ Display the contact and spouse name (i e John & Ma

Management Information
Supervising Paitnes:| v| Mmog'ngAcoouMJ v|

Iﬂnm Report ] | &) Print Labels I Cancel ok

1) Fill in contact's information under following tabs:

Name, Business/Personal/Spouse Info, Family Members, and Other.
2) Click Ok.

Note: Check off Is this contact the default contact for this company?
if contact is main contact for company.

Step 4

of Nddress Book (=] @ S
file Edt Took Reports Help |

1. P2 x@ 1

New Edt  Delete | WebSte Repont
s!mm‘ua
* & Chent Track
= rack Busin hents
isnm.s« (odmmﬂmw mu«mlw@
ey < Chritabie O on Name: Mr, Oerek B Michaels Address:

Company Name: Sample Printeg Me. Derel 8 Nichaels
Services ARerts

Job Title: Serior Accourtant
Department Accoutng

Defacit Contact: Yes

B Swrarzan, Jown
© 83 Sarple Slectric Company Umited
83 Semple Mome Bulder Ltd,
&) 8 Saevgle Lawyers Office
* 83 Sample Overheod Ooor Manfact
© €3 Sargle Roof Bulder
* 83 Sample Tatioo Studo
© 83 Savgle Truding Covpany
« & Chent Track Personal chents

Main Phone: (705) 5655774
Fax: 705) 5855775

Sasialzon, Sasiachewsn A1A1Z1

. = 1 »

Verify that contact's information is correct.
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. » Add New Company

Step 1

&4 Address Book oE

File Edt Tools Reports Help

1. /22 X @

Find Edit Delete chS«te Rtpo«

) Client Track Business

Summary

Categories: 0

Compenies: 10
Contacts: 10

Add Company

. (3 ! » = =

Select a category from Address Book list by clicking on it.
Step 2

New Find Edit | Delete | WebSite =R

Category
Company

Contact

R In menu, go to New (icon) = Company

Other Methods
1) Menu: Edit > Add > Add Company
2) Sidebar: Add Company

3) Right-click on a category: Add New Company to this Category
4) Right-click on Address Book: Add New Company

ey
Client Track Busines Clients

This category contains all of the Client Track Business
clients.

Step 3
‘Add New Company 53]
Business lnloT Peisonnel T mb Olher ]
Business Name: |[JLC Designs Mein Phone: [(613) 052-0000
Coiporate Name: [JLC Designs 1 A1l Pheee: |
Chent ID: [ ‘ Fax]
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Business Type: [Farinenip = Emait [info@jedesigns.ca
Industey; IG'W design LI Websie:]wm.ibdeswca D)
Addess: (545 liland - FaceBook| el

" Toiter: o

Chy: [Nepean
-
Postal Code: [K7G OKO Supervising Panner:[David éndeison |
Counlry:  |Canada Mmaginghccoumam:ﬂ—;]

Iﬂ Print Report &l Print Labels M L

1) Fill in company's infoermation under following tabs:
Business Info, Personnel, Associated Professionals, and Other.
2) Click Ok.

Step 4
44 Adacess Book lsim

= 83 Sample Beauty Ssion

2 Styist, Soran Company Mnes e Corbre
=81 s;'ale Charitadle Organizaton Default Contact: Yes

R Samartan, Joan
@ B3 Ssaple Becric Company Limited :ummg::))m-oool :lmmg:gmooot
« 81 Somple Budder L9 e Lo
o Faah s, e o
«1 83 Saple Overhead Door Marnfact ‘ % R Desigos
-8R Sample frinthg Serviots Address: Js Ketay
= 81 Semple Roof Gulder JLC Designs 1025 Nertvaie Rd.
@) B3 Samgie Tatioo S2uso 1025 Merivale Ra. Nepean, Ortario KEH 8J5

(=1 83 Seple Trudeng Company

Add New Category

Step 1

i s ==y
File EdR Tools Reports Help

J- 122 X @ 3

Find Edit Delete | Web Site

Client Track Business chents Address Book

Client Track Personal chents
Welcome to the Client Track Address Book
Summary
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Categories: 10

Companées: 11
Contacts: 30
Add Contact
Add Companry
Add Category
—

Select Address Book from list by clicking on it.

Step 2

S
d |- X @

New Find Edit Delete Web Site | Report

Category
Company

Contact

X | In menu, go to New (icon) = Category

Other Methods

1) Menu: Edit = Add > Add Category
2) Right-click on Address Book category: Add New Category
3) Right-click on a category: Add New Sub Category

Step 3
[ Add New Category ﬂ
Create Category In: IAddtess Book Z|

Category Name: IPayt:ak

Small Business Experty »

-

Cancel ‘ 0K

1) Select category from drop-down list.
2) Type in category name and description.
3) Click Ok.

Description:

=& Address Book

v-&9) Client Track

# Client Track Business clients
%/ Client Track Personal clients

Verify that new catergory has been added in Address Book list.
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Notes

&Y/ Client Track Business clients
#- &9 Client Track Personal clients

Adding a new category outside the default categories (Client Track, Client Track
Business & Personal Clients) will not appear in Client Track.

Elg Address Book

3 Client Track

Adding a new sub category inside one of the default categories (Client Track,
Client Track Business & Personal Clients) will appear in Client Track.

., » Edit Contact

Step 1

E]--Q Address Book
#-&¥ Client Track
Client Track Business clients
=82 ILC Designs
*% Kelley, Joe

@ Michaels, Derek

E-€2 Sample Beauty Salon
AT

Select a contact from Address Book to edit by clicking on it.

=

Step 2

X | In meny, go to Edit (icon)

Other Methods

1) Menu: Edit > Edit
2) Sidebar: Edit Contact
3) Right-click on contact: Edit this Contact

Step 3

Edit Contact S

I| Name T Business Info T Personal Info T Spouse Irfo TFameMembecs] Othet ]
‘ Fitst Narne: John Tieo | ~]
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Middle Name: | Display Name: John Dooiman
Last Name: [Docman Narre Suffic - I

Default Contact

|5 thiz contact the defaul contact for this coerpany?

Personal Tax Status

15 this contact & pessonal tax chent loc the 2010 tax yes? [~

In the personal tax st
@ Display ordy as the contact listed above li.e Jobe Smith
€ Dicplay the cortact ¢ pouse name [re. John & Many ¢

wh

Supenising Paitner. v| MMAW| vl

[ &) Piint Report l l &) Piint Labels l Cancel ok

1) Edit contact's infermation under following tabs:

Name, Business/Personal/Spouse Info, Family Members, and Other.
2) Click Ok.

Step 4

Contact Business Informati Contact Personal Informatlon
Name: Mrs. Sarah Merritt Cell Phone: (613) 258-8936

Company Name: Sample Beauty

Salon Address:
Job Title: Bookkeeper Mrs. Sarah Merritt
Default Contact: Yes

Main Phone: (705) 555-12{=-&% Address Book
Fax: (705) 555-25¢ 3 Client Track

Add =] Client Track Business clients
ress:
JLC Designs
Sample Beauty Salon EI Qa % kel 9 3
Mrs. Sarah Merritt ey, Joe
111 Hailey Holow | ™ ﬂ Michaels, Derek

Calgary, AB A1A 1Z1 El 82 Sample Beauty Salon
ER &= Y Merritt, Sarah

Verify that contact's information has been edited.

Step 1

3  From toolbar, go to Find

Other Methods

1) Menu: Edit > Find Entry
2) Right-click on a category: Find in this Category
3) Right-click on Address Book: Find
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Step 2

Find Contacts Ex
SearchCriteria |  SearchResults |
—Find In Group
|Client Track Business dients |

Search For: |Search only Contacts

Lo L

Search Field: Name

Search Text: |Joe

[~ Match Whole Word
[T Match Case

Cancel

1) Under Search Criteria tab, select type of search from drop-down list.
2) Click Find.

Step 3
Find Contacts CxE)

1) Under Search Results tab, select the appopriate business client.
2) Click Go to Record.

Step 4
EJ--G Address Book

~ Client Track
=-&¥ Client Track Business clients

=182 ILC Designs

|-

- /4 Sample Beauty Salon
"8 Merritt, Sarah

The searched contact is highlighted in the Address Book.
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» Delete Contact

Step 1

file Edit Tools Reperts Help

d. P2 X @ B

I(—
New Find Edt  Delete | WebSie | Report

T Sarove Sesuty Su0
i Sofst, Sarah Name: Mr, Derek 8 Uichaess Address:
= 83 Sample Charitable Organzaton - Company Mame: Sarple Printe e, Derel S Michaels
B Sararian, Jown Servicns. Arerts
B2 Sarple Sectric Company Umited Job Title: Secior Accountast
w 83 Sample Mome Bulder Ltd, Department Accownting
© 83 Saevgle Lanyers Office
% B3 Samole Overhaad Goor Manfact Defouk Contact: Yoy
% B Ssmole Pty Senvices
G Sample Roof Bulder
% §3 Samole Tattoo Studo
@ 81 Ssvgle Trudking Covpany
4 &) Chent Track Personal chents

Main Phone; (70%) $55.5774
Fax: 705) 5855775

Address:
Sarmple Pricting Secvices.
Nr. Devek B Michasls

. m 1 »

#4 Address Book (=@ w3

Michaels, Detek
Contact Business Informatiot ]| Contact Personal Iaformatios 7]

Select a contact from Address Book by clicking on it.

Step 2

Delete

R In menu, go to Delete (icon)

1) Menu: Edit > Delete
2) Right-click on contact: Delete this Contact

Step 3

' Are you sure you want to remove the contact 'Michaels, Derek’
from this category?

Click Yes tc delete contact.
Step 4

EJQ Address Book
#-&9 Client Track
=-&9 Client Track Business clients
2T} ILC Designs
29 Kelley, Joe
=@ Sample Beauty Salon

...... 2 Merritt, Sarah

Verify that selected contact has been deleted from Address Book list.
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» Delete Category

Step 1

EIQ Address Book

Select an added category from Address Book by clicking on it.

Step 2

Delete

X | In menu, go to Delete (icon)

Other Methods
1) Menu: Edit > Delete
2) Right-click on category: Delete this Category

Step 3

companies and contacts within this category?

No I

'E Are you sure you want to remove the category 'Partners’ and all
-

Click Yes to delete category.

Step 4

Verify that the selected category has been deleted from Address Book list.
Notes

E]g Address Book

229



m ‘You cannot delete the main business clients category.

The Address Book will not allow you to delete any of the default
categories (Client Track, Client Track Business & Personal Clients)
because they are a part of Client Track. If you try, you will receive a popup
message indicating that you can't delete them.

'@ Moving Multiple Contacts

Step 1

= &J Chent Track Multiple ltems Select

Selected Rems: 2

Move Sclecied Compansos to Category

Make Soloctad Compansoz Asrociato Companses of o Compony

Move Companies l

1) Held down Ctrl key and click multiple entries.
2) Move the entries to a specified category from drop-down list.
3) Click Move Companies.

Other Method

1) Held down Ctrl key and click multiple entries.
2) Drag the multiple entries to another category with mouse.

Step 2

' Are you sure you want to move the selected companies to the
category: Client Track Personal clients

Click Yes tc confirm moving contacts in pop-up.

Step 3

&) Address Book

= & hent Track
MEvoy, Amands
Moderos, Jazon

= &) (Bent Track Business clien

= £) Chent Track Personal chient

= 83 Sample Bectric Company Uimted
BT A Dares D,

® APARTC
« & cea
82 Ovitadie Corp.
&3 Blectriz Company Corp.

Verify that selected entries have been moved to selected category.

230



» Preferences

Step 1

m Tools Custom Tasks Users Support

Change Working Province
Change Working Year
Change Your Company Infermation

Auto-Notification
Edit Auto-Notification Template Comments

Change Background

l Preferences

R In menu, go to Edit = Preferences

Step 2

Preferences =)

[ DocMerge | AppicationFiles |  Task Options |
f Pop Ups ] Warnings T Address Book I Display Names T
Fields T Email T Custom Fields T Genesal Oplions |

-~ Highlight Field Background
IV Highlight the cuirent data field backarourd on focus.

Highlight Background Colour: [~ -]

Enter Field Options

Select your data entry style by choosing how you want the field
infarmation to be selected when you enter 3 data field,

€ Highlight whote figld @ Place cursor where you clck

~ Auto Format Text

W Check this box to have Client Track automatically foimat test
such as 2ip/postal codes and phone numbers.

Cancel | ok

1) Select on a preference tab and customize is needed.
2) Click Ok to save changes.
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Document Merge

' » Create New Merge

Step 1

Create Doc

R In Business Clients, go to = Create Doc (icon)
Step 2

Tla Merge Document

Choose Type Of Merge Document You Want To Create Or Open

Companies I Contacts I Tacks T Apponiments

[# New Company Merge Doc [use Defauk Contact)
[~ New Compary Merge Doc [use Specified Contacts)

Click The Document You Want To Open

Apology to Clent Letter.ctb
Audk Waiver.ctd

Open an eastng template
document by selecting &
from Est on ledl side.

Select New Company Merge Doc to begin merging a new document.

Step 3

42" Client Track
m Edit Tools Custom Tasks
New Data File
Open Data File
Save Data File As

Import Clients' Information  »
Synchronize with MS Outlock

R From menu, go to File > Save Data File As
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b‘* Save file as E5)

OO | . « Template Documents » - I 44 || Seorch )
Favorite Linke Nome Date token Tags Size »
l? Dcurnets 1. Personal Tax Clients E
¥ i . Sample Beauty Salen
1. Sample Charitable Organization
Folders V|, Sample Electric Company Limited

1. Template Docume » | Sample Home Builder Ltd
. Personal Tax Clic . Sample Lawyers Office
l’e 'nn A’s Le "l‘ thead Door M. nrle
4. SempleCharitsb | Sample Printing Services
4. SampleBlecticC ) gumnte Roof Builder
4 SampleHomeB: ) o0 ote Tattoo Studio

4. Sample Lawyers « I Samofe Tnickinn € =~
File name: [ Letter - Raise I ~
Save as type: [Client Track Documents (*.ctv;*.ctb;* cte;*.ctt: " cta) ']
(= Hide Folders [ Save ] [ Concel |

1) Name the new doc merge template in File Name.
2) Click Save.

Step 4

«(Totays Quce. mrovenm & yyyyle

Doae oContact Full Names,

Place cursor inside the merge template document.

ERENENEE

85

' Insert Merge Insert Firm Insert Date Select Select Select Select
Field Field Field Companies Contacts Appointments Tasks
Insert Merge Fields | Select Information

To customize the fields in the merge template document, click on the merge tools
and select the fields from drop-down list.

Step 5

IeErEE R
' Insert Merge Insert Firm Insert Date Select Select Select Select

Field Field Field Companies Contacts Appointments Tasks
Insert Merge Fields ! Select Information

Click Create Merge Doc from Doc Merge toolbar.
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Chant Track

140 Colomrade RY., Sote 203
Neseun

Ot

K26 7RZ

May §, 2009

Cear Sarah Stybst

Verify the results for new merge.

» Merge Companies

Step 1
Create Doc
R In Business Clients, go to = Create Doc (icon)
Step 2
Merge Document =

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

N\

Companies ] Contacts T Tasks ] Appontments

™ New Company Meige Doc (use Defauk Contact)
[ New Company Meige Doc (use Specified Contacts)

Click The Document You Want To Open

Apclogy to Chent Leltes.ctb Open an existing template
Audt Waiver.ctb T document by selecting it
Business Introduction Lelter.ctb from list on left side.
Change Accountants foe Client clb

Clent Appreciation & Refenral.ctb =

(Callection | altes cth Browse For File Not In List

Change Templates Foldes Location

Select type of document to merge companies with.
Step 3

© Clent Track Pad - [Merge Dac Temmplate - Cellecticn Letter] =S gon =~
O Fle €& View lnset Foemat Toble Opfiors Wiedow Help

Document Merge | Emal Merge
= e £ & P BRE
2 & 49w 8 ;
NewDoc  MergeTypa  Inaest Nerge Issert Fem lrsert Date Salect Select Salect Select Creste  POristOscs SaveDecs Saveto Savete
[ Tie Field Companies Czetaces Agpoistmests Tazka | Merge ward
Insert Morge Fiolds Select Informaticn Save Your Nerge
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{omsl] v Taoma *0 sl szyu|F)dzmE|wn CiEEITS

Pierpe Doc Template - Collection Letter |I arx
Y T T ) ? ] ) 1" 2 13 “ E 1" 1"
g . L ] TereBogee st oonce R Bogteenllecsge Beaticn L T L | T e oo

«Your Company I ames

<Your Adosse
«Your Ctys, «¥our Provinces <Youw Postal Coder
P <Yeour Cffice Numbers

«Todays Cate, mmmm d, yyyyls
«Compary Names

wAddressy
«Cays. cProuncer «Pestd Cofon

& 5 "

Sectonl/1 | Paoedt | Ueet | Col) | 100% N | |
To customize the look of the template, click the Merge Template tab.

Step 4

B B B | FUE R

\
Insert Merge Insert Firm Insert Date i Select Select Select
Field Field Field | Companies | Contacts Appointments

Insert Merge Fields Select Information

Click Select Companies from Doc Merge toolbar.

|

Select
Tasks

3 Select Companies @Elg

Select the companies you would like to merge

Cancel | oK

1) Check off which companies to merge from Business Clients.
2) Click Ok.

Step 5
=N = o =
= =l | & B
Insert Merge Insert Firm Insert Date | Select Select Select Select
Field Field Field | Companies Contacts Appointments Tasks
Insert Merge Fields Select Information

Click Create Merge Doc from Doc Merge toolbar.
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'@ Merge Contacts

Step 1

Create Doc

R In Personal Clients, go to = Create Doc (icon)

Step 2

Merge Document

T '?, Merge Document

Choose Type Of Merge Document You Want To Create Or Open

Comparies I

[~ New Contact Merge Document

N\

T Tasks ] Appointments

Click The Document You Want To Open Open an existing template
: document by selecting it
T1 Engsgement Letler.cle Troen list on left side.
Tat Seasoncle
Browse For File Not In List
Change Templates Foldes Location

Cancel Wizard

Select type of document to merge contacts with.

Step 3

© Chert Track P - [Merge Doc Template - T1 Engagement Lester]
& Fle Ed2 View leset Formst Table Optioms Wisdow Help
Cocument Marge | Emadl Merge

I I = N S S e i I~ O ™

- - o
New Dot Marge Type  Insert Merge [nsent Fiem [asen Date Select Select Select Select Cremte vt Doty Save Oets Savete Saveln
Field Fieid et Companies Costacts Appommments Tarks | Marge Weed S0P
Insort Merge Ficlds Select Information Save Your Marge
[heomal] - Tohoms *+10 |8 Zu|FuFM 0 -1 EC
quvm-nwuml] 40 x
') Y T T . 3 . o r 2 0 L. ) S |
5 Woreterdioode |._-I B ...t?..'... R L iy .t...,.,.ll_,h L. SR S
-
=
e [

*Your Addrosse
wYour Otys, aYour Provincis «Your Postal Codas

i «Company Name»
- ~Addresse
2 «Cntys, «Provinces «Postal Codes
P «(Todays Date, mmmen d, yyyy)»
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i «Company Name»

- ~Addresse

«Citys, «Provinces sPostal Codes
«{Todays Date, mmmm d, yyyy)»

- Good ofternosn «Contact Nome Prefxe aContact Lost Nomes,
e You may inow that Canada CUstoms and Revenue AQency imposes pansities upen taxpayers,
< 303 upon S 23 LaK feturn preparers, for falkire 10 O3Rrve dun COre In FEPONting on Mome tax -
|- : b rrbediodie . elbronrichutte b e -
Sectonll | Poprli2 | Leed | (Col) | 100X N

To customize the lock of the template, click the Merge Template tab.

Step 4
NN (== = - [ = = [
=S5 EEEE R
Insert Merge Insert Firm Insert Date Select Select Select Select |
Field Field Field Companies| Contacts |Appointments Tasks
Insert Merge Fields | Select Information

Click Select Companies from Doc Merge toolbar.

By Select Contacts =] E

Select the contacts you would like to merge

/ Client Track Business clients
Client Track Personal clients
&) 2009

§ Samaiitan, Joan

€ Stylist, Sarah

Cancel oK

1) Check off which companies to merge from Personal Clients.
2) Click Ok.

Step 5
;\_‘ = =,\ == [ = [ s .
HEEEEREm R
Insert Merge Insert Firm Insert Date Select Select Select Select ||
Field Field Field |Companics Contacts Appointments Tasks
Insert Merge Fields | Select Information

Click Create Merge Doc from Doc Merge toolbar.

Merge Document Navigation? @@ Robent Drake E]@

Merge Doc Tempiate - T1 Engagement Letter  Merge Doc Results - T1 Engagement Letter |

5 RN RN - JSNPRN | JURPRUON VO | ST - SN : SUPTNNN | VNN | JUCTUN . VYOO L AP . MR | SCTROR |, JOPIN |\ BN L. OO |- A9
e - [y (3 Y [y [y (9 [y [y . L
- July 20, 2011
¥ Goed afteroon Drake,
& You may know that Canada Customs and Revenue Agency imposes penalties upon taxpayers,
and upon us as tax return preparers, for failure to observe due care in reporting on income tax

= returns. In order to ensure 3 clear understanding of our mutual responsibilities, we ask you to

E confirm the following arrangements.




A.

i We will prepare your 2011 personal income tax return from information you provide
3 to us. We will not audit, review or otherwise attempt to verify the data you submit,
& although we may ask for clarification of some of the information. The return will
: include the following statement “Prepared without audit from information supplied by
the taxpayer.”

.,

< "

Browse through the selected contacts from toolbar to view the merge results by
clicking the controls besides contact name.

”

» Merge Tasks

Step 1
Create Doc
R In Tasks, go to = Create Doc (icon)
Step 2
Merge Document |

-
Tl ‘i' ) Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

Comparies T Contacts T Tasks) Appointments

[~ MNew Iask Merge Document

Click The Document You Want To Open Open an existing template
document by selecting it
froen list on left side.

Browse For File Not In List

Change Templates Foldes Location
Cancel Wizard i
Select type of document to merge tasks with.
Step 3
© Chent Track Pad - [Merge Doc Template - Task - Need isformation from chent] ol o )
G Fle Ede View Jnsen Format Table Optors Wimdow Help =j&ix
Document Merge | Email Merge
@ =) =] =) [ Y1 )
& 2= o “ :ﬂ P v C' B @ P
NewDoc  Marge Type  Dnsert Merge lesat Fum fesent Dace Select Select Select Select Create PristOacs SaveOuds Save o Savete
Field bt Fald Comganas Costadty Agpamimants Tasks  Marge wont s
Insert Merge Fields Sefect information Save Your Merge
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o] v Tooms v10 vl Zy|F)uzmin v [ISEQY

= Ak Yok S maad ek g ..._.II - drx

(I ] 2 1 [ l“ e ». . { ) i " &, |‘6 a 0t n:l it A lé P

“ Your «Tazk Names & due 0n « Task Due Oate, mmmm d yyyyde. VR are mssing oitcal nformation that
W 10Qure from you I order t COgRTY th Task.

Plata 2700 10 G400 O 2l AR wark 3nd Nfoamation kted Delow 1o 20w o3 1 COMPRTe the retum,
= Information Required:

(o = J =

CSectonll | Pagell Leed  Col) | 100X { N

To customize the look of the template, click the Merge Template tab.

k Pad - [Merge Doc Template - |

& File Edit View Inset Format Toble Options Window Help
| Document Merge | Email Merge

NENRT NETNEINETN (B S -

NewDoc Marga Typa |Insart Marga Insert Firm Insert Date Salact Selact Saelact Salact
Il Fiald Fi Fiald | Companias C Appoi Tasks
|l 1 Insert Merge Fields |l Select Information |

[Normal) v Al ~v2 ~+|BZU|F)EzE|x
- Merge Doc Template | - Merge Emai Template |

To customize the fields in the document, click on the merge field tools.

Step 5
—,\ : = {5 =3 = T— “.
=5 B B8 H ® @0
Insert Merge Ins;t—ﬁm Insert Date Select Select Select Selact
Field Field Field Companies Contacts Appointments Tasks
Insert Merge Fields | Select Information B

Click Create Merge Doc from Doc Merge toolbar.

Merge Doc t Navigati @E Sample Beauty Salon El@

Merge Doc Template - Tazk - Need nformation from clent Merge|Doc Results - Task - Need Information from client |

=
% S SO (K _-l 1 & I?...-.L.‘J.' .." -2_ i . . . (L .." -'3 (1 & l'?....i:.l!?.......
Y
Sample Beauty Salon
256 Clook St.
= Nep2an, Ontzrio K2E 7680
Ph:
L
Dear Susan ,
“ Your & dueon. \Weare missing antical information that we require from you n order to complete this task.
B Please arrange to drop off 21 paper work and nformation ksted balow to allow us to complete the retum.
- Information Required: income Tax T4
& |« | m

Verify the merge results for tasks.
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: » Merge Appointments

Step 1
Create Doc
R In Appointments, go to = Create Doc (icon)
Step 2
Advenced Search (Appointments) ()
Seaich Main | Seschappoiniment Tme: |
[T Search by Appointment Name € Fird Appoirkeents in a1 dates
Find all sppomiments that contain folowing : " Find sppoirtinents o
! | =
[7 Search by Client R )
Fnd cnly apportments for the following chent " OIS
[ =] | -
[ Search by User Nome " Fird sppomtments on of beloce:
Find ol appoiniments fot the lolowing uses [ =]
[W l]  Fird sgpomiimants badwean
[T Search by Appointment Color [ ;I
Fnd all 2pponiments with the followng coloe. ol
—1 | =1

Cancel | Select Appointments |

Select type of appointment search to create document merge as shown above.

Merge Document s

-
Tl “. ,‘ Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

Comparies ] Contacts T Tasks Appointments!

[T New Appointment Merge Document

Click The Document You Want To Open

Clhent Annual Appontment. cla

Client Upcoming Appoirtment cta

Folow-up to Clent Appoiniment.cta Goen s esiting .
document by selecting it

from hist on left side.
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Change Templates Folde: Location

| I | anFaFieNotlnLisl| |

Cancel Wizard I

Select type of document to merge appeintments with.

{u.mwv-wmmnmomuwmm

| Document Merge | Email Merge

BN RCA TR IER e

New Doc | Merge Type | Insert Mug. [nsert Firmn Insert Date

Tasks J Merge
| lnsert Merge Fields Select In!

)

[Nomal] v | Add v 12 v|azg|®;;.|1oox'
| Merge Doc Template - Client Upcoming Appointment |

To customize the lock of the template, click the Merge Doc Template tab.

anmmwmmmnueomuwmwp

_[ Document Merge l Email Merge

@Ill'm 8 G

Ncnoec J Marge Type |Insart Marga Insart Firm Insart Date sdaet o sdoet Salact

Fiald Tasks
Insert Merge Fields Select Infonnahon (

[Neemal) v sl v 12 v]B!!l@]i.l'ﬁ
- Merge Doc Template | - Merge Emad Tempiate |

To customize the fields in the document, click on the merge field tools.

le.saewv-umm'rmomwmmp

JDocument Merge | Email Merge

Merge Type | Insert Mm launﬁm lnun Date

RN e ST

| Create
Tasks | Marge
Insert Menge Fields Select Information J
(Nomal] | b v2 ~|B 7 U|E)W ¥ =00 -

Hmeooc'l’emphte-dmtllmilomml

Click Create Merge Doc from Doc Merge toolbar.
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© Chert Track Pad - [Mesge Dac Template - Chent Upcoming Appomntesent] oD
S fle (3t View lecen formae Table Optiors Window Melp -|®ix
Document Merge | Emad Merge

LIS ST S I U - o

NewDic  MergeTrpe  InsenMerge IasecFiom [aretOste Select  Select Seect  Select Creste  PristDecs Swve Osce Swvete Sevats
Fald Fuke Feld Companes Coatacts Azpowomests Tasks  Merge it
Insert Merge Fields Select Information Save Your Merge

Noms] v Aw -2 'lll!!m'li-’W%'EE':’[BQ

Herpe Doc date - Chont l 4 x

2 J T 9 ) L] » & ) At o3 19 1 19 B At Y

. ] T e .r atoulleite f. |l:l B e R e e L L
- ;
- Dt Track

148 Colornade R2., Suke 203

‘3 Nepean, Ontaro K26 782

Y. Ph:

':: Samgle Bessty Salon

Saah Stydst

< 111 Hadley Hollow

H Calgary, AB ATA 121

K Dear Saeah Styst

i R's tree for your ansual revew 30portmeet, As you inow, @t Clert Track cur purpose is to help
. achieve thew Snancial goals We accomplish this by prowding the highest level of professionaiym -
- 2 s haers 108 alh wmohand o cuw shant ralwtone hoe -4

« " »

Sactoel Poged/l  Leet Cod 1w Num

Verify the merge results for appeintments.

» Insert Merge Field

Step 1

Create Doc

From Client Track sidebar menu, select a section and click Create Doc icon.

Step 2

Merge Document =2

t I—P, Merge Document

Choose Type Of Merge Document You Want To Create Or Open

N\

Companies ] Contacts T Tasks T Appontments

[~ New Company Metge Doc (use Defauk Contact)
[T Mew Company Meige Doc (use Specified Contacts)

Click The Document You Want To Open

Apclogy to Chent Leltes.ctb -~
Sudit Waiver.cth =

Select type of document to merge with from one of the four tabs.

Step 3
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| Document Merge | Email Merge

[_'\

)| 2
|

SebE

=]

New Dec | Merge Type
Field Field

i j [E—Inser UMergelEiekds .|

Nomaal (Company Address Info]
f ) Coerpany Name
- Merge Doc Template ! e Nowe
sl 0GRS Type
= el pdiess

e

=
L

Insert Merge |Insert Firm Insert Date

Field

B e
,s"'“f ps.loct | Selact s:l’okc: 3:::

Select lnfo;l'nation |

>

v 7 yu|FE)E & H| 0 ~

=

Click Insert Merge Field and select type of merge field from list.

Merge Field Name
Appointment Info
Appointment Name
Appcintment Date
Appointment Start Time

Appointment End Time

Text

Date

Time(h:Nn am/pm)

Time(h:Nn am/pm)

Bats Type

Client Appointment
Jan 31, 2009
S:00 AM

9:30 AM

Appointment Text Text Client Appointment
Task Info

Task Name Text ist Quarterly GST Payment
Task Due Date Date Dec 23, 2011
Task In-House Due Date Date Dec 15, 2011
Task Weekday Due Date Date Dec 15, 2011
Employee Assigned Text Ms.Accountant
Task Year Text 2011

Task Date Date Dec 23, 2011
Task Start Time Time(h:Nn am/pm) 9:00 AM

Task End Time Time(h:Nn am/pm) 9:30 AM

Task Text Text Sample Task
Task Type Text HST
Amount Paid Text $123.50
Completed By Text Chris Counter
Date Completed Date 12/28/2011
Custom Task Field 1 Text Custom Task Info 1
Custom Task Field 2 Text Custom Task Info 2
Custom Task Field 3 Text Custom Task Info 3
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Custom Task Field 4 Text Custom Task Info 4
Custom Task Field 5 Text Custom Task Info 5

Time Entry Info

Time Entry Name Text CIGH

Time Entry Date Date Dec 18, 2011
Time Entry Start Time Time(h:Nn am/pm) 9:00 AM
Time Entry End Time Time(h:Nn am/pm) 9:30 AM
Time Entry Text Text Sample Time Entry

Company Address Info

Company Name Text Client Track
Corporate Name Text Trilobyte Solutions Inc.
Company Type Text Corporation
Industry Type Text Software
Address Text 148 Colonnade Rd. South
City Text Nepean
Province Text Ontario

Postal Code Text K2E 7R4
Country Text Canada

Office Number Text 1-866-423-8525

Fax Number Text (613) 688-2962
Email Text inquiries@clienttrack.ca
Web Site Text www.ClientTrack.ca
Supervising Partner Text Susan Partner
Managing Accountant Text John Accountant
Custom Task Field 1 Text Company Custom Info 1
Custom Task Field 2 Text Company Custom Info 2
Custom Task Field 3 Text Company Custom Info 3
Custom Task Field 4 Text Company Custom Info 4
Custom Task Field 5 Text Company Custom Infc S

Contact Name

Contact Full Name Text Isabella Daniels
Contact Name Prefix Text Mrs.
Contact First Name Text Isabella
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Contact Last Name Text Daniels
Contact Name Suffix Text CMA

Company Accounting Info

GST Number Text 19284375RT
PST Number Text 18274375
Payroll Registered As Text 1827455 Ontaric Corp.
Year End Date Date 12/31/2011
Corp. Tax Number Text 198475
Quebec ID Number Text 94837284
ON Corp. MCBS Number Text 94837284
Incerporation Date Date Dec 7, 2011
Charitable Number Text 3828374
NEQ Number Text 3829394
WCB Number Text 3829394
WSIB Number Text 19283743
WCB Premium Rate Text $2.98
WCB Coverage Text $50

EHT Number Text 3948483
EHT Premium Rate Text $5.98
Name Renewal Date Date 10/24/2011
Law Society Member Number Text 39348457473
Custom Task Field 1 Text Custom Info 1
Custom Task Field 2 Text Custom Info 2
Custom Task Field 3 Text Custom Infe 3
Custom Task Field 4 Text Custom Info 4
Custom Task Field 5 Text Custom Info 5

Company Software Info

Software Name Text Simply Accounting 2011
Software Serial Number Text SJIF8 4JHF D13
Software Version Text Pro

Software Account Number Text DR 459685

Data File Saved As Text C:\Data\Client Data.cft
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More Contact Info
Contact SIN

Contact Employee Type

Contact Percentage
Ownership

Contact Business Name

Contact Job Title

Contact Business Department

Contact Business Office

Contact Business Phone
Contact Business Cell
Contact Business Pager
Contact Business Fax
Contact Business Address
Contact Business City

Contact Business Province

Contact Business Postal Code

Contact Business Country
Contact Business Web Site
Contact Business Email
Contact Personal Email
Contact Personal Phone
Contact Personal Cell
Contact Personal Pager
Contact Personal Fax
Contact Home Address
Contact Home City
Contact Home Province
Contact Home Postal Code
Contact Home Country
Contact Personal Web Site
Contact Children

Contact Gender

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

268 630 056
Full-Time
100%
Client Track
Vice-President
Software

Office 210

1-866-423-8525
(613) 853-1009
(613) 853-5643
(613) 688-2962
101 Industrial Dr.
Nepean
Ontario
K2E 7R4
Canada
www.ClientTrack.ca
business@email.com
personal@email.com
(613) 555-4938
(613) 555-1034
(613) 555-9875
(613) 555-9254
101 Finchley St.
Ottawa
Ontario
K2F 2T4
Canada
www.ClientTrack.ca
Erin Daniels

Female

246



Contact Birthday

Contact Anniversary

Contact Spoken Language

Contact Maritial Status
Contact Custom Field 1
Contact Custom Field 2
Contact Custom Field 3
Contact Custom Field 4
Contact Custom Field 5
Spouse Name Prefix
Spouse First Name
Spouse Middle Name
Spouse Last Name
Spouse Name Suffix
Spouse Full Name
Spouse Personal Email
Spouse Home Phone
Spouse Personal Cell
Spouse Home Address
Spouse Home City

Spouse Home Province

Spouse Home Postal Code

Spouse Home Country
Spouse Gender
Spouse Birthday

Spouse SIN

'@ Insert Firm Field

Date

Date

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

Text

June 25, 1951
April 25, 1975
English
Married
Contact Info 1
Contact Info 2
Contact Info 3
Contact Infoc 4
Contact Info 5
Mr.

John
Henry
Daniels
Jr.

John Daniels
jdaniels@email.com
(613) 555-4954
(613) 555-9812
101 Finchley St.
Ottawa
Ontaric
K2F 274
Canada
Male
April 29, 1950

367 845 147

Step 1

Create Doc

From Client Track sidebar menu, select a section and click Create Doc icon.
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Step 2

@ Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

N\

Companies T Contacts T Tasks T Appontments

[~ New Company Mesge Doc (use Defauk Contact)
[~ New Company Meige Doc (use Specified Contacts)

Click The Document You Want To Open

Apalogy to Chent Leltes.ctb

Audt Waiver.ctb

Step 3

&5 File Edit View Inset Format Table Options Window Help

JBbéumént Merge | Email Merge

Bl A RENRER R e e S !

Naw Doc  Marge Type lau&ﬁﬂgo lnionﬁm Insert Data Salact Selact Selact Salact
Fiald Fiald Fiald (= ies C Appoil Tasks

] Insert Merge Fields | Select Information J
[Norma) v Aol 2 ~|B 7 Uu|F)EzE|x
- Merge Doc Template | -Megeanal‘l’amlatel

Click Insert Firm Field and select type of firm field from list.

Your Company Name Text Client Track
Your Corporate Name Text Trilobyte Solutions Inc.
Your Company Type Text Corporation

Your Industry Type Text Software

Your Address Text 148 Colonnade Rd. South
Your City Text Nepean

Your Province Text Ontario

Your Postal Code Text K2E 7R4

Your Country Text Canada

Your Office Number Text 1-866-423-8525
Your Fax Number Text (613) 688-2962
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Your Email Text inquiries@clienttrack.ca

Your Web Site Text www.ClientTrack.ca

Your Company Custom Field 1 Text Company Custom Info 1
Your Company Custom Field 2 Text Company Custem Info 2
Your Company Custom Field 3 Text Company Custoem Info 3
Your Company Custom Field 4 Text Company Custem Info 4
Your Company Custom Field S Text Company Custem Info 5

» Insert Date Field

Step 1

Create Doc
From Client Track sidebar menu, select a section and click Create Doc icon.
Step 2
Merge Document i

A
| Merge Document

Switch to MS Word Merge

Choose Type Of Merge Document You Want To Create Or Open

Companies ] Contacts T Tasks ] Appontments

[~ New Company Merge Doc (use Defauk Contact)
[ New Company Meige Doc (use Specified Contacts)

Click The Document You Want To Open

| Apclogy to Chent Leltes.ctb -~
Sudit Waiver.cth A

Select type of document to merge with under chosen doc merge type tab.
Step 3
© Client Track Pad

G File Edit View Inset Format Table Options Window Help
Document Merge = Email Merge

Y 1 = - — ?' 0) 3 Q
Ly - & G »
NewDoc  Marge Type | InsertMerge I[nsert Firm |Ingert Date Select Select Select Select  Create
Field Fleld Field Companies Contacts Agpointments Tasks Merge
Insert Merge Fields Select Information
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>

[Normal] Frday, Jaruaty 14 2011 = "
|F|'%JMEMZDH = /B 7 U |®‘ ¥ H|00% v

I aruaty 14 2011 %

[V Bl B a0 14 201 A menemtertoie B BB

142011 L [y
| ﬂlﬂlll

Click Insert Date Field and select type of date field from list.

Date Field Example Date Field String

Monday, December 8 2011 <<(Tedays Date, dddd, mmmm d yyyy)>>
Monday December 8 2011 <<(Todays Date, dddd mmmm d yyyy)==>
December 8, 2011 <<(Todays Date, mmmm d, yyyy)==>
December 8 2011 <<(Todays Date, mmmm d yyyy)=>
Dec 8 2011 <<(Todays Date, mmm d yyyy)>>
08/12/11 <<(Todays Date, dd/mm/yy)=>=>
12/08/11 <<(Todays Date, mm/dd/yy)=>>

8 <<(Todays Date, d)>>

Monday <<(Todays Date, dddd)=>
December <<(Todays Date, mmmm)>=>

Dec <<(Todays Date, mmm)=>=>

2011 <<(Todays Date, yyyy)>>
December 2011 <<(Todays Date, mmmm yyyy)>>
December 8 <<(Todays Date, mmmm d)>>

Labels

» For Companies

Step 1

File Edit lTooIs] Custom Services Reports Users Support

Create Labels » Create Labels for Companies
Create Document Create Labels for Contacts
Address Book Create Labels for Personal Tax Clients

Create Return Labels for your Firm

Calculator

R In menu, go to Tools = Create Labels > ...for Companies
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Step 2

TR r—— ]

Label Wizard

= | Label Wizard

This wizard allows you to quickly create mailing labels for your clients.
Select Clients You Would Like To Create Labels For:

= l &J/ Client Track Business clients

-1 []83 Sample Beauty Salon |

i--[]83 Sample Charitable Organization
-[]82 Sample Electric Company Limited
i+ []82 Sample Home Builder Ltd.
-[]82 Sample Lawyers Office
-[]82 Sample Overhead Door Manufacturer
i~-[]82 Sample Printing Services
(183 Sample Roof Bulder

i-[]83 Sample Tattoo Studio

“-[[]82 Sample Trucking Company

Cancel | <Back - Select Comparies | Nest> Einish

1) Select which companies from list to create labels for.
2) Click Next.

Step 3

Label Wizard

= Label Wizard

Enter Number of Labels You Want To Print For Each Company:

Company Name No. of Labels

Fill Label Sheet Change All Quantities Above To: I 5

Open A Saved Label Scheme
| cboSavedScheme | Deete

Avery 5361 - Identification card Labels

{ Select Your Label Type

Cancel | <§ack-$elect0anpaies] Mea> |  Einish ]

1) Insert number of labels by under No. of Labels category.
2) To choose type of label different from default, click Select Label.
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i~ Printer Type
(¢ Laser andInk Jet " Dot Mati

Label Manufacturer: v

Label Details

Type: Address
Hesght: 1
Width: 4
Page Size: Letter

Cancel I Custom Label 0Ok

1) Select type of printer, label manufacturer and label from lists.
2) Click Ok to exit label type window.
Note: To create a custom label, click Custom Label and go to Step 4.

Step 4

Custom Label Maker

. = Custom Label Maker

Side Maigins
Top Marain |l' ——Horizontal Pitch———
’ i ] i Number
Veitical Pitch | [ Widthr s

Heilght J

4

-

Number Across

All Measurements Are In Inches

TopMagn: [5 VerPitch [T Height [T No.Acwoss: [3°
SidceMaign: [13~  HomPich [25  Widh [25°  No.Oown: [9—

Custom Label Name: I

Cancel | Ok I

1) Enter in dimensions of custom label and create name.
2) Click Ok.
3) Click Next tc continue on and go to Step 5. 559




Step 5

P

5% | Label Wizard

onononnn =]=]=]=

Insert dient field here ~

Company Address Info l_——j
<<Company Name>> E;omp,,nyymm ]
<<Address>> Corporate Name
<<City>>, <<Province>> <4Company Type

Industry Type
Address %

™ Do you want any multiple-line data values to be displayed as muliple lines? Test I

Cancel | <am-smcm:m] Next > | Finish |

1) Customize what informaticn to appear on label by placing the cursor on a specific
place in the template and inserting client fields from drop-down menu
2) Click Finish to complete the label process.

Optional: To create return labels, click Next and follow Step 6 below.

Step 6

= | Label Wizard

- Return Labels -
W DoYouWant To Pirt Relurn Labels? I checked, enter number of refurn labels.

Number Of Return Labels: l 5 Edit Labels I

~ Stat Label

You can ndicate the row and column of the fiist label you want to stait pirting on # pou
are uging a label theet with some uppet labels removed.

Row: [T Cohwe [1

~ Save Label Scheme

| Save I
Cancel l ¢Bock-SelectComparies | New> | Finish

1) Check off Do you want to print return labels? and type no. of return labels.
2) Decide where the labels will start for printing under Start Label.
3) Optional: To save settings for label, type in name and click Save under
Save Label Scheme.
4) Click Edit Labels.

253



Label Wizard

5 | Label Wizard

Format Retuin Labels

Qnooan ~H=1=1=1=

Client Track
148 Colonnade Rd. South
Nepean, Ontario K2E 7R4

Cancel | <Back-Select Conpaeine [l Next> s |

1) Customize what information to appear on return label by placing the cursor on
a specific place in the template and using the text tools from toclbar

2) Click Finish.

3) Click Finish to exit label wizard

' » For Contacts

Step 1

File Edit |Too|s| Custom Services Reports Users Support

Create Labels 4 ' Create Labels for Companies
Create Document | Create Labels for Contacts
Address Book Create Labels for Personal Tax Clients

Calcalatos Create Return Labels for your Firm

R In menu, go to Tools = Create Labels = ...for Contacts

Step 2

Label Wizard

| Label Wizard

This wizard allows you to quickly create mailing labels for your clients.
Select Clients You Would Like To Create Labels For:

= [V]1&¥ Client Track

-4 8 McEvoy, Amanda
-..[v] & Samaritan, Jason
(= [1& Client Track Business clients
= []82 Sample Beauty Salon

[ stylist, Sarsh
-[182 Sample Charitable Organization

¢ [ Mederos, Joan
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=-[]182 Sample Electric Company Limited
. ~[]3 Electridan, Eric
- [[]82 Sample Trucking Company

Cancel | <gack-5eceat:oaunses| Newt> Einish

1) Select which contacts from list to create labels for.
2) Click Next.

Step 3

Follow Steps 3-6 in How to Create Labels for Companies.

» For Personal Tax Clients

Step 1

File Edit |Too|s| Custom Services Reports Users Support

Create Labels 4 Create Labels for Companies

Create Document Create Labels for Contacts

Address Book [ Create Labels for Personal Tax Clients
Calculator I Create Return Labels for your Firm

R In menu, go to Tools = Create Labels - ...for Personal Tax Clients

Step 2

Label Wizard

= | Label Wizard

This wizard allows you to quickly create mailing labels for your clients.
Select Clients You Would Like To Create Labels For:

[ 8 eulder Ltd., Sample
—M8 suider L1d., Sample
V18 euilder, Sample

Cancel I < Back - Select Companies Next > Einish

1) Select which personal tax clients from list to create labels for.
2) Click Next.

Step 3

Follow Steps 3-6 in How to Create Labels for Companies.
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" ® For Returns

Step 1
File Edit [ Tools ] Custom Services Reports Users Support
! ' Create Labels 4 Create Labels for Companies
Create Document Create Labels for Contacts
Address Book Create Labels for Personal Tax Clients
Calcudaton Create Return Labels for your Firm

3 In menuy, go to Tools = Create Labels = ...Return Labels for firm

Step 2

Label Wizard

: g Label Wizard

Enter Number of Labels You Want To Print For Each Company:

Fill Label Sheet | Change All Quantities Above To: I 5

Open A Saved Label Scheme
| cboSavedScheme ~v| Delete

- Select Your Label Type

Avesy 5361 - [dentification card Labels
2'%325") Select Label |

Cancel <§ad<-$ebctCompan’es| Newt> | Finikh |

1) Insert number of return labels under No. of Labels category.
2) To choose type of label different from default, click Select Label.

Label Type

+

Label Type

~ Printer Type
(¢ Laserandink Jet " Dot Matix

Label Manufacturer: -
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Label Details

Type: Address
Height: 1
Width: 4

Page Size: Letter

Cancel l Custom Label Ok

1) Select type of printer, label manufacturer and label from lists.

2) Click Ok to exit label type window.
Note: To create a custom label, click Custom Label and go to Step 4.

Step 3

Custom Label Maker

% Custom Label Maker

Side Margins
Top Margin 4 —Horizontal Pitch——
j f [ Number
Veitical Pitch | [ Width—— o
Height
f i
Nurmbet Across

All Measurements Are In Inches

Top Margn: l5_ Ver.Pitch: |1_ Height; II_ No. &cross: ’3_
SideMargn: [13  HozPitch: [25  Widh: IH No. Down: IT

Custom Label Name: I

Cancel | Ok I

1) Enter in dimensions of custom label and create name.

2) Click Ok.
3) Click Next to continue on and go to Step 5.

Step 4

Label Wizard

= | Label Wizard

Format Return Labels
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Format Return Labels

gnnooaon ~l=1=1=1=

Client Track
148 Colonnade Rd. South
Nepean, Ontario K2E 7R4

Cancel | CRack - Selsct Companios ||| Nest Fmish |

1) Customize what information to appear on label by placing the curser on a specific
place in the template and inserting client fields from drop-down menu
2) Click Finish tc complete the label process.

Step 5

= | Label Wizard

Start Label

You can rnckcate the row and column of the list label you want to stait prrting on # you
ae using a label sheel wih some uppet labels removed.

Row: [1 Cohwe [1

Save Label Scheme

| JLC Designs Inc. Save I

Cancel ¢Bock-SelectCompavies | New> | Finish

1) Decide where the labels will start for printing under Start Label.

2) Optional: To save settings for label, type in name and click Save under
Save Label Scheme.

3) Click Finish.
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' ® Create Reports for Business Clients
Step 1
#2* Client Track

File Edit Tools Custom Services Reports
[P —
Business Clients

Users Support

Sample Beauty Salon

() <](>] (o8]

Bookkeeping PST

More Info

I Client Info Projects

: Client Status: Active - Sample Client
Client Info

Client Information

»I» s 1 Company Name: Sample Beauty Salon
» W Corporate Name: Beauty Salon Corp.
Company Type: Corporation

Industry Type: Retail

Find Client

1) Click the Client Info icon under Business Clients section in sidebar.
2) Select a business client to do report on by using the controls as shown above.

Step 2

R In Business Clients, go to = Reports (icon)
or

29+ Client Track

File Edit Tools Custom Services lReports] Users Support
Business Clients

Client Info

Report Wizard

| Business Client Reports |
Personal Tax Client Reports
Client Status: Active - Sample Client

R In menu, go to Reports = Business Client Reports

Step 3
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Client Reports

Client Reports for Sample Electric Company

Client Information Reports

Client report which shows client
addiess and mportant infaemation

* Client Details (1 page)
Client teport which shows most of the
clent's address and accounting
wfoimation.

" Client Details (2 pages)
Client teport which shows &l of the

clent's address and accounting
irfoimalion and notes.

(" Company Information
Company repait which shows all the
infoimation entered in the Edit
Caompany' section.

" Default Contact Information

Cortact teport which shows 3l of the
nfoimation entered foe the default
contact

Other Client Reports

The Client Track Reports Wizaed has many
other uselul repoets. Click the oplions below
to jump to common repart options.
" Time and Billing Repoits
" Accounts Receivable Reports
(" Customer Outstanding AR
" Customer Aged Summaries
" WIP Repoits
" Employee Time Sheet Reports
" Client Reports
" Client Name & Address Lists
" Other Client List Reports
" Task List Repoits
" Task By Client
" Task By Employee
(" Task By Date
" Client Services List Reports
(" Client Check List List Reports

Cancel
Select type of report for client under Client Information Reports.
&2 Company Information ﬁ

|£] Zoom [100¢ =

Sample Electric Company Limited

Company Information
[ Addressiaformaion ][ ConfactUiaformaton ]|
Business Name{Sampis Electric Company Limtes | Wain Phone|(705) S55-5508 |
Corporate Nome {Electric Company Corp ] Fax((705) S56-5644 i)
Business Type 1 | Emai| |
ncustry [Consiructon | Web Ste[Www Clentirack ca ]
Add 111 EssaRd
P.0.Box 111
Cey[Haifax |
Province[NS |
Postal Code|A1A 121 |
Counh{ I

poses W4T M| <]

1) Click the printer icon in menu to print report as shown above.

Zoom |1OU°/° v l
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£3 Export ]
| & B exEDr

Date modified -

Name_ Size Type

o
o
s,
o
1

j Public

Flename: |[clent information ba

=

Sove o5 type: |[ET MM -] | Cocel |
~ Paga Range
@ Al

" Pages lrom:'l totl

2) To export a business client report, click the document icon in menu.
3) Select save destination and save type from drop-down lists. Name the export

file and click Save.

" ® Create Reports for Personal Tax Clients

Step 1

49" Client Track
File Edit Tools

Custom Services Reports Users Support

Business Clients

Personal Clients

Client Info
&0\
- -’

Find Client

Samaritan, Joan

General
Info

Client Status: Active

Client Information

Name: Joan Samaritan
Associated Category: 2010
Business Information

(se)<)(>] (o8]

Employment :%nssnpon &

More Info

@)

Company Name: Sample Char#able Organization

1) Click the Client Info icon under Personal Clients section in sidebar.
2) Select a personal client to do report on by using the controls as shown above.

Step 2

R

In Personal Clients, go to > Reports (icon)

or
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#2: Client Track
File Edit Tools Custom Services |Reports| Users Support

Business Clients [ Samaritan, Jo
[ ——
Personal Clients

Report Wizard

Business Client Reports

Laeneral
info

| Personal Tax Client Reports |

@ Client Status: Active

Client Info Client Information 6

R In menu, go to Reports = Personal Tax Client Reports

Step 3

PmomlTuCﬁuuRzpom @
Client Reports for Joan Samaritan

Client Specific Reports General Personal Tax Reports

ey - pp——— The Clent Track Reports Wizard has mary other usehd
c E@[E}L@i‘!@ﬂt tepoits. Clck the oplicris below to jump 1o coremon
Chent repott which thows chant addiess and repoit options
contact nicemation
" Chent Documentation Required O/ ook Branode
Chent report wiich shows the documentation " Client Name & Address Lists
nicemabion tequated and tecarved lrom ke chard " Other Client List Reports
¢~ Client Income Tax Information " Chent Services List Reports

Request Forms " Chient Check List List Reports

The folowing are blank generic forms
1equatng persond ncome tax from the chert

" Detaled Infoemation Request Form
" Self Emplogment Information Form
" Mowing Expences Foim

" Rental Incoene Infoemation Foem

Cancel
Select type of report for client under Client Specific Reports.
Step 4
B3 Client Information

Bls] s < |

Joan Samaritan
Documents Required & Received
" Employment ]

>

[0 Employment Income . T4 [0 Workers Compensation - T5007

O 74 Recenves [0 75007 Receives

Date Received: |February 17, 2012 Date Recewved |: .
] commission Income - T4 [0 Taxable Benefit - Automobil

O T4 Received O Supperting Documantation Received

Y — N
[ other Income O Employment Deductions - T2200

O T4E Recewved O supperting Documentation Received
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Date Recewved: [Fedruary 17, 2012 eRecenes ]

[ employment Insurance - T4E [ Apprenticeship Tools
O T4 Received O supporting Documentation Recaived
Date Received Date Received :
Pages MIJT M| <] | i

1) Click the printer icon in menu to print report as shown above.

Zoom |1UUZ v I

~| & & ey EDr
Type Date modified

Flensme: | [summary_repot e | Save |
Save astype:| [Text (") =l Cancel |

~Page Range -
@ M

 Pages  lreen: |1 lo:|

2) To export a personal tax client report, click the document icon in menu.
3) Select save destination and save type from drop-down lists. Name the export
file and click Save.

» Create Reports for Tasks

22+ Client Track
File Edit Tools Custom Services Reports Users Support
Business Clients | Tasks List (246 tasks)

Personal Clients a E @ -'A |

Advanced | View/Hide | View/Print Tasks For Tasks For All Prior
Search Columns Report This Week This Month Unclosed Tasks

Tasks List [ LI

Chent Name " TaskMame  DueDae ~ Close | Employee Assig
Sample Printing Services  ClientYearEnd  Dec 31,12 [ None Assigned

All uncompleted tasks

Tasks Calend...

Sample Oveihead Door Client Year End Dec31,12 [ | MNoneAssigned

1) Click the Tasks List icon under Tasks section in sidebar.
2) Click Refresh List to update the tasks list for all clients.
3) Click View/Hide Columns from tasks menu bar as shown above.

Note: To print a specific type of tasks report, go to Step 2.
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~ Task Information Columns | [ Flag Information
™ Prioiity Rank P ™ Piodty Flag
Client ID [ I Missing Info Flag
~ g B [ PicblemFlag
2] T NotesFlag
™ Task Type B ™ OverdueFlag
0 Cdendu Dal.e. ~ Completed Information ——
[T Period Description A
. mount Due
[ Period End Date I Completed By
™ InHouse Due Date ™ Date Completed
o R ~ Company Information
; i:?;::::ﬂe [T Cosnpany Phone Number
 Notfiod ; Company Fax Number
™ Prepared Srpeytont

4) Check off which columns to appear on report and then click Ok.

Tasks List (246 tasks)

PERE 8

Advanced View/Hide | View/Print Tasks For  Tasks For All Prior
Search  Columns | Report This Week This Month Unclosed Tasks

i
All uncompleted tasks
Somple Printng Services Client Year End Dec31.12 As‘;’i';m
piomple Overheod Door | ClientYear End Dec31,12 ek
JSomple Electrc Compony | Nome Renewol (5 Years) | 0ct19.13 o T
Semple Trucking Comparty m7I°WEWW° Dec30.12 L"s‘;’.‘;m 4
Somple Root Buider g;mamea Dec30.12 2'5‘;':;1\@ ’
Somple Lawyers Offics g;”;,""”’e""‘w“ Dec30.12 L‘;’l‘;m d
Somple Home Builder Lid. Weekly Employee Poyroll | Dec 30,12 :sl;'il;ne d
Somple Lawyers Office 11th Trust Reconciliaton Dec 25,12 :’sg?; ot
<« v lﬂ

6) Skim through all the pages of the report to verify that all the columns for tasks
appears as well the tasks information for all clients.
7) Follow Step 4 on print and report options.
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Step 2

File Edit Tools Custom Services lReportsl Users Support
Business Clients | Tasks List (2{|  Report Wizard ]

~ Personal Clients Business Client Reports
Personal Tax Client Reports

Advanced View/Hide View/Print Tasks For  Tasks
Search Columns Report This Week This M

Tasks L'ist l = @

R ‘ In menu, go to Reports = Report Wizard

Step 3
Client Track Reports

&2 Time & Billing Oplions Reponts -
R Clert Regons HST
+ OBWMNM&MenUﬂRW:
&) &2 Personal Tax Mame & Address Clent List Re | | Generate Report
&2 Other Client List Reports
P e
B4 Tosk Qe € Find alasks crx
& &DT&RByEmpbyee chbxua:yLZO‘lZ d
= & TaskByDate K|
: Q g @& Find all lasks on ot befece:
% - Febiuary 17, 2012 ~]
1) Proiects by Date
a PST by Date " Find all tasks on ot Sfter:
a T4 & Surnmary by Date [Februa|y1.2012 ZI
1) TéAL Summay by Date € Find alltasks between:
O T5byDate i [Febuary 1. 2012 =]
1) Emplogee Payrollby Date and [February 29, 2012 =]
~D Lowbyose .

1) Click Task List Reports in list menu as shown above.

2) Click on a task type to create report for under Task by Client, Employee
or by Date by clicking on the plus (+) sign.

3) Select type of task date search and click Generate Report.
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Task Reports

HST

Results on or before February 17, 2012

Client Name Name in-House Due Date Due Date

pample OverheadDoor 15t Quarterly HST Return | Jan 28, 2012 Jan 31,2012

Sample Trucking Company 15t Quarterly HST Return | Jan 28, 2012 Jan 31,2012

Sample Printng Services 1st Quarterly HST Return | Jan 28, 2012 Jan 31,2012

fm Electric Company o) Quarterly HST Return | Jan 28, 2012 Jan 31,2012

Sample Lawyers Office  1st Quarterly HST Return | Jan 28, 2012 Jan 31,2012
GSTHST Returns Jan 31,2012 Feb 3,2012

[ i WTAW&M_&MM!—M_&LM—EOF_&M’_ 5 I -

4) Skim through all the pages of the report to verify all tasks information.

5) Follow Step 4 on print and report options.

Step 4

Select defaud page onentation of the report when it is first displayed:
 Portat ¢ Landscape ¢ SizetoFit

~Report Maig *
!
Top: [i [ RepottLayout || Colors/Grid |
A ook ~ Title Bar Background Color
e Title Bar Background Color: [~ ] ~]  Tile Bar Font Coloe: [ +|
¥ Show Co
© SWC‘T -~ Grid Colors
Header L Header Background Color: [[JN.~]  Header Fort Color [N ~|
Main Giid | GridBackground Color: [~ <] Grid Fort Coloc: [N~
~ Report Alternating Grid Lines
V' Show Alteinating Gad Line Colors In Report
_Jc‘""’" Arernating Coloe 1: [ <]

Reset to Defaut

" Ademating Caloc 2 [ 1 <]
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| ¥ Show 'Date Generated On Repot ¥ Show Page Numbers On The Report |

Caull Ok I

2) Click the Report Layout tab to customize the layout settings for report.
Repeat same for the Colors/Grid tab.
3) Click Ok to save settings.

Page Setup

~ Paper Size [ Inches )

Paper Size: [ RBEN D)
Paper Vidth: lll Paper Height: |8.5
~ Orientation Margins ( Inches )

€ Portrait Leit [063 Right [063
@ Landscape Top [083  Bodom [063

Cbael Okl

5) Select paper size, orientation, margins and then click Ok.

7) Click Print from main menu.
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» Create Reports for Time & Billing

Step 1

22+ Client Track
File Edt Tools Custom Services Reports Users Support
Business Clients

Time Entries List (4 Time Entries)

HE & @ ¢ 4

Soorch Time | View/Hide |View/Print | Seloct Add Selected Time Add Selocted Timo | Mark Up/Down wme
Reoport Chiont  To Now Invoice  To Existing Imvoico | Timo Entries

All time entries for the dates between Wednesd

Wednesday. February 28,
Sclectal | Changs Selected Statuz To... |
BaTo | Tiwe EchiyName | Tieoe Erdiy Stahus
Sample Homa Bulder Lid. Proposal Inveiced
Sample Beaudy Sakon Pagrol Woek n Progress
Sample Tattoo Studio Scarcing Intensd]  Week in Progress
Sample Chadtable Organiz... Paycol Woek in Progress

1) Click the Tasks List icon under Time & Billing section in sidebar.
2) Click Refresh List to update the time entries list for all clients.
3) Click View/Hide Columns from time & billing menu bar as shown above.

Note: To print a specific type of time & billing report, go to Step 2.

View/Hide Columns ==
View/Hide Columns
N

~Flag Information ——— ~Date & Time Columns

& I TineEntry Locked W Tite Eriy Date

D I Alocated toInvaice ¥ St Time

£J T NotesFlag WV End Time
' ¥ Total Time

~ Time Entty Information Columns
. ™ Rounded Stan Time

™ Billable Tine :
[~ Client Name rl: RomdedEndTw
™ 8ill To Cliert Rounded Total Time
™ Use Adjusted Time
W Time Entry Name ™ Adusted Time
¥ Time Entry Status [ Final Total Time
:___ Task Type ~ Billing Information Columns
Work Code -
W Tirme Entry Biling T
™ Employee Name ri g ape

W Time Erty Biling Rate
™ Real Tolal Amount

V' Date Time Enty Created

4) Check off which columns to appear on report and then click Ok.

Time Entries List (4 Time Entries)

A& o @

Search Time View/Hlide | View/Print|| Select Add Selected Time Add Selected Time
Entries Columns Report Client  To New Invoice  To Existing Involce

5) Check View/Print Report from time & billing menu. 268



Client Track Report: Time Entry List

All time entries for the dates between Wednesday, February 1, 2012 and Wednesday, February...

- Fmal
Time Entry Time Entry Date Total I ¢
Name Status / » Vpe Bdling Amount || (Chent)

(imemal) Pogess | 12 | 12 | om | pem | ms| Rew $45.00 ”“’“‘1
Work in Jond0. | Febl | 800 | 1200 4 Hourly | Bookkeapern - |,

Peyrol Progress 12 12 om pen | s | Re $65.00 '250'“1
. : Jon30.| Fedl. | 1:00 400 3 Hourly GDasign- |,

Proposal Inoiced 12 12 | pm | pn | ws| Rew sss00 | 1350

6) Skim through all the pages of the report to verify that all the columns for time
& billing appears as well the time entries information for all clients.
7) Follow Step 4 on print and report options.

Step 2

File Edit Tools Custom Services Reports| Users Support

| Report Wizard
Business Client Reports

 Business Clients
Personal Clients s
Tasks Personal Tax Client Reports

Time &Billing |

m Client Track Reports

)

L2 Time and Biling Repots | -~
&3 Accounts Receivabis Repaits
= &3 WP Repons WIP Summary for All

WP Summary for Al Business Chents |
VAP Summary for Al Pessonal Tax Clents Generate Report

VAP Employee Summary for All Business Clients
VAP Employee Sumenaey for All Personal Tax Chante
VAP Detad for o specific Business Clent

VAP Detal for a specific Personal Tax Chent

(Bl ivivivie]
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| B &2 Emplopee Time Sheet Repeas

|€3MROMS

&2 Business Cient Name & Address List Repotts
&2 Personal Tax Name & Address Cient Lit Repots
[ &2 Other Clent List Reports

« M

|
{

1) Click Time and Billing Reports in list menu as shown above.

2) Click on a billing type to create report for under Accounts Receivable,
WIP, Employee Time Sheet or by Time & Billing options by clicking on

the plus (+) sign.
3) Click Generate Report.

WIP Reports ‘J
WIP Summary for All Business Clients
WIP summary for all Companies | |
Client Name SubTotal WIP Total Taxes
Sample Beauty Salon $90.00 $0.00
Sample Charitable Organization §260.00 $0.00
Sample Electric Company Limited $90.00 $0.00
Sample Lawyers Office $210.00 $0.00
Sample Tattoo Studio $90.00 $0.00
Grand Totat $740.00
‘ —y

4) Skim through all the pages of the report to verify all billing information.

S) Follow Step 4 on print and report options.

Step 4

1) In report previewer for tasks, click Report Settings from main menu.
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Report Layout|| Colrs/Gid |
- Report Orientation

Select defaul page crientation of the report when iLis first displayed
€ Potist Landscape  Sizetofi

|
!
‘ ~Report Marg R
|

| thf, [ ReportLayout || Colors/Grid |
‘ — | | Titte Bar Background Color
\ ’M| Tie Bar Background Color: [~ ] +|  Thle Bar Font Coler: [~ <

¥ ShowCo
‘ v smc@; -~ Grid Colors
| Header Header Background Color: [JJ~]  Header Fort Color: [N ~)
( Main Giid L GridBackground Color: [~ ~]  Giid For Color: [N~
| ~ Report Alternating Grid Lines
| V' Show Altemating Gd Line Colors In Report
: _Jc‘"”' ARemating Colox 1:

Ademating Caloe 2 [ 1 <] Reset to Defondt
WV Show 'Date Generated On Report & Show Page Numbers On The Report

ﬁ] 7#]\

2) Click the Report Layout tab to customize the layout settings for report.
Repeat same for the Colors/Grid tab.
3) Click Ok to save settings.

- Paper Size [ Inches )
Pepersice. [ETTEETEIE TR |
PaperVidh: [T PaperHeiht [85
-~ Orientation Margins ( Inches )
€ Podrait Let [063  Right [083
@ Landsoape Top: [063  Botom [063
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Close I Ok |

5) Select paper size, orientation, margins and then click Ok.

B3 Client Track Report Previewer
—~ — — S o N N\ N\
5P| 88 | 2¢) < ‘
5’ y ‘ = | § | 11 2
Print Page Colour Options | Report First Previous Next Last
Sottings IP"* in Colo .,l Settings Page Page Page Page

6) Select colour type from drop-down list under Colour Options to print report in.

B3 Client Track Report Previewer
— — o g8 ‘ nN N N
‘ B ) ; \
B98P B8 2%y 23
Print Pago Colour Options Report First Provious Next Last
Sottings Pritin Colo v Sottings Page Page Page Page

||

7) Click Print from main menu.

» Create Reports for Client Services

Step 1
22+ Client Track
File Edit Tools Custom Services Reports Users Support
TR L ——
= || Sample Beauty Salon @@@@ (> Add | Ont
Chent Info Piojscts | Bockkesprg | HST | PST | Papol (Scurce) | Papol | YeaEnd
1
Client Status: Active - Somple Chiont | Business Numbor: |
Company Name: Sampie Beauty Saka ™ GST [ Lawwer Related
Corporate Name: Seauty Sakn Corp 2
Company Type: Corporaticn " PsT ® (S:UWNCWM
Find Client Industry Type: Retai ™ Poyroll Romitts vppod
- v Bockkeeprg
Main Phone: (705) 5551224 Pagrl - -
Fax: (705) 585-2¢58 ¥ Yox End Perzonal Tax Retuns
Web Site:  www.ChentTrack ca & CopTax ¥ Financial Stalemeants
Edit Client Address:  wsis ™ Unite Fees
Samgi Beauty Sakon = -
111 Madey Molow [~ EHT @ Customize List
Calpary. AB ATA 121

1) Under Business Clients section in sidebar, click the Client Info icon
and then the Client Info tab as shown above.

2) Select a business client by using the controls as shown above.

3) To add or edit client services, click Customize List.

Note: Editing or adding client services applies to all business clients
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3 Defino Cliont Services
é Define Client Services

Define Services Names

Seivices Field 1: [GST Services Field 8: [ENT
Defauk GST Defaa EMT
Seivices Field 2; |PST Services Field 9; ILm Related
Delonit PST Detondt Lawget Related
Services Fiedd 3: [Payeol Resttz Sesvices Field 10: [Computer Consuting Suppadt
Defad Payrol Remt Defad: Computer consulting & Suppont
Seivices Field 4: [Payecl Saevices Field 11: [Bockheeping
Detad Pyrol Delad Bookkespen
Services Field 5: Yex End Services Field 12: [Perscoal Tax Retuens
Defaud: Yes End Delout Personal Tax Reduns
Seivices Field 6: [Cop Ta Services Field 13: [Frsncial Statements
Dotod Cop Tax Oetad Francial Statements
Services Field 7: (W58 Seevices Field 14: [Menbertho Fees
Defaa WSIB Uelai T4 Frepaan
Cancel Ok

4) Name a client service and then click Ok.

Client Services Provided

V|GST [~ Lawver Related

[V [PST [~ Computer Consulting
[T Payroll Remitts Support

[ Payrol [v Bookkeeping

W YearEnd [T Personal Tax Retuns
¥ Corp Tax V' Financial Statements
 wsiB |~ Membership Fees |
[~ EHT @ Customize List

5) Verify the new client service has been added/edited to list as shown above.
6) Check off which client services applies to selected client from above.

Note: Services that have been checked off but greyed-out as shown above
are services that will be applied to client at a later time. To do this, click once to
check off and click again to grey-out.

Step 2

#4: Client Track
File Edit Tools Custom Services |Reports| Users Support

" Business Clients Sample Beau l Report Wizard
Personal Tax Client Reports

B II: Client Status: Active - Sample Client
Cheri lufo T ——————

R In menu, go to Reports = Business Client Reports

Business Client Reports

Client Info | Mor
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Step 3

Client Track Reports

L Task List Reparts -

..... &2 Task By Cliert

&2 Task By Employee Business Accounting

& TakByDate — '
[|€2 Crent Services List Reposts | Generate Report

=& Client Sewvices By Client
. - 1) Business Client Services - Selected Sesvices 7
........ 1) Business Clien Sewvices - UnSelected Services
1) Business Cient Services - Greyed Selected Services
1) Perscnal Tax Clent Services - Selected Sesvices
........ 1) Personal T Cient Services - UnS elected Services
- 1) Personsl Tax Clent Services - Greyed Selected Servi
(= & Clent Sewvices By Service

m

Business Clert Seivices - Selecied Sesvices

........ 1) Business Cient Services - UnSelecled Services

........ 1) Business Cien Services - Greyed Selected Services
1) Personal Tas Cient Services - Selected Sewvices
1) Personal Tax Cient Services - UnSelected Services

........ 1) Personal Ta Cient Services - Greyed Selected Servi
< [_.—-~ P ——_— T ' »

1) Click Client Services List Reports in list menu as shown above.

2) Click on a client service type to create report for under Client Services by
Client or Service by clicking on the plus (+) sign.

3) Click Generate Report.

FH B 5 o

Primt Page Colour Options First  Provious Noxt
Settings Printin Colo Settings Page Page Page
Accounting Services Reports r‘

Business Accounting Services - Checked Services

Client Services
i o ||

GsT
‘ Sample Electric Company Limited

Sarple Home Buikder LI,
Sample Lawyers Office
Sample Overhead Door Manufacturer
Ssrple Printing Services
Sample Roof Buikder
Sampie Trucking Company

.| o

4) Skim through all the pages of the report to verify all client services.
S) Follow Step 4 on print and report options.
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'aoponl.m]I Colors/Gid |
- Report Orientation
Select defaul page crisntation of the report when its first displayed

 Portat ¢ Landscape ¢ SizetoFit

- Report Marg Report Options
!

Top: [i [ Report Layout || Colors/Grid |

~ Title Bar Background Color

~Report Opli
:‘:mﬁ Title Bar Background Color: [ ] «|  Thle Bar Fort Coloe: [~ +]

¥ ShowCs | Gid Colors
H.,,,,J Header Background Color: L]  Header Fort Color: [N ~|
Main Giid | Grid Background Color: [~ ]« Giid Fort Color: [N~

~ Report Alternating Grid Lines

' Show Altemating Giid Line Colors In Repect
_jc""’" Ahemting Colee 1: [+
Aernating Color 2 [~ 7] Reset to Defonat

W Show 'Date Generated On Report ¥ Show Page Numbers On The Report

Cmull Ok

2) Click the Report Layout tab to customize the layout settings for report.
Repeat same for the Colors/Grid tab.
3) Click Ok to save settings.

4) Click Page Settings from main menu.
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| & Page Setup

~ Paper Size [ Inches )

TR | atter (85 % 110n)

Paper Width: IH Paper Height: |345

~ Orientation |~ Margins [ Inches )
"""""""" € Podrait Let [083  Right [063
@ Landsczpe Top [083  Bowom [083

Chsel Dkl

5) Select paper size, orientation, margins and then click Ok.

(%) ¢y 3 8

Print Page Colour Options | Report First  Previous Next Last
Settings |m in Colo vI Settings Page Page Page Page

| Print Black and
Prirt Monochro
Print in Colowr

598 B 12/%) )y 33

Print Colour Options  Report First  Previous Next Last
s«tlnp IPmt_mCdo ,| Settings Page Page Page Page

—e

7) Click Print from main menu.

» Create Reports for Checklist Items

Step 1

22+ Client Track
File Edit Tools Custom Services Reports Users Support

(s)(<](>)(08)

Bookkeeping | HST | PST

Business ClientsH [T ) Beauty Salon

ClientInfo  More Info
%2 Define Custom Fields e :
Missing Informatiol

Client Info

-

453
e
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Edit Client

View Tasks

h

Personal Clients

Proiects

Time & Billing
Appointments

Authorization Date [

Foim Status |NotFled ;]

5 Add New Missing Ini

Client Communicat

(A N 52 Customize List

v Received Papemwack
v Initial Mesting
[~ ltem3

[ ltem4

[~ ltem5

[ ltemB

[T ltem?7

[~ ltem8

[~ ltem$

[ ltem10

[~ ltem 11

™ ltem12

[~ ltem13

[ ltem14

-

M5 Add New Communica

Client Aged Summ:

Total Owtstanding 0-30

1) Under Business Clients section in sidebar, click the Client Info icon

and then the More Info tab as shown above.
2) Select a business client by using the controls as shown above.
3) To add or edit client check list, click Customize List.

Note: Editing or adding client check list applies to all business clients

T3 Define Client Check Lst Fieids =
E) Define Client Check List Fields
Client Check List Field Nomes
Check List Field 1: Recered Paperod Check List Field 11: [ltern 17
Check List Field 2: fral Mesing Check List Field 12; [Item 12
Check List Field 3: Metbersfo Foes Check List Field 13: [ltem 13
Check List Field 4: [tem 4 Check List Field 14: [Iter 14
Check List Feeld 5: temS Check List Field 15: [Iten 15
Check List Field 6; em b Check List Field 16: [lte 16
Check List Feeld 7 tem? Check List Field 17: [Itern 17
Check List Field 8: Ttem 8 Check List Field 18: [Itern 18
Check List Fiold 9: ltem 3 Check List Field 19; [Ite 13
Check List Fietd 10: rem 10 Check List Field 20: itern 20
Cheek List Field 21: [Itors 21
Cancel =

4) Name a client check list item and then click Ok.

72 Customize List

[v Received Paperwork

[v Initial Meeting

[Z Membership Fees |

[~ ltem 4
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Item 39

Item 10
Item 11
Item 12
Item 13
Item 14

C1ICICICICNCCE

5]

5) Verify the new check list item has been added/edited to list as shown above.
6) Check off which item applies to selected client from above.

Note: Items that have been checked off but greyed-out as shown above are items

that will be applied to client at a later time. To do this, click once to check off and

click again to grey-out.

Step 2

#9+ Client Track

File Edit Tools Custom Services IReports| Users Support

Business Clients Sample Beaut

N Client Info

Client Info

Mor

| Report Wizard 1

Business Client Reports

Personal Tax Client Reports

Client Status: Active - Sample Client

R In menu, go to Reports = Business Client Reports

Step 3

£ Client Track Reports

| .
J Client Track Reports

o Clert Repeats
+ {‘3 Busmess Chant Name & Addiess List Reports
+ @P«WT&N&M&M”MU&HW:
& Other Clern List Repeas
&2 Task List Reports
o {‘3 Task By Chent
B & TackByErployes
B & Tak8yDae
{'3 Clerk Servicas Let Repotts
&2 Chent Services By Chent
B &2 Chent Services By Sewvice
&2 Cient Check List List Reports |
B & Chent Chack List By Clent
= & Chent Chack List By Seevice

a Businass Chert Chack List - Sedecied Servicas

-~

Business Client Check List

Generate Report

m

1) Business Clerk Check List - UnSelected Senvices
1) Business Clerk Chack List - Greyed Selected Services
1) Peisonsl Tax Client Check List - Selected Services
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1) Click Client Check List List Reports in list menu as shown above.

2) Click on a client check list type to create report for under Client Check List

By

Client or Service by clicking on the plus (+) sign.

3) Click Generate Report.

<

Client Check List Reports
Business Client Check List - Checked Service:

|Client Check Listitem | Name Client 1D
|
Recered Paperwork
Sample Beauty Salon
Inttial Meetng
Sample Beauty Saion
Vembership Fees

4) Skim through all the pages of the report to verify all client check lists.

S) Fol

low Step 4 on print and report options.

Select defaud page orientation of the report when itis first displayed:
 Pocktat " Landscape ( SizetoFit

Colors/Grid |
PSP Title Bar Background Color
: 'M| Tie Bat Background Color [~ +|  Thle Bat Fort Coloe: [ +|
¥ Show Ca
¥ ShowCo | Giid Colors
—— [ Header Backspound Colo. [JLS]  Header Fort Coor [TRL]
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Main Giid L Giid Background Color: [~ J~]  Giid Fort Coloc [N~
| | Report Alternating Grid Lines
¥ Show Altemating Ged Line Colors In Rlopart
4]':"“' Aemating Coloe 1: [ <]
Abemating Coloe 2 [+ Reset to Defort

[V Show 'Date Generated On Repot ¥ Show Page Numbers On The Report

Canedl Ok I

2) Click the Report Layout tab to customize the layout settings for report.
Repeat same for the Colors/Grid tab.
3) Click Ok to save settings.

~Paper Size [ Inches )

RGN tter (85 % 11 in)

Paper Width: Ill Paper Height: |&5

~ Orientation Margins ( Inches )
""""""""" € Porrait Lett 063 Right [083
@ Landscape Top: 083 Botom [063

Uonl Ok l

5) Select paper size, orientation, margins and then click Ok.

6) Select colour type from drop-down list under Colour Options to print report in.
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S Clent Tk ReporPreiver

898 8 o¢) iy 3

Print Page Colour Options Report First  Previous Next Last
Sottings Immwo 'I Settings Page Page Page Page

7) Click Print from main menu.

'® Adda Single Custom Service

Step 1

22+ Client Track
File Edit Tools Custom Services Reports Users Support

Business Clients Sample Beauty Salon @@@
I Client Info Bookkeeping | HST | PST

More Info | Projects

Client Status: Active - Sample Client

Client Info

Client Information ‘}J //‘

1) Under Business or Personal Clients, click the Client Info icon.
2) Select a client to create recurring custom service for by using the arrow controls
as shown above.

Step 2

Sample Beauy Solon (#)@][8)[0) (@ 205) @000 [0 (] 2012 (]

Chrtinfo | Moelnlo | Pagrol (Sourcs] | Pagol | YestEnd | CopTax | WSIB [ ERYT [ Lawyer [ Other

Custom Services

Add Now Cutlom Services Mecn Petiod End Date Due Date | Assigned Close | Notily
84 3 New Servce [Sege Task) No Tadks Schedued

© Add New Service (Recunng Tatks) — |

Add New Custom Services

" Add a New Service [Single Task)
 Add New Service (Recurring Tasks) |

Saved Custom Services List

Contracts
GST/HST Retumns
T1 Tax Related Returns

Assign Selectod Service To Chent

[ Opnumom Senicamanpee |

[ Marspe Your Sernces For Thes Clent ]

1) Click the Custom tab.
2) Click on Add a New Service (Single Task) under Add New Custom
Services as shown above.
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or

49+ Client Track

File Edit Tools | Custom Services | Reports Users Support
Business Clients Create New Custom Service Wizard

Manage Existing Services Wizard

Manage your Tasks Scheduled For This Client

ClientInfo Custom Services

R In menu, go to Custom Services > Create New Custom Service...

Create Custom Services Wizard

lEl!« Custom Services Wizard

Select Type of Custom Service You Want To Schedule For Client

@ Create A Custom Service [Single Task]

This is ideal for tasks ke chant bithdays and company audits. You can choose if they wil be
onetime everts of ¥ they will recur every year.

(" Create A Custom Service (Recurring Or Multiple Tasks)

This is ideal foe tasks ke chant bookkeeping of reviews where you want to schedule many simiiar
custom seivices over the year.

(" Schedule A Previously Saved Custom Seivice
This option alows you 1o 2pply a peeviously saved custom service for this clent.

Cancel Next> Finish
Click Create a Custom Service (Single Task) and then click Next.

Step 3

Create Custom Services Wizard - Add a single task

\JI-E;"L’ Custom Services Wizard

Add a Custom Service with a Single Task
|Task Name: |T2 Coeporate Tax Related Retuins I

Due Date: guary 13,2 vl

Ermployee Assigned: [None Assigned |

Task Type: |Custom =l

Total Estmated Compietion Time: [1 s [ min

[ Do you wark to recur this custom task each pear?
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~Save Custom Service 1

You can save this custom sesvice if you wish so that you can schedule it for other
chierts as well

[TZ Corporate Tax Related Returns Save

Cancel ‘ < Back Next Schedule Custom Service for This Company

1) Insert name and completion time for task as shown above.

2) Select due date and employee assigned from drop-down lists.
3) For Task Type, select Custom from drop-down list.

4) Create a save name for task and click Save.

[B The custom service has been successfully saved.

4) After single custom service has been saved, click Ok.
5) Click Schedule Custom Service Service for this Company.

Sample Beauty Salon @@[E]@

Chentinfo | Moelnfo | Projects | Bookkeeping | HST | Papol (Souce) Payol | YexEnd | Cop Tax

Custom Services

Add New Custom Services Name Period End Date| Due Date

" Add a New Service (Single Task) T2 Coepocste Related Tax Retuns Feb 13,12
" Add New Service [Recuring Tasks)

Saved Custom Services List

Contracts

GST/HST Retums

T1 Tax Related Returns
|| T2 Corporste Tax Related Retums ||

| Assign Selected Service To Client

| Open CustomSenice Manages |

| Manage Your Sewices For This Cient |

6) In Business or Personal Clients, click the Custom tab.

7) The added single custom service appears in task list with its information as
shown above. All saved custom services appears under Saved Custom
Services list.

Note: To apply the same single custom service but to a different client, use the
arrow controls on top bar and click Assign Selected Service To Client.

» Add a Recurring Custom Service

Step 1
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23+ Client Track

File Edit Tools Custom Services Reports Users Support

]| Sample Beauty Salon (1e)(<)(2](28)

Client Info Projects | Bookkeeping | HST | PST

b !I‘ @ Client Status: Active - Sample Client

et o mation ™ e |
Client Information (¢ P74

1) Under Business or Personal Clients, click the Client Info icon.
2) Select a client to create single custom service for by using the arrow controls
as shown above.

More Info

Step 2

Smpi Beauy Soon () 4] () (00 [ omt. (2] 2012 (7] (@ v

Chertinlo | Moelnlo | Paol(Sourcs) | Pawol | YeaEnd | CotpTac | WSIB | ERT [ Lawyer | Other |Custom|

Custom Services

| Add Now Custom Services | Period End Dote| Due Date |Assigned | Close | Notily

A4 3 New Servce [Srge Tack) No Tadks Schedued
 Add New Servce (Recunng Tatks)

Add New Custom Services

 Add aNew Service (Single Task) |
" Add New Setvice (Recurring Tasks)

Saved Custom Services List
Contracts

A — GST/HST Retums
T1 Tax Related Returns

R ———

[ Mansge Vour Sovnces Foe This Cient |

TR
[k et st doer =] (@) 3)

(G 1 sect et 7] (@) (@) Asvign abave 10: e i | duto oy M above | )

1) Click the Custom tab.
2) Click on Add a New Service (Recurring Task) under Add New Custom
Services as shown above.

or
22+ Client Track
File Edit Tools | Custom Services | Reports Users Support
[P ——— A .
Business Clients Create New Custom Service Wizard

Manage Existing Services Wizard

Manage your Tasks Scheduled For This Client

Client Info Custom Services

Q In menu, go to Custom Services = Create New Custom Service...
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Create Custom Services Wizard

lﬂy Custom Services Wizard

Select Type of Custom Service You Want To Schedule For Client

¢ [Create A Custom Service [Single Task])

This is ideal for tasks ke chant bithdays and company audits. You can choose if they wil be
onedtime everts of ¥ they will recur every year,

custom services over the year.

¢+ Create A Custom Service [Recurring Or Multiple Tasks)
This is ideal for tasks lke chant bockkesping of reviews where you want to schedule many simbiar

(" Schedule A Previously Saved Custom Service

Carcel |

This option alows you lo 2pply a peeviously saved custom service for this clent.

Next > Finish

Click Create a Custom Service (Recurring Task) and then click Next.

Step 3

Creste Custom Services Wizsed - Add 3 multiple orzet of tasks

9‘\ Custom Services Wizard

Add a Custom Service with Dezcription

Task Naene: (Ol Fing
[ Croste Numberod Hames 69 131, 2nd, olc

Seevice Typee [Custoen

= |

Dady

Weekdy

Sorne Macth | Moetl)

BiMaertly

Quartedy

Serre Arewsal | Arewssd

Repeat On

Evesy
Stat Meeth

Febeuaty M

O |28 'l
By |Repast onthe 280h -|

O%ce Fibng
Ofce Filng
0% Filng
Oice Fibng
O%ce Fiing
0o Filng
Ofice Fing
Ofice Filng

Estimated Completion Time: [T tes [ min

D0 you wart 1o recur [+
e latks each yex?

Carcsl

Due Date |Assigned Recur |Estimoated e

-

Feb 2312 Norw Astprac
Mx 2312 Nemiuope B 1
At 2312 Noos Aswpoed
My 23,12 Nees Asorec
Jun23,12  Nere Asngec
JUZ3.12  Nors Astprex
L 23,12 Noew Asogrec
Sep23.12 Norw Assignec

AR EAE

 Save Custom Service

As an optaon, you Con 1ave the tacks kled above ssenvico 10 that you con
Quickly apply these tatis to cther cherts a2 wel

I Saved Name: [Olfes Fiirg Save l

< Back

1) Insert name and completion time for task.
2) Select type of start period and date for recurring task as shown above.
3) For Task Type, select Custom from drop-down list.

4) Create a save name for task and click Save.

Schedule Custom Sevice for This Company |

B The custom recurring task(s) has been successfully saved.

4) After recurring custom service has been saved, click Ok.
5) Click Add Tasks. The recurring task automatically appears in tasks list.
6) Click Schedule Custom Service Service for this Company.
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Sample Beauty Salon @@@@

Chentinfo | Moelnfo | Projects | Bookkeepng | HST | Payol (Sowce) Pawol | YexEnd | CopTax

Custom Services

Add New Custom Services Name Period End Date| Due Date

" Add a New Service (Single Task) T2 Corpoesto Related Tax Rotuens Fob 13,12
" Add New Service [Recuring Tasks) Oféce Fing Fob 23,12
o i a2 12
Contracts Office
GST/HST Retums ) AeZR12
Office Filing ||| 0t5ce Fing Moy 23,12
T1 Tax Related Retums
T2 Corporate Tax Reloted Returns Office Fiing i)
Office Filng Jul28,12
Office Fing Aug 23,12
" Assign Selected Service To Client || Mmsibiaid Sy 1L
Ofice Filrg 0ct 23,12
| OpenCustomServies Manager | e S
I Manage Your Sesvices For Thes Cient I Offce Fiing Dec23.12

6) In Business or Personal Clients, click the Custom tab.

7) The added recurring custom service appears in task list with its information
as shown above. All saved custom services appears under Saved Custom
Services list.

Note: To apply the same recurring custom service but to a different client, use the
arrow controls on top bar and click Assign Selected Service To Client.

» Manage Existing Custom Services

Step 1

4* Client Track
File Edit Tools Custom Services Reports Users Support
Business Clients

(se)(<](>](08]

PST

Sample Beauty Salon

Client Info | More Info Bookkeeping

“ Projects
Ot Client Status: Active - Sample Client
clentio |l ot itomation PSR
Client Information el 7

1) Under Business or Personal Clients, click the Client Info icon.
2) Select a client to manage custom services by using the arrow controls
as shown above.

Step 2

Custom Services

Add New Custom Services

" Add a New Service (Single Task) T2 Cotpocate Related Tax Retums
" Add New Setvice [Recuring Tasks)
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Saved Custom Services List

Contracts
GST/HST Retums

Office Filing

T2 Corporate Tex Reloted Returns

[ Assign Selected Service To Client

| OpenCusiom Service Manager |

| Manage You Tasks For This Cient |

1) Click the Custom tab.
2) Click Open Custom Service Manager as shown above.

or

Create New Custom Service Wizard

Manage Existing Services Wizard

Manage your Tasks Scheduled For This Client

R In menu, go to Custom Services > Manage Existing Services...

@ Manage Your Custom Services

~ Custom Sesvice Infoimali
! Add A New Custom Service |

|Cu:hm Sesvice Name: I—DM Propasals
Saved Custom Sesvices ]

Business Proposals Numbes of Tasks inthes Custom Sernce: 2 Tasks
Contvracis Husrber of Chants thes Cuatom Setvica has been sched.ded foe 0

GSTHST Retuns
Offcs Fiing [ € || Detere | | € natseason Coament |
o Tor P - Schedule Custom Sewvices for Clients
Busi C i T Perzcnd Tax Contacts
& (149 Client Track Business chients -
Sampls Beardy Saker
V183 Semple Charitatle Qiganzation "
183 Sampls Eloctic Copary L
Semple Home Bulder Lid.
[183 Sample Pinting Service: =
ot g e e Sl i
zcl senvices oy
Cherks 10 PIcAEk 15 Oveusdo The postet r‘nwm:mA_..w
vabies ... [ Proeret lot Extnated Time
Wl theceis akeady this custom =
[ zervice zcheduied for zelected O s 19
<Banl dutng Oven pea. |

WI Ok I

1) Under Saved Custom Services list, select a service to schedule for clients.

2) From the Business Companies or Personal Tax Contacts tab, check off
which clients to apply custom service to.

3) Check off Warn if there is already this custom service scheduled...

4) Click Apply Custom Services to Selected Clients

Note: To add a recurring custom service, click Add a New Custom Service

and follow Step 3 here.
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selected clients and will appear under the 'Custom’ tab in the

Q ! The custom services were successfully scheduled for the
- business clients section.

5) After custom services have been applied to client, click Ok.
6) Click Ok to exit Manage Your Custom Services wizard.

Step 4

Sample Charitable Organization

More Info Payrol (Source) Papxol | YearEnd
Custom Tasks
A o G v
" Add a New Sevice (Single Task) T2 Corporate Tax Relzted Returns Feb 13,12
" Add New Service (Recuring Tasks) Busi Ploposas Mar 23,12

Saved Custom Services List Business Proposals Sep 15,12

Business Proposals T
Contracts
GST/HST Retums
Office Filing

T1 ToxRelated Retums

T2 Corporate Tax Related Returns

1) Browse to the selected client(s) from Step 3 by using the arrow controls.
2) Click the Custom tab and verify that the custom services have been added
to tasks list as shown above.

~

» Manage Scheduled Tasks

Step 1

2+ Client Track
File Edit Tools Custom Services Reports Users Support

|

(2] )(>)(]

Bookkeeping

S8l | Sample Beauty Salon

Client Info | More Info

\. > ll Client Status: Active - Sample Client
chentinto |l e aparion |
Client Information [~ P74

1) Under Business or Personal Clients, click the Client Info icon.
2) Select a client to manage custom services by using the arrow controls
as shown above.

Projects

Step 2
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Custom Services

s sovis e |

" Add aNew Service (Single Task) T2 Corpocate Related Tax Retuns
" Add New Service [Recuriing Tatks)

Busness Proposals
Saved Custom Services List Busi Propasals
Contracts
GST/HST Retums
Office Filing

T2 Corporate Tox Related Returns

_—
| Assign Selected Service To Client

| OpenCustomServiee Manager |

| Monage You Tasks For This Clent |

1) Click the Custom tab.
2) Click Manage Your Tasks For This Client as shown above.

or

49+ Client Track
File Edit Tools | Custom Services | Reports Users Support
Business Clients || Create New Custom Service Wizard

Manage Existing Services Wizard

Manage your Tasks Scheduled For This Client

Client Info Custom Services

R In menu, go to Custom Services > Manage Your Tasks Scheduled...

Step 3

Custom Tasks for Sample Charitable Organization (=23

<
TO\ Manage Client's Tasks

Delete | Selectal

Task Name Due Date
[ GST/HST Retwns HST Feb3,12 None &ssignec
| : T2 Comporate Tax Related Re T2 Corporate Tax R Feb13,12  None Assignec
O T4 & Summaty T4 & Summary Feb28,12 | NoneAssignec
[0 Business Proposals Business Proposals Mar23,12  None Assignec
[ Business Propasals Business Proposals Sep 15,12  None Assignec

| @ Shave ANl Tasks For This Client |

Note: Tasks that relate to Projects and their steps cannot be deleted here. Close
They must be managed through the project section. L

1) Check off Show All Tasks For This Client.
2) Select a task from list and click Delete.
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': Are you sure you want to permanently remove the selected
L

tasks?
No |

3) Click Yes to confirm delete in pop-up warning.

Custom Tasks for Sample Charitable Organization

N
[ Q Manage Client's Tasks

Delete |  Selectal

Task Name Due Date Ass
[J GST/HST Retuns HST Feb3,12  NoneAssignec
O 74 & Surmmary T4 & Summary Feb28,12  NoneAssignec
[ Business Proposals Business Proposals  Mar23,12  None Assignec
O anmual HST Retun HST Mar31,12  NoneAssignec
[ Business Proposals Business Proposals  Sep 15,12  None Assignec

V' Showe A1l Tasks For This Client

Note: Tasks that relate to Projects and their steps cannot be deleted here.
They must be managed through the project section.

4) Click Close after task(s) has been deleted.

Step 4

Sample Charitable Organization @E] [ £dd |2 Detete |

Payroll (Source) | Papioll | YearEnd | CompTax | WSIB | EHT | Lawger | Other |Custom |

Custom Tasks

Add New Custom Services Period End Date| Due Date

" Add a New Sesvice (Single Task) Business Proposals Mar 23,12

" Add New Sewvice (Recuning Tasks)

Saved Custom Services List
Business Proposals

Under the Custom tab, the deleted task(s) do not appear in tasks list anymore.

Business Proposals Sep 15,12
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. Other Tools

4

» Send Notification

Step 1
A-EN Custom Tasks Users Suppert
| Auto-Notification
Edit Auto-Notification Template Comments
3 In meny, go to Tools = Auto Notification
Step 2
5 Send Notification Client List

\\% There are 1 notifications to send today

Type | Coark Nacta Nothason Nase Notdy Dus Date [Netihed | [Date Cierk Notind l

w Detch.P. Srsth Densat Surgery Dec 3,10 o

Send AN Emails Close

To send a notification to a specific client, click Send

Step 3

Send Notification (Phone) =

P
@ Send Notification

Person To Call: |Mr. Derek P. Smith

Telephone Number; |[705] 555.9892 ll

Available Times: |

Hi,

This is a reminder that you have an appointment scheduled with Trilobyte Solutions
Inc. on Friday, December 31 2010 at 8:00 am. We expect this appointment to last
aporoximately 120 minutes.

No answer, call again later!
WRARTAL

Verify the notication information and click to confirm notification being sent.
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= Send Notication Client List =

{ 5-,/ There are|0 notifications|to send today

Type |Chark Nacre Notfizaton Nama Notly Dus Date |Nothed -
& Mo Dewek P Srith Dentat Sugery deci0 | B send | cancel |

Send AN Emails | (D) Chote

When notification has been sent, the date will appear under Date Client Notified
category and checked off. In addition, the number of nctifications changes.

S
» Cancel Notification

Step 1
Custom Tasks Users Support
| Auto-Notification
Edit Auto-Notification Template Comments
R In menu, go to Tools > Auto Notification
Step 2
= Send Notfication Client List =

—

[S / There are 0 notifications to send today

Date Chert Notind | -
G Vo Devei P Smith Donsat Sugery Doc 0,10 =] Send |

Send AN Emails Chose

Type |Chart Nace Notficaton Namse Notly Dus Date (Nothed

To cancel a notification for a specific client, click Cancel

When notification has been cancelled, Cancelled will appear under Date Client
Notified category and checked off. In addition, the # of notifications changes.

" ® Client Status

Step 1

| More Info [ Projects [ Bookkeeping [HST [ F2il

(L ||Client Status: Active - Sample Client

Client Information

Company Name: Sample Beauty Salon
Corporate Name: Beauty Salon Corp.
Company Type: Corperation

Industry Type: Retail

Click on the information icon beside Client Status.
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Step 2

Active Status @
@ Active Status

ATD Banking
Choose The Active Status For This Client

|Active M I
| Inactive |

Cancel ’ Ok

From the Active Status drop-down list, select Inactive as example.
Step 3

'E Are you sure you want to set this client as nactive?

If you choase Yes', then this client's tasks will no longer show
up in the tasks list

No

Click Yes to confirm client as inactive.
Step 4

" Client |I'If0| More Info [ Projects [ Bookkeeping [ HST I PST

(L) |/Client Status: InActive - Sample Client

Client Information

k:ompany Name: Sample Beauty Salon
Corporate Name: Beauty Salen Corp.
Company Type: Corperation

Industry Type: Retail

Verify that selected client has been set as Inactive.
Note: To change client back tc Active, follow step 2 and select Active.

@ Business Tab Options

Step 1

[m Add ][3;. Delete ]| Ont. 2011 |
oo D CEYTN

In Business Clients, click Search and then Tab Options.
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Step 2

T T oo ==

Business Tab Options

Select A Tab To Configure Goods and Services Tax
Ortatio B | ™ Do You Want This Tab To Be Visible?
GST Template Documents Websites
PST Add ard custerrize the 444 and customize the webshes
Payioll Tasks documents availadle inthe avalable inthe Ouick Tasks
Quick Tacks section of this Lab. seehon of this Lab,
Employee Payrall B
Ceepecation Centre - Regzt
Coporzte Fax CRA - Buziness Number Re ™ i
Yea End CRA - Business Regishatio
WSIB e b
| 3 « | [ | » < (] »
EHT . :
Lowyer Relsted Add Document Add Website
e Edit Documert | EdtWebsie

™ Display only 1353 that ate checked n
the ‘& g Seevices Infoematy

9 Remove Document | Remove Websie
Section' o each clent ’ : '

Close

1) Select which tab you want tc configure from list on left side

2) By default, all tabs are visible. If you want a certain tab to not appear, uncheck
Do You Want This Tab To Be Visible as shown above.

3) Add any documents and/or websites pertaining to a selected tab.

Accounling Seivices Provided
WSIB L—
L3 <

€ ™ HST [~ Lavwwyer Related _J

S [ est [T Computer Consulting %

ithes = ™ Payrol Reitts e
¥ Display ooy labs that ate checked in ™ Payral [V Bookkeeping

Sactort e somnebent o 7 YearEnd ™ Pessonal Tax Retumns
| ¥ coprax W Financial Statements |
Close ~ wele [ T4 Pieparation
et

4) Optional: To make tabs specific for each client, check off Display only tabs....

5) Click Close to save changes.

Step 3

[Client |nf0| More Info [ Projects [ Bookkeeping [HST [PST I Payroll Remitt |

Verify the changes to tab(s).
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» Client Options

Step 1

|48 client Software |

@ ciient options |

[P sendEmail |

R In Business Clients, go to = Client Info > Client Options

General Options

Client Options for Sample Beauty Salon =

[ Hide Tasks T Assign Employees T Auto-Notifications
Auto Pop-Ups T InHouse Due Dates T General Options

L

Task Options -
When viewing tasks in the Client Information sectior:
" View tasks for only the current year
& View all tasks that are not aichived

~ Task Close Options

[T Check this box to prevent ary closed tasks from being
removed when changing payment types.

[T When scheduling new lasks for clients, check this box to
automaticaly set the closed status of the new tasks to
‘Completed' if the due dates have alieady passed.

~Close Currently Scheduled Tasks
@ Close all tasks on or before date -> pan 5,201 vl

" Close all tasks between the following dates
Wan1,2011  »| ang [Dec31 2011 |

@ Close specified tasks for only Sample
Beauty Salon
" Close speciied tasks for 2ll clients

Close Specified Tasks |

' Cancel

1) Select an option for each category.
2) Click Ok.

In-House Due Dates

Client Options for Sample Beauty Salon

X

[ Hide T asks T Assign Employees T Auto-Notifications

[ AuoPopUps | In-House Due Dates|  GeneialOptions |
I
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Enter number of days prior to the task due date
you want to set your In-House Due Date.

GST InHouse Due Date Period:

PST InHouse Due Date Period:

Payioll Remitt InHouse Due Date Period:
Employee Payroll InHouse Due Date Period:
Year End InHouse Due Date Period:

Corp Tax InHouse Due Date Period:

W/SIB InHouse Due Date Period:

EHT InHouse Due Date Period:

Lawyer Related InHouse Due Date Period:
Other InHouse Due Date Period:

Custom InHouse Due Date Period:

i 1 o

Note: These inhouse due date periods will apply to all clients, not
just this client,

Cancel Ok

1) Customize the number of days prior to task deadline as an in-house date for
each tab under Business/Personal Clients.
2) Click Ok.

Auto Pop-Ups

Client Options for Sample Beauty Salon =)

[ Hide T asks T Assign Employees T AutoNotiications |
Auto Pop-Ups T InHouseDueDdesT General Options )

Client Track gives you the ability to schedule a pop-up reminder that
appeais on your task bar, This wizard allows you to quickly schedule
mulliple automatic pop-ups quickly for this client.

Note: The popups scheduled in Chent Track for tasks and
appointments only apply to the user who scheduled them.

~Automatically Schedule Following Auto-Notifications
[~ Schedule all HST Pop ups 10ay | Before

[~ Schedule all PST Pop-Ups 10ay v/ Before
‘ [~ Schedule all Payroll Remitt Pop-Ups  [1Day v | Before
| ™ Schedue all Employee Payroll PopUps [1Day v | Before
|
\
|
|
|

[~ Schedule all Year End PopUps [1Day v Before
[~ Schedule all Cotp Tax Pop-Ups 1Day v | Before
I Schedule all WSIB Pop ups [10ay ] Before
[~ Schedule all EHT PopLps [1Day = Befoe
| [~ Schedule all Law RelstedPopUps  |1Day _~| Before
| [~ Schedule all Othes PapUps [1Day =] Befere
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[~ Schedule all Custom Pop-Ups |1 Day vI Before ‘

Select All Change &l To: | <Select> v | Before
Cancel 0Ok

1) Select which tab(s) and number of days prior to task from drop-down list
te schedule automatic pop-ups.
2) Click Ok.

Auto-Notifications

Client Options for Sample Beauty Salon

f Auto Pop-Ups T In-House Due Dates T General Options
Hide Tasks T Assign Employees T Auto-Notifications |

Client Track gives you the ability to automatically notify each of your
clients of their upcoming remittances. This wizard allows youto
quickly schedule mulliple automalic nelifications quickly for this client.

- Automatically Schedule Following Auto-Notifications

[T Schedule all HST Aute Notifications

[T Schedule all PST Aute-Nolifications

[T Schedule all Payroll Remitt Auto-Notifications
[T Schedule all Employee Payol Auto-Nolifications
[T Schedule all Yeat End Aute-Nolifications

[T Schedule all Corp Tax Auto-NolFications

[T Schedule all'WSIB Awo Notifications

[T Schedule all EHT Auto-Nolifications

[T Schedule all Laws Related Auto-Netifications
[T Schedule all Other AutoNotifications

[T Schedule all Custom &uto-Nolifications

Select All |

Cancel Ok |

1) Select which tab to create automatic notifications.
2) Click Ok.

» Change Default Province

When you start up Client Track for the first time, you will be asked to select your
province in the Startup Wizard. If you accidently chose the wrong province, you
can easily fix that in the Province Wizard in Client Track.

Step 1
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Step 1

m Create Tools Custom Tasks Users

Add New Business Client
Add New Personal Tax Client

Find Business Client

Find Personal Tax Client

Edit Current Business Client
Edit Current Business Contact Client
Edit Current Personal Tax Client

Change Default Province

Change Working Province
Change Working Year
Change Working Tax Year

Change Your Company Information

Change Background

Preferences

3 | In menu, go to Edit > Change Default Province

Step 2

Change Default Province

@ Change Default Province

This wizard allows you to sefect your province so that Client Track will
use the appropriate dales,

Select Your Province: [l ~ |

Cancel Ok |

1) Select province from drop-down list as shown above.
2) Click Ok to save setting.

'@ Change Working Province

Step 1

(80)(](®)(08] [ Add ] (2 Delee ] | Ont 2011 )| (W Search |

In Business Clients, click the pencil icon next to province shown above.
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Step 2

Change Working Province

@ Change Working Province

By changing the working province you can temporarily tell Client Track which
province you want to schedule and remove remittances for in the ‘Clients' section.

This only applies to PST, WSIB and EHT

This allows you to schedule and remove remittances for this particular province
without affecting other remittances scheduled.

Note: If you want to set a province as default in Client Track, go to the
'Province Wizard' under the Tools menu.

Select Your Working Province: [ v |

Cancel | Ok |

1) Select a province from drop-down list shown above.
2) Click Ok tc save change.

Step 3

@E]E] [“’ pdd ][33 Delete ] I Man. 2011 I [v Search ]

Verify that the new working province has been changed.

e Change Default Year

Step 1

@E]E] [w Add ][3;’ Delete ] | Ont. 2011 l [v Search ]

In Business Clients, click the pencil icon next to year number shown above.

Step 2

Change Working Year (]

Change Working Year

By changing the working year, you can tell Chent Track which yeas
you want to schedule and remove tasks in the 'Clients' section.

This allows you to schedule and remove tasks for any particulas
year without affecting other years.

299



Note: If youwant to reschedule all of your tasks for the next
year, Use the 'New Year Wizaid' in the tools menu,

Working Year: I 2010 vI

Click here to change the main default vear

Cancel I 0K |

Select new working year from drop-down list shown above.

Step 3

(84)(@)(®])(08) [t Asd |[@s Dekte | | Ont 2010 | Search |

Verify that the new working year has been changed.

" » Change Working Year

Step 1

(0] @)(®](28) (i 499 | (2 Delete ] | Ont. 2011

In Business Clients, click the pencil icon next to year number shown above.

[v Search ]

Step 2

Change Working Year

» Change Working Year

By changing the working year, you can tell Chent Track which year
you want to schedule and remove tasks in the ‘Clients' seclion.

This alows you to schedule and remove tasks for any particulas
year without affecting other years.

Note: If youwant to reschedule all of your tasks for the next
year, Use the 'New Year Wizad' in the tools menu,

Working Year: | 2010 vl

Click here to change the main default vear

Cancel I OK I

Select new working year from drop-down list shown above.

Step 3

@E]E]@ ["’ Add ]['33 Delete ] | Ont. 2010 | [v Search ]

Verify that the new working year has been changed.
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» Change Working Tax Year

Step 1

(#0)(@)(®) (28] [ Add ] (@ Delete | 2010 (W Search |

In Personal Clients, click the pencil icon next te year number shown above.

Step 2

Change Working Tax Year

Change Working Tax Year

By changing the working tax year, you can tell Client Track
which year you want to view your personal tax clients in the
‘Clients' section.

Note: If you want to reschedule all of your personal tax
clients for the next year, go to Tools > 'New Year
Wizard' from menu bar.

Working Tax Year: (2010 v|

Click here to change the main default tax year

................................

Cancel i OK

................................

1) Select new working tax year from drop-down list shown above.
Optional: If you want te change default tax year as well, proceed to Step 3.

2) Click Ok to save new tax year.

Step 3 (optional)

Working Tax Year: (2010 v|

Click here to change the main default tax year |

................................

................................

Click Change the Main Default Tax Year link shown above.

Step 4

Change Default Year |

El} Change Default Year
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~Business Default Year

Change the defauk year Client Track uses to schedule tasks.

Business Default Year: | 2011 - |

Change Business Default Year

~Personal Default Year

Change the defauk year Client Track uses in the personal Lax seclion

Pessonal Tax Defauit Yea: I 2011 vl

Change Personal Tax Default Year

Cancel I

Select new business default tax year from drop-down list.

Step 5

@E]@@ [m Add ][33 Delete ] 2011

2 Fsee)

Verify that the new default tax year has been changed.

'@ Upgrade Settings

Step 1

Step 2

Help Center
Downlead User Guide (PDF)

Check for Upgrades

Upgrades Settings

Register Client Track
About Client Track

Visit our Official Website

R In menu, go to = Support > Upgrades Settings

Upgrade Settings for Jason

@, Upgrade Settings

@ iCheck for upgrades every time Client Track starts

" Check for upgrades peiiodicaly
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Check Every: |1_':| Days

" Manually 1un the 'Check For Upgrades’ wizard

Ok I

1) Select type of upgrade setting.
2) Click Ok to save setting.

" ® Check For Upgrades

Step 1

Help Center
Download User Guide (PDF)

I Check for Upgrades |
Upgrades Settings

Register Client Track
About Client Track

Visit our Official Website

R In menu, go to = Support = Check For Upgrades

Step 2
Check For Upgrades

i Check For Upgrades

‘Check For Upgrades' allows you to check and upgrade your Client
Track to the newest minor release which includes improvements and
additional features based on clients' feedback.

If an new upgrade is available, this wizard will:

- Allows you to view what is included i new minor release before downloading.
- Download and install the upalade.

- Client Track will automatically run Check For Uparades' on other Chent Track
instaliations when they are next started wo.

Click "Next' to view the details of newest minor release of Client Track.

Cancel I < Back Next > Finish

1) Click Next tc begin checking for newest upgrade.
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i Check For Upgrades

There is an upgrade available.

Minor Release Details:

(CheckForUpgrades - =

Chent Teack 5.0.436

«  New custom tasks wizard that allows you to dynamically schedule your custom
tasks,.specify day of month (i.e. 5, 17), the estimated time, andfer the employee assigned

+  Custom Tasks Wizard will 3ls¢ warm you & you're scheduling 3 custom task for a ciientthal
has the custom task installed. You can access this vizard under Custom Tasks menu 3t
the top and select Manage Existing Custom Tasks Wizard

Click the 'Next' button to conlinue the upgrade process.

Caodl | <Back Nest> | Eaieh

2) When an upgrade is available, skim through the details in release and click Next.

Check For Upgrades

Check For Upgrades

Downloading Client Track Setup File, please wait...

Cancel Download I

Chck 'Finish' to complete the upgrade process, 'Check For Upgrades'
window wil close Clent Track and win the upgrade setup program.

Cancel < Back Next > FEinish

3) After setup file has been downloaded, click Finish. Client Track will close itself

and an Upgrade Wizard window will pop up.

Step 3

g Upgrade Wizard

Data file needs to be upgraded to the current version.

If you are upgiading & data fle accessed from & netwatk, it is best to have
ary cther users close Client Track while the data fle is being upgraded.

Cancel Show Mote Info >> Upgrade I

1) Click Upgrade to update your data file.
2) Click Ok after successful upgrade.
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[—’D Wizards

» Compare Tasks

Step 1

Add a Single Custom Task
Add Recurring Custom Tasks
Schedule a Previously Saved Custom Task Scheme

Manage Existing Custom Task
Manage Custom Tasks Scheduled For This Client

I Compare Tasks Wizard

R In menu, go to Custom Tasks = Compare Tasks Wizard

Step 2

‘Compare Tasks Wizard EXE)

Compare Tasks Wizard

Client Track will compare the due dates of the 2010 tasks to
the due dates of the 2011 year. This allows you to see the
difference in the dates from one year to the next.

This step will generate a report indicating all cases where the 2010 due
dates used are not the same as the 2011 due dates.

{ Advanced Options |

Cancel Compare Tasks

Click Advanced Options.

Step 3

‘Compare Tasks Wizard (=23

Compare Tasks Wizard
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Advanced Options

Client Track compares the task due dates of the source year to the task due dates
of the destination year and generates a report based on all the dates that are
different. You can specify the sowce year and deslination year below.

~Source Year
Select source year Client Track will l . ﬁ‘
use to generate the new tasks. Source Year: 2010 ¥

~ Destination Year - )
Select destination year Client Track | Destination Year: [2011  v] |

will copy the source years' tasks into.

Cancel

1) Select Source and Destination Years from drop-down lists.
2) Click Back.

Step 4

Compare Tasks Wizard

Compare Tasks Wizard

Client Track will compare the due dates of the 2010 tasks to
the due dates of the 2011 year. This allows you to see the
difference in the dates from one year to the next.

This step will generate a report indicating all cases where the 2010 due
dates used are not the same as the 2011 due dates.

! Advanced Options !

Cancel Compare Tasks

Click Compare Tasks to being comparing tasks.

Step 5

B Tosk List

e

Client Track Comparison List

This report indicates 2l cases where the 2010 due dates used are notthe same as the 2011 due dates.

Company Name Task Type Task Name 2010 Date 2011 Date
Samgic Beauty Salon  Boolkeeping Bookk 9 Missing 10-Sep
Sampie Beauty Salon  Bookk 9 8coikespng Missing 28-Nov
Ssmple Beauty Salon Boolkeeping Beokkesping Missing 10-Dec

Pages MI4JT M| <] |

Verify the compare tasks list report.

306



» Remove Duplicate Companies

Step 1

Client Info

R In Business Clients, go to = Client Info (icon)

Step 2

Client Track

Client Info | More Info

Client Status: Active

Client Information

Client Track

(28] ()(2]) (08) (> 239 ) (& 0=t )

Bookkeeping | HST | PST | Pawoll (S

Client Status: Active

Client Information

Client Info | Mare Info

Company Name: Client Track
Company Type: Corporation
Industry Type: Software and|

Main Phone: (868) 423-8525 Company Name: Client Track

Email: inquiries@clientf | corporate Name: Triobyte Solutions Inc.

Web Site:  www .clenttrac] Company Type: Corporation

Industry Type: Software and information services

Address:
Client Track Main Phone: (255) 422.8525
21 Corona St. Email: sales@clienttrack.ca
Cttawa, Ontario KSH 848 Web Site:  www.clientirack ca
Address:
Clent Track

148 Colonnade Rd. South, Suite 203
Nepean, Ontario K2E R4

1) Under Client Info tab, browse through the companies using the arrows to
see if there are any duplicates. If so, see if there is any difference in contact
infermation under Client Information as shown above.

6 Are you sue you want to permanently delete Client Track'?

You wil also permanently remove all related task and employes
records for this client as well.

2) If the contact information is not the same, go to Step 3. If identical, click Delete
on either company as shown above and then click Yes to confirm removal.

Step 3

a-EN Custom Tasks Users Suppert

Aute-Notification
Edit Auto-Notification Template Comments
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Open Advanced Missing Information Form
Open Advanced Communications Form

New Year Reschedule Wizard
Holiday Schedule Wizard
Interrupt Wizard
Maintenance Wizard
Templates Folder Wizard
Sample Clients Wizard

Remove Duplicate Companies Wizard
Remove Duplicate Contacts Wizard

Profile Integration Settings Wizard

R In menu, go to Tools = Remove Duplicate Companies Wizard

Step 4
e S Sampie Overh...
Surols Tomoo S vy | (L[ Fsiane T o veks [ bestchveion 21 seacks Tome.
m;ws‘m O] ComrpariesTime.. (/11720011 11:37.09AM (21172011 11:3254AM Sample Truck..
Sample Beaut...
Sarrple Home Buldes Ltd O] Catepsydlum 13 3 : Bode
Saerple Proving Setvices O compargtiun s.ﬂ. Home ...
Ehstiis Donoiry O] Patnelane s -*""" Eloct.
Sarmple Rloot Buldes =
Sarmple Lavgers Office O] AccountartNane | Sample Roof ..,
Sample Beauty Sshn | Corparnblame  Chert Track Chant Teock £l Sample Lawye...
Chert Track o . Tricbste Soksiona Inc. —w_]
. O] Cenid s s

ComparyType  Cotpasion Corpoeation

~ IndatiyType Soly el wloumnyes . Soy el Sl

Addes: 148 Colornade Rd Sout... 21 Corona SL

8| & Negean Otawed

Province Orvario Ortaio

8| Posalode 12 bR K5 EHE

Counnry Canada Canada

Otfeeuber  [655) 4238525 (956) 4236525

O] APhonediumbe

O] Fatiurde

Emsl sens@eberitack ca baitaiiaticsy

& wetee e cleritiack 03 v chentyac. ca

| FaceBookURL

O] Twitetccoun

O] Employess Faln Fale

0| Acconaiirio 5
@ Higlght Matches by [Lazt Name ~l o I

1) Select a company from left sidebar list to begin duplicate search

2) Check off Highlight Matches by

3) Click on the matching company from right sidebar list

4) Check off which information fields that is most updated to keep as shown above
5) Click Perform Merge to merge both identical companies intc one

Step 5

Client Track

Client Info

More Info Bookkeeping

Client Status: Active
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Client Information m

Company Name: Client Track

Corporate Name: Trilobyte Solutions Inc.
Company Type: Cerporation

Industry Type: Software and information services

Main Phone: (866) 423-8525
Email: sales@clienttrack.ca
Web Site: www._clienttrack.ca

Associated Parent Company:

Address:

Client Track

148 Colonnade Rd. South, Suite 203
Nepean, Ontarioc K2E 6R4

Verify that the newly merged company contains the most updated information
as shown above from Step 4.

» Remove Duplicate Contacts

Step 1
Client Info
R In Personal Clients, go to = Client Info (icon)
Step 2
»24 Client Track

Fide Edt Teols CustomTasks Reports Users Suppeet

Business Clients | Drake, Nathan [#9)(@)[®](#)] [ 2s¢
bl

Personal Clients
(e | 72" Client Track
T File Edt Tools CustomTasks Reports Users Support

(®) cxem Stotus: Active [gzes Crents Drake. Nathan

e
3 i
I

nlo Maote Info
|| Hame: M1 Namas Drake

Company Name: Stdo Py
Job Titlo: Owner

Mexe Into

C fo P P
E‘, RRSP

A5

w -

Chient Status: Active

Name: M. Nathan Drake

Find Chent

Main Phone: (612) 056.36¢
Celt Phone: (£13) 208620

Address: Company Name: St.do Plus
Studo Pus Job Title: Owner

Yr Namas Drake Find Chent

125 Bani St Main Phone: (613) 210-7455

Cell Phone: (613) 236-£200

Ozaws, Ontaro KiH JS

/\ Web Site: wwiw studiopus ca
‘ Address:
Edet Chient Stede Pus
Nathan Orake
&0 Rezeau St

1) Under General Info tab, browse through the contacts using the arrows to
see if there are any duplicates. If so, see if there is any difference in contact
infermation under Client Information as shown above.
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2) If the contact information is not the same, go to Step 3. If identical, click Delete

X

Are you sure you want to permanently delete Nathan Drake'?

You wil also permanently remove all related personal tax
clent as well

information for this

on either contact as shown above and then click Yes to confirm removal.

Step 3

Tools

Custom Tasks

Users Support

Auto-Notification

Edit Auto-Notification Template Comments

Open Advanced Missing Information Form

Open Advanced Communications Form

New Year Reschedule Wizard
Holiday Schedule Wizard

Interrupt Wizard

Remove Duplicate Companies Wizard

Remove Duplicate Contacts Wizard

Profile Integration Settings Wizard

R - In meny, go to Tools = Remove Duplicate Contacts Wizard

Step 4
p— — — - — p— 3
& Formt =8 §cR ~==|
|°¢“*-S"‘”' NIE— Herey Homebudder Bcb Trucker
Izabels Sth U [ Foskd Narme | MainVaus | MachVaue o | Petes Prirkes Joan Samyitan
. | SpouteProne_Cel Eoc Electicins  Hovey Homebusl
Robed Diske 0| Spouserddess NodaMooz  Petes Prinkes
Mavia Fucero 0O/ Soouzecty Jolt Rooler Enc Electscian
Sohn Docinan L g , . Joan Samaiten  Jelt Rooter
Kevin Tatiooitt 0| SeousePsrrines Orisio Ontaio Jiske Lawyes Joan Samstan
Bob Tracker O] SpouzePorailode Desek Serdh Jabe Loyt
May Seeandon O] SpouseCounty |sabels Smith Mokl Sconst
Oates Prler M| ButirnzNane Studio Phus Shado Pz ?:"‘“Yf"“"" rﬂﬂmﬂm_"mﬂn D ulu]
Eric Elechician O] tebwstConparginto Falin Faisn Robeit Diske ———
Jeif Roctes M| ButresslcbTile Owrat Owner Masia Frdento
Josn Samartan )| SutrnsDepuinert Jobn Dociman
Jobn Dooenan 0| BusresOlfce mm
Kevin Tattocit ButensFroos Man  (S1310853%556 192107456 it i 38
Bob Truckes M| BusrmsiProns Cel (5132355200 (513)235-5200 Herey Homebesddor
Sach gm £ O] Butiewa:Prons_Pager Petes Prichet
Jobn Docenan | ButensiProns_Fax Enc Electician
Kevin Tatiocit & | Butinezsbdden 1258k SL WAdesust [T j‘" "s““'.
f::"g' "dmk" ButrmsCay Ottawnd Ottarws Jm Lowyes
Herey M| BusirnziProvince Ontyo Ontario Joter Docemnsn
Michel Soones O] Cuttemt m‘lﬂm‘
Nathar Diske s O] Cutto2 b «| 1 »

W HigighMachesty [Losthams  v]

Pedorrn Metgs I

1) Select a contact from left sidebar list to begin duplicate search
2) Check off Highlight Matches by

3) Click on the matching contact from right sidebar list
4) Check off which information fields that is most updated tc keep as shown above
5) Click Perform Merge tc merge both identical contacts into cne
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'@ Holidays Schedule

Step 1

Q-GN Custom Tasks Users Support

Auto-Notification
Edit Auto-Notification Template Comments

Open Advanced Missing Information Form

Open Advanced Communications Form

New Year Reschedule Wizard

Holiday Schedule Wizard

Interrupt Wizard
Maintenance Wizard
Templates Folder Wizard
Sample Clients Wizard

Profile Integration Settings Wizard

R In menu, go to Tools = Holiday Schedule Wizard

Step 2

Holidays Schedule Wizard

FB Holidays Schedule Wizard

This wizard allows you to easily schedule your statutlory holidays 2011 |

and other important dates.

e
New Yeas - Jan 3 11 [ on | o | N | ns | PE |
Faemdy Day - Feb 21,11 = y
Viclonia Day - May 23, 11
meoow.s‘;m%“ ¥ New Year's Day ¥ Labow Day
2bow Day - Sep 5, < o
Tharksgiving - Oct 10, 11 V¥ Good Fiiday ¥ Thanksgiving Day
Christmas - Dec 26, 11 [~ Easter Monday [™ Remembrance Day
Boxing Day - Dec 27,11 3 S
¥ Victoria Day ¥ Chastmas [ |
W Canada Day ¥ Boxing Day a
Resel all unsert clert notfication Reset &l schedued tasks Talendat
dales to take into account the Date! fiedd to take into account the
holidays scheduled i the list. holdays scheduled in the ist.

Note: The new vear wzaid will automalticall create a new set of holidays each year,

Show Advanced Options >>

Cancel Ok

1) Select year to schedule holiday dates from drop-down list.

2) Check off which statutory holidays to schedule under the National tab

3) Check off any other important dates to schedule under your province tab

4) Click Reset all unsent client notitication... and/or Reset all scheduled

tasks... as shown above.
5) Optional: Click Show Advanced Options
6) Click Ok to save settings.
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Step 3

1AM Custom Tasks Users Support
Auto-Notification
I Edit Auto-Notification Template Comments

Open Advanced Missing Information Form
Open Advanced Communications Form

New Year Reschedule Wizard
Heliday Schedule Wizard
Interrupt Wizard
Maintenance Wizard
Templates Folder Wizard
Sample Clients Wizard

Remove Duplicate Companies Wizard

Remove Duplicate Contacts Wizard

Profile Integration Settings Wizard
R In menu, go to Tools = Edit Auto-Notification Template...

Step 4

'Edit Auto-Notification Templates 55
5}4 Edit Auto-Notification Templates

Customize your nofilfication templates that will be used when you notify your clients of upcoming tasks.
Select An Auto-Notification Template Type You Want To Edit:

Payroll Bamitt

Payroll Source Deductions

Customize Your Notification Template Select List Item To Save J
Inzeit A Merge Field ————
< >>
Dear <<Contact Full Name>>, [,' atk Irfo) = Test I
Your payroll source deduction remittance is due on T:kk I,m =
<<{Due Date, dddd, mmmm d yyyy)>>. Dus Date Resel to Delart
lnHousegue Date
Please arrange to drop off all paper work to allow us : ale
{to complete the return. imp:; g Reset Al Unsent Chent
: : Coergleted By Motficatons OF This
'You can call our office if you need any assistance or | |Date Completed Type To Use This
have any questions. Custom }ﬁ Fz‘g 12 & Template Commert

Enter the numbes of days prior o task due date you want your clients to Notification Period: rﬁ—
be of their upcoming tasks of this type,

Note: Clert Track wil subliact business days and ipnote weekends and hosdays. Open Hobday Schedule Wizad |

Cloze I

The notificaticn pericd of notifications sent to clients will ignore holidays scheduled
as shown above.
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» Maintenance

Step 1

A-EN Custom Tasks  Users  Suppeort

New Year Reschedule Wizard
Heliday Schedule Wizard
Interrupt Wizard

Maintenance Wizard
Templates Folder Wizard
Sample Clients Wizard

R In menu, go to Tools = Maintenance Wizard
Step 2

Maintenance Wizard (23]

~

\@ Maintenance Wizard

This wizard runs maintenance tasks which improves the performance
of Client Track.

Select the tasks below pou wish to perform then click the ‘Petform Maintenance’ bulton

General Maintenace I ] Other Maintenance ]

[~ Remove 0Old System Backups Open Backups Folder

[~ Change Your Information's CAPS (Type Case) Formatting CaPS Oplions \

[V Close Scheduled Tasks
& Close all tasks on or before date: | Nov 10, 2011 vl

¢ Qosetasks betweenthe. (557 2017 ] and Pec 3. 2011 <]

[ Verify Client Document Storage Folders

Client Track stores copies of all faxes, letlers and merge documents in & foldes on your
computes, This maintenance task confims the foldess exist and refreshes the data fle
with the folder locations.

[~ Rebuild Personal Tax Client Document Storage Folders

Eariler versions of Clent Track stored Personal tax clents’ folders using 'Fist last’ format.
Thés maintenance task renames all the Personal Tax clients' folders to the new ‘Last,
Fiest’ name format.

[ Verily Database Information

[T Verify Scheduled Project and Steps

Close Perform Maintenance

1) Select type of task to perform maintenance on Client Track under General
Maintenance tab. Close Scheduled Tasks is the most common task to
perform maintenance on as shown above. Select the date to close tasks.

2) Click the Other Maintenance tab.

Note: Client Track allows you to manually backup your data file. For instructions
on how to backup, click here.
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Maintenance Wizard

,J\/
2@ Maintenance Wizard

This wizard runs maintenance tasks which improves the performance
of Client Track.

Select the tasks below you wish to perfoim then click the ‘Perform Maintenance’ bulton

General Maintenace T I Other Maintenance I

¥ Archive completed 2010 tasks Change Year |

¢~ Archive only completed tasks o Aschive only completed tasks
for just 2010 for 2010 and prior years

" Archive altasks in 2010 " Auchive all tasks for 2010 and price years

[ Retiieve Tasks from Archives

 Relnzve al tasks n 2010 " Retiieve all task 2010 and §
[T Clear the 2010 Personal Tax Custom Fields

I~ Cle
f_ l¢ 14
c
-
r' s20m *
[~ Assign all 2010 Personal Tax clients to following user

l ]

Close Perform Maintenance

3) Select type of task to perform maintenance on Client Track under Other
Maintenance tab. Archive Completed 2010 tasks is also the most commeon
task to perform maintenance on as shown above. To archive previous years,
click Change Year and seleted year from drop-down list and then click Back.

4) Click the Perform Maintenance toc complete maintenance.

Custom Tasks Users Support
Auto-Notification

Edit Auto-Notification Template Comments

Open Advanced Missing Information Form

Open Advanced Communications Form

New Year Reschedule Wizard
Holiday Schedule Wizard
[ Interrupt Wizard

Maintenance Wizard

R From menu, go to Tools = Interrupt Wizard
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Step 2

15" Client Track Interrupt Control o) e s

j Interrupt Information

Interruption Time: 00:09:0

Keep this window open duting the cowse of this interruplion. Clent Track wil automaticaly tesume your previous
timer when this window is closed.

~ Type of Interupplion
Interrupiion Type: (] =
|<SelectIntenupt> 1
~ Interrupted By: (Dptional) AC‘ZI
Buginess Chert: |Sample Pinting Setvices v
Personal Tax Chent: I L]
Description of Interruption
Intemal Descriplion of Inteiruption: Cliznt Invoice Description of Intetuption
Irvoice cog, plirk detals, deadine -~ -~
Cancel Ok

1) Select a type of interruption that was created in Step 3 from drop-down list. If
needed to edit or add more interruption types, click the information icon.

2) Select a business or personal tax client

3) Optional: Include more descriptions of interruption

4) Note: Leave window open as long as interruption continues. Note the interruption
time on top as shown above.

S) After the interruption is over, click Ok to save settings.

Edit Existing Time Entry (=

General | Bifglfo |  BlingDescipion | BilTiveTo.. | Custominfo

|Tme Entiy Name: |Intenupted by: Phore Call | Time Entry Display Text

Errployes besigned: | 9:28 am to $:37 am ~
T Sample Printing Services
N Interrupted by: Phone Cal
Date: | November-0311 | =
[e:28am < v to [9:37aM = | Edt = Reliesh

Time Duration: |— kes 9

Business Clont: [Sange Pintimp Senices  w] o Schemes [<No Scherne Selectec v

Peesanal Tax Cleet: | ~| Tile Bat Background:
o gt [T
Solect Task: | Bod Backpound:
Bl Work Code: | Body Foreground:
Mon Bil Work Code: |
Biling Categoty: | <Select Category
Deiete | MergatoDoc \ Cancel ok ‘

315



6) The interruption informaticn and time appears in General tab as shown above.
7) Optional: Customize the color of time entry from drop-down lists.

8) Go through the other 4 tabs to include more infermation on interruption.

9) Click Ok to save settings.

Step 6

Time List

3 From menu, go to Time & Billing > Time List

Select User's Sched

October 31 - November 5, 2011
Mon 31

9:00a
:00 am to 11:00 am ~ [5:00 am to 1:00 pm P
Sample Printing Services Sample Lawyers Office
10:00a 5jjing WC - New Work Code
11:00a

The interrupt time entry appears on calendar. Double-click or right-click on time
entry and select Edit Time Entry to view or edit information.

. » New Year Reschedule

The New Year Reschedule Wizard reschedules all of the tasks and auto-notifications
for clients for the next year but only run the wizard at the beginning of the
new year.

Step 1

- Custom Tasks Users  Support
Auto-Notification
Edit Auto-Notification Template Comments

Open Advanced Missing Information Form
Open Advanced Communications Form

[ New Year Reschedule Wizard ]
Holiday Schedule Wizard

R From menu, go to Tools = New Year Reschedule Wizard
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Step 2

'New Year Reschedule Wizard

@ New Year Reschedule

This wizard allows you to automalically reschedule all of your tasks and
automatic notifications for your clients for the next year.

Now iz a good time to backup your data before starling the new year. Click the ‘Backup Youw Data File'
button to run the Clent Track Backup Wizard

Backup Your Data File |

[Chck "Next' to continue)

Heb Cancel Skip this Step > <Back | New > Finith

1) Back up data file by clicking Backup Your Data File tc bring up Backup and
Restore Wizard. For instructions on how to back up data file, click here.
2) Click Next

Step 2

New Year Reschedule Wizard

@ New Year Reschedule

Client Track will create new tasks for the 2012 year based on the tasks
created in the 2011 year.

Step 10f3

Check the task categories you want to have rescheduled below. If you uncheck a category. no tasks
vall be created for any of your chents for the ndicated year

Task Categories
M Gst M wsie ] Low Remindess
™ est M EHr ] Othes
[ Parol Remit [ YeaErd & Custom

[¥] Employee Payoll [l Comporate Tax

Advanced Options |

Hep Cancel Skip tis Step > <Back Nest> | Finith I

1) Check off which task categories to reschedule for new year.
2) Click Advanced Options

New Year Reschedule Wizard

g New Year Reschedule
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General Dptions Imum Date owom] Calenda Date Opliom] Emf‘" Time ] Custom Field Options

Chiert Track reschedules all the recuting latks by rescheduling tasks from the sowce pear and creating new

onas n the destination year.
Select Source Year . Reschedule Automatic Notifications 'i
SourceYear: (2011 Automatically ensble sutomatic notications n |
the destination year for those tasks that had it [
enabled in the sowce year, ‘
Sclect Destination Year L
Destination Year: (2012 | ~Enable Pop-ups

destination year for thase tasks that had them
ensbled in the sowce pear,

v Automanicaly enable usar pop ups in the

< Back | Finish

3) In General Options tab, select source and destinaticn years.
4) Go through the other 4 tabs if needed and when completed, click Back.
5) Click Next.

This process may take a few minutes and appear to pause near
the end, particularly if you are accessing a networked data file.
Please be patient.

{.7

Reschedulng Bookkeeping

O |

g! The scheduled tasks have been created sucessfuly

6) Click Ok to begin rescheduling tasks
7) When finished, click Ok to continue on with New Year Reschedule Wizard

Step 5
'New Year Reschedule Wizard

g New Year Reschedule

Step2o0f3

Now that you have created all your tasks for the new year you should archive
your completed tasks from last year.

When you archive your tasks you are storing them in a separate location from your curent tasks.
This allows Chent Track to run laster and fnd your task search resuls more quickly by only
searchng through pour curtent tasks,
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Yeu can ¢lil access yow achived tasks by ceatching thecugh yout Aichives in the Task Lists

Seclion.

Heb

Archive Options

& Achive only completed lacks from previcus year (Recommended)
" Archive all tasks from previous year

Cancel Skip his Step > <Back | Nest > |

Finish

1) Under Archive Options, select Archive only completed tasks from...

2) Click Next.

sucessfully archived.

TQ__ ! All completed tasks before December 31 2011 have been

3) Click Ok after tasks have been archived

Step 6

'New Year Reschedule Wizard

Client Track will now allow you to choose which personal tax clients

E New Year Reschedule

you want to roll forward to the next year

Step

Nolte: You wil have the oppoiturily to easily import, add, remave and copy clients lrom other lax yeats

Hebp

[S@ !4 Client Track Personal clients
=& 2010

3of3

Drake. Nathan
¥ & Diske. Robert
M8 Fukero, Madia
M8 Mattison, James
VI8 Meos, Nadia
08 Samantan, Joan
8 Samantan, Joan
08 Smith, Dawd

Smith, Desek
& Grith leabala

v g Diske. Nathan
=

and also impoat information from other tax peograms 2t any lime, so this slep iz not critical

Cancel Skip this Step > < Back Newt >

1) Check off which personal tax clients te roll into new year and then click Finish

Einish

;Q)! The selected personal tax clients have been rolled forward

sucessfully.

2) Click Ok after clients have been rolled over succesfully.
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Profile Integration Settings

Step 1

Q-GN Custom Tasks Users  Support

Auto-Notification
Edit Auto-Notification Template Comments

Open Advanced Missing Information Form
Open Advanced Communications Form

[ Profile Integration Settings Wizard

R In menu, go to Tools = Profile Integration Settings Wizard

Step 2

Data Integraticn Options

Profile T1 l

‘TaxYea: 2010 J

-~ Profile T1 Integration Control for 2010
¥ Show the Profile T1 Integration Controls

The Profile Integialion cortrols are a seiies of bultons that appear below the
cortact information summary on the 'General Info’ tab in the Client Info section.

Profile Information to be imported for 2010
[~ Show The Following Profile Info In The Clients’ Summaries

Select which of the following you'd lke to import from Prclile and
display in the client’s summaty information.

WV Profie Cliert Status ™ GST Refund (in $3)

W eFile Status ¥ Discounrted [Yes/No)

¥ T5007 [Yes/No) ¥ Deceased Retun [Yes/No)
™ Revenue (in $3) W Date Return Created

[ Estimated Refund (in $3) V¥ Date Return Signed

[T Actusl Refund (in $3) [T Prepater Name

™ Paid to Client fin $$) [T Pastner Name

-Default Profile T1 ‘Save To' Folder for 2010 tax files

The following indicates the folder that Client Track will save new Profie T1
files created vathin Clierst Track to.

| C:\Users\GraphicGuy\D ocuments\Profile Browse (= v

Cancel | ok

1) Select tax year frem drop-down list

2) Check off Show the Profile T1 Integration Controls under Profile T1
Integration Control for 2010.

3) Check off Show The Following Profile... and select which fields to import.

4) Click Browse to find folder to save Profile file in.

5) Click Ok to save settings.
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Step 3

Client Info

R In Personal Clients, go to = Client Info (icon)

Step 4

" Personal Clients |

Pension &
RRSP

Info More Info

Client Status: Aclive

Client Information

Client Info

j ‘;“1 ') Name: Nathan Drake
v @ Address:
Find Client Studio Plos
Nathan Drake
80 Rideau St.
Lasks Ottawa, Ontario K4G 7J8
Time & Billing
— Updste Pfil | | Create New Proie ik
Projects

1) Under Client Information, click Update Profile

= ! There is no file currently associated with this client in Client

. Track for the 2010 tax year. Do you want to specify the Profile
file location now?
Note: Client Track will automtically record the file location if you
import this client from the 2010 Profile using our import wizard.

2) Click Yes to browse folder to save Profile T1 file if it hasn't been done in Step 2.

72+ Select the 2010 Profile file for Nathan Drake =
@—@v( I » GraphicGuy » My Documents » v é9 || Search My Documents r
Organize v New folder =2~ 0 O
2 Favorites = Name Date modified Type A
B Desktop |, Adcbe 16/12/2010 DM File folder
& Cownloads E I, Backgrounds 21/05/2010 8:11 AM  File folder
L. RecentPlaces 1. Client Track Files 2105/2010 812 AM  File folder
1. Downloads 21/05/2010 8:06 AM  File folder B
1% Computer |. Profite 10/11/2011 12:56 .. File folder
& He ) | Profile Templates 21/05/2010 8:12 AM  File folder -
FacToRy mas v ¢ ) J ’
File name: ~ [Profite T2 TaxFile (*10T;05T;" ~)

oo 9 (oo ]

3) Select the Profile T1 file in appropriate folder and click Open.
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Step 5

“Personal Clients | s : Famy TS
enera am ension
Info | o | Members |E“"‘°"m‘| RASP

Client Status: Aclive
Client Information @

Client Info
.,-l ;) Address:
Studio Plus
il Nathan Drake
80 Rideau St.
Jasks Ottawa, Ontario K4G 7J8
Time & Billing
Appointments [ Update Prcfile ] [ Create New Profie File ]
Projects

1) Under Client Information, click Create New Profile File

Profile Year Wizard

Profile Year Wizard

Select year for new Profile T1 file: 2010 vl

LCancel | 0Ok |

2) Select Profile year from drop-down list if it hasn't been created in Step 2.
3) Click Ok to save year.

/

» Removing Sample Clients
"SurtupWiurd

MR, ClientTrack Startup Wizard

Your Clients

Select which type of clients you want to import to
start using Client Track.

-

- Type Of Clients

@ Install Sample Clients
You can temove sample clents at any lime and & wont
affect any clents you impest o entes manualy.

" Add Your First Client

Note: Youmay install o uninstall the sample clients al any tins
vamout affeciing sy of your existing mfoemabion o any new
information you enter,

Concel | < Back New> |  Finish |

If you have selected Install Sample Clients from the Startup Wizard
(shown above) when you first begin using Client Track and want to remove the

sample clients, follow these steps: 329




-5 Custom Tasks Users  Support

Auto-Notification
Edit Auto-Notification Template Comments

Open Advanced Missing Information Form
Open Advanced Communications Form

New Year Reschedule Wizard
Holiday Schedule Wizard
Interrupt Wizard

Maintenance Wizard
Templates Folder Wizard

| Sample Clients Wizard

R In menu, go to Tools = Sample Clients Wizard

Step 2

Client Track Wizard

m Sample Clients Wizard

In order to help you familiarize yourself with Client Track, Client Track can install
sample clients to help you explore all of Client Track's features.

You may install or uninstall the sample clients at any time without affecting any
of your existing information or any new information you enter.

Cancel

Remove Sample Clients

Install Sample Clients

Click Remove Sample Clients to delete sample clients.

Note: If you have manually entered your own clients along with sample clients,
your clients will remain in Client Track. If you only have sample clients installed,
the Startup Wizard will appear after you removed sample clients asking for user
information and type of clients.

'@ Installing Sample Clients

Startup Wizard

e

A

/77

Client Track Startup Wizard

Your Clients

Select which type of clients you want to import to
start using Client Track.

~ Type Of Clients
& Install Sample Clients

You can remove sample cients at any lime and &t won't

affect any chents you impest or entes manualy.



| Add You First Client |

Note: Youmay install or uninstall the sample clients al any tine
vamout affecting any of your existing mfocmation o any new
information you enter,

Concel | <Back |  MNet> | Finish |

If you have selected Add Your First Client from the Startup Wizard
(shown above) when you first begin using Client Track and want to install the
sample clients, follow these steps:

Step 1

AN Custom Tasks Users Suppert

Auto-Notification
Edit Auto-Notification Template Comments

Open Advanced Missing Information Form
Open Advanced Communications Form

New Year Reschedule Wizard
Holiday Schedule Wizard
Interrupt Wizard
Maintenance Wizard
Templates Folder Wizard

| Sample Clients Wizard

R In menu, go to Tools = Sample Clients Wizard

Step 2

Client Track Wizard
@ Sample Clients Wizard

In order to help you familiarize yourself with Client Track, Client Track can install
sample clients to help you explore all of Client Track's features.

You may install or uninstall the sample clients at any time without affecting any
of your existing information or any new information you enter.

gerssmsensnssssressasensssensntessnsnens)

Cancel Remove Sample Clients Install Sample Clients

Click Install Sample Clients to install sample clients.

Note: If Add Your First Client was selected from Startup Wizard, the Install
Sample Clients button will be enabled in Sample Clients Wizard.
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» Send Notification

Step 1
Tasks List
3 In Tasks, go to > Tasks List (icon)
Step 2
#2' Client Track

File Edit Tools Custom Tasks Reports Users Support
Business Clients | Tasks List (537 tasks)

Personal Clients ? . a El @ W

Advanced View/Hide View/Primt Tasks For Tasks For A Prior
Search Columns Report This Week This Month Unclosed Tasks

| =)

Name | DueDate | Chse  Emplopeefssigned

Bookkeeping Dec25,11 [ lsabeba Smith GG[ View Info [ Notity Now l
Bookkeeping Dec25.11 [ | Admabben (3 G| Viewinlo | Noiiyhow |
Bookkesping Dec25,11 [ NoneAssigned GG[ View Info [NollyNow]

Move the horizontal scrollbar to the far end and click Notify Now on any task.

Step 3

Send Notification Wizard @

Send Notification Wizard

This wizard will allow you to notify Sample Trucking Company reqading thei
Bookkesping.

Notification Date
iSaturday. March 12, 2011 L'

Notification Method
@ [T Eemail
[~ Fax
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B

] [T Letter
@ [~ PhoneCal

" Cancel |

Edit Notification Template ]

Note: A notification template can be customized by clicking Edit Notification
Template shown above.

E-mail

Send Notification (Email)

Send Notification (Email)

Tor I 3
ce | =
Bee l |

Subject: Iﬁegatding your personal tax retum

[T Insest Cliert Personal Address And Date

Featherite Inc.,

Thank you from the Trilobyte Selulions Inc, team,

Cancel Advanced Options Finish |

1) Check off E-mail under Notification Method from Step 1.
2) Type in all contact's name and email.
3) Click Finish to send notification.

Fax

‘Send Notification (Fax) &=

[ > -
@ Send Notification (Fax)

Tor [Featherite Inc.
Recipient Fax No.: | | From [Trlobyte Sclutions Inc.

Nurmbet of Pages: |1 (inchadingcc  Subject: [Regarding your personal tax retum
™ Insest Clent Pessonal Addeess

IFewmﬂe Inc.
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Thank yeu lrom the Triobste Solutuas Inc, team.

Cancel | Advarced Options |

1) Check off Fax under Notification Method from Step 1.

2) Select contact's fax number from drop-down list.

3) Click Finish to send notification.

Optional: To include client's business address, check off Insert Client...Address.

Letter

Send Notification (Letter) |23

E =/ Send Notification (Letter)

—
—

[ Insert Client Personal &ddress

Featherlite Inc.,

Thank you from the Trilobyte Solutions Inc. team.

reeemetssmaesstsansrory]

Cancel Advanced Oplions { Finish !

1) Check off Letter under Notification Method from Step 1.
2) Click Finish tc send notification.
Optional: To include client's address, check off Insert Client...Address.

Phone

‘Send Notification (Phone) ==
@ Send Notification (Phone)

Person To Call: |Bob Trucke:

Telephone Numbe:: (705) 555-9863 ~|

Available Times: |

Dear Bob Trucker,
Your Bookkeeping is due on Friday, March 25 2011.

Please arrange to drop off all paper work to allow us to complete the
return.
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You can call our office if you need any assistance or have any
questions.

No angwer, call again later!

1) Check off Phone under Notification Method from Step 1.
2) Select contact's phone number from drop-down list.
3) Click Call Completed to send notification.

Optional: To include times when to call client, type in Available Times.

» Templates Folder
Step 1

Q- Custom Tasks Users Support

New Year Reschedule Wizard
Holiday Schedule Wizard
Interrupt Wizard
Maintenance Wizard

| Templates Felder Wizard
Sample Clients Wizard

R In menu, go to Tools = Templates Folder Wizard

Step 2

Templates Folder Wizard =5
\D Templates Folder Wizard

The template folder wizard allows you to specify the location of the folder which
stores your template and client merge documents.

~ Template Folder Information

I Folder Location: C:\Users\GraphicGuy'Documents\Template Documents

~ Specify Folder Location

Cick thés button to manually specily the location of the templates folder. If pou have Client Track
setup on a nelweek you should have 3l of your Client Track installstions point to the same folder.

Specify Folder Location

Cancel I Ok l

1) The location of merge templates can be found beside Folder Location.

2) Click Specify Folder Location tc manually select folder if data file was placed
on the network.

3) Click Ok to save settings.
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